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Chapter 1. Introduction
Unica Plan  is a tool for enterprise planning, collaboration, and workflow that provides a complete solution for the needs of 

marketers. You can use Unica Plan  to get a comprehensive and holistic view of all marketing projects across your company.

You can then focus on improving each dimension of marketing planning. Everyone on the marketing team: chief marketing 

officers, marketing managers, event planners, creative directors, and marketing controllers, realizes immediate benefits in 

efficiency and performance.

What does Unica Plan  do?

Unica Plan  is the marketing resource management (MRM) solution to plan, budget, and monitor every type of marketing 

program in your company.

Use Unica Plan  for the following tasks.

• Get real-time visibility into every marketing program.

• Manage all marketing activities, including advertising, brand management, direct and interactive marketing, 

promotions, events, collateral, research, public relations.

• Enforce quality standards.

• Increase productivity and optimization of resources, including people and budgets, through automated workflow, 

collaboration, and unique optimization capabilities.

• Promote effective management of marketing content and projects that are created by dynamic marketing 

organizations.

• Manage workflow and projects across the entire marketing operation for all types of media, events, campaigns, and 

brand loyalty efforts. For projects as diverse as mailers, ad campaigns, catalogs, and seminars, Unica Plan  is an 

effective management tool.

Why use Unica Plan?
Unica Plan, users increase the return and lower the risk of resource investments by optimizing decisions, collaborating 

across programs, operating more efficiently, and gaining greater visibility.

Unica Plan  has the following benefits.

• Manage and coordinate all your marketing activities in one solution.

Because all relevant marketing information is in one place, there are fewer misaligned investments. Centralization 

leads to tighter controls over which marketing programs are started. As a result, greater operational efficiencies are 

gained, allowing marketers to get to market rapidly and spend more time on strategy.

• Improve decision making, minimize risk.

The marketing measurement that is provided by using Unica Plan  enables marketers to focus on the most profitable 

opportunities. Additionally, marketers make better tactical decisions because the marketing mix is more easily 

optimized.
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• Ensure that strategic goals and marketing activities align.

Strategic goals, marketing plans, and budgets are centralized to promote clarity of agreed upon objectives and tactics 

to achieve business goals. The result is improved alignment of marketing plans and activity.

• Achieve faster, lower-cost execution of all marketing activities.

Rather than reconciling individual project plans, chasing down approvals, and manually tracking creative changes, 

project plans and assets are centralized, and approvals are clear and automated. Waste is eliminated because better 

execution results in less duplication of effort, fewer fees and penalties for completing tasks in a rush, and allocation 

of resources to the right programs.

• Create To-dos and Checklists

To-dos are items in a checklist. To-do is a task or an activity that you must perform. Checklist maintains lists of to-

dos for yourself or for another user. These features are independent of other features of Unica Plan.

• Ensure compliance.

By using the centralized repository and advanced reporting capabilities in Unica Plan, marketers reduce time and 

money that is spent satisfying the needs of regulatory agencies, corporate auditors, and management.

• Open, flexible architecture.

Unica Plan  is based on an open architecture that makes it easy for IT to implement and use your existing 

infrastructure and data. Unica Plan  uses a three-tier Java™  Platform, Enterprise Edition architecture, which separates 

the client, web server, application server, and back-end data sources.

Unica Plan  documentation and help
Different people in your organization use Unica Plan  to accomplish different tasks. Information about Unica Plan  is available 

in a set of guides, each of which is intended for use by team members with specific objectives and skill sets.

The following table describes the information available in each guide.

Table  1. Guides in the Unica Plan  documentation set

The following three-column table describes tasks in one column, guide names in the second column, and audience in the third column.

If you See Audience

• Plan and manage projects

• Establish workflow tasks, 

milestones, and personnel

• Track project expenses

• Get reviews and approvals for 

content

Unica Plan  User's Guide • Project managers

• Creative designers

• Direct mail marketing managers

• Marketers

7
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Table  1. Guides in the Unica Plan  documentation set

The following three-column table describes tasks in one column, guide names in the second column, and audience in the third column.

(continued)

If you See Audience

• Produce reports

• Create to-dos and checklists

• Design templates, forms, 

attributes, and metrics

• Customize the user interface

• Define user access levels and 

security

• Implement optional features

• Configure and tune Unica Plan

Unica Plan  Administrator's Guide • Project managers

• IT administrators

• Implementation consultants

• Create marketing campaigns

• Plan offers

• Implement integration between 

Unica Plan  and Unica Campaign

• Implement integration between 

Unica Plan  and  IBM Digital 

Recommendations

Unica Plan  and Integration Guide • Project managers

• Marketing execution specialists

• Direct marketing managers

• Learn about new system 

features

• Research known issues and 

workarounds

Unica Plan  Release Notes® Everyone who uses Unica Plan

• Install Unica Plan

• Configure Unica Plan

• Upgrade to a new version of 

Unica Plan

Unica Plan  Installation Guide • Software implementation 

consultants

• IT administrators

• Database administrators
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Table  1. Guides in the Unica Plan  documentation set

The following three-column table describes tasks in one column, guide names in the second column, and audience in the third column.

(continued)

If you See Audience

Create custom procedures to integrate 

Unica Plan  with other applications

Unica Plan  Integration Module  and 

the API JavaDocs available when you 

click Help > Product Documentation 

in Unica Plan, and then download the 

UnicaPlan<version>PublicAPI.

zip  file for the SOAP API and 

UnicaPlan<version>PublicAPI-Re

stClient.zip  for the REST API.

• IT administrators

• Database administrators

• Implementation consultants

Learn about the structure of the Unica 

Plan  database

Unica Plan  System Schema Database administrators

Need more information while you work • Get help and search or browse 

the  User's, Administrator's, or 

Installation  guides: Click Help > 

Help for this page

• Access all of the Unica Plan 

guides: Click Help > Product 

Documentation

• Access guides for all Unica 

products: Click Help > All Unica 

Suite Documentation

Everyone who uses Unica Plan

Unica Plan  workflow
The workflow for Unica Plan  includes creating and managing marketing objects, such as plans, programs, and projects.

Before you begin

Before you start working in Unica Plan, your administrator must install Unica Plan  and set it up. If you are having problems, 

contact your administrator.

About this task

The following steps outline some of the major tasks users do in Unica Plan.

9
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1. Create plans that contain programs.

2. Create programs that contain projects.

3. Create more projects, request a project, accept a request, start a project, or view projects.

4. Work with projects by completing the setup of workflows, viewing and modifying tasks, and printing, copying, and 

deleting the projects.

5. Work with assets, including adding, editing, and changing the status of assets. You can also add folders.

6. Work with approvals, including adding an approval process; submitting it for review; canceling the review; modifying, 

printing, and deleting it; putting the approval on hold; responding to it; and marking up approval items with comments.

7. Create invoices that track expenses related to programs and projects.

8. Search for projects and approvals with both the standard and advanced search capabilities, and save advanced 

searches for future use.

9. Collaborate with other users with the alerts window and the message board.

10. Create To-dos and Checklists to track items to be performed by you or other users.

Integration with Unica Campaign
Unica Plan  optionally integrates with Unica Campaign, which, in turn, can integrate with several other products. When Unica 

Plan  and Unica Campaign  are integrated, you can use the marketing resource management features in Unica Plan  to create, 

plan, and approve campaigns and flowcharts.

For information about working with an integrated system, see the Unica Plan  and Unica Campaign  Integration Guide.

Business processes
In Unica Plan, a business process is the representation of a collection of related, structured activities (a chain of events).

A business process can produce one of the following results:

• Marketing activities that are targeted at a particular set of prospects or customers

• Reusable marketing components that support these marketing activities

Unica Plan  provides the following types of business processes:

• Plans

• Programs

• Projects

• Subprojects

• Project requests

• Approvals

Relationship of planning objects
In Unica Plan, planning objects include plans, programs, and projects. Plans contain one or more programs, and programs 

contain one or more projects. Projects can contain subprojects. A budget for a plan consists of individual line items for 

projects and programs that roll up into the budget for the plan.
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The following diagram shows how the planning objects relate to one another.

On the summary page of projects and programs, there is a field called Parent Items and Code  that contains a view of the 

ancestors for the object. For example, the summary page of a subproject shows the current object (a subproject), its parent 

project, and all of its ancestors back to its root plan. The ID codes for these objects are displayed, as well as direct links to 

each of the ancestor objects.

Plans
A plan captures the objectives of a business unit or area for a specific time period, typically measured yearly or quarterly. 

A plan also serves as a container and "rollup" point for the various programs and projects that you define to meet your 

marketing goals.

Information from "child" programs and child projects of the programs roll up to the plan, tracking linked information. For 

example, if you have a plan with a child program, you can make budget information that is related to the program roll up from 

the program to the plan. You can then study and track this information from the perspective of the plan.

Programs
A program represents a marketing activity and is typically comprises multiple related marketing deliverables or initiatives.

A program can contain or group multiple projects. The program itself has information that is central or common to the 

development and execution of these marketing deliverables. For example, a direct marketing program might contain multiple 

11
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projects each representing a distinct marketing promotion or campaign. A product launch program might contain projects 

that pertain to various types of collateral development, analyst briefings, and tradeshow attendance.

Projects
A project represents all of the information that is related to developing and running one or more related marketing 

deliverables or initiatives. This information can include a checklist or schedule of tasks that people who work on the project 

must complete to prepare and produce the deliverables for the project.

For example, you might create the project "Monthly Tradeshow" to collect all information that is needed for the one 

tradeshow each month that your organization attends. This information might include any of the following information:

• Who attends the show

• What equipment you need in the booth

• Demonstrations of the product that you intend to present

• Collateral to hand out to customers

• Costs of promotional materials

Note:  Projects can have subprojects. A subproject has the same characteristics as a project. A subproject is linked to 

a parent project; any project that is linked in this manner is referred to as a subproject.

Project structure

A project contains a workflow, budget information, metrics, digital assets, approvals, and both standard and custom 

information. Not every project needs all of this information; most of it is optional and can be completed only when needed.

Note:  Approvals can also exist independently from projects. An approval does not need to be associated with a 

particular project.

Project requests

If you do not have the security permissions to create a project, you create a project request. A project request is similar to a 

work order or creative brief. It represents a request for someone else to do work according to the specifications supplied by 

the requester.

Users within an organization and outside vendors can request a project. For example, an outside vendor can submit a project 

request to the marketing services organization that requests collateral material. The marketing services representative 

accepts the request and creates a project, which organizes tasks and assigning resources to manage the creation of the 

collateral.

If you request a project, you are a requester. The requester then submits the request to a recipient for approval. When the 

recipient accepts the request, the recipient owns the resulting project and is called the owner.
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Note:  A project request does not contain a workflow. When the request is approved and is converted to a project, it 

contains the appropriate workflow.

Approvals
An approval process streamlines the process of having your work reviewed and approved. Multiple users can review work in 

parallel or in an order that represents your business processes.

Reviewers (or approvers) can electronically mark up content that is submitted for review. Then, Unica Plan  records approvals 

and denials for audit purposes. You can tie approvals to a project or they can exist independently from any project.

You can use some approval features on mobile devices.

Teams
A team is a group of people who work together to complete tasks across a number of different business processes. 

Someone in charge of a business process can assign tasks to a team, rather than an individual, when necessary.

Team leaders manage their resources across initiatives. Team leaders can decide to explicitly assign work to team members 

or allow team members to assign work to themselves. In all cases, the team leader can monitor the queue of work that is 

assigned to their team and track the progress and performance of individual team members.

Alerts
Alerts are notifications of important events or actions you need to take regarding a program, project, a project request, 

asset, account, approval, or invoice. For example, an alert might remind you that a project is running behind schedule or over 

budget, or that an item needs your approval.

You receive alerts directly through Unica Plan  and through email. When you receive an alert through Unica Plan, you go to the 

Alerts  page to view it. When you receive an alert through email, it goes directly to the inbox of your email application.

There are two types of alerts in Unica Plan.

• Alerts that Unica Plan  sends based on events, such as the start of a project.

• Alarms that an administrator sets up to send at regular intervals, such as one time a day.

Attachments
Team members can attach relevant documents to the main Unica Plan  objects. An attachment is a URL, digital asset, or 

a file that you add to a Unica Plan  object. You can add attachments to plans, programs, projects, invoices, approvals, and 

accounts.

Attachments can be organized by category. For example, your project might contain the following attachment categories.

• Reference Materials

• Vendor Forms

13
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• Offer Creatives

• Deliverables

The attachment categories are set up in the template that is used to create the particular object.

Metrics
Metrics are used for management reports and analysis. View metrics on the Tracking  tab for plans, programs, and projects.

Use Unica Plan  metrics for the following calculations.

• Automatically calculate internal measures (such as budgets and resource consumption).

• Automatically tabulate program results, such as the following results.

◦ Measure consistently across activities.

◦ Aggregate results across programs.

• Automatically link key metrics, such as number of contacts and responses, from campaigns back to project metrics.

• Build a marketing memory.

The metrics that are available in a plan, program, or project depend on the template you used to create it.

Workflows
A workflow displays and manages the group of tasks and milestones that drives the project. Workflows efficiently meet and 

manage project goals.

Tasks, dependencies, and durations are populated for a workflow based on the template that is used to create it. You can 

view workflow information as either a spreadsheet, timeline, or process flowchart. You can use workflows to forecast and 

plan your activities. After work begins, workflows make monitoring progress and identifying bottlenecks easy.

Functional roles
When you set up a project, you assign individuals to tasks based on the individuals' functional role or job role, such as writer, 

graphic artist, or project manager. Unica Plan  uses the concept of roles as a bridge between people and tasks.

Roles have the following benefits.

• People come and go: assigning a role to a task makes it easier to control work when people leave or return to a 

project.

• Resources are not always available: you can assign a role to a task before any people are available to fill the role or 

perform the task.

• Roles are predictable: you can create project templates with standard roles and fill people into the roles 

independently for each project you create from the project template.
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Security policies
A security policy is a set of rules that govern objects that are associated with the policy, such as plans, programs, and 

projects. These rules indicate which types of users can view, modify, delete, or perform any of the other relevant functions for 

these objects.

To express these security privileges, security policies contain the following components:

• User roles to identify the types of users

• Function grants or blocks to identify what each type of user can or cannot do

Your organization might use multiple security policies. One example security policy, Global, is provided with Unica Plan.

The global policy is a special policy that is always considered in controlling all objects in the system, rather than all users. 

Companies with simple security models can customize the global policy to express their rules.

Companies that require different, discrete groups can use custom security policies to do so. Then, these companies can use 

the global policy only for system-wide administrative or executive access rules.

Note:  The term global does not indicate that every user has full access to everything. Instead, the security policy is 

globally associated with every user by default.

The Unica Plan  Administrator's Guide  discusses the details of security policies in more depth.

Strategic planning and financial management
Unica Plan  includes strategic planning and financial management.

Manage strategic planning and financial management with the following features.

• Develop top-down budgets for marketing plans and the programs they contain.

• Track actual expenses that are incurred, regarding the budget.

• Facilitate spend tracking and reporting in Accounting (GL) terms.

In Unica Plan, you use the following tools for Strategic Planning and Financial Management tasks.

• Accounts

• Budgets

• Cost Categories

• Invoices

Accounts
The finance department can use accounts to monitor the expenditures and cash flow for your business.
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A top-level account represents a specific corporate general ledger account for tracking and controlling expenditures and 

cash flows for a certain area of the business. This account tracks budget needs and expenditures at weekly and monthly 

levels and then aggregates them to quarterly and yearly levels.

Accounts can have subaccounts. Depending on the account structure at your company, the subaccounts also might 

represent specific general ledger accounts. Alternatively, subaccounts might represent a greater level of granularity that 

marketing wants to track, even if the general ledger structure doesn't include that level of detail.

Budgets
In Unica Plan, a budget coordinates expenses of plans, programs, and projects. After you establish the plan budget, you can 

fund linked programs, and ultimately projects, from it. Unica Plan  tracks budgets of child programs and projects in the form 

of allocations, forecasted or committed spending, and actual expenses.

Unica Plan  tracks budgets of child programs and projects, although these objects can have different owners. For example, a 

program that is linked to a plan can have a different owner than the plan itself. As such, the person who allocates a budget 

from a plan down to a program can be different from the person forecasting expenses from a program up to a plan. A plan 

owner, such as a marketing manager, can track expected expenses from child programs, projects, and the plan budget itself, 

to remain responsive to budgetary needs.

Note:  Budgets are available only when the  Unica Plan  financial module is enabled.

Fiscal year

You can view the total budget for all years, or see a detailed view for a particular year that is broken down into weeks, 

months, or quarters.

Unica Plan  keeps budget information for the current fiscal year, the next two fiscal years, and any past fiscal years that date 

back to when you first installed Unica Plan.

On the plan level, to view or edit a different fiscal year, change the Fiscal Year  field value on the Plan Summary  tab. Linked 

programs and projects take the financial year from the parent plan; stand-alone programs and projects use the system's 

current fiscal year.

Granularity

With Unica Plan, you can break fiscal years into weeks, months, or quarters. When you create a plan, program, or project, 

choose the wanted increment from the Budget Granularity  list on the Summary  tab.

Users cannot edit budget granularity. Plans, programs, and projects with different budget granularities are not allowed to be 

linked together.

For example, if a plan's fiscal year is broken into months, you can only link it to programs and projects that also use months 

as the budget granularity. In this scenario, programs and projects with weeks or quarters as their granularity are unavailable 

for linking.
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Cost categories
Cost categories are used to categorize expenses into types, such as travel expense and mailing expense. Cost categories are 

used both when tracking invoices and creating budgets.

For details on creating and editing cost categories, see the Unica Plan  Administrator's Guide.

Invoices
In Unica Plan, an invoice electronically captures a paper invoice that is submitted to a marketing department for services, 

time, or materials that are provided by a third-party vendor or supplier. You must manually transfer the information from the 

paper invoice into an Unica Plan  invoice.

Here are some advantages of transferring your paper invoices to Unica Plan.

• Easy accessibility

• Accurate and immediate expense tracking

• Vendor spend analysis

• Roll up reporting

• Periodic transfer or export to a general ledger (GL) system

Libraries of reusable elements
Within Unica Plan, you can store and reuse marketing items.

Unica Plan  provides libraries to store the following reusable elements:

• Marketing objects: Products a marketing team develops

• Digital assets: Electronically stored documents that can be used or referenced in a marketing program

Marketing objects
A marketing object is any work product a team develops and reuses in the course of its marketing activities. Marketing 

objects can represent physical items (such as a letter or banner ad) or a business component (such as a credit card offer, a 

target segment definition, or a rewards program definition).

You can create new marketing objects if you have permission to do so. After you create a marketing object, you can start it at 

any time. Starting the marketing object makes it active.

• You define and manage marketing objects that represent all reusable work products.

• You can perform basic operations (create, edit, change state, copy, link, and delete) on marketing objects.

• You enter and manage all of the attributes that define a particular marketing object, such as name, owner, state/

status, description.

• You can define and manage business processes (such as projects) that produce, modify, and retire marketing 

objects.

• You can construct robust projects that define multiple marketing activities by "assembling" each discrete marketing 

activity from existing marketing objects.
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Unica Plan  marketing objects are defined in stages, and how they are defined influences how they are organized and 

presented to users. The following terms are important in understanding the definition and organization of marketing objects.

Marketing object type

A marketing object type is the highest-level division for marketing objects. An administrator creates marketing object types. 

Each marketing object type has a menu item, but the menu on which it appears depends on how the administrator configured 

the marketing object type.

Marketing object template

A marketing object type is broken down into one or more marketing object templates. Typically, an administrator creates a 

marketing object template for each significant characteristic for the marketing object type.

Marketing object instance

A marketing object instance is a single marketing object. Users with appropriate security permissions create marketing 

object instances from marketing object templates. Within Unica Plan, marketing object instances are called "marketing 

objects".

Digital asset management
A digital asset is any electronically stored document that you might want to use or reference in a marketing program. Digital 

assets can include brand images, marketing research documents, reference materials, corporate collateral, letterheads, or 

document templates.

You can store all marketing assets in a secure, central location, by using Unica Plan  Assets, with the following advantages:

• Use concepts that were approved in previous marketing campaigns.

• Require pre-approval of material to reduce review times.

• Assign usage guidelines and expiration dates to items.

Additionally, assets that are contained in Approval objects have integrated mark-up capabilities that enable collaboration 

between staff and agency partners and tracking of comments, edits, and changes within creative content.

Logging in to Unica
Before you begin

This procedure assumes that you know the website address (or URL) to your server and you have an assigned user name 

and password. If you need help, contact your Unica  administrator.

1. Open a supported browser and enter the URL to the Unica  server.

The prompts that display vary based on the security settings that are defined for your installation.

2. If prompted, accept the digital security certificate.
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3. On the login page, enter your user name and password, then click Sign In.

If you are prompted to accept the digital security certificate, click Yes  to accept the certificate.

Results

The dashboard or the default start page displays. The options that are available to you depend on the permissions that are 

assigned to you by your Unica  administrator.

Note:  For a list of supported browsers, see the  Unica  Enterprise Products Recommended Software Environments 

and Minimum System Requirements  guide.

Customize Unica Plan
You can customize the Unica Plan  interface to meet your needs. Customization settings are available in Unica Plan  when you 

click Settings  or Settings > Unica Plan  Settings.

The following table describes what you can customize.

Table  2. Options for customizing Unica Plan

Option Description

Set current page as 

Home

Set the current page to display automatically as soon as you log in to Unica Plan.

Basic Settings Set the security policy to apply to new items by default.

Timezone Choose your local timezone.

Assets Options Define the asset list to show by default.

Approvals Options Define the approval list to show by default.

Projects Options Define the project list and view to show by default for projects.

Tasks Options Define the task list and view to show by default for tasks.

Analytics Options Set a default report to display when you go to the Analytics >Analytics  page, and set the Analytics 

home page as your login page.

Calendar/Timeline 

Settings

Select options to customize how you view the calendar and task milestones.

See Calendar display options  on page 191.

Out of Office Settings Define whether you are in or out of the office and identify delegates. From version 12.1.4, you can 

schedule Out of Office for future dates.

You (or another user with the appropriate permission) can set up dashboards to show the information that you view most 

often. Each dashboard can include one or more "portlets" that present:
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• Lists of links to Unica Plan  items such as Approvals Awaiting Action, Manage My Tasks, and My Alerts.

For more information, see Unica Plan list portlets  on page 264.

• Quick Links that provide access with a single click to options such as Create New Project or Add Invoice.

For more information, see Quick link portlets  on page 266.

• Reports, such as Budget by Project Type or Marketing Financial Position.

For more information, see Unica Plan report portlets  on page 267.

Setting your start page
The start page is the page that displays when you log in to Unica. The default start page is the default dashboard, but you 

can easily specify a different start page.

If you do not want a dashboard page to display when you first log in to Unica, you can select a page from one of the installed 

HCL products as your start page.

To set a page you are viewing as your start page, select Settings > Set current page as home. Pages available for selection 

as a start page are determined by each Unica  product and by your permissions in Unica.

On any page you are viewing, if the Set current page as home  option is enabled, you can set the page as your start page.

Setting your basic settings
Use the basic settings option to choose the security policy that is used by default when you create items.

About this task

To set the security policy, complete the following steps.

1. Select Settings  > Unica Plan  Settings.

Result

The Administrative Settings  page opens.

2. Click Basic Settings.

Result

The Basic Settings  page opens.

3. In the Default Security Policy  field, select the security policy to use by default when you create items in Unica Plan.

You can leave Global  selected, which is the default, to use the global security policy that is defined by your 

administrator. Otherwise, you can select a security policy that your administrator instructed you to select. As a best 

practice, do not change the security policy without the guidance of your administrator. For more information about 

security policies, contact your administrator or see the Unica Plan  Administrator's Guide.

4. Click Save Changes  to save your changes.
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Setting your approvals options
Use the approvals options to customize Unica Plan  so you can view and receive information about approvals that are 

important to you.

About this task

To set your approval options, complete the following steps.

1. Select Settings  > Plan settings  > Approvals.

Result

The Approvals Options  page appears.

2. In the Default List  field, select the default Approval List view that you want to appear when you open the approval list 

page.

By default, the My Active Approvals  view appears in this field; the result is that Unica Plan  displays only your active 

approvals when you select Operations  > Approvals.

If you have any saved searches, this list also includes that information.

Setting your project options
Contains links for users to customize Unica Plan  to view and receive information that is important to them.

User Personalization section

To set your project options, complete the following steps:

1. Select Settings  > Plan settings  > Project options.

The Project options  page appears.

2. In the Default list  field, select the default Project list that you want to appear when you open the project list page.

By default, the Active projects and requests  view appears in this field; the result is that Unica Plan  displays only your 

active projects and request when you select Operations  > Projects.

If you have any saved searches, this list also includes that information.

In 12.1.7, we introduced a new section called Default displayed project columns. After selecting the Default list  and and the 

Default list view, you can set the default columns that will appear for the selected Default list view.

Example: If you want only Owner, My role, Target start, Target end, and Status  columns to be default list view for Project 

list, retain only the required columns in Selected columns  and put the unwanted columns to Available columns. Click Save 

changes  to save the default list view.
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Setting your tasks options

About this task

Your tasks options allow you to customize Unica Plan  so you view and receive task information. For example, you can 

specify the list of tasks that appears by default when you open the Tasks page.

1. Select Settings > Unica Plan  settings > Tasks Options.

Result

The Task Options  page opens.

2. For the Default List, select the default Task List view that you want to appear when you open the Tasks list page.

By default, the My Tasks  view appears in this field, so Unica Plan  displays only tasks currently awaiting your action 

when you click Operations > Tasks.

This list also includes saved searches.

3. For the Default List View, select the default list view mode that you want to appear when you open the Tasks page. 

You can display tasks in a list view (the default) or a calendar view.

4. Click Save Changes  to save your changes, Revert to Saved  to discard the changes you made since the last time you 

saved changes, or Cancel  to exit.

Setting options for projects
You can customize Unica Plan  so that you receive the project information that is most important to you.

For example, you can specify the following options:

• The default view

• Data columns to include when you review a list of projects

• Whether to receive email notifications about changes in health status for your projects

You can also arrange the columns in the order most useful for you.

Receiving project health status updates by email
Daily, Unica Plan  compares project data to a set of key performance indicators to assess project health. For the projects that 

you own, you can subscribe to daily messages with the health status of your projects.

About this task

To receive project health status updates by email, complete the following steps.

1. Click Settings  > Plan Settings.

2. Click Project Health Daily Mails - Subscribe. 

"Subscribe" changes to "Unsubscribe".
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What to do next

For more information about project health status, see Project health  on page 51.

Optional project columns
For Project List  view pages, you can customize which columns appear in the list.

The column choices in the Available Columns  field include all fields that are used in all project templates in the system. 

Template creators define fields in project templates. Some projects that appear in the Project list view might have been 

created with a project template that did not contain a certain field. If a project does not have a field that is defined, there will 

be no value in the corresponding column on the project list view.

In the Project Calendar  view, in the Optional Information to Show  field, select any optional project milestones or project start 

and end dates that you want to view. These milestones and dates appear in the calendar.

When you select optional columns, you select them for a particular view. For example, if you select an optional column that 

is called Objectives  in the Active Projects and Requests  view, this column does not appear in the All Projects and Requests 

view.

Rearranging columns on object lists
You can rearrange the custom and standard columns of data on marketing object lists so you can see the most relevant data 

without scrolling. You can choose which custom columns to display. From

About this task

You can rearrange the column order on the lists of the following marketing objects.

• projects

• assets

• offers

• marketing objects

Note:  You cannot remove standard attributes because they are used by the system, but you can put them where they 

are most useful or least intrusive.

1. Go to a list page for one of these object types, such as Active Projects.

2. Click Options.

Result

The Project Options  window opens. In this window, Available Columns  shows all columns that can be displayed. The 

list of Selected Columns  shows default columns that are currently displayed in the order that they display.

3. Use the >>  and <<  arrows to move the columns you want to display into Selected Columns  or to remove columns 

from Selected Columns.
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Note:  From version 12.1.7, you can remove default standard attributes from Selected Columns.

Note:  On the Assets list page, standard columns are not shown in the Available Columns  list.

4. Use the up and down arrows arrange the columns in Selected Columns  in the order you want them to appear.

5. For projects only, in the Default List  field, select the list view to use by default when you select Operations > Projects.

By default, the Active Projects and Requests  view appears in this field, unless you previously changed the setting.

If you have any saved searches, you can also select one of them as your default view.

6. For projects only, in the Default View Mode  field, select project list or project calendar.

7. Click Save Changes.

Setting your analytics options

About this task

By default, the Analytics Home page shows a list of all available reports. You can set a different report to display when you 

go to the Analytics Home page.

1. Select Settings > Plan Settings.

2. Click Analytics Options.

Result

The Analysis Options page appears.

3. Select the report you want as the default report.

If at any time the report you select is not available, the list of all available reports is displayed.

4. Click Save Changes.

Results

Defining Out-of-office settings

About this task

Out of office settings help ensure that there is coverage for your tasks, approvals, and requests when you are out of the 

office.

1. Select Settings > Unica Plan  Settings.

The Administrative Settings page opens.

2. Click Out of Office Settings.

The Out of Office Settings page opens.

3. At the top of the page, indicate whether you are currently in or out of the office.
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4. From version 12.1.4, you can set immediate out of office or schedule it to a future date. To set an immediate out of 

office, select From now. Your selection goes into effect when you click Save Changes.

5. To set out of office for a future date, select Schedule, and:

a. Select future date and time for Start. This date defines when the Out of Office must start.

b. Select future date and time for End. This date defines when the Out of Office must end.

Your selection goes into effect when you click Save Changes.

6. Specify the Unica Plan  user who covers for your responsibilities when you are out of the office. You can specify the 

same user or different users for:

◦ Workflow Tasks and Approval Tasks: You are provided three options in Out-of-office settings for Delegating 

users for workflow tasks and approval tasks:

▪ Do not auto-delegate: The workflow tasks and approvals which are currently ready to start and 

assigned to the user will not be delegated. However, tasks and approvals that will become ready to 

start after enabling Out-of-office will be delegated automatically.

▪ Auto-delegate all: All the workflow tasks and approvals which are currently ready to start and 

assigned to the user will be delegated. However, tasks and approvals that will become ready to start 

after enabling Out-of-office will be delegated automatically.

▪ Auto delegate selected:

Note:  This option is not available if you select Schedule  to schedule out of office for a future 

date.

Only the selected workflow tasks and approvals which are currently ready to start and assigned to the 

user will be delegated. However, tasks and approvals that will become ready to start after enabling 

Out-of-office will be delegated automatically.

Note:  Workflow tasks and approval delegation will happen if the project state is draft/in progress 

(started)/on hold (paused)/reconcile.Workflow tasks and approval delegation will not happen if 

project state is cancelled or complete.

Note:  Approval delegation only applies to approval reviewers. Approval owners do not get delegated.

Your system administrator defines whether you can select any other user as a delegate, or only a user who 

is already a member of the same project teams and with appropriate permissions. If your system or any of 

your projects uses the more restrictive setting, an error displays if you attempt to delegate tasks to a user who 

cannot perform them.

◦ Standalone Approvals and Budget Approvals: You are provided three options in Out-of-office settings for 

delegating user for standalone approvals and budget approvals:
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▪ Do not auto-delegate: The standalone approvals and budget approvals which are currently ready 

to start and assigned to the user will not be delegated. However, standalone approvals and budget 

approvals that will become ready to start after enabling Out-of-office will be delegated automatically.

▪ Auto-delegate all: All the standalone approvals and budget approvals which are currently ready to 

start and assigned to the user will be delegated. However, standalone approvals and budget approvals 

that will become ready to start after enabling Out-of-office will be delegated automatically.

▪ Auto delegate selected:

Note:  This option is not available if you select Schedule  to schedule out of office for a future 

date.

Only the selected standalone approvals and budget approvals which are currently ready to start and 

assigned to the user will be delegated. However, tasks and approvals that will become ready to start 

after enabling Out-of-office will be delegated automatically.

Note:  Approval delegation only applies to approval reviewers. Approval owners do not get delegated.

An error displays if you attempt to delegate approvals to a user who cannot respond to them.

◦ Project Requests: You are provided three options in Out-of-office settings for Delegating user for project 

requests:

▪ Do not auto-delegate: The project requests which are currently ready to start and assigned to the user 

will not be delegated. However, project requests that will become ready to start after enabling Out-of-

office will be delegated automatically.

▪ Auto-delegate all: All the project requests which are currently ready to start and assigned to the user 

will be delegated. However, project requests that will become ready to start after enabling Out-of-

office will be delegated automatically.

▪ Auto delegate selected:

Note:  This option is not available if you select Schedule  to schedule out of office for a future 

date.

Only the selected project requests which are currently ready to start and assigned to the user will be 

delegated. However, project requests that will become ready to start after enabling Out-of-office will 

be delegated automatically.

From version 12.1.6, if there is a delegation failure, the user, who just initiated an out of office, or when the 

user is already out of office, the user and the user who was selected for the delegated task will receive 

notifications about the failure. The notification contains the reason of failure as well.

The users receive alerts if they have subscribed to the alerts and they must have permissions to access the 

delegated Object.
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The delegation failure event is applicable to the three Objects as listed in the Out of Office feature:

▪ Failure of Workflow task delegation

▪ Failure of Project request delegation

▪ Failure of Approval delegation

An error displays if you attempt to delegate project requests to a user who cannot respond to them.

7. Enter an optional message to include with all of the activities that are delegated while you are out of the office.

8. Click Save Changes.

When you indicate that you are Out of Office:

◦ The Item Delegation History at the bottom of this page logs all of the activities that are delegated in your 

absence.

◦ A reminder displays each time you log in to Unica Plan.

◦ Project and request owners can review a list of team members who are out of the office on the People tab. 

The assigned delegates and when delegation begins also display.
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Chapter 2. Common tasks
Some tasks are not specific to Unica Plan  objects. For example, several different types of objects can contain attachments. 

You work with project attachments in the same way as you work with program or plan attachments. This section describes:

• Attachments  on page 28

• Statuses of business processes  on page 31

• Disabled attribute values  on page 35

• Selecting resources  on page 36Selecting resources  on page 36

• Printing objects  on page 37

• Exporting information in Microsoft Excel format  on page 37

Attachments
You can attach relevant documents to Unica Plan  objects, such as plans, programs, and projects. The Attachments  tab of an 

object contains links to all files or URLs related to the object.

Unica Plan  automatically creates a thumbnail for documents, images, PDF files, and web pages when these items are 

attached or sent for approval. Unica Plan  supports the following file types.

• BMP

• Doc

• Docx

• GIF

• htm

• html

• JPEG

• JPG

• pdf

• ppt

• pptx

• RTF

• xls

Note the following limitations.

• By default, you can attach up to five files at one time. This number is configurable, and might be different in your 

system.

• Attachment size is limited to under 2 gigabytes (GB) in size. The exact limitation depends on your browser and 

operating system.

To add an attachment to an object

About this task
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Users can add attachments on an ongoing basis.

1. Navigate to the object to which you would like to add an attachment.

2. Click the Attachments  tab.

Result

The tab displays any attachments that are already present for the object.

3. Click the Add  icon ( ) to add an attachment to the object.

Result

The Add Attachment window appears.

4. From the drop-down list in the Save Attachment To  field, select where you want to save the attachment.

5. In the File to Attach  field, select  From My Computer, From the Asset Library, or URL.

6. Do one of the following.

◦ Click Browse  to search for a file on your computer. When the dialog box appears, navigate to the file you want 

to attach, and click Open.

◦ Click Browse Library  to attach a file in an asset library. Click the library that contains the file you want to add. 

Use the tree in the left pane of the screen to navigate to the folder and then the asset that you want to attach. 

Click Accept Asset  when viewing the asset in the right pane.

◦ Enter the URL in the field provided.

7. Add any comments about the attachment.

8. Click Add More  to display an additional set of fields for each additional attachment you want to add.

9. Click Save Changes  to add the attachment or attachments.

The attachments are added to the Attachments tab for the object.

To remove an attachment from an object

1. Navigate to the object to which you would like to remove an attachment.

2. Click the Attachments tab.

Result

The tab displays any attachments that already exist for the object.

3. Click Remove  beside the attachment you would like to delete. 

Result

A message appears asking you to verify the deletion.

4. Click OK.

Results

The attachment is removed.
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To send e-mail attachments

About this task

Users that have a valid e-mail address configured in Unica Plan  or Unica Platform  can send e-mail attachments. If your e-mail 

address is configured incorrectly in the system, you receive an error message.

1. Navigate to the object to which you would like to add an attachment.

For approvals and assets, attachments are available on the summary page. For all other objects, click the 

Attachments  tab.

Result

The tab displays any attachments that already exist for the object.

2. Click Send as Mail Attachment  beside the attachment you would like to send.

You can also right-click the attachment icon and choose Send as Mail Attachment  from the menu.

Result

The Send Mail Attachment window appears.

3. Enter or select values in the To  and Cc  fields for the email recipients.

◦ To send the attachment to Unica Plan  users, click the arrow at the right side of the field and select one or 

more email addresses. The addresses you select are added to the field. If you deselect an address, it is 

removed from the field.

◦ You can also enter any valid external email address in the fields. Separate multiple addresses by a comma. 

For example: user1@inbox.com,user2@myCompany.com

4. Enter values for the Subject  field and body of the message.

5. Click Send  to send the attachment.

Result

The system displays a message that confirms that the e-mail has been sent or that an error occurred while the 

system attempted to send the message.

The Send Mail Attachment window remains open until the e-mail server has sent the message. If you close the 

window while the mail is being sent, you do not receive any confirmation.

Results

Note the following.

• Any replies to the message go directly to the e-mail address of the sender.

• If you sends an attachment to an invalid address, a message is sent to the user that the e-mail was not delivered.
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• If the mail server is down (for the Unica Plan  server), the system displays a message that the attachment could not 

be sent. You can take either of the following actions:

• If the mail is accepted by the e-mail server for delivery, and it cannot be delivered for any reason (for example, if 

an email address is invalid) the e-mail server sends the details directly back to the user in the local client e-mail 

application.

Statuses of business processes
The status of a business process quickly informs users of where the business process is in its lifecycle. You change the 

status by selecting a transition.

The available statuses and transitions depend on the type of business process and the needs of your organization. Your 

system administrator can create more statuses and add or remove transitions as required by your installation.

The following table describes the possible default statuses for plans, programs, projects, approvals, assets, and custom 

marketing objects.

Table  3. Workflow statuses for plans, programs, projects, approvals, and custom marketing objects.

Status Description

Not Started The object was created, but work is not started.

In Progress The work on this object started.

On Hold Work on this object stops while the object status is On Hold. Work might resume later.

Canceled This status warns users not to access the object because work on it is stopped permanently.

Completed The work on this object is finished.

In Reconciliation (Projects only). Indicates that someone is editing a Canceled or Completed project. This status is 

temporary and can be selected by users with the correct security permission.

The following table describes the possible default statuses for requests.

Table  4. Request statuses

Status Description

Draft The request was created, but not yet submitted.

Submitted The request was submitted to the appropriate person who can accept or reject the request.

Returned Indicates that the person who reviewed the request returned it to the submitter, either for rework 

or some other deficiency.

Accepted Indicates that the request was accepted. After a request is accepted, Unica Plan  creates a 

corresponding project. This status indicates the end of the lifecycle for the request.

The following table describes invoice status types.
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Table  5. Invoice status types

Status Description

Draft Indicates that the invoice is still being worked on. An invoice is in the Draft state when it is first 

created. To move an invoice out of the Draft state, you must add line items.

If necessary, you can place an invoice in the Draft state by choosing Re-draft Invoice  from the 

Change Status  menu.

Canceled Canceling an invoice is not the same as deleting an invoice. When you cancel an invoice, it is not 

active but you can still view it in Unica Plan. Deleting an invoice removes it from the system. When 

you move an invoice to Canceled, Unica Plan  sends an alert to the invoice owners.

Under Review Approvers are currently examining the invoice line items.

Note:  This internal status occurs after you mark an invoice Payable.

Payable Items on the invoice were reviewed, and the invoice is ready to be sent to Accounts Payable. 

When you move an invoice to Payable, the owner of the account to which the invoice belongs 

receives a notification.

If your organization uses the invoice approval function, changing an invoice state to Payable 

triggers the Unica Plan  approval process. The invoice can enter the Under Review state while 

approvers examine the line items. For more information, see Invoice Line Item Approvals  on 

page 235.

Paid The invoice is paid. When you move an invoice to this status, the system triggers invoice rollup. 

This status is not available until the approval process is complete.

The following table describes asset status types.

Table  6. Asset statuses

Status Description

Draft Indicates that the asset is in a draft state. All owners can edit the asset. Other users can 

view it or select it as an attachment.

When you first add an asset, it has a status of Draft.

Locked Indicates that the asset is in a locked state. No one can edit the asset until it is 

unlocked.

You can lock an asset for a period if you do not want anyone to edit the asset.

Finalized Indicates that the asset is finalized. Everyone with permission to do so can access the 

asset (and attach it to a business process), but no one can edit it.
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Table  6. Asset statuses  (continued)

Status Description

Archived Indicates that the asset is no longer available. No one can access the asset nor retrieve 

it.

If this asset is attached to an object (such as a project or plan), it is still available from 

that object.

Status changes

To indicate a change in the status of a business process, you select a transition from one status to another. The following 

transitions are typically available.

For example, if a program is In Progress, you can choose one of the following transitions.

• Pause it: change its status to On Hold

• Finish it: change its status to Completed

• Cancel it: change its status to Canceled

Changing the status of business processes
Statuses identify the progress of business processes. To move a business process through the lifecycle, you must change 

the status.

About this task

The following procedure describes how to change the status for plans, programs, projects, requests, marketing objects, and 

approvals.
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Note:  Your administrator can set up Unica Plan  to send an alert to owners and members of a process when its status 

changes.

1. Select the type of object you want to work with from the navigational menus. 

Example

For example, to work with a plan click Operations > Plans.

2. Click the name of the object you want to change.

3. Click Change Status  and select a transition from the menu.

Most status transitions are available with comments and without comments. To add more information, select an 

option with comments. To change the status immediately, select an option without comments.

Note:  You can only select transitions to Finish  or Cancel  an object with comments.

The available transitions depend on the status of the object.

◦ For objects that are Not Started, Start  <object>  changes the status to In Progress. For requests and 

approvals, select Submit  <object>.

◦ For objects that are In Progress, Pause  <object>  changes the status to On Hold. For approvals, select Stop 

Review.

◦ For objects that are On Hold, Continue  <object>  changes the status to In Progress.

◦ For objects that are In Progress, Finish  <object>  changes the status to Completed. Objects in this status 

cannot be changed to any other status, except for projects. You can reconcile projects to open them again 

after you change the status to Completed.

◦ For objects that are Not Started or In Progress, Cancel  <object>  changes the status to Canceled. Select this 

option to cancel the object permanently. Objects in this status cannot be changed to any other status, except 

for projects. You can reconcile projects to open them again after you change the status to Canceled.

4. Optional: If you selected a transition option "with comments," enter appropriate comments. Click Continue.

Results

If you do not enter comments, the status changes immediately after you select a transition from the menu. If you enter 

comments, the status changes after you enter your comments.

Changing the status of multiple projects or requests
You can change the status of one or more projects or requests simultaneously to improve efficiency.

About this task

Your change must meet the following prerequisites; if it does not, a warning message describes the possible problems.

• The new status that you select must be valid for every item that you select.

• To make status changes, you must have appropriate permissions.

• To accept or reject requests, you must be an approver for every item you select.
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Your administrator can set up Unica Plan  to send an alert to owners and members of a process when its status changes.

1. Select Operations  > Projects.

2. Click Actions  ( ) and select All Projects and Requests.

3. Select one or more items.

Note:  You can select items on more than one page. However, the system applies the status change only to 

the page you are viewing when you select the new status.

4. Click Change Status  and select a status from the menu to apply to all of the selected items.

You can make most status changes with or without comments.

◦ If you chose a new status without comments, Unica Plan  changes the status immediately when you click the 

new status.

◦ If you chose a new status with comments, type your comments and click Continue  to apply the new status.

Disabled attribute values
Throughout Unica Plan, users select an item or items from a list. Over time, the items in the lists can change; administrators 

can add, remove, or disable items from lists.

When an administrator disables an attribute, it affects the behavior of Unica Plan  in the following ways.

• When users run advanced searches.

• When users edit an existing object that contains a disabled value in one of its lists.

Disabled attribute values in objects
When an administrator disables an attribute value, it no longer appears in lists for new objects. However, disabled attributes 

still affect users in some situations.

Users need to consider disabled values in the following situations.

• A user edits a tab for an existing object with an attribute that is set to a disabled value. The attribute is optional.

If the user edits the attribute, the user must select an enabled value. However, the user can save the page without 

editing the attribute. If the user does not edit the attribute, the object can be saved with the existing, disabled value.

• A user edits a tab with an attribute that is set to a disabled value. The attribute is required.

The user must select an enabled value for the attribute. The system does not allow the user to save the data until an 

enabled value is set for the attribute.

• A user creates a new object. One tab contains an optional attribute that has a disabled, default value.

The attribute is set to a blank value.
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• A user creates a new object. One tab contains a required attribute that has a disabled, default value.

The system presents an error message that the attribute is required. The user cannot finish creating the object until 

the user sets the value of the required attribute.

Example: disabled attribute values
When an administrator deletes an attribute value, it affects templates and objects that use that value.

Example

Consider a project template, named Marketing Collateral, which contains a tab, Production Info. Production Info  contains 

several attributes, including a required attribute, Color, and an optional attribute, Coating.

The attributes have the following values.

Color (required) Coating (optional)

(default value)

4C

4/4

Black and White

Gloss Aqueous (default value)

Dull Aqueous

UV Coating

Etched

Tom creates a marketing collateral project, MC001, and sets the Color  to 4/4  and the Coating  to Dull Aqueous.

An administrator then disables the 4/4  and Dull Aqueous  values.

Tom opens the MC001  project, and edits the Production Info  tab.

• Tom can leave the Coating  value as Dull Aqueous, or set it to any of the enabled values, such as Etched.

• Tom must change the value of Color  to one of the enabled values before he can save the Production Info  tab.

The administrator re-enables 4/4  and Dull Aqueous  values, and disables the default value (Gloss Aqueous).

Tom creates a marketing collateral project, MC002:

• The value of Coating  is blank.

• Tom must select a valid value for Color  before he finishes creating MC002

Selecting resources
Throughout Unica Plan, users can select people and teams as resources.

Users add and remove members to planning objects, marketing objects, assets, invoices and approvals. When users perform 

advanced searches, they can add people and teams to the search criteria.
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Note:  The list of people available in Unica Plan  is populated from Unica Platform. Administrators can limit the list of 

teams and people a particular user sees, depending on the role and permissions for the user.

Printing objects
You can print the current page for many Unica Plan  objects.

About this task

Use the following procedure to print any of these objects: accounts, approvals, invoices, plans, programs, projects, and 

marketing objects.

1. Go to the Summary  tab of the object you want to print.

2. Select the tab to print and click Print  ( ) on the Unica Plan  toolbar.

Result

For some objects, a drop-down menu displays with two choices: Print  and Export.

3. If the menu appears, click Print.

4. Complete the fields in the print dialog and click Print.

Results

The data on the screen prints to the selected printer.

Exporting information in Microsoft™  Excel format
You can export information from Unica Plan  to an Excel spreadsheet for programs, projects, and project requests.

About this task

When you export list pages for programs, projects, tasks, and marketing objects, all the items in the list are exported, even if 

the list spans multiple pages.

Note:  You cannot export the Tracking, People, Attachment, Workflow, Budget, or Analysis tabs to Excel.

1. You can export information for a single object or for a list of objects.

◦ To export information to Excel for a single object, go to Summary or custom tab of the object.

◦ To export a list of objects to Excel, click Operations > Programs  or Operations > Projects  and open the view 

that you want to export.

2. Click Print  ( ) and select Export  from the menu.

Result
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A window displays, asking whether to Open or Save the file that will be exported. If you are exporting a list, Unica Plan 

prints information about all the objects in the current view of the list page.

3. You can either open the item in Excel, or save it to disk.

◦ Click Open to launch Excel. The information that you exported displays on the spreadsheet.

◦ Click Save to save the file. You can then open the Excel spreadsheet, displaying summary information about 

the object or list of objects.
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Plans capture the objectives of a business unit or geographic area for a specific timeframe, such as a year or a quarter. A 

plan is the container for your marketing programs and projects.

After you add a plan, you link one or more programs to the plan. Information from each linked, or child, program, and 

from each of the projects that is linked to a program, "roll up" to the plan. As a result, you can review metrics and budget 

information from the perspective of the overall plan in addition to the program and project levels.

Plan views
Unica Plan  organizes plans in views.

You can access the different plan views from the Actions  menu. This menu contains a link to each of the plan views. In 

either view, you can change the sort order by clicking the column that you want to sort by. Click the column a second time to 

reverse the sort order.

• The All Plans  view lists all plans. It also contains links to the Active Plans  view.

• The Active Plans  view lists all plans currently in the "In Progress" state. The Active Plans  view is the default view.

From version 12.1.6, you can adjust the width of only the Name column in the Plans listing page. This helps you view the 

complete Plan name rather than having to hover the mouse over the Plan to view the complete Plan name in the tooltip.

Additionally, you can search for a plan.

Summary information for plans
On the plan Summary tab, Unica Plan  lists summary information about a plan, such as status, program areas, and security 

policy.

By default, the plan Summary tab displays when you select a plan from the Plan List page. Any programs that are linked to 

the plan are listed on the Summary tab. You can perform tasks such as changing plan status, editing the plan, adding a new 

program, linking an existing program, or removing a linked program.

Fiscal year for plans
When you add or edit a plan, you choose its fiscal year from a list. You can edit budget information for the fiscal year you 

choose.

Unica Plan  keeps multi-year budget data for plans. The system keeps budget information for the current fiscal year, the next 

two fiscal years, and any past fiscal years, dating back to when you first installed Unica Plan.

Viewing budget information

The budget information that you view in Total mode is for the life of the plan. The budget information that you view in 

Detailed mode is for the specified fiscal year.
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Editing budget information

Budget information that you edit on the Budget tab corresponds to the selected fiscal year. You can edit only the budget for 

one fiscal year at a time. To edit budget data for a fiscal year, edit the Fiscal Year  value on the summary page for the plan. 

Then, set the value to the fiscal year that corresponds to the budget data you want to edit.

Adding a plan
When you add a plan, you become an owner of that plan.

About this task

To add a plan, complete the following steps.

1. Click Operations  > Plans.

2. Click the Add Plan  icon ( ).

3. Enter a plan name in the Name  field.

4. Enter a description of the plan in the Description  field.

5. Click Add/Remove Members  to add team members to the plan.

6. Select Auto-generate on save  or enter a plan ID in the Plan Code  field.

By default, the Auto-generate on save  field is checked and Unica Plan  generates a number automatically when the 

plan is saved. To enter a plan ID manually in the Plan ID  field, clear the Auto-generate on save  check box.

The plan ID must be unique.

7. Select the security policy from the Security Policy  list.

A security policy is required and defaults to Global or the default security policy set by your system administrator.

8. Select a business area in the Business Area  field.

9. Click Add/Remove Program Area  to select the program areas to use for programs in this plan.

10. Select a fiscal year from the Fiscal Year  list.

To indicate the year in which the plan is active, you can choose the current fiscal year or one of the next two fiscal 

years. That is, for a plan that is created in fiscal year 2015 you can select FY 2015, FY 2016, or FY 2017.

Note:  The budget information available on the Budget tab corresponds to the value in this field.

11. Select the Budget Granularity.

12. Click Save Changes  to save the plan.

To edit an existing plan, click the Edit  icon ( ) found on the plan Summary  tab.
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Adding and removing program areas
Program areas are subsections of plans, allowing programs that are linked to the plan to be arranged into logical subgroups. 

In Unica Plan, administrators create the program areas.

Before you begin

Important:  Before you remove a program area, you must first remove any programs that are assigned to it.

About this task

To add or remove a program area, complete the following steps.

1. Follow the steps for adding a plan until the step where you add a program area.

2. Click Add/Remove Program Areas  under the Program Areas  field.

3. To add a program area, select a program area from the Available Program Areas  field and click the right-pointing 

arrows to add the program area to the Selected Program Areas  field.

Result

When you add a program area to the Selected Program Areas  field, it populates the Program Areas  field on the plan 

Summary  tab.

4. To remove a program area, select a program area in the Selected Program Areas  field and click the left-pointing 

arrows to remove it.

Linking a program to a plan
After you create a plan, you can link existing programs to it. When you link a program to a plan, all the plan participants 

receive an email message that informs them of the link.

Before you begin

Important:  Linked programs and plans must have the same security policy. When you link a program to a plan, you 

cannot change the security policy of either object without first removing the program from the plan.

To link an existing program to the plan, you must have Edit Summary Tab permission on each program you want to link. If you 

do not have this permission, ask your administrator for help.

About this task

To link a program to a plan, complete the following steps.

1. Navigate to the plan to which you want to link a program.

2. Click the Manage Linked Objects  icon ( ) and select Link Existing.

Result
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The Link Existing Programs to Plan  window appears.

3. Type a string in the Find by name or code  field and click Find  or leave the field empty and click Find

Result

Note:  The Search Results  field shows only programs that you can link to the plan. Only programs with the 

same budget granularity and security policy as the plan are available. Programs with a status of Canceled, 

Deleted, or Completed never appear in Search Results.

4. In the Select a Program Area  field, select a program area. The program belongs to the program area that you choose.

5. In the Search Results  field, click the programs to link to the plan.

Note:  To select more than one program at a time, press the Ctrl  key and click each program.

6. Click the right-pointing arrows. The Selected Items to link  field populates with your selections.

To deselect a program, click the program in the Selected Items to link  field and click the left-pointing arrows.

7. Click Save Changes.

Note: Plans can sort their linked plans or projects.

Results

The program appears in the Supporting Program(s)  field on the Plan Summary tab.

Linked programs appear with summary information on the Plan Summary tab in the Supporting Programs  field. Click the 

program name to be taken to the Summary tab for that program.

Creating a program from a plan
You can create a new program when you are in a plan. Unica Plan  links the new program to the plan. The program areas that 

you choose in the program creation process are the program areas that are currently defined for the plan.

About this task

When you add a program from the plan summary page, the new program's program area is constrained by the plan's program 

areas:

• If the plan contains more than one program area, you must select the program area to which you want the new 

program to belong.

• If the plan contains only one program area, the new program defaults to that program area.

• To assign a different program area to a linked program, you must remove that program from the plan and then link 

the program to the other program area.
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Note:  When you add a program that is not linked to a plan, you can assign it to any program area.

Click the Add Program  icon ( ) on the plan summary page.

The process is similar to creating a non-linked program.

Removing a program from a plan
Before you can delete a plan, you must remove any programs that are linked to it. Removing the link does not delete the 

program from Unica Plan, it only breaks the link.

About this task

To remove a program from a plan, complete the following steps.

1. Navigate to the Summary  tab of the plan from which to remove a linked program.

2. Click the Manage Linked Objects  icon ( ) and select Remove.

Result

The Remove Program Links From Plan  window appears.

3. Select the program that you want to remove from the Linked Program(s)  field.

4. Click the right-pointing arrows to move the program into the Selected Items to Remove  field.

To move the program back to the Linked Program(s)  field, click the program in the Selected Items to Remove  field 

and click the left-pointing arrows.

5. Click Save Changes.

Starting plans
You start a plan by changing the status. Select the status transition Start Plan. After you start a plan, all participants can 

work on the plan.

About this task

To start a plan, complete the following steps.

1. Go to the Summary  tab of the plan you want to start.

Example

Click Operations  > Plans. Click Actions( ) and select a view (such as My Plans  or All Plans) that includes plans 

with "Not Started" as the status.

2. Click Change Status  and select Start Plan  or Start Plan with comments  from the menu.

3. Optional:  If you chose Start Plan with comments, type your comments and click Continue.
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Results

The plan status changes to In Progress.

Deleting a plan
You can delete a plan from the Plan List  page or from the plan Summary  tab.

About this task

Note:  You cannot delete a plan if it has linked programs. You must first remove the link to the program before you 

delete the plan.

To delete a plan from the Plan List  page, complete the following steps

1. Click Operations  > Plans.

Result

By default the Active Plans  view of the Plan List  page appears.

2. Select the check box next to each plan that you want to delete.

3. Click the Delete this Item  icon ( ).

4. Click OK  at the prompt.
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Programs are the child-objects of Plans. Programs can contain multiple projects to organize work for your organization.

If you have permission, you can add a program. To add a program, you select a template that was set up by an Unica Plan 

administrator and enter custom information.

After you create a program, you can start the program at any time. Starting the program makes it active and changes the 

status of the program to In Progress.

Program views

Unica Plan  organizes programs in views.

• The All Programs  view lists all programs. It also contains links to the Active Programs  and My Programs  views.

• The Active Programs  view lists all the programs that are now in the In Progress  state. The Active Programs  view is 

the default view.

• The My Programs  view lists all the programs that you own or are part of as a team member.

You can also access the different views of programs on the Actions  menu. It contains links to each of the program views. In 

any view, you can change the sort order by clicking the column that you want to sort by. Click the column a second time to 

reverse the sort order.

From version 12.1.6, you can adjust the width of only the Name column in the Programs listing page. This helps you view the 

complete Program name rather than having to hover the mouse over the Program to view the complete Program name in the 

tooltip.

Additionally, you can search for a program.

Summary information for programs

On the program Summary  tab, Unica Plan  lists summary information about a program, such as status and security policy. By 

default, the Summary  tab for the program displays when you select a program from the Program List  page. Any projects that 

are linked to the program are listed on the Summary  tab as well.

From the Summary  tab, you can change program status, add a request, edit the program, link an existing project, or remove a 

linked project.

Supporting projects and requests

At the bottom of the Summary  tab, the Supporting Projects and Requests  section displays information about all child 

projects for the program. This list shows the project name, the project owners, the project ID, when the last person updated 

the project, the target start and end dates, and the project status.

Adding a program
If you have permission, you can add a program.
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About this task

When you add a program, consider the following issues:

• To add a program, you must have permission to add a program.

• If you add a program, you are the owner of the program.

• You can add other team members, some of whom can also be program owners.

1. Click Operations  > Programs.

2. Click the Add Program  icon ( ).

3. Select the appropriate template for your program.

Your administrator sets up templates that correspond to the types of programs that fit the needs of your 

organization. For more information about templates, see the Unica Plan  Administrator's Guide.

4. Click Continue.

On the Summary  page of the program wizard, you can click Add/Remove Members  to add team members to the 

program. You can add members as either owners or participants in the program. For details, see Team alerts  on 

page 176.

5. Complete the fields and continue clicking Next  and completing the required fields until you reach the Attachments 

page. The required fields have a double asterisk (**) next to them.

The number and content of your program pages differ depending on the template you use. A typical program 

contains program summary information, perhaps some additional information pages, and attachments of documents 

that are related to the program.

Starting programs
You start a program by changing the status. Select the transition Start Program.

About this task

You can start any program that you created or any program for which you are listed as an owner. Additionally, a user can 

have permission to change the status of all programs. These permissions are assigned based on a user's role in the security 

policy for the program.

1. Go to the Summary  tab of the program to want to start.

Example

Click Operations  > Programs. Click Actions( ) and select a view (such as My Programs  or All Programs) that 

includes programs with  "Not Started" as the status.

2. Click Change Status  and select Start Program  or Start Program with comments  from the menu.

3. Optional:  If you chose Start Program with comments, type your comments and click Continue.

Results
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The program status changes to In Progress.

Adding new project requests and projects to programs
After you create a program, you can create a project request or project from within the program. When you do so, Unica Plan 

automatically links the project request or new project to the program.

About this task

After you add a project request or a project to a program, you cannot change the security policy of the project request, 

project, or program. You must remove the item from the program to change the security policy.

1. Go to the Summary  tab of the program that you want to contain the new project request or project.

2. Click the Manage Linked Objects  icon ( ) and select either Add Request  to create a project request or Add Project 

to create a project.

Result

The wizard for adding a project request or adding a project opens

3. Complete one of the following actions:

Choose from:

◦ Follow the steps in Submitting requests  on page 60 to add a project request and associate it with this 

program. After a user accepts the request, the project that is created from this project request is also part of 

this program.

◦ Follow the steps in Creating projects  on page 55 to add a project and associate it with this program.

Result

When you complete the steps, the project request or project opens to the Summary  tab. The Summary  tab has a field 

that is called Parent Items and Code. This field contains a link to the program of which the project is a part.

4. Click the link to open the program.

Result

Scroll to the bottom of the Summary  tab of the program to view a list of all the projects that are contained in the 

program.

Linking existing projects to programs
Link projects and programs to create an organizational hierarchy of work. Before you can link an existing project to a 

program, there must be existing projects in your system and you must have the appropriate permission.

Before you begin
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Note:  Linked projects and programs must have the same security policy. After you link a project to a program, you 

cannot change the security policy of either object without first removing the project from the program.

To add projects to the program, you must have Edit Summary Tab permission for each project you want to add. If you do not 

have this permission for one or more projects, ask your administrator for help.

About this task

After you create a program, you can link existing projects to the program. When you link a project to a program, all team 

members who are listed in both the project and program receive an email that informs them of the link.

1. Go to the Summary  tab of the program that you want to link to an existing project.

2. Click Manage Linked Objects  ( ) and select Link Existing.

Result

A dialog box appears for you to specify the projects to link.

3. Type your search criteria in the Find by name or code  field.

4. Click Find.

Note:  The Search Results  field displays only projects that you can link to the program. Only projects with 

the same budget granularity and security policy as the program are available. Programs with a status of 

Canceled, Deleted, or Completed never appear in Search Results.

5. In the Search Results  field, select the projects to link.

6. Click the double arrows to move projects into or out of the Selected Items to Link  list box.

7. Click Save Changes  to create child links to the projects you selected.

Note: Programs can sort their linked plans or projects.

Results

The projects that you added appear in the list of projects at the bottom of the Summary tab of the program.

Removing projects from programs
You can remove new project requests, new projects, and existing projects from a program.

1. Go to the Summary  tab of the program that contains the project you want to remove.

2. Click Manage Linked Objects  ( ) and select Remove.

3. In the Linked Project/Request  list box, select the project requests or projects to remove.

4. Use the arrows to move selected items to the Selected Items to Remove  list box.

5. Click Save Changes.

Results
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The project requests and projects no longer appear in the list on the Summary  tab of the program.

Deleting programs
When you delete a program, Unica Plan  checks to see whether the program contains links to any projects. If so, you cannot 

delete the program until you remove all linked projects.

About this task

Note:  You can also delete a program when you have the program open. From any tab, click the Delete this Item  icon 

( ) in the Unica Plan  toolbar.

To delete a program, complete the following steps.

1. Select Operations  > Programs.

2. Select the check box next to each program to delete.

3. Click Delete this Item  ( ).

Results

The selected programs are deleted from the system.
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A project organizes all the information that is related to develop and run one or more related marketing initiatives. Projects 

contain general information, resources, and attachments for the marketing initiative. Projects also typically organize the 

people who work on the marketing initiative, including who completes which tasks, and the timeline to complete the tasks. 

Projects can also include budget information. Monitoring features ensure that everyone knows whether the project is 

completed on time.

For example, you might use a project that is called "Monthly Trade Show" to collect all the information your organization 

needs for one trade show each month. This information might include who attends the show, equipment for the booth, 

product demonstrations, collateral to hand out to customers, costs of promotional materials, and more.

Projects are based on project templates. In the previous scenario, your organization might use a template for Trade Show 

projects, so that you consistently reuse the basic information about the trade show. When you create a project for the June 

trade show, you enter any specific information for that month. For example, if a team member is on vacation during the June 

trade show, select a substitute to attend the trade show and then reassign work in the project.

Projects can have subprojects. A subproject has the same characteristics as a project. A subproject is linked to a parent 

project; any project that is linked in this manner is referred to as a subproject. For example, designing new collateral to hand 

out at the trade show might be a subproject of the trade show project.

Projects and project requests
Your permission settings determine whether you create projects or project requests. If you do not have permission to create 

projects, you submit a project request to someone who has the necessary permissions.

Your organization might limit the number of users who can create projects. Depending on your permissions, you either create 

projects or project requests, which you submit to someone else for approval.

• If you have permission to create projects, you can create one directly by selecting either a project template or copying 

an existing project.

• If you do not have permission to create a project, you create a project request instead. Project requests ask for formal 

approval of a proposed project, or acceptance of a work request.

After you create a project request, you submit it to an authorized individual; when the request is accepted Unica Plan 

creates a project.

For example, a marketing manager submits a project request to the CMO. The CMO approves the request, which 

becomes a a project. Similarly, a sales account manager might submit a project request to the marketing services 

department to request development and production of some specialized collateral.

You can also create projects and project requests from within a program.

After you create a project, you can start it at any time. Starting the project makes it active and you can see it in different 

views in Unica Plan.
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Project reconciliation
Typically, projects use the same statuses as other business objects in Unica Plan. However, projects can also be in a 

temporary state, In Reconciliation. You apply this status while you reactivate a completed or canceled project, update project 

information, then change the state back to completed or canceled. For example, the owner of a project can make private 

changes to a canceled project.

While a project is in the In Reconciliation  state, it is not available to any other participants for editing. The project is read-only 

for users who do not have reactivate rights.

The spirit of project reconciliation is that one can do anything within the project but nothing externally. That is, for the rest of 

the Unica Plan  system, the project is not available. For example, while a project is in reconciliation you cannot reassign tasks.

For more information, see Reconciling projects  on page 71.

Note:  A different set of statuses applies to project requests.

Project request statuses
Project requests have a different set of statuses from other marketing objects: draft, submitted, returned, and accepted.

The following table describes the possible statuses for requests.

Table  7. Request statuses

Status Description

Draft The request was created, but not yet submitted.

Submitted The request was submitted to the appropriate person who can accept or reject the request.

Returned Indicates that the person who reviewed the request returned it to the submitter, either for rework 

or some other deficiency.

Accepted Indicates that the request was accepted. After a request is accepted, Unica Plan  creates a 

corresponding project. This status indicates the end of the lifecycle for the request.

Project health
In addition to the statuses that indicate the lifecycle stage of a project, Unica Plan  calculates a health status for projects.

A project can be given one of the following default health statuses.

• Healthy

• Warning

• Critical

• Unknown
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Note:  Your system administrator can change these default names for your installation.

To objectively assess the overall health of a project, Unica Plan  compares project data to thresholds for key performance 

indicators (KPIs). For example, a project with 0% of its tasks overdue and 0% of its milestones overdue is Healthy. However, if 

more than 5% of its tasks, or 3% of its milestones, are overdue, the project is Critical.

Your system administrator uses the KPIs to define rules for this calculation. The rules are associated with specific project 

templates, and therefore with the projects that use those templates.

The system automatically calculates project health status daily, and updates the calculation periodically throughout the day. 

In addition, you can manually initiate the health status calculation when needed.

Use the following features to review the health status of your project.

• Subscribe to daily email notifications with the daily status. See Receiving project health status updates by email  on 

page 22.

• Click Operations > Projects  and view a project list. The Project Health column shows the status that was calculated 

during the most recent automated periodic update.

• View detailed information for a project and click its Health Status tab. When you click this tab, the system 

automatically updates the project health status; however, the values that are shown elsewhere in Unica Plan  are not 

updated.

• Add the Health Status portlet to your dashboard. See Unica Plan report portlets  on page 267.

To facilitate analysis, reports are available to compare the health statuses that were calculated for different projects within a 

month or trending over time. See Multi-object reports  on page 251.

Project views
Unica Plan  organizes projects and project requests in views.

The following table describes the views that organize projects and requests.

Table  8. Project views

View Description

All Projects and 

Requests

Lists all projects and requests. It also contains links to the other project views and any saved 

project searches.

Active Projects and 

Requests

Lists any active projects or project requests. A project is active when it is in the In Progress  state 

and a request is active when it is in the Submitted  state. The Active Projects and Requests  view 

is the default view.

My Projects Lists all the projects that you own or are part of as a team member.

My Requests Lists all the requests where you are either the requester or the recipient.

Completed Projects Lists all projects with a status of Completed.
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Table  8. Project views  (continued)

View Description

This Week's Projects 

and Requests

All projects and requests that fall within the current week.

Next Week's Projects 

and Requests

All projects and requests that fall within next week.

This Month's Projects 

and Requests

All projects and requests that fall within the current month.

Next Month's Projects 

and Requests

All projects and requests that fall within next month.

All My Teams Projects All projects that are assigned to your team.

All My Teams Project 

Requests

All project requests that are assigned to your team.

All My Teams 

Unassigned Project 

Requests

Lists all project requests that are assigned to your team, but not yet assigned to a team member.

You can also customize the order in which columns appear in these views. For more information, see Rearranging columns 

on object lists  on page 23.

Selecting project views
You can access the different views of projects from the Actions  menu. Views organize projects based on criteria, such as the 

team to which the project is assigned or the due date.

About this task

In any view, you can change the sort order by clicking the column that you want to sort by. Click the column a second time to 

reverse the sort order.

1. Open Unica Plan  and select Operations  > Projects.

The default page that appears is the Active projects and Requests  view. You can change this default page by 

modifying your user options.

2. Click the Actions  icon ( ) and select All Projects and Requests, My Requests, or My Projects.
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Note:  From version 12.1.6, you can adjust the width of only the Name column in the Projects listing page. 

This helps you view the complete Project name rather than having to hover the mouse over the Project to 

view the complete Project name in the tooltip.

3. Click the Actions  icon ( ) and select Search for Projects  to search for projects that meet a specified criteria. You 

can then save that search.

Project search
You can search for projects that are grouped by any criteria that is useful to you and save the results of that search to view 

later.

For example, you might search for all projects that started in June and then save the results of that search by naming it June 

Projects. You can also search for all projects of a certain type, such as all trade show projects, and save that search. You can 

then access those search results at any time.

Displaying projects in list and calendar view modes
By default, Unica Plan  displays your projects in project list view. You can also display your projects in calendar view, which 

shows your projects by due date on a calendar. Your administrator sets the default of whether projects are displayed in list 

view or calendar view when you select Operations  > Projects.

About this task

Note:  Unica Plan  documentation assumes that the project list displays when you select Operations  > Projects. If your 

administrator changed the default display option, you might see the calendar view instead.

• You can also see projects in a list by selecting Operations  > Projects. In project list view, you can take the following 

actions:

Choose from:

◦ To access detailed information about the project, click a project name.

◦ To select a different view, click Actions.

◦ To change the way the project list is sorted, click a column header.

• You can also see projects on a calendar by selecting Operations  > Calendar. Unica Plan  uses the activity dates for the 

project to place them on the calendar. In the calendar view, you can take the following actions:

Choose from:

◦ To access detailed information about the project, click a project name.

◦ To select a different view, click Actions.

◦ Change to the next or previous time period.

Unica Campaign projects in an integrated system
If your Unica Plan  system is integrated with Unica Campaign, you can create campaign projects.
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A campaign project collects the information that is related to developing a marketing campaign and running it through Unica 

Campaign.

A campaign project can contain any features available to projects, including subprojects. Campaign projects also contain a 

TCS®  tab with a Target Cell Spreadsheet and an additional Campaign Summary section of the Summary tab.

In a campaign project, you synchronize the campaign, offer, contact history, and response history data for the project with 

Unica Campaign.

In a campaign project workflow you can create flowchart approval tasks. When such approval are created, the Flowchart will 

not run until all related approvals are in completed or canceled state.

Project codes and campaign codes
When you create a campaign project, you must specify a project name and code. The same name and code are used as the 

campaign name and code when you click the Create Linked Campaign  icon to create the campaign in Unica Campaign.

The code must be unique in both Unica Plan  and Unica Campaign. If you change the code, the system checks the uniqueness 

of the code before it creates or saves the project.

Creating projects
You can create a single project from a project template. Your administrator sets up and maintains project templates. You can 

also create projects by copying a project, making up to 99 clones of a project, or responding to a project request.

Before you begin

When you create a project, note the following behavior.

• To create a project, you must have the appropriate security permission.

• When you create a project, you are the owner of the project.

• You can add other team members to the project, some of whom can also be project owners.

1. Select Operations  > Projects.

2. Click Add Project  ( ).

Note:  Ensure that you do not use the following invalid characters (%?|:,<>&\/"+$<tab>)*  under the Project 

name. These special characters are not supported for the Project Name field. Although these characters are 

allowed in project name while Campaign is integrated, but you must not use these characters.

3. Select a template for your project.

An Unica Plan  administrator sets up the templates for your organization. To access any of the Unica Plan  and Unica 

Campaign  integration features, you must select a template that is configured as a campaign project template. The 
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template selected here will reflect in the Operations > Approvals  page in the All approvals > My active  approvals. The 

template name is thus indicative of the project template the approval belongs to.

4. Click Continue.

5. Use the Add Project wizard to supply values for the project fields.

6. When you save the project, the system verifies that all required fields have a value. It also completes optional fields by 

supplying default values from the template when available. To save your project, use one of the following options.

◦ Click Finish. The Summary tab displays for the new project.

◦ Click Save and Duplicate. The system saves the initial project and then uses the same information to create 

another project. The Summary tab displays for the duplicate project. You can edit the default name for the 

duplicate project and for other fields as needed, then save that project as well.

◦ Click Save and Return to List  on any page. The All Projects and Requests  page displays.

Results

Newly created projects are given a status of Not Started. To use the project to collect and share information, you change its 

status. See Starting projects  on page 57.

The tabs in a project differ depending on the template you used. A typical project contains the following tabs:

• Summary

• People

• Strategy

• Workflow (schedule of tasks, milestones, and approvals)

• Tracking (expenses and resources)

• Health Status (project monitoring)

• Attachments

When Unica Campaign  is integrated with Unica Plan, a campaign project also contains a Target Cell Spreadsheet tab.

Some selections in the Add Project wizard also affect the tab content in the project. If your administrator configured 

workflow template branching, your field options might include a specific template for the Workflow  tab. For example, the 

template might use a different workflow for a project that is based on whether you selected direct mail or email as the 

channel.

Cloning projects
To create multiple similar projects from a single existing project, you clone the project. You specify how many projects to 

create, and select fields you want to edit before the new projects are saved. You can clone a project when it is in any status.

About this task

To clone a project you must have the appropriate security permission.
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1. Go to the Summary tab of the project you want to clone.

2. Click the Clone  icon ( ).

Result

The Clone this project  dialog opens.

3. Specify from 1 to 99 as the Number of projects  to create.

4. Select either the project or the project template as the source of the metrics to use in the new projects.

5. If the project you are cloning is linked to a program, the Copy parent link  check box appears. Select this check box to 

apply the same relationship link to all of the new projects.

6. Select at least one attribute (or field) to edit for the new projects. Use Ctrl+click or Shift+click to select up to 20 

attributes from the list. For example, to edit the default name and specify a target start date for each of the new 

projects, hold down the Ctrl key while you click Name  and Target start date.

7. Click OK.

The Clone Projects Grid displays a column for each of the attributes you selected and a row for each new project.

8. To change or enter values for attributes in the grid, click the Edit mode  icon ( ) and then click in the cell you want 

to edit.

For more information about working with grids, see Grids  on page 199.

9. To create all of the projects, click the Save  icon ( ) to save your edits and then click Create Projects.

For successfully created projects, the Status/Project Code column displays the assigned project code. For projects 

that cannot be created, this column displays Failed.

10. Click Back to Summary  to return to the Summary tab of the project you cloned.

Results

All of the newly created projects are given a status of Not Started. To use the project to collect and share information, you 

change its status. See Starting projects  on page 57.

Starting projects
You start a project by changing the status. Select the transition Start Project.

About this task

You can start any project that you own:

• The projects that you create

• The projects that you create when you accept a project request

• The projects that include you as an owner

You can also start several projects at the same time. For more information, see Changing the status of multiple projects or 

requests  on page 34.
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1. Go to the Summary  tab of the project you want to start.

Example

Select Operations  > Projects. Click the Actions  icon and select a view, such as My Projects, that includes projects 

with a "Not Started" status.

2. Click Change Status  and select Start Project  or Start Project with comments  from the menu.

3. Optional:  If you chose Start Project with comments, type your comments and click Continue.

Results

The project status changes to "In Progress". After you start a project, all project participants can work with their assigned 

tasks.

Project attachments tab
The Project Attachments  tab organizes attachments to the project. The tab contains two sections: one for attachments for 

the project as a whole and one for attachments to individual tasks in the project.

Table  9. Columns on the Project Attachments tab

Column Description

Icon, file name Icon of the file type and the file name of the attached file. The file type and file size are listed in 

brackets.

Description The name of the person who attached the file, the date and time that the file was added, and the 

description for the file.

Task Available in the Task Attachments  section of the page only. Displays a link to the task the file is 

attached to.

Actions This column contains the following links:

• Send as Mail Attachment: Click to send the attachment by using email.

• Remove: A user with privileges to remove the attachment can delete the attachment 

by using this link. The task or project owner receives an alert when an attachment is 

removed. Removed attachments do not appear on the Project Attachments  tab.

Project requests
If you do not have the security permissions to create a project, you create a project request. A project request is similar to a 

work order or creative brief. It represents a request for someone else to do work according to the specifications supplied by 

the requester.

Users within an organization and outside vendors can request a project. For example, an outside vendor can submit a project 

request to the marketing services organization requesting some collateral. The marketing services representative accepts 

the request and creates a project, which organizes tasks and assigning resources to manage the creation of the collateral.



Chapter 5. Projects

If you request a project, you are a requester. The requester then submits the request to a recipient for approval. When the 

recipient accepts the request, the recipient owns the resulting project and is called the owner.

Note:  A project request does not contain a workflow. When the request is approved and transitions to a project, it 

contains the appropriate workflow.

Creating requests
If you do not have permission to create a project, you create a project request.

Before you begin

When you create a project request, note the following behavior:

• You must create the request and then submit it.

• You must have the appropriate security permission.

• After the recipient accepts the request, the recipient owns the project. (You are the requester.)

About this task

When you create a request, the pages in the wizard that you complete differ depending on the type of project you want to 

create. A typical request contains the following sections:

• Summary information about the request

• Tracking information

• Attachments that are part of the request

1. Select Operations  > Projects.

2. Click Add Request  ( ).

Result

The Add Request  dialog opens.

3. Select a template for your request.

Your administrator sets up project templates that correspond to the types of projects that your organization 

undertakes. To request a project that uses Unica Plan-Unica Campaign  integration features, you must select a 

campaign project template.

4. Click Continue.

5. Use the Add Project wizard to supply values for the project fields.

Each request identifies recipients to review and redraft or approve the request. If the template you selected allows 

these modifications, you can also:

◦ Add recipients.

◦ Change recipient roles.

◦ Change the duration periods for responses.
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◦ Change the sequence numbers that order request receipt and approval.

◦ Specify whether a response is required.

6. When you save the request, the system verifies that all required fields have a value. It also completes optional fields 

by supplying default values from the template when available. To save your request, use one of the following options:

Choose from:

◦ Click Finish.

◦ Click Save and Duplicate. The system saves the initial request and then uses the same information to create 

another request. The Summary tab displays for the duplicate request: edit the default name that is supplied 

for the duplicate and other fields as needed, then save that request as well.

◦ Click Save and Return to List  on any page.

7. Submit the request to the first reviewer.

◦ If you created a single request, on the Summary  tab, click Change Status  and select Submit Request.

◦ If you created multiple requests, submit them as described in Changing the status of multiple projects or 

requests  on page 34.

You cannot change the request after the first reviewer approves the project request. If you need to change a request 

after the first reviewer approves the project, you should change the project status to draft and resubmit the project 

after you make your changes.

Results

When the last required recipient approves the request, Unica Plan  creates the project.

Submitting requests
To submit a request, you must first add the request. Next, you submit the request to the request recipients. If the request is 

accepted, then one of the recipients becomes the owner of the project.

Before you begin

You can also submit several requests that are in  Draft  status at the same time. For more information, see Changing the 

status of multiple projects or requests  on page 34.

1. Add a request.

For detailed information, see Creating requests  on page 59.

2. If the request template does not supply recipients, add one or more recipients and select a User or Team as each 

recipient.

3. Click the name of the request to open its Summary tab.

4. Click Change Status  and select Submit Request  or Submit Request with comments  from the list.

5. Optionally, if you chose Submit Request with comments, enter any comments or additional information for the 

recipients and click Continue.

Results
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The status of the request changes to Submitted. The recipients are notified of your request. If the recipients were assigned 

sequence numbers, they are notified in sequence. The recipients appear in the Recipient section of the Summary tab for the 

request.

Monitoring the status of project requests
You can monitor the status of project requests to see which recipients must respond to the request and their response to the 

request.

About this task

You can view the following information about project request recipients:

• Role

• User who is assigned to the role

• The sequence number that is assigned to the recipient

• The status of the response from the recipient (Not yet notified, Waiting, Accepted, or Returned)

• Any comments added by the recipients (click the User comments  link)

1. Select Operations  > Projects.

Result

The Active Projects and Requests  page appears.

2. Click the project request that you want to monitor.

Result

The Summary  page for the project request displays information about the recipients and the status of their 

responses.

Canceling or redrafting requests
To edit a request, you can cancel or redraft it. You can add or change information for a request before recipients accepted 

the request or if a required recipient returns the request.

1. Go to the Summary  tab of the request you want to change.

Example

For example, click Operations  > Projects. Click Actions  ( ) and select a view, such as All Projects and Requests, 

that includes projects in Submitted status.

2. To cancel the request, click Change Status  and select Cancel Request  or Cancel Request with comments  from the 

list.

3. Alternatively, to redraft the request, click Change Status  and select Re-draft Request  or Re-draft Request with 

comments  from the list.

4. Optional:  If you chose an option "with comments," type comments that indicate the reason for the cancellation or 

revision, and click Continue.
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Results

The status of the request changes to Canceled or Draft.

While you redraft a request, recipients cannot respond to the original request. If you must change recipients, click Edit.

What to do next

When you resubmit a request, recipients are notified according to the reapproval rule selected when the request was created. 

Reapproval rules might allow you to select recipients. In this case, if you did not change recipients when you redrafted the 

request, you can select from a list of required recipients who accepted the request when you resubmit it. If the recipients 

were assigned sequence numbers, recipients are notified in sequence.

Responding to requests as an individual
When someone creates a project request and you are the recipient, you receive an alert message on the My Alerts  page and 

an email to notify you of the request. Then, you must respond to the request.

1. Go to a request by selecting Operations  > Projects.

The Active Projects and Requests  view appears. If the request you want to accept is not in the list, click All Projects 

and Requests.

2. Click the request to open it.

3. Review the request and decide whether you want to accept it or return it to the submitter.

4. Enter any comments in the Comments  field and click Accept  or Return.

5. If you are accepting a team request, select the user who becomes the owner of the resulting project in the Assign to 

field.

6. Click the Actions  icon ( ) and select All Projects and Requests:

Results

• If you accepted, both the accepted request and the new project appear in the list. You are the owner of the project, 

which is not yet started.

• If you returned the request, Unica Plan  notifies the requester. The status of the request changes to Returned.

• If the request is returned, the requester can resubmit or cancel the project request.

Copying requests
To create a request that is similar to an existing one, you can copy that existing request. You can make the copy when the 

request is in any state, including before or after you submit a request. You can then edit the copied request as needed.

About this task

To copy a request or to edit a copied request, you must have the appropriate security permission.
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1. Go to the Summary  tab of the request you want to copy.

2. Click Copy  ( ).

Result

The Copy to  dialog box opens.

3. Select either the copied project or the project template as the source of the metrics to use in the new project. The 

metrics in the project instance you are copying might be customized from the template.

4. Click OK.

The Summary  tab opens for the new request. The name defaults to Copy of original request name.

5. Modify any information that you want to change in the copy, including the default name, and click Save Changes.

Results

The new request appears in your All Projects and Requests  view and your My Requests  view. New requests have a status 

Draft.

Copying projects
To create a project that is similar to an existing one, you can copy that existing project. You can make the copy when the 

project is in any state. You can then edit the copied project as needed. This functionality provides you a high flexibility with 

many options.

About this task

To copy a project, or to edit a copied project, you must have the appropriate security permission.

1. Go to the Summary  tab of the project you want to copy.Note: The copy option is available on all tabs.

2. Click Copy  ( ).

Result

The Copy project  dialog box opens.

3. Select the Make me the owner  check-box to become the co-owner with the current project owners.

4. Select either the From project  or the From template  (this is the project template)  or Customized copy  as the source 

to use in the new project.

5. On clicking the Customised Copy  button, a hidden section, consisting of Summary, Workflow, Budget, Tracking and 

Attachment tabs, becomes visible. On clicking the other buttons (From project or the From template), this panel 

remains hidden.

a. On clicking the Summary  and Workflow  button, a dropdown shows and you can make further choices. From 

the Summary  page you have the option of including the dates from the original project. If the Include Dates 

checkbox is unchecked, then the dates field remains blank in the new project. From the Workflow  section, 
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you can choose to keep the dates and attachments by checking the required checkboxes. By default, all the 

checkboxes are checked.

b. On clicking the Attachments  Button, a dropdown shows up with two options Include Attachment from Project 

and Include Attachment from Template. As the name suggests, the attachments will be copied from the 

project or from the template respectively. The Include Attachment from Project  radio button is checked by 

default. If you choose not to copy any attachment then you may keep the Attachments  button unchecked.

c. If the template of the project you are copying from has no metrics, then the Tracking  tab will remain hidden 

under theCustomised copy  section.

d. If the Financial module  is disabled in the original project, then the Budget  button is hidden under the 

Customised copy  section.

6. If the project you copy is linked to a parent program or project, and you wish to maintain the link in the newly copied 

project, you can do that by checking either the Copy parent program  link or the Copy parent project  link.

7. Click OK.

The Summary  tab opens in a View mode for the new project . The name defaults to Copy of original project name.

8. The Edit  button will remain enabled or disabled as per your project permissions. Modify any information that you 

want to change in the copied project, including the default name, and click Save Changes.

9. Under Include custom tabs  pane, you can perform the following actions. By default, all the tabs are selected.

Choose from:

◦ If you want to copy the current data from the project instance, select all checkboxes.

◦ If you want to copy the default value of the form from the template level, deselect the checkbox for that tab. 

If the default value for a required field in a form is set to null, then the current value gets copied, provided the 

ValidationWizardStep under Configuration is set to true.

Note:  The checkboxes are disabled and you cannot copy the form from the template if the form contains one 

or more required fields. You can copy the form from the instance and make the changes after copying the 

project.

Results

The new project appears in your All Projects  view and your My Projects  view. New projects have a status of Not Started.

Team projects and requests
Users can submit requests to a team, rather than an individual. Such requests are called team requests.

When someone accepts a team request, the resulting project is called a team project.

Team projects lifecycle
Team projects and requests have a different lifecycle because multiple team members work together on the project or 

request.



Chapter 5. Projects

The following table describes the lifecycle of team requests and projects.

Note:  The following steps depend on the routing model for the particular team that is involved in the request.

Table  10. Lifecycle for team projects

User action System action

1 A user submits a request to a team.
• Creates a team request.

• Populates the My Team Routing  field for the 

request.

• Sets the status of the request to Submitted.

2a A team manager assigns the request to a team 

member.

Sets the owner of the team project to the team 

member selected during the assignment.

2b A team member accepts or returns the request. Sets the owner of the team project to the team 

member selected during the assignment.

3a If accepted, the owner of the team project sees it 

through to completion.

Updates the status for the team project as applicable.

3b If the owner becomes unavailable, a team manager or 

member can reassign the project. • Sets the owner of the team project to the newly 

assigned team member.

• Updates the My Team Routing  field for the 

project.

Reassigning team projects
A team project can be reassigned if a team member becomes unavailable. For example, you can reassign a team project if 

the team member who is responsible for the project goes on vacation.

About this task

To reassign a team project, complete the following steps.

1. Go to the Projects  list page by selecting Operations  > Projects.

Result

The Active Projects and Requests  view appears. If the project you want to reassign does not display, click All 

Projects and Requests.

2. Select the team projects to reassign by checking the box next to each project.

3. Click Reassign Team Projects.
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A dialog box appears. You can reassign only team projects for which you have the correct authorization. 

Authorization depends on team membership and routing options.

4. In the Assign to  field for each project, select the user to whom the project belongs. This user becomes the owner of 

the project.

5. Optional:  Type your comments.

6. Click the Reassign Project(s)  button to complete the reassignments, or click Cancel  to close the dialog box without 

changing any project ownerships.

Responding to team requests as a team manager
When someone submits a request to a team you manage, you might assign a team member to the request. The assigned 

team member becomes the owner of the resulting project.

1. Select Operations  > Projects.

2. Respond to team requests in either of the following ways:

◦ Select a single project and click the Assign Team Request  icon ( ).

◦ Click the Actions  icon ( ) and select All my teams project requests. From this view, you can respond to 

one or multiple project requests by selecting the requests that you want to assign and clicking the Assign 

Team Request  icon ( ).

Note:  You can respond only to team requests for which you have the proper authorization. Authorization 

depends on team membership and routing options.

3. In the dialog box, assign the request or requests to the appropriate team members.

4. Optional:  Type your comments.

Navigating from projects to programs
You can link a project to a program. Programs help you organize projects in logical groups. After you link a project to a 

program, you can go to the program from within that project.

1. In the All Projects and Requests  view, select Operations  > Projects  and click All Projects and Requests.

2. Click a project to open it.

The Summary  tab has a field that is called Parent Items and Code. This field contains links to the ancestors of the 

project, its container program, and plan.

3. Click the link to open the program.
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The Summary  tab of the program appears. Scroll to the bottom of the Summary  tab of the program to view a list of 

all the projects that are contained in the program.

4. Click the name of the project you were just in to go back to that project.

Linked projects
Marketing projects often involve people from outside the marketing department, making it difficult to track everything with a 

single, comprehensive project. You can use multiple linked projects or subprojects to manage these tasks.

For example, work for an upcoming trade show involves the following tasks, each a project in its own right.

• Identify and assign individuals to attend, present, cover the booth, and so on.

• Produce marketing collateral.

• Design, build, and test a demonstration.

• Set up training sessions and speaking engagements.

• Generate the customer invitation list, create the invitation, send the invitation, track the responses, and so on.

• Create and maintain the trade show web pages.

You can track and manage these individual tasks within the respective departments, but you might lack a full view of whether 

the trade show occurs on time and without problems.

Using Unica Plan, you can organize projects by creating parent-child relationships between them. A project coordinator can 

create a trade show project and all of the necessary individual projects, assign owners to each, and then create links from the 

trade show project to each of the subprojects. This method provides the project coordinator with a single view into the entire 

project.

Note:  No data is exchanged between parent and child projects; the relationship is for organizational purposes only.

Subprojects overview
Projects can contain multiple subprojects.

From the summary page for a project, you can manage subprojects with the following menu items that display when you 

click the Manage Linked Objects  icon ( ).

• Add Project: creates a child project.

• Add Request: creates a child project request.

• Link Existing: creates a child link to one or more existing projects or requests.

• Remove: removes existing links to one or more child projects or requests.

Note the following behaviors.
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• Security policies must be the same for parent and child projects.

• The summary page for a project shows the links to all of its direct subprojects.

• A project can have a child-parent relationship with either another project or a program, but not both. That is, if a 

project is linked to a program, it cannot be linked to a parent project.

• After you add a subproject, you cannot change the security policy of the parent or child project; you must first remove 

the link.

Details on the project-subproject relationship
Within certain parameters, you can build complicated hierarchies of projects and subprojects to organize work.

The project-to-subproject relationship has the following characteristics.

• Any project or request can be linked to another project with the same security policy.

• A project can have at most one parent project or program, but not both.

• A project can have an unlimited number of child projects.

• A project can have both a parent and child project. This option makes it possible to have an n-level deep hierarchy for 

projects, such as: parent project, child project, grandchild project.

However, a request cannot be a parent. Requests can be a child of projects only.

• You cannot delete a project that is linked to either a parent or child. You must first remove all parent-child, and 

project-program, relationships before you can delete a project.

• When you copy a project that is either linked as child or parent, the new project is not linked.

• Metrics, budgets, and the workflow do not roll up from a child project to a parent project.

Creating child projects and requests
Use child projects and requests to organize work below the project level.

1. Go to the Summary  tab of the parent project.

2. Click Manage Linked Objects  ( ) and select Add Project  or Add Request.

Note:  These options are available only if you have the appropriate security permissions.

3. Choose a template for the new subproject or request.

The wizard for adding a project or project request appears.

4. Complete the wizard.

◦ As the user who completes these steps, you are the owner of the new subproject. Depending on who 

competes the wizard, the owners of the parent and child projects can be different.

◦ The security policy defaults to the value for the parent project.

◦ If you use the Save and Duplicate  option to create multiple projects or requests, each project and request 

links to the same parent.



Chapter 5. Projects

Results

When you complete the wizard, the project request or project is open to the Summary  tab. The Summary  tab has a field that 

is called Parent Items and Code. This field contains links to the ancestors of the project.

Linking child projects and requests to projects
To organize a hierarchy of work with projects and subprojects, you must link the parent projects to child projects and 

requests.

1. Go to the Summary  tab of the parent project.

2. Click Manage Linked Objects  ( ) and select Link Existing. This link is enabled only if you have the appropriate 

security permission.

Specify the projects to link in the dialog box.

3. Type your search criteria in the Find by name or code  field.

4. Click Find.

Unica Plan  displays search results of only those projects and requests that have the same security policy and budget 

granularity as the project. For example, if your project uses the global security policy, only projects and requests that 

also use the global security policy appear after a search. Additionally, projects with the status of Cancelled, Deleted, 

or Completed  never appear in your search results.

5. In the Search Results  field, select the projects and requests to link as children.

6. Use the double-arrows to move projects and requests into or out of the Selected Items to Link  list box.

7. Click Save Changes  to create child links to the projects or requests that you selected.

Security for linked projects
Linked projects and subprojects must have the same security policy. After you link a project to another project, you cannot 

change the security policy of either object without first removing the relationship.

To link, add, or remove parent-child projects and requests, you need to have the appropriate security permission. If you do not 

have the appropriate permission for the task you attempt, ask your administrator for help.

Removing parent-child project links
If the hierarchy of work changes, you can remove links between projects, subprojects, and requests. You can remove N-level 

deep child relationships with this procedure. For example, you can remove "grandchild" and "great-grandchild" relationships.

1. Go to the Summary  tab of the parent project.

2. Click Manage Linked Objects  ( ) and select Remove.

A dialog box appears, where you specify projects and requests to remove.
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Note:  The list contains child projects and requests from all levels. All child projects and requests, direct and 

indirect, appear on the list.

3. In the Linked Project...  field, select the projects to remove as children.

4. Use the double-arrows to move projects into or out of the Selected Items to Remove  list box.

5. Click Save Changes  to remove child links to the projects you selected.

Results

The project requests and projects no longer appear in the list on the Summary  tab of the project.

Note:  Removing the link does not remove or delete the project; it removes only the relationship.

Linking a Journey to Projects
You can link a Journey to a project. The conditions for linking a Journey to a project are as follows:

• Ensure that you have JourneyAdmin  or JourneyUser  privileges.

• Ensure that your role has the permission to Create/remove a linked journey. If you do not have this permission, 

contact your administrator to set this permission for your role.

• You can link a Journey to a project in any state of the Project.

• You can link only one Journey to a Project.

• If a Journey is already linked to a project, you must unlink it from the existing project before linking it to another 

project.

Linking a Journey
To link a Journey to a project, complete the following steps:

1. Go to Summary  tab of the project.

2. Select Link a Journey.

Result

The Link a journey  dialog appears.

3. Type the Journey name or Journey code and click Find.

Result

The Search results  section displays the matching results.

4. From the Search results  section, select the required Journey and click Save.

Result

The selected Journey is attached to the Project.

Viewing the linked Journey
To view a linked Journey, complete the following steps:
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1. Go to Summary  tab of the project.

2. Click Linked journey.

Result

A dialog appears and you can view the Journey.

Unlinking a Journey
To unlink a Journey from a project, complete the following steps:

1. Go to Summary  tab of the project.

2. Click the icon succeeding the Linked journey.

Result

The Journey is unlinked from the Project.

Assigning work
After a project exists, users can assign work to people or teams.

1. Go to a project.

2. Add people and teams to the project. To assign work to an individual or team, they must be members or reviewers of 

the project.

3. Assign tasks in any of the following ways:

Click Manage roles  > Assign work by role  on the People  tab of the project to assign all tasks. Tasks are assigned 

based on user roles.

◦ Click Find and Replace  > Find And Replace Task Members  or Find and Replace  > Find and Replace Task 

Reviewers  on the People  tab to reassign work for certain people or teams.

◦ Use the Workflow  tab to individually assign tasks to users and or teams.

◦ Click Members  on the People  tab of the project to assign a team.

Results

When users log in, they can act on the tasks that are assigned to them.

Reconciling projects
After you complete or cancel a project, you can edit certain portions of the project by placing it into a temporary state, In 

Reconciliation.

About this task

1. Go to the Summary  tab of the project to want to place In Reconciliation.

Example

For example, select Operations  > Projects. Click Actions( ) and select a view (such as Completed Projects) that 

includes projects in the status of  Completed or  Canceled.
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2. Click Change Status  and select Reconcile Project  or Reconcile Project with comments  from the list.

3. Optional:  If you chose Reconcile Project with comments, add comments and click Continue.

Results

The project status changes to  In Reconciliation. You can edit the project information.

Deleting projects
When you delete a project, Unica Plan  checks to see whether you linked the project to a program. If you did, you cannot 

delete the project until you remove it from the program.

1. Open Unica  and select Operations  > Projects.

By default the Active Projects and Requests  page appears.

2. Select the check box next to each project you want to delete.

3. Click Delete this Item  ( ).

Project and request deactivation
After your organization uses Unica Plan  for some time, the user interface can become cluttered with out-dated or unwanted 

projects and requests. You can deactivate projects and requests to reduce clutter and simplify searches.

Most Unica Plan  users can deactivate and reactivate projects and requests from the object Summary tab or project and 

request list pages. You can deactivate or reactivate up to 1000 projects and requests with this method, which depends on 

the number of objects that are displayed on each page. Your administrator specifies the maximum number of objects that 

display on each page in the administrative configuration settings. Administrators can also deactivate or reactivate multiple 

projects and requests that fit selected criteria with bulk deactivation and reactivation features.

Note:  You must have appropriate security permissions to deactivate and reactivate projects. Administrators set 

permissions at the template level. When a template is created, the Project Owner and Plan Administrator can 

deactivate and reactivate projects and requests by default.

After you deactivate projects and requests, they no longer appear in the user interface or search results unless you 

specifically search for it. The following standard searches show deactivated projects and requests.

• Deactivated Projects

• Deactivated Requests

• Deactivated Projects and Requests

You can also locate deactivated projects and requests in searches that are built by filtering these default searches.

The inactive projects and requests remain in your database. Inactive projects can always be reactivated.
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To deactivate a project or request, it must fulfill the following criteria.

• Projects must be in the state of Complete, Canceled, or On Hold.

• Project requests must have a status of Canceled.

• If the project has subprojects, the state of the subprojects must also be Complete, Canceled, or On Hold. You must 

also deactivate the subprojects before you can deactivate the parent project.

• In an integrated Unica Campaign-Unica Plan  environment, the campaign end date must pass before you can 

deactivate a project or subproject with a linked campaign. You cannot deactivate a project with a future end date.

Deactivating projects and requests
You can deactivate projects and requests to remove them from the Unica Plan  user interface directly from the list pages.

About this task

You can deactivate up to 1000 projects and requests with this method. If you need to deactivate more than 1000 items and 

have the appropriate permissions, use the bulk deactivation feature.

1. Go to the projects or requests you want to deactivate.

You can open the project or request Summary  tab. You can also select multiple projects and requests from a list view 

such as All Projects and Requests.

Note:  Projects must be in the state of Complete, Canceled, or On Hold state. Project requests must have the 

status of Accepted or Canceled status. Select a list view that shows projects and requests in these statuses.

2. Click 

3. Optional:  Type comments to explain why you are deactivating the project or request.

4. Click Deactivate.

Results

After you deactivate projects and requests, you see them in the user interface only if you use predefined searches for 

deactivated projects and requests. To see the deactivated projects, use the Deactivated Projects, Deactivated Requests, and 

Deactivated Projects and Requests  searches. You can refine these predefined searches for more specific results.

Reactivating projects and requests
You can reactivate projects and requests on an individual basis.

About this task

Find deactivated projects and requests with the default searches Deactivated Projects, Deactivated Requests, and 

Deactivated Projects and Requests. When projects and requests are deactivated, you can view them only in these searches.

You can reactivate up to 1000 projects and requests with this method. If you need to reactivate more than 1000 items and 

have the appropriate permissions, use the bulk reactivation feature.
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1. Go to the projects or requests you want to reactivate.

You can open the project or request Summary tab. You can also select multiple projects and requests from a list view.

2. Click 

3. Optional:  Type comments to explain why you are reactivating the project or request.

4. Click Reactivate.

Results

After reactivation, projects and requests appear in the All projects and requests  view again.
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To help you complete different workflow-related efforts, the Workflow  tab offers different view modes and an edit mode.

To record and track the tasks that need to be completed during a project, you add information to the project Workflow tab. 

Project managers add tasks, organize them into stages, and identify dependencies, personnel, and other related information. 

Project participants update task status and scheduling data, add attachments, and provide approvals.

You can manage tasks that are associated with a project. The Workflow tab provides a spreadsheet on which you can list all 

tasks. You can assign dates and team members to each task.

When a project manager creates a project, the selected template can provide an initial workflow. The project manager can 

then use the Workflow tab to customize the workflow that is provided by the template to meet specific needs.

Team members that are assigned to a project  use the Workflow tab to track their work. Any team member that is involved in 

the project  (with the appropriate access permission) can edit any value on the Workflow tab.

Note:  The advanced workflow feature with rework loops is not supported.

In Unica 12.1 release, Plan offers two versions of Workflow:

• Workflows - Enhanced version  on page 75

• Workflows - Classic version  on page 107

You can monitor and manage workflows from both views.

Workflows - Enhanced version
The enhanced version of workflows is the new version of workflows, added in 12.1 release of Unica Plan, to view and modify 

workflows.

The new features of the enhanced version are as follows:

• An intuitive user interface

• Drag-and-drop feature to move tasks or stages, or to change the sequence of columns

• Auto-save feature eliminates the worry of saving the modifications

• Saves UI-related user customization, which includes:

◦ added columns or removed columns

◦ rearranged column sequence

◦ resized Task/Approval name column

You can switch from one workflow version to another without any feature loss. Changes made using one version can be 

viewed using the other version too.
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When multiple users are on the enhanced workflow for a certain project, then Action taken by one user causes a refresh in 

the other users' view.

An action taken by the user in the enhanced workflow will be rejected if the user is working on stale data . This happens in 

the following cases:

• user 1  is on the enhanced workflow of a project, for example, named Tradeshow.

• user 2  is on the enhanced workflow of the same project.

• user 1  performs some updates on the workflow.

• Before the view of user 2  is refreshed, if user 2  performs some updates, user 2  will receive an error because user 2 

is working on the stale state of the project.

Updates performed on the screens, other than the enhanced workflow, do not refresh the other users' view.

Workflow concepts
Workflows organize the tasks, approval tasks, stages, and milestones for each project. Workflows measure the time that is 

spent on each part of the project and the people who are assigned to work on it.

Tasks

Tasks are steps in the workflow where a user or the system  acts. The task is not complete until the action is complete.

Form tasks

Form tasks are steps in the workflow where a user must complete a specific form. After the user completes the form, the 

task is complete.

Each form task requires the user to complete one specific form on a custom tab in the template. Use multiple form tasks to 

instruct users to complete multiple forms. You cannot use form tasks to complete custom forms on the summary tab.

After users complete the form, they can submit the form for approval.

Approval tasks

You include approval tasks in a workflow to indicate that an approval process must take place. On the Workflow tab, you 

can start the approval process for an approval task. When the approval process is in progress, the Workflow tab organizes 

information about that process, but you can no longer edit the approval task.

Flowchart approval

In an Unica Plan/Unica Campaign  integrated setup, you can now create a flowchart approval and attach a flowchart to it. 

When a flowchart is run, the following points are checked:

1. If no approval exists for a particular flowchart, it should be executed successfully.

2. If one or more approvals exist, the flowchart will be allowed to run only if all the approvals are approved and in 

completed/canceled state else it should not run.
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Note:

1. One flowchart can have several approvals.

2. One flowchart approval can have only one flowchart.

Stages

You can group tasks together under headings called stages. Stages can help you with task organization. For example, you 

can create a stage that has all tasks your field marketers-specific users  do. Stages are the headings in bold that group the 

tasks together.

Milestones

You can identify workflow tasks as milestones for your project. Example milestones include Job Start, Meeting, and Event.

Dates

Workflows contain the following types of dates.

• Forecast/Actual dates  begin as forecast dates: future dates when a task owner plans on starting and completing a 

task. These dates are specified while the task is still pending. When a team member starts and completes a task, the 

same dates can be used or different dates that are supplied as the actual dates.

Actual  dates specify when tasks start and finish.

• Target dates  are dates that are used to plan the project  schedule. Typically, they are set at the beginning of the 

project.

• Anchored  are fixed dates that cannot change, even if the dates of the tasks, upon which they are dependent, change. 

If you set Anchored  to Yes, the dates considered will be the Forecast/Actual dates  and not the Target dates.

• Non-work time  represents dates when people do not work, so the system skips those dates when it calculates 

durations for tasks. Unica Plan  currently supports system-wide non-work time that applies to all tasks. It is up to the 

project manager  to determine whether overriding any of these dates is necessary. System administrators enter and 

maintain these dates.

• Weekend dates  are dates that you use to specify work that occurs on a weekend on a per-task basis. You can 

schedule work on a weekend date by using the Schedule Through option for each task.

Duration

Duration is the actual number of days that are assigned to a task. When you assign start and end dates, the system 

automatically calculates the difference between the forecast or actual start date, and the forecast or actual end date for a 

task. The actual number of days between the start and end dates equals the duration of the task.

You can assign duration by using any non-negative number. For example, you can use 0.25 to assign a quarter of a day for 

the task duration.
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Duration is the actual number of days that are assigned to a task. The duration control is in a DD-HH-MM  format. You can 

enter up to 999 days value for the DD  field, your applicable business hours that are based on the beginningOfDay and 

numberOfHoursPerDay configuration settings for the HH  field, and a value in 30-minute intervals for the MM  field.

Effort

The work effort in days (as opposed to duration) that it takes a user to complete a task. For example, a task takes three 

calendar days to complete, but the task owner spends only half a day on the task for each of the three days. In this case, the 

effort for the task is one and a half days even though the duration is three days.

Locked tasks

From the enhanced workflow, if the user tries to save the task or an approval, the user will see an error message if:

• the given task or approval is opened in edit mode in any of the existing screens by another user.

• there is another concurrent operation performed on the same task or approval from the enhanced workflow and it is 

passed.

If anyone attempts to edit a locked task, they receive a warning message, indicating that it is in use.

People and roles

You can assign tasks to individual team members or you can assign tasks to all team members in each role. When you 

assign a task to one or more team members, they are considered to be task owners. You assign roles to team members on 

the People tab of the project.

Workflows use the following concepts to identify people in the workflow.

• Task owners  are the people responsible for running or managing workflow tasks.

• Reviewers  are responsible for approval tasks. These members become the approvers of the task.

• Roles  are used as a bridge between tasks and people. They are useful for assigning work on a generic basis. For 

example, each type of project you create can have its own workflow template, and the template can contain standard 

roles for certain tasks. Then, when you create a project, some (or all) of the tasks have a default role that is already 

associated with them.

Note:  Each workflow might contain users from different timezones. You chose whether Unica Plan  displays the 

timezone after the time stamps on the workflow and workflow columns. For more information, see Calendar display 

options  on page 191.

Schedules
There are two options for scheduling in workflows: baseline and up-to-date.
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Baseline scheduling

You use baseline scheduling when you want to compare actual dates to fixed target dates. With baseline scheduling, you 

never change the target dates, allowing them to serve as a baseline. Users who are assigned tasks receive reminders on 

completing the actual/forecast  dates.

While you work with a baseline schedule, the owner of the project sets the initial Target Start and End dates for each task. 

These dates stay fixed throughout the entire workflow. As the owner can update the actual/forecast  dates with real data 

based on status information received from team members.

Up-to-date scheduling

You use up-to-date scheduling when you want to use actual dates to update the official schedule (defined by the Target Start 

and End dates) regularly. This mode enables project managers to capture the most up-to-date, official schedule; however, it 

does not provide an easy way of viewing a baseline version of the schedule.

Using a baseline schedule
System administrators set up permissions and reminders for baseline schedules. Schedule owners set the dates for each 

task in the baseline schedule. Team members update the progress for their tasks in the baseline schedule.

Before you begin

Before you create your projects, have the system administrator set up the following permissions and reminders:

• Set permissions so that only project  owners can update Target  dates.

• Set reminders (alerts) that are based on the Actual/ForecastActual  dates.

About this task

While you work with a baseline schedule, team members perform the following high-level steps.

1. The owner sets the Target Start  and End  dates for each task.

These dates stay fixed throughout the entire project.

2. As the project  progresses, team members update the Actual/Forecast  dates with real data.

Keeping an up-to-date schedule
System administrators set up permissions and reminders for schedules. Schedule owners set the dates for each task in the 

schedule. Team members update the progress for their tasks.

Before you begin

Before you create your projects, have your system administrator set up permissions and reminders as follows.

• Set permissions so that only project  owners can update Target  dates.

• Set reminders (Alerts) that are based on the Target  dates.
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• Set reminders to be sent only to the owner or owners.

• Optionally, set reminders on the Actual/Forecast  dates to be sent to team members.

About this task

While you work with an up-to-date schedule, team members perform the following high-level steps.

1. The owner sets the initial Target Start  and End  dates for each task.

2. As the project  progresses, team members update the Actual/Forecast  dates with real data.

3. If a task is delayed (the owner receives reminders that are based on Target  dates), the owner assesses the situation 

and adjusts the Target  dates and durations as necessary.

Recalculating dates
When you enter or change the date for a task, the system calculates other dates that are based on your entry. It uses an 

internal algorithm to bidirectionally recalculate dates, starting with the cell where you entered the date.

When you initiate Recalculate dates for a workflow, note the following issues:

• In addition to factoring in non-work days and hours, Recalculate dates uses two additional system-wide properties: 

start time of day and number of hours per day. Your system administrator configures these settings.

• If a task row is anchored, Recalcuate dates does not update its dates (even if the date columns are empty).

• Recalculate dates does not affect active and finished tasks; only tasks with a status of Pending.

• Recalculate dates observe the per-task options for non-work time. The calculation algorithm takes into account 

whether a task is scheduled to progress during non-work time, weekends, or both.

• Do not log forecast  target  times outside of business hours if you intend to recalculate dates or other automatic 

calculations afterward. That information is overwritten by the automated process.

Calculating workflow dates automatically
When you enter or change the date of a task, the system calculates other dates that are based on your entry.

About this task

To calculate workflow dates automatically, complete the following steps.

1. Enter or change the date for a task in any of the date fields.

Result

If the entered date does not interfere with the dates of other dependent components, it is accepted. Otherwise the 

date turns red with an !  succeeding the date.

2. Keep the date selected and click the Recalculate dates  and one of the following options:

Choose from:

◦ Preserving slack time between tasks

◦ Removing slack time between tasks

Results
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The other dates in the workflow are updated, because of the new entry.

Calculating date dependencies above a locked task
If a workflow has a locked task, and you change the date of a task that is located above that task, you receive a warning 

when you calculate date dependencies.

About this task

To clarify this task, the procedure that follows assumes:

• Task 1.8 is locked.

• You need to change the duration of task 1.5 from five days to 10 days.

• All tasks depend on the previous task.

1. Open the workflow and change the duration on task 1.5 from five days to 10 days.

2. Click Recalculate dates  to end the date of task 1.5.

Result

The system displays a warning message, saying you cannot recalculate through the locked row.

3. Click the start date of task 1.8

4. Click the Recalculate dates.

Results

The system calculates the dates below the locked task.

Scheduling work time
You can use Unica Plan  to help you manage and allocate your resources effectively.

Unica Plan  offers the following settings to help manage and allocate resources:

• Specify non-work time: allows your organization to define a set of dates that, by default, are not included when the 

system calculates task dates and durations.

• Include weekends in work time: by default, weekends are not included when task dates and durations are calculated. 

However, you can override the default to schedule certain tasks through weekends.

By default, tasks do not include weekends or non-work dates when task dates and durations are calculated.

To view a list of defined non-work dates, click Non-working Business Days  from the Administration  page.
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Note:  When you view the Unica Plan  calendar, any day that is specified as non-work time is indicated by a gray X in 

the background. In timeline view, non-work time appears in a gray-shaded column. Additionally, the name of the non-

work time (for example, Labor Day) displays when you point to the date.

Non-work time
You can set days on which no work is typically done by employees as non-work time in Unica Plan. Unica Plan  supports a set 

of system-wide non-work time, which is separated into user-defined types.

For example, assume that you have the following non-work dates set in Unica Plan.

Table  11. Non-work time example categories and dates

Category Dates

Corporate Holiday 1/1/2015, 7/4/2015, 12/25/2015

State Holiday 4/15/2015, 10/3/2015

Corporate Off-site 8/15/2015

After you define non-work time, you can elect whether to schedule work on these days, for each project and its tasks.

If the active time for a task includes any non-work time, its end date is pushed out by an extra day for each of these dates. 

For example, assume 7/4/2015 is defined as non-work time. If Task 1.3 is scheduled to start on 7/3/2015, and has a duration 

of three days, its end date is 7/7/2015. Work is not scheduled for 7/4, since it is defined as non-work time.

For any task, you can choose to ignore the non-work time; if so, the workflow includes any non-work time as normal work 

days. So, if you choose to ignore non-work time for Task 1.3, its end date becomes 7/6/2015.

In Gantt view, for a Task or an Approval, if the start date and time and the end date and time are not within working hours, a 

rectangle still appears on the view but the duration is zero. For example, in Gantt view, for a Task or an Approval, if the start 

date and time is 8:00 pm, and the end date and time is 5:00 am, a rectangle exists in the Gantt view for a task or a workflow 

but the duration will still be zero.

Weekends
For certain tasks, you might need to schedule work to proceed on weekends. For example, print shops often work 24 hours a 

day, 7 days a week. If you have tasks that go to a print shop, you can have these tasks take into account weekend days.

For example, you have a task that is called "Print Brochures at print shop." This task might start on Friday 6/15, and have a 

duration of three days. If you choose to include weekends for this task, its end date is end of business Monday, 6/18. If you 

choose not to include weekends for the task, it ends on end of business Wednesday, 6/20.

Work and non-work time settings
By using the Schedule Through  indicator on the workflow, you have many options for scheduling tasks.

You can schedule tasks in any of the following ways.
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Table  12. Options for scheduling tasks

Flags Behavior

Bus. (Business)
Non-work time and weekends are excluded from task scheduling.

Note:  This option is the default setting for all tasks.

Wkd. (Weekends) The task is scheduled to include weekends, but not system-wide non-work time.

Off. (Days off) Weekends are excluded from task scheduling, but work is expected to be done during other 

non-work time.

All (All calendar days) The task is scheduled to include all days.

Note:  The Schedule Through column is a planning and targeting tool. Do not change this column after the actual 

dates and times are logged on a task. Doing so can overwrite the actual dates and times.

Modifying workflows
When you create a project, a wizard that is based on the template you selected collects information. After you complete the 

wizard pages, you can customize the default workflow that is provided by the project  template.

Before you begin

Before you can modify a workflow, the project must not be in the In Progress  state. If it is, you must pause it.

About this task

In addition to project templates, which can include workflow tasks and values, your installation can maintain a set of 

workflow templates. Workflow templates are template components that are independent from project templates. While a 

project is in the Not Started status, you can assess whether the workflow supplied by the project template is adequate or if a 

different workflow template provides a better starting point. For more information about workflow templates, see the Unica 

Plan  Administrator's Guide.

The ability to customize template-supplied workflows is controlled by your user permissions.

1. Open the new project  and click Workflow.

2. To replace all rows and values with data from a previously defined workflow template (if the project is in Not Started 

status), click More  > Import and save workflow.

A warning that this procedure deletes the current workflow displays. Click OK, then select a workflow template and 

click Import.

3. To change default task and stage names to reflect your specific tasks and stages, click in the cells in first column to 

make your edits. You can also change task dependencies. 

For more information about dependencies, see Task dependencies  on page 91.
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4. To add rows to the workflow, click Add Row  and then select Task, Form Task, Approval, or Flowchart approval.

Result

For more information, see Adding a stage or task  on page 88.

5. To add a stage, click the Add Stage.

6. To add a user task, click Add Row  > Task.

7. Enter target or forecast/actual dates for the tasks, depending on how you want to use the schedule.

Example

◦ You can enter a start date, end date, and duration for a task. If you enter any two of these values, the system 

calculates the third value automatically. For example, if you enter a target start and a target end date, the 

system calculates the duration.

◦ While the Schedule Through column indicates work days for a task, you can enter any date as a start or end 

date. For example, for a task that is not scheduled to include weekends you can still pick a Sunday as the end 

date.

8. To specify that a task is a milestone, such as a drop date, click the Milestone Type  column and select a milestone 

from the list.

Your administrator sets the milestones options in this list.

9. Select members or roles to assign the task to in the Members  and Member Roles  columns  or in the Reviewers  and 

Reviewer Roles  columns.

Result

For more information, see Adding roles and members to tasks  on page 99.

10. Make other selections and entries in the spreadsheet to reflect the workflow for your project.

11. Enter any instructions or notes about a task in the Notes  column.

Workflow toolbar
In the Enhanced workflow version, you do not have to open in edit view to make changes. You can make changes in the 

default view and the changes are auto-saved.

The following table describes the toolbar options.

Table  13. The workflow toolbar

Icon Description

Add row
Add Row. To add a row after an existing row in the workflow, select the row then click this icon to 

specify the type of row. You can add:

• Task

• Form task

• Approval

• Flowchart approval

Unica Plan  adds the task and renumbers the subsequent tasks.
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Table  13. The workflow toolbar  (continued)

Icon Description

Add stage To add a new stage after a row or an existing stage. Select an existing row or a stage and click the 

button.

Unica Plan  adds the stage and renumbers the subsequent stages.

In series / In parallel / 

No dependency
By default, the system adds rows to the spreadsheet in series, so each task depends on the task 

that precedes it. To use a different dependency option, click the button and make a selection 

before you add the next task to the workflow.

Select a dependency option.

• No Dependencies: when you add a row, the system does not make it dependent on any 

other row

• In series: when you add a row, the system makes it dependent on the row above it

• In parallel: when you add a row, the system makes it dependent on the same task or tasks 

as the row above it

Each row that you add uses the same dependency option until you change your selection.

You can also change dependencies manually. Click the task or stage name and supply a 

comma-separated list of numbers in parentheses. For more information, see Task dependencies 

on page 91.

Deleting a component

Select a task or stage name and click  >  to delete the component.

Note:

• You cannot delete the first stage in a workflow spreadsheet.

• When you delete a stage, its associated tasks are appended to the previous stage. 

The tasks are not deleted.

Spreadsheet view 

(enabled)
This is a toggle button which either activates or deactivates the Spreadsheet view.

If you activate the Spreadsheet view, you can view and modify the fields.
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Table  13. The workflow toolbar  (continued)

Icon Description

Spreadsheet view 

(disabled)
If you deactivate the Spreadsheet view, the view turns to read-only mode. In this mode you can 

modify the following details: You can only modify the timeline view of the project. The timeline 

view options are as follows:

• Forecast date / Target date: By default, Forecast date is selected. You can change the 

view to Target date.

• Hour / Days / Weeks / Months: By default, Days is selected. You can change the view to:

◦ Hours: Shows an hourly view of a particular day.

◦ Days: Shows a daily view of the project status.

◦ Weeks: Shows a weekly view of the project status.

◦ Months: Shows a monthly view of the project status.

If you have the required permissions, you can add or remove dependency in the read-only mode.

To add a dependency, drag-and-drop a dependency line from the source task or approval to the 

destination task or approval.

To remove a dependency, select the required dependency line and press the Delete  key.

Note:  If there are multiple dependency lines from the source task or approval, they will 

overlap each other and you cannot remove the shorter lines before deleting the longer 

line. This is a Known Issue in 12.1.0.2 release.

You can modify the tasks even if the Spreadsheet view  is disabled. Click the task in the Dock 

Panel  column. A dialog appears. A side panel opens containing the following tabs:

• General

• Attachment

• Dependency

In the side panel, complete the following steps:

1. In the General  tab, provide values for the following fields:

◦ Set the Status  of the task.

◦ Confirm if the Anchor  is needed or not.

◦ Set the Milestone  for the task.

◦ Toggle Enforce dependency  if you want to set it.

◦ Set the schedule using Schedule through.
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Table  13. The workflow toolbar  (continued)

Icon Description

◦ Set the Start date  and End date  for Forecast/Actual dates  and Target dates. Either 

set the End date  for Forecast/Actual dates  and Target dates, or provide the Actual 

duration  and Target duration.

◦ If required, enter the Workflow notes  and Comments for revision history.

◦ For the Members  field, search a member by name and select the required member 

to assign the task.

◦ For the Task roles  field, search a role and select the role to assign to the member.

2. In the Attachments  tab, provide values for the following fields:

3. In the Dependency  tab, provide values for the following fields:

4. Click Save.

An entry for the task with the duration appears in the grid. After you set the dates, using the side 

panel, you do not have to access the panel to make modifications. You can resize the block, by 

selecting either the start point or the end point of th block, or move the block and the dates get 

updated automatically.

Recalculate dates
Shift+click  to select one or more adjacent cells, click Recalculate dates  and one of the following 

options:

• Preserving slack time between tasks: recalculates all date dependencies that are based 

on your changes; any slack time between dependent tasks is not removed.

• Removing slack time between tasks: recalculates all date dependencies that are based on 

your changes; any slack time between dependent tasks is removed.

Tools
Offers options that affect the values in specific cells, or that affect a column or the entire 

spreadsheet.

To apply any of the following options, you must first Shift+click to select one or more adjacent 

cells, click Tools, and one of the following options:

• Copy: copies the contents of the selected cells to the clipboard.

• Paste: pastes the contents of the clipboard, beginning at the selected cell.

• Paste row after: pastes the contents of the clipboard below the selected row.

• Mark: changes the Status and % Complete values for the corresponding task or tasks. 

For example, Mark as Finished  changes the Status to Finished and % Complete to 100%. 

You can mark tasks as Mark as Skipped, Mark as finished, Mark as active, or Mark as 

pending.
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Table  13. The workflow toolbar  (continued)

Icon Description

• Fill  > Fill up / Fill  > Fill down: copies the value in the selected cell or group of cells to the 

cells above or below it.

• Clear  > Clear cell: erases all entries in the selected cell or group of cells.

Note:  You must apply these options to cells that are adjacent; that is, Ctrl+click selections 

are not supported.

The other options on the Tools  menu function as follows:

• Clear  > Clear column: click a single cell, then select this option to erase all entries in that 

column. For columns that have a default value, such as Schedule Through, every cell is set 

to the default.

• Clear  > Clear all: erases the entire workflow.

Adding a stage or task
To add a task or stage to a workflow, you must have the appropriate permission for the related template.

If the Add row  or Add stage  buttons are missing from the toolbar, contact your administrator about obtaining the appropriate 

access rights.

Note the following information about stage and task rows.

• To differentiate stages from tasks, the rows for stages display in the workflow with a shaded background. In addition, 

identifying icons differentiate tasks from approvals.

• When you add a stage or task, you can indicate where in the workflow to insert it: enter the stage number and the task 

number before the task name.

For example, if you enter 2.3 Have team meeting  anywhere in the task list, the task is placed under the task that is 

labeled 2.2. Any subsequent tasks in that stage are automatically renumbered: the step that was previously labeled 

2.3 is now 2.4.

• You can move a stage or task to a different location by dragging it from the source location and dropping it to the 

destination location.

• There are several options for managing dependencies on tasks as new rows are added and existing rows are 

removed. For more information, see Task dependencies  on page 91.
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• After you create an approval from a workflow task, you can edit only the approval itself; you cannot edit the 

corresponding task in the workflow.

If you try to edit the approval from its workflow task, an error message indicates that the task row is locked. You must 

open the approval to update any of its fields.

Adding form tasks
Add form tasks to the workflow when the user needs to complete a specific form as one step in the workflow. Select one 

form to assign to each form task.

1. Decide what dependency option you want the new task or stage to use: Click In series  and select No dependencies, 

In series, or In parallel.

Your selection remains in effect until you change it again.

2. In the workflow, click the stage or task name that you want the new row to follow.

3. Click Add row  > Form task.

4. Select a form in the pop-up and click Ok.

Note:  You can only select one form for each form task. Your administrator populates this list on the project 

template.

What to do next

After you add form tasks to the workflow, you can configure approval tasks to send the completed forms for approval.

Adding rows to the workflow
Add rows to the workflow to add more tasks, form tasks,  and approvals.

About this task

Before adding rows, familiarize yourselves with the toolbar. For more information, see Workflow toolbar  on page 84.

1. Decide what dependency option you want the new task or stage to use: Click In series  and select No dependencies, 

In series, or In parallel.

Your selection remains in effect until you change it again.

2. In the workflow, click the stage or task name that you want the new row to follow.

3. Click Add row  and then select Task, Approval, Form Task, or Flowchart approval. To add a new stage, click Add 

stage.

Unica Plan  adds the new row to the workflow. Stages display with a shaded background; tasks and approvals have 

different identifying icons.

4. Add a stage or task.

◦ To add a stage, click the Add stage.

◦ To add a user task, click the Add task.
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5. Optional: Change the dependency that is assigned by the system to the row. The numbers of the tasks that a task 

or stage depends on display in parentheses after the name. If a date for one task changes, the system changes the 

dates for all the dependent tasks.

Example

For example, suppose that you add a task and its name is 2.5 Deliver draft to vendor (2.4)2.5 Generate List (2.4). 

To make this task dependent on task 1.3 instead of task 2.4, change the task name to 2.5 Deliver draft to vendor 

(1.3)2.5 Generate List (1.3). To make this task dependent on both task 1.3 and task 2.4, separate the task numbers 

with commas: change the task name to 2.5 Deliver draft to vendor (1.3, 2.4)2.5 Generate List (1.3, 2.4).

For more information, see Task dependencies  on page 91.

Results

The stage or task is added to the workflow after the insertion point.

Adding rows below a locked approval task
When the approval process is in progress for an approval task, the approval task is locked. If a project manager clicks a 

locked approval task, an error appears. You might need to add another step after the approval process starts. To avoid this 

error, you add a task and then change number the system assigns to the task.

1. Decide what dependency option you want the new task or stage to use. Click In series  and select No dependencies, 

In series, or In parallel.

Your selection remains in effect until you change it again.

2. Select any row that is not locked.

Example

Select the row immediately below the locked approval task.

3. To add approvals or tasks, click Add row  and then select Task, Approval, Form task, or Flowchart approval. To add 

stages, click Add stage.

4. Change the number that the system assigns to the new task or stage so that it follows the locked task. 

Example

Suppose that the locked task is 2.5 Review copy - informal (2.3). Click the name of the new task and change its 

number to 2.6. When you click in another spreadsheet cell, the system moves the new task so that it is after task 2.5.

Stage and task sequence
If you change the number for a task or stage, the task is inserted before the row that matches the new number.

For example, assume the following stage order:

1. Planning

2. Collateral Design

3. Lead Generation
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4. Show Setup-to-Breakdown

5. Marketing Review

If you edit task 5, Marketing Review, changing its number to 3, the new order is as follows.

1. Planning

2. Collateral Design

3. Marketing Review

4. Lead Generation

5. Show Setup-to-Breakdown

Now suppose that you edit task 2, Collateral Design, changing its number to 4. The new order is as follows.

1. Planning

2. Marketing Review

3. Lead Generation

4. Collateral Design

5. Show Setup-to-Breakdown

To move a task or stage to the end, give it any number higher than the final task or stage. For example, to move stage 2, 

Marketing Review to the end, change its number to 6  or higher.

Task dependencies
Unica Plan  offers different options for managing task dependencies as new rows are added to a workflow spreadsheet and 

existing rows are removed.

In the workflow, you click In series  and select one of the following options:

• No dependencies: the system does not create dependencies for new rows automatically. If you need dependencies 

for the new tasks and stages, edit the task name to add them manually.

• In series: the system inserts new rows into an existing chain of tasks.

• In parallel: the system inserts new rows in a dependency branch that is parallel to an existing chain of tasks.

Inserting tasks in series

Inserting In series  makes a new task dependent on the task before it, and then makes all items that depended on that task 

dependent on the new task.

You insert a task in series when it can start only after the previous task is complete. For example, in this figure, if task X 

cannot be worked on until task B is complete, you insert task X in series.
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Inserting tasks in parallel

Inserting In parallel  makes the task dependent on the items (tasks or stages) that the task before it depended on. This action 

makes the items that are dependent on the previous task also dependent on the new task.

You insert a task in parallel when it can be worked on at the same time as another task. For example, in this figure, if task X 

can be worked on simultaneously with task B, you insert task X in parallel.

Deleting tasks

Deleting a task removes the selected task from the chain. Then, the system relinks the two remaining segments of the chain 

together so that it is one continuous chain again.

When a task is deleted, its dependent tasks are made dependent on its dependencies before the deletion takes place. This 

practice preserves all sequential chains of dependencies.

Default and "last used" modes

To make adding a task as simple and consistent as possible, Unica Plan  provides the following behavior.
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• The default mode is In Series. When you are modifying values, this mode is used as the insertion mode.

• The "last used mode" is remembered each time you modify the values. When you select a different dependency 

mode, it is used each time that you add a task until you change it again or finish your modifications.

• For example, to add several tasks in parallel, you need to select In Parallel  mode only one time. Then, every time you 

insert another task, the system inserts it in parallel unless you explicitly select another mode.

If needed, you can change the dependency that is assigned by the system manually. Click the task name, then edit the 

comma-separated list of task numbers that display in parentheses after the name.

Workflow columns
In the workflow, data is presented in columns and rows. You review and enter information in the cells for each row-column 

pair.

Table  14. Workflow columns

Column Description

Tasks, Stages Lists the tasks and stages that make up the project.

Click a stage or task to revise or change its sequence, name, or dependencies.

When in view mode, click a task to update status and scheduling information. For more 

information, see Post Task Update dialog  on page 108 or Starting an approval process from 

view mode  on page 112.

Status Displays an icon to indicate the status of the task. Tasks can have one of the following statuses.

• Pending

• Active

• Skipped

• Finished

Approval tasks can have one of the following statuses.

• Not Started

• In Progress

• On hold

• Completed

• Canceled

When an approval task has a status of Not started, you can change the status to In Progress or 

Canceled. When the approval process is in progress for an approval task, this field is read-only. 

For more information, see Starting an approval process from view mode  on page 112.

% Complete The percentage value that represents how complete a task is.
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Table  14. Workflow columns  (continued)

Column Description

Click the measuring bar for a task and enter a new % Complete number. The measuring bar 

expands to display a comparable level. For approval tasks, this field is read-only.

Forecast/Actual Start For tasks in the pending state, this field represents the Forecast Start date. Forecast Start dates 

display in italic font.  After you change a task from Pending to Active, this field represents the 

Actual Start date. Actual Start dates are in regular font.

Click in the cell to use a calendar to select a date and time.

Forecast/Actual End For tasks in the pending state, this field represents the Forecast End date. Forecast End dates 

display in italic font.  After you change a task from Active to Finished, this field represents the 

Actual End date. Actual End dates are in regular font. 

Click in the cell to use a calendar to select a date and time.

Forecast/Actual 

Duration

The duration of the task, in days, hours, and minutes.

If you enter both start and end dates, the system automatically calculates a value for this field (the 

Forecast/Actual End date minus the Forecast/Actual Start date).

Actual Effort The actual effort that it took to complete the task, as opposed to calendar duration. Effort is 

measured in days, hours, and minutes.

Anchored Indicates whether the task is anchored. If a lock icon displays, the dates for the task are anchored.

To specify anchored dates for a task, click the required cell in the Anchored  column, double-click 

it and select Yes. The task date cannot move even if the dates of the tasks it depends on change.

The dates considered will be the Forecast/Actual start date  and the Forecast/Actual end date. 

The value set for Anchored  does not apply for the Target start date  and the Target end date.

If a dependency is not met, the dates in conflict appear with a different icon and in a different font.

For example, suppose task 2.2 depends on task 2.1. If the Forecast/Actual end date of task 2.1 is 

after the Forecast/Actual start date of task 2.2, both the Forecast/Actual end date of 2.1 and the 

Forecast/Actual start date of 2.2 appear in red. This action occurs only if you anchored the date 

for task 2.2 by setting a value of Yes  in the Anchored  column.

Schedule Through Indicators for which dates to use when you determine task dates. The following options are 

available.
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Table  14. Workflow columns  (continued)

Column Description

• Bus. - Business days only: include only standard, non-holiday, non-weekend dates in date 

calculations that are made for this task. This schedule is the default for all tasks.

• Wkd. - Business days + Weekends: include weekends in date calculations that are made 

for this task.

• Off. - Business days + Days off: include predefined system-wide non-work time in date 

calculations that are made for this task.

• All - All calendar days: include all dates in date calculations that are made for this task. 

No dates are ignored when dates are calculated for this task.

Target Start
The targeted start date of the task. Use the calendar to select a date.

You can add a custom milestone type to set a target and forecast dates for all tasks in a workflow 

in a project template. To do this, create a milestone with code START. Then, create a project 

template. In the workflow of this template, assign one task with this milestone type. When you 

create and save a project with a target start date that uses this template, the task with the new 

milestone type copies the project start date as its own target start date as well as its forecast 

start date. These target and forecast dates are then rippled to all dependent tasks in the project.

The milestone type START  can only be assigned to one task in a workflow.

Target End The targeted end date of the task. Use the calendar to select a date.

Target Duration The duration of the task, in days, hours, and minutes. The Target End minus the Target Start 

dates.

Target Effort The targeted effort that is estimated to complete the task, as opposed to calendar duration.

Milestone Type A task milestone that you choose from a list. Example options might be Meeting, Event, and Job 

Start. System administrators set the milestone types that are on the list.

For more information about setting up milestones, see the Unica Plan  Administrator's Guide.

Member Roles A role or roles that are associated with the task. These roles can be loaded automatically from the 

project template that is used to create the project, or the project owner can set them up manually.

When an approval task has a status of In Progress, On hold, or Completed, this field is read-only.

Members The people that are associated with the task.

If a workflow task has a role in its Member Role(s)  column, when you assign people to roles, the 

workflow automatically adds a person in the corresponding Members  column.

You can also add people to the Members column manually while you edit the workflow.
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Table  14. Workflow columns  (continued)

Column Description

When an approval task has a status of In Progress, On hold, or Completed, this field is read-only.

Reviewer Roles A read-only field that shows the role or roles that are associated with an approval task.

These roles can be loaded automatically from the project template that is used to create the 

project, or the project owner can set them up manually.

Reviewer roles are used to pre-populate an approval process.

Reviewers A read-only field that shows the reviewers that are associated with an approval task. Reviewers 

are used to pre-populate an approval process.

If a workflow task has a role in its Reviewer Role(s)  column, when you assign people to roles the 

workflow automatically adds a person in the corresponding Reviewer  column.

Enforce Dep. If this task depends on other tasks, determines how strictly the system interprets dependencies. 

When this option is selected, the system restricts project members from updating this task until 

the tasks it depends on are finished.

Required Indicates whether this task is required. Required tasks cannot be skipped or deleted and their 

names cannot be changed.

Task Code A read-only code that identifies each task uniquely within a project. System integrators use this 

code to implement custom business logic for tasks.

Notes Any comments about the task.

Filling data into a range of cells
To reduce data entry time, you can copy data that is entered for one or more tasks and supply it for another task or tasks by 

using Tools  options.

About this task

For example, you have 10 consecutive tasks with the same values for target start, target end, target duration, and target 

effort. You enter the data for the first task. To copy the values that are in the first row into the remaining nine rows, Shift+click 

to select the cells in those four columns for all 10 tasks. Then, use the Tools  > Fill  > Fill Down  option.

You can also copy the data in one or more adjacent cells and paste it into one or more adjacent cells. See Workflow copy and 

paste  on page 97.

Note:  The options for working with a range of cells apply to adjoining cells only: use Shift+click to select the cells.

1. Open the project  that has the task values to duplicate, and click Workflow.

2. Shift+click  in the first cell, or click the cell, to select it.
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3. Move the cursor to the last cell you want to include, then Shift+click  in this cell. You can also drag the cursor to the 

destination cell to include all cells from the source cell.

Result

The range of cells you selected is highlighted.

Note:  You must select a continuous range of cells, rather than selecting multiple, disconnected cells.

4. Click Tools  and select one of the following options:

Choose from:

◦ Fill  > Fill down  - Copies the values in the top-most selected cell (or cells) to all the other selected cells, 

including the bottom-most.

◦ Fill  > Fill up  - Copies the values in the bottom-most selected cell (or cells) to all the other selected cells, 

including the top-most.

Workflow copy and paste
For efficiency, you can copy and paste most kinds of tasks in the workflow.

Note:  You cannot copy and paste form tasks in the workflow.

When you are copying and pasting tasks, note the following behavior.

• To copy, you must select a continuous range of cells by using Shift+click, or select the range of cells by selecting the 

cell and draggin the cursor to the destination cell. Click Tools  > Copy. You cannot select multiple, disconnected tasks 

by using Ctrl+click.

• To select a single cell, use Shift+click  or just click the required cell.

• If you do not insert enough blank tasks to correspond to the ones you are copying, existing task values are 

overwritten.

• To paste rows at the insertion point, you can click Tools  > Paste. To paste rows after the selected row, you must click 

Tools  > Paste row after.

• You can copy the status from one approval task and paste it in another approval task status column. You cannot 

paste the status into a standard task status column.

• Approval statuses do not copy. If you copy the status from one approval and paste it in a new row of an approval that 

is not saved, the status of the new approval is Not started.

Copying tasks on Macintosh/Safari
Copying and pasting tasks on a Safari browser is slightly different than the procedure described for Internet Explorer.

About this task

When you use the Shift  key to select multiple task rows on the Macintosh, it can be difficult to determine which rows are 

selected by their appearance. Take extra care to make sure that you know which rows you selected.
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Note:  You cannot copy form tasks on the workflow.

1. Select and copy tasks.

a. Select the task or the block of cells to copy.

b. Click Tools  > Copy.

Result

The Text To Copy  dialog appears with the information from your selection already highlighted.

c. Press Command+C  to copy all text in the dialog to your clipboard.

d. Click Continue  to close the dialog.

Result

You can now paste the information to another application or to another area on your spreadsheet.

2. Paste selected tasks.

a. Copy information from another application or from another area on your workflow.

b. In Unica Plan, select the destination row, rows, or block of cells in the workflow.

c. Click Tools  > Paste.

Result

The Text To Paste dialog appears containing an empty text box.

d. Press Command+V  to paste your clipboard information into the text box.

e. Click Continue  to paste that information into the spreadsheet at your previous selection location.

Copying data in Internet Explorer
You can copy data from a continuous group of cells to another place in the same workflow, or into the workflow for another 

project.

About this task

Note:  You cannot copy and paste form tasks in the workflow.

1. Open the project  that has the tasks to copy and click Workflow.

2. Shift+click  to select the first source cell. You can also just click the source cell. If this value is the only one that you 

are copying, skip to step 4.

3. Point to the final source cell, then press Shift+click  over this cell. Alternatively, you can drag the cursor to the 

destination cell.

Result

A range of cells you selected is highlighted.
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4. Click Tools  > Copy  to copy the selected task or tasks.

If you are pasting the tasks into the same workflow, skip to step 7.

5. If you are copying the tasks to another project workflow, go to the destination Workflow tab.

6. Optional: Insert enough blank rows below the destination to act as placeholders for the task values you are copying.

Example

For example, if you copied data from six tasks, make sure that there are six consecutive task rows available. If you do 

not create the necessary rows, existing values for tasks below the insertion point are overwritten.

7. Shift+click  the destination cells, or drag the cursor to the include the required cells.

8. From the workflow toolbar, click Tools  > Paste  to paste the values.

Results

The source data is placed in the workflow, starting from the selected destination task.

Adding roles and members to tasks
When you create a project, the workflow automatically includes member and reviewer roles for all tasks if the template you 

selected provides this information. However, you can edit workflow tasks to assign different roles.

About this task

To add roles and members to tasks, complete the following steps.

1. For your project , navigate to Workflow.

2. To select or change the member roles, double-click the Member Role  cell for the task you want to change.

3. Click Select Options  to view the list of available roles.

4. Click to select one role, or Ctrl+click  to select more roles to assign to this task.

5. To select or change specific members, double-click the Member  cell for the task you want to change.

6. Click to view the list of available members.

What to do next

Note:  For approval tasks, the Reviewer  and Reviewer Role  cells cannot be edited directly on the workflow. You select 

reviewers and reviewer roles when you start an approval process. For more information, see Starting an approval 

process from view mode  on page 112.

Roles, people, and approval tasks
You can assign an order to roles when you add them to an approval task in a workflow. This order is saved if you save the 

workflow as a template.

When you add people to the roles and then assign work, the spreadsheet lists the people alphabetically by their name. When 

you create an approval from the task, the reviewers are ordered according to their role order. However, in the To field of the 
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approval, they are still listed in alphabetical order. If more than one user is in a role, those users are sorted alphabetically by 

their name.

Example: Order of reviewers for an approval task
You can specify the order of reviewers for an approval task.

Example

Assume that your workflow has approval task 1.5 Review printed Brochure. For reviewer roles, you add roles in the following 

order.

1. Legal reviewer

2. Marketing manager

3. Content reviewer

If you save this workflow as a template, and later create a project that uses this template, this order is preserved.

Now assume that you assign people to roles as follows.

1. Legal reviewer: Nancy Chan

2. Marketing manager: Brian Doyle, Andy Proctor

3. Content reviewer: Elaine Jones, Mark Davis, Brad Johnson, Wilson Alverez

When you click task 1.5 and create the corresponding approval task, the reviewers are listed in the following order 

(alphabetically within their respective roles):

1. Nancy Chan

2. Andy Proctor

3. Brian Doyle

4. Brad Johnson

5. Elaine Jones

6. Mark Davis

7. Wilson Alverez

To list the reviewers in a different order, move them up and down within the approval task.

The My Tasks  list
Unica Plan  allows users to view the list of tasks that are assigned to them.

This list is called My Tasks. Each user sees a customized view when they select Operations  > Tasks.

On the My Tasks  list, you can see all tasks to which you are assigned, which allows you to view tasks across multiple 

projects. This feature consolidates the information that you would otherwise retrieve by navigating to each project 

individually, clicking Workflow, and searching for all tasks to which you are assigned.
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From this screen, you can perform the following actions.

• Get a summary view of all your tasks and approvals.

• Mark selected tasks as completed or skipped.

• Navigate to the Workflow tab for a task.

• Update task properties.

• Search or filter the task list by criteria you choose.

Filters on the My Tasks  page
By default, the My Tasks  page displays all of your tasks, for all projects and requests.

You can filter the list of tasks that are displayed by clicking the Actions  icon ( ) at the top of the page.

This table describes the available filters.

Table  15. Task Filters

Filter Description

All My Teams tasks Lists the tasks that are assigned to all teams of which you are a member.

All My Teams 

Unassigned Tasks

Lists the tasks that are assigned to a team of which you are a member but that are not yet 

assigned to an individual.

All Tasks Lists all tasks in the system.

My Active Tasks Lists your assigned tasks for all projects that are currently active (started but not yet completed).

My Completed Tasks Lists tasks that are assigned to you that are marked as completed.

My Future Milestones Lists tasks where all the following criteria are met.

• The task has a milestone flag specified.

• The task is assigned to you.

• The task is not completed or skipped.

My Milestones Lists all milestones in tasks that are assigned to you.

My Recent Tasks Lists all upcoming and in progress tasks that meet the following criteria.

• The task is assigned to you.

• The task is not completed or skipped.

• The task has a start or end date that falls within the past 14 days.

My Pending Approvals Lists all the approval tasks that are waiting for your response.

My Tasks Lists all assigned tasks. This list is the default view when you select Operations  > Tasks.

My Upcoming Tasks Lists tasks that are assigned to you that are scheduled to end within the next 14 days.
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Task pane
When you click a task in the My Tasks  page, its parent object opens on the left and the task pane opens on the right. The task 

pane provides shortcuts to many Unica Plan  functions, context for the task you are working on, and tools to move directly 

through the workflow.

Depending on the parent object you are working on and your permissions, you can click links in the task pane to do the 

following tasks.

• Edit project tabs.

• Add attachments.

• Read and post messages.

• Manage team members and reviewers.

• Find and replace task owners.

• Edit the workflow.

• Edit budget allocations and line items.

• Edit tracking.

• Add a child object or request.

• Link an existing program, project, or request to the parent object.

• If you are a project owner, you can change the form linked to a form task in the workflow.

The task pane also provides context while you work by showing the next task in the workflow (that you have permission to 

see) on the bottom of the task pane. You can also record effort time and write hand-off comments.

Use the following tools to move through multiple tasks and approvals directly on the task pane.

• Save the task to work on later by clicking Save for Later.

• Go to the linked form for form tasks.

• Mark the task complete by clicking Finish.

• Skip the task by clicking Skip.

Note:  You cannot Skip  or Finish  form tasks from the task pane. To finish the form task, follow the link to the form 

and complete it.

Defining a milestone for a task
You can set a milestone for a task to ensure that task is complete before the workflow proceeds.

Before you begin

Before you can define a milestone for a task:
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• You must define milestones by going to Plan Settings > List Definitions > Workflow Milestone Types.

Note:  You must have administrative privileges to define milestones.

• The Milestone Type  column must be present in the workflow layout. If it is not present, add it by clicking Add/Remove 

columns  and selecting the Milestone Type  field. You can ensure that it is present by basing the project on a template 

that uses milestones or by modifying the workflow layout.

1. Open the project and select Workflow.

2. In the Milestone Type  column, in the task row for which you want to set a milestone, double-click and select a 

milestone from the drop-down list.

Results

The milestone is now in effect for the project.

Workflow task status
Each new workflow task has a status of Pending. As project managers and participants work on tasks, they update the 

status to indicate the current progress.

You can change the status of a task when you are working in spreadsheet view mode or timeline view mode by clicking the 

task name. For more information, see Post Task Update dialog  on page 108. You can also change the status of a task: 

Click the Status  column of the task, then choose the appropriate status from the drop-down list.

Table  16. Task status

Status Description

Pending Indicates that a task is not yet in progress. When you create a task, it defaults to the 

pending state. The pending state is symbolized by a blank status field.

Active
Indicates that a task is in progress. Symbolized by the  icon. You can also type A  to 

place a task in the active state

Skipped
Indicates that a task was skipped. Symbolized by the  icon. Skipped tasks are tasks for 

which members no longer do work. Any dependencies of this task are also disregarded.

Finished
Indicates that a task is complete. Symbolized by the  icon.

Note the following relationships between the task status and the % Complete  for a task.

• If you enter 100  as the % Complete  for a task, the status is updated to Finished.

• If you enter 0  as the % Complete  for a task (if it was previously finished), the status is updated to Pending.
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• If you enter any number from 1  to 99  as the % Complete  for a task (if it was previously finished), the status is updated 

to Active.

• If you mark the status for a task as Skipped, all of the dates for the task are cleared.

Note:  Form tasks in the workflow can have only a status of Pending  or Active. To finish a form task, you must 

complete the linked form.

Approval task status

The approval process updates the status for approval tasks. When the approval process starts for an approval task, you can 

no longer edit the task on the Workflow tab.

For more information, see Starting an approval process from view mode  on page 112.

Completing multiple tasks
If you are assigned tasks for one or more projects, you can set them to complete at the same time.

About this task

To complete multiple tasks at one time, complete the following steps.

1. Open the Tasks  list page to view all of your assigned tasks.

2. Select the check box for each task you want to complete.

3. Click Complete Selected.

4. In the Complete Selected Tasks  dialog box, select one of the following options:

Choose from:

◦ Leave all dates as they are  - The tasks are marked as complete, but no end dates are modified.

◦ Set all actual end dates to now  - Each selected task is marked complete, and its actual end date field is set to 

the current date and time.

5. Click Continue  to complete the selected task or tasks or Cancel  to return to the list page without saving your 

changes.

Results

Any tasks that you selected are removed from the Tasks  list page and their status is changed to complete. Additionally, their 

end dates are set, if you selected that option.

Skipping multiple tasks
You can skip tasks when you are assigned tasks for one or more projects.

About this task
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Note:  You cannot skip form tasks in the workflow.

1. Open the Tasks  list page to view all of your assigned tasks.

2. Select the check box for each task to skip.

3. Click Skip Selected.

4. In the confirmation dialog box, click OK  to skip the selected tasks, or Cancel.

Results

Any tasks that you selected and skipped are removed from the Tasks  list page, and their status is changed to Skipped.

Skipping an approval task
You can skip an approval process from a task on the Workflow  tab.

1. Open a project that contains the approval to skip, and select Workflow.

2. In the Status  column, double click the cell containing the approval task to skip.

3. From the dropdown list, select Cancelled.

Results

The approval task is crossed out and can no longer be accessed. If necessary, you can also delete the approval.

Importing workflow templates into projects
You can import a previously saved workflow template into a new project instance.

About this task

Note:  Administrators can also import saved workflow templates into project templates so every project instance has 

the same workflow. However, administrators cannot import saved workflow templates with form tasks into project 

templates.

1. For a project instance, select Workflow.

2. Click More  > Import and save workflow.

3. Unica Plan  warns you that importing a workflow template deletes the current workflow. Click OK  to continue.

4. Use the Search  bar to locate a template, or sort the list of templates based on Name, Created date, or Last modified 

date, in ascending order or descending order, to locate the required template.

5. Select a workflow template and click Import.

Results

Unica Plan  imports the new workflow, saves it automatically, and warns you if you imported form tasks with broken links or 

approval steps with invalid users, teams or rules.

What to do next
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After importing the workflow template, you can modify the imported workflow. For more information, see Modifying 

workflows  on page 83.

Considerations for importing and exporting form tasks in workflow templates
You can save a project workflow as a template to use in other projects. You can export the template from the project and 

import it into another project. If the workflow template contains some flowchart approval, you cannot import it to a non 

Campaign project.

The following situations apply to importing a saved project workflow template into a new project instance. Administrators 

can also import workflow templates into templates for projects if the workflow template does not contain form tasks.

• When you save a project workflow as a template with a linked form task and export it, then the link to the form is 

maintained. However, the form is not exported with the workflow template.

• You can import Approver steps as part of workflow import. This saves your time to set-up approvers again at both the 

template and project instance level.

The following situations apply to importing a project workflow template into a new project.

• If you import a workflow template and the linked form is present in the new project, then the link to the form works as 

expected.

• If you import a workflow template and the linked form is not present in the new project, then the link is broken.

◦ A warning lists form tasks with broken links. The form task is shown with an icon that indicates a broken link 

( ).

◦ If you copy or clone the workflow, broken link copies as they are. The links remain broken in any copies.

◦ You can save the workflow with broken links. A user who tries to complete a task with a broken link cannot 

access the form.

If you encounter a broken link in the workflow, the project owner can open the form task pop-up and select an available form 

before assigning the form task to a team member.

Considerations for importing and exporting approvals with approval steps in workflow 
templates

• if a user does not exist - step is not created

• if a team does not exist -> step is not created

• if a team exists but with different users -> it is not checked

• if a rule refers to a form that is not part of the template -> step is not created

• if a rule refers to a user or team that does not exist -> step is not created
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• if a role does not exist it will be created in the system. There is no verification of rule having criteria on form attribute 

of type user selection.

In case some steps could not be created a warning message is shown and user can get the detail about these steps that 

were not created and can export it for reference and be able to recreate these steps manually.

Saving projects as workflow templates
You can save the data of the Workflow tab as a separate workflow template component and reuse the workflow in other 

project templates.

About this task

To save projects as workflow templates, complete the following steps:

1. For a project instance, select Workflow.

2. Click More  > Save as workflow template.

Result

The Save as workflow template  dialog appears.

3. Provide the following values:

◦ Name

◦ Task code prefix

4. Click Save.

Workflows - Classic version
The classic version of workflows is the existing version to view and modify workflows.

You can switch from one workflow version to another without any feature loss. Changes made using one version can be 

viewed using the other version too.

Workflow views
To monitor and update workflow in an ongoing project, project participants typically use the three view modes to work with 

the spreadsheet tab. Project managers also use the edit mode to set up the workflow for new projects. In edit mode, project 

managers can add stages, tasks, and approval tasks to projects that are in progress.

On the Workflow tab of a project, you can choose different ways to view scheduled tasks and to change the tasks or the 

workflow.

• Spreadsheet view mode presents granular task-related information in tabular format. Team members can enter 

status, the percentage of work that is completed, and scheduling data for individual tasks in this view mode. The 

Workflow tab displays the spreadsheet view by default, or click View  > View as a spreadsheet.

• Timeline view mode emphasizes data that is related to scheduling and presents pending, on schedule, late, and 

overdue tasks with color-coded indicators. Click View  > View as a Timeline/Gantt chart. For more information, see 

Timeline view mode  on page 113.
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• Process flowchart view mode emphasizes task dependencies and presents a visual plot of task sequence. Click View 

> View as a process flowchart. For more information, see Process flowchart view  on page 115.

• Edit mode gives you access to the workflow spreadsheet so that you can changes it. Project managers add, delete, 

and organize tasks in the workflow, and all participants supply information for the tasks. Click Edit  ( ). For more 

information, see Editing workflow spreadsheets  on page 122.

Spreadsheet view mode
When you display the Workflow  tab in spreadsheet view (the default), information about the stages and tasks in your 

workflow display in tabular format.

For information about the columns that display, see Workflow spreadsheet columns  on page 132.

In addition to viewing data for the workflow, you can update task status and scheduling information and add attachments. 

For more information, see Post Task Update dialog  on page 108 or Starting an approval process from view mode  on 

page 112.

To customize the spreadsheet view, click Layout  ( ) on the Workflow tab. You can select the columns to display 

and the width of the first (task name) column. For more information, see Spreadsheet or timeline view customization  on 

page 113.

Post Task Update dialog
To provide a quick update for a workflow task when the Workflow  tab is in spreadsheet view mode or timeline view mode, 

click the task name. The Post Task Update  dialog opens. Use this dialog as a quick alternative to editing the entire workflow, 

when you need to update a single task only. From this dialog, you can update a subset of task values, add attachments, and 

add comments.

The Post Task Update  dialog box contains the Status  and Attachments  tabs.

Different options display when you click the name of an approval task. For more information, see Starting an approval 

process from view mode  on page 112.

Note:  When you open the Post Task Update  dialog for a task, the system locks the task to prevent anyone else from 

editing it. Make sure that you close this dialog by clicking either Save and Return  or Cancel. Otherwise, the task can 

remain locked and no one else can edit it.

Task status tab

The Status  tab contains the following fields.
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Table  17. Fields on the Status tab

Field Description

Owners
Display only. The task owner or owners. At the task level, project  members are identified as task 

owners.

To change the task owners, you use workflow spreadsheet edit mode. In the Members  column, 

add people to a task.

Target DatesActual 

Dates

Display only. Calculated start and end dates and duration for the task. To update these values, 

change the values in the date and time fields.

Status The status of the task. Select a value from the supplied list.

Enable attachments Project owners and the administrators who design workflow templates can indicate whether 

members can add attachments for the task.

% Complete
Progress for the task. Enter a whole number 0 - 100.

Note:  To change the state of a task marked as finished back to active, you must change 

the status to Pending  and the % Complete  to a number less than 100. If you do not 

change both values, the task remains marked as completed after you save.

Actual Effort The time that is spent on the task. Click the field to enter a value in days, hours, and minutes, for 

example, 03D-02H-00M.

Forecast /ActualTarget 

date and time

The begin and end dates and times for the task.

Unica Plan  calculates these dates for your task based on the status if you do not enter a start 

date, end date, or both

When you start a task (change the status from Pending  or empty to Active), and save:

• If the start and end date are empty, then the start date is set to the current date and time. 

The end date is set to the current date time plus duration.

• If the start date is set, but the end date is not set, the end date is set to the start date plus 

duration.

• If the end date is set, but the start date is not set, the start date is set to the end date 

minus duration.

When you complete a task (change status from Pending  or empty to Finish), and save:

• If the start and end date are empty, then the end date is set to current date and time. The 

start date is set to the end date minus duration.

• If the start date is set, but the end date is not set:
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Table  17. Fields on the Status tab  (continued)

Field Description

◦ If the start date is set prior to the current date, then the end date is set to the 

current date and the duration is set to the end date minus the start date.

◦ If the start date is set later than the current date, then the end date is set to the 

current date and the start date is set to the end date minus duration.

• If the end date is set, but the start date is not set, the start date is set to the end date 

minus duration.

When you change a task to pending, and save:

• If the start and end dates are empty, those dates are kept empty.

• If the start date is set but the end date is not set, then the end date is set to the current 

time plus duration.

• If the end date is set but the start date is not set, then the start date is set to the end date 

minus duration.

Comments for revision 

history

Enter notes to include in the revision history of the project and in any notifications that are sent 

about the task.

Workflow Notes Enter notes to display with the task in spreadsheet view or edit mode.

Task attachments tab

The Attachments  tab contains the following fields.

Note:  Only the owner of a task can add an attachment. You can identify member roles and members for tasks in edit 

mode.

Table  18. Fields on the Attachments tab

Item Description

Attachments
The top of the page lists current task attachments. The following information displays for each 

attachment:

• The attachment name, which is a link to the attachment.

• The file type and size.

• A description, including the date and time the attachment was added, the name of the 

person who added it, and any additional comments.

• Links for removing attachments  or for sending the attachment by email.
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Table  18. Fields on the Attachments tab  (continued)

Item Description

File to Attach Select the source of the file to attach.

Browse Click to browse your computer or the asset libraries for the file to attach. Supported file formats 

include DOC, PPT, XLS, PDF, GIF, JPEG, PNG, and MPP.

Comments Enter text to describe the attachment.

Save Attachment Click to attach the selected file or URL.

Adding an attachment to a task
To add attachments for a task, a project owner must enable adding attachments for the task. New attachments are added to 

the Attachments  tab for the task.

Before you begin

The following users can add or remove task attachments.

• Task owners can add attachments only to their tasks.

• Task owners and users with the Delete Attachment security permission for projects can delete task attachments.

About this task

Adding attachments to tasks is similar to adding attachments to other objects (such as programs). However, note the 

following behavior that is specific for adding attachments to tasks.

Note the following restrictions:

• You cannot use markup on task attachments

• There is no versioning for task attachments: uploading a new version overwrites the existing version of the 

attachment.

• It is possible to have multiple task attachments with the same name for the same task. This situation can occur if 

multiple owners of the task each upload a file with the same name. You can differentiate the files by the user who 

created the attachment.

• You can add and remove attachments no matter the state of the task. That is, even if a task is marked complete or 

skipped, you can still add and remove attachments.

• The Attachments tab for a project  is divided into two sections: one for files that are attached directly to the project, 

and one for files that are attached to the tasks.

• If a task owner adds task attachments, and later the project  owner sets the Enable Task Attachment  flag to false, 

attachments can no longer be added or removed from the Post Task Update  dialog. However, task attachments for 

the project  can still be removed from the Attachments tab.
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1. Navigate to the task to which you would like to add an attachment.

Click the task from a project workflow or from the Tasks list page.

Result

The Post Task Update  dialog box opens.

2. Click the Attachments  tab.

Result

The tab displays any attachments that exist for the task.

3. In the File to Attach  field, select From My Computer, From the Asset Library, or URL.

4. Complete one of the following actions:

Choose from:

◦ Click Browse  to attach a file that is on your computer. When the dialog box appears, navigate to the file you 

want to attach and click Open.

◦ Click Browse Library  to attach a file in an asset library. Click the library that contains the file you want to add. 

Use the tree in the left pane of the screen to navigate to the folder and then the asset that you want to attach. 

Click Accept Asset  when you view the asset in the right pane.

◦ Enter the URL in the field provided.

5. Add any comments about the attachment.

6. Click Add More  to display an extra set of fields for each additional attachment you want to add.

7. After you add all your attachments, click Save and Return  to close the dialog box.

Starting an approval process from view mode
When the Workflow  tab is in spreadsheet or timeline view mode, you can supply the approvers and target due date for an 

approval task and start the approval process.

About this task

For more information about the approval process, see Approvals  on page 13.

Note:  When the approval process is in progress for an approval task, the approval task is locked. Project managers 

cannot change information for the task with spreadsheet edit mode.

1. Navigate to the Workflow  tab of the project that contains the approval task.

2. In spreadsheet or timeline view mode, click the name of an approval task.

Result

The Start Approval  dialog opens. In this dialog, you can do any of the following actions:

◦ Add or remove owners.

◦ Add or remove approvers.

◦ Specify a target due date.

◦ Select the reapproval rule.

◦ Attach items or flowchart to approve.
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3. Complete the details for the approval process.

4. Do any of the following actions to complete the process:

Choose from:

◦ To save the approval process with the status of In Progress, click Send Approval. The approval task also 

displays as In Progress.

◦ To save the approval process with the status of Not Started, click Save for Later. The approval task also 

displays as Not Started. To start the approval process, you must edit the approval not the workflow task.

◦ To discard your changes, click Cancel. No approval process is created.

Timeline view mode
When you view the workflow on a timeline, you can update the task status and scheduling information and add attachments.

The Workflow tab timeline view presents a view of the tasks for a project  over a period of weeks or months. To display tasks 

on a timeline, click View  > View as a Timeline/Gantt chart  Timeline View .

For more information, see Post Task Update dialog  on page 108 or Starting an approval process from view mode  on 

page 112.

To customize the timeline view, click Layout  ( ) on the Workflow  tab. You can customize the timeline view in any of 

the following ways:

• Choose weeks or months as the time scale.

• Select the dates to plot: Actual/Forecast or Target.

• Select captions for timeline bars.

For more information, see Spreadsheet or timeline view customization  on page 113.

Spreadsheet or timeline view customization
When you view the Workflow  tab in spreadsheet view mode or timeline view mode, you can make choices about the 

information that you want to see.

To customize the view, click Layout  ( ).

Options on the Project Workflow Tab Layout dialog

The Project Workflow Tab Layout  dialog displays the following options:

Table  19. Options on the Project Workflow Tab Layout dialog

Option Description

Spreadsheet Layout To hide the options in the Spreadsheet Layout section on this dialog, click the icon next to the 

section title. To view a hidden section, click again.
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Table  19. Options on the Project Workflow Tab Layout dialog  (continued)

Option Description

Columns to Display
A list of check boxes that corresponds to the columns you can include in spreadsheet view mode. 

Click a link above the list to select a preset group of columns to display:

• all: default setting; all boxes checked (all columns display).

• targets: hides Status, % Complete, and Actual date columns.

• actuals: hides Target Dates/Effort and Member/Reviewer roles columns.

• all dates: displays all columns that are related to target and actual dates.

• responsibility: displays columns that are related to who is assigned to complete the tasks.

Alternatively, you can check individual columns to include them or clear columns to remove them.

First Column Width Defines the width for the first column, which displays task names and dependencies. You can set 

a different first column width for spreadsheet view mode and for timeline view mode. Select:

• Remember Last Setting: When you view the workflow spreadsheet, you can adjust the first 

column width to see more or less of the task names.

• Exactly: Select to enter a number that sets the column to an exact width in pixels.

Timeline Layout To hide the options in the Timeline Layout  section, click the icon next to the section title. To view 

a hidden section, click again.

Time Scale The increment of time that is used for measurement. Select Weeks  or Months. The default setting 

is Weeks.

Bars Represent The bars in the timeline view indicate durations. You can choose to display Actual/Forecast dates, 

Target dates, or both. The default is to display both.

Bar Captions By default, the bars do not have captions. Select an option to display task information as bar 

captions. For example, you can have task names or milestone types display as the captions.

First Column Width Defines the width for the first column, which displays task names and dependencies. You can set 

a different first column width for spreadsheet view mode and for timeline view mode. Select:

• Remember Last Setting: When you view the workflow spreadsheet, you can adjust the first 

column width to see more or less of the task names.

• Exactly: Select to enter a number that sets the column to an exact width in pixels.

Make these the default 

settings for this project 

workflow tab

Check this box to make your selections the default for the Workflow  tab. This option ensures that 

your display settings for this tab do not change until you make another change and check this 

box.
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Table  19. Options on the Project Workflow Tab Layout dialog  (continued)

Option Description

Note:  Your settings become the defaults for all users for this workflow, until someone 

changes the defaults.

Use these settings for 

current workflow only
Check this box to apply your selections to the current workflow only. This option ensures that your 

display settings for this workflow do not change until you make another change and check this 

box.

Clear this box to make your selections the default for the Workflow  tab. Your settings become the 

defaults for all users for this workflow until someone changes the defaults.

Setting the first column width
You can change the width of the first column in the workflow spreadsheet view and keep this setting for your entire session.

About this task

To set the first column width, complete the following steps.

1. Navigate to the Workflow  tab of the project.

2. Use the column width control to resize the first column to your preferred width.

3. Click Layout  in the upper right section of the screen.

4. In the Project Workflow Tab LayoutInstance Workflow Tab Layout  dialog, complete the following steps:

a. In the First Column Width  section, select Remember Last Setting.

b. At the bottom of the dialog, check the Make these the default settings for this project's workflow tab  box.

5. Click Apply and Close  to save your changes and close the dialog.

Results

The first column width is now set for this project for the remainder of your session.

Process flowchart view
The process flowchart view displays the tasks in a network diagram style.

• Each task is displayed as a box with a task number and ID.

• Tasks that have dependencies are connected to any tasks they depend on.

• Sequential tasks are displayed on the same line.

• Parallel tasks are displayed on different lines.

• Independent and orphan tasks are displayed on their own line, with no connections.
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Workflow concepts
Workflows organize the tasks, approval tasks, stages, and milestones for each project. Workflows measure the time that is 

spent on each part of the project and the people who are assigned to work on it.

Tasks

Tasks are steps in the workflow where a user or the system  acts. The task is not complete until the action is complete.

Form tasks

Form tasks are steps in the workflow where a user must complete a specific form. After the user completes the form, the 

task is complete.

Each form task requires the user to complete one specific form on a custom tab in the template. Use multiple form tasks to 

instruct users to complete multiple forms. You cannot use form tasks to complete custom forms on the summary tab.

After users complete the form, they can submit the form for approval.

Approval tasks

You include approval tasks in a workflow to indicate that an approval process must take place. On the Workflow tab, you 

can start the approval process for an approval task. When the approval process is in progress, the Workflow tab organizes 

information about that process, but you can no longer edit the approval task.

Flowchart approval

In an Unica Plan/Unica Campaign  integrated setup, you can now create a flowchart approval and attach a flowchart to it. 

When a flowchart is run, the following points are checked:

1. If no approval exists for a particular flowchart, it should be executed successfully.

2. If one or more approvals exist, the flowchart will be allowed to run only if all the approvals are approved and in 

completed/canceled state else it should not run.

Note:

1. One flowchart can have several approvals.

2. One flowchart approval can have only one flowchart.

Stages

You can group tasks together under headings called stages. Stages can help you with task organization. For example, you 

can create a stage that has all tasks your field marketers-specific  users  do. In spreadsheet view mode or edit mode, stages 

are the headings in bold that group the tasks together.
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Milestones

You can identify workflow tasks as milestones for your project. Example milestones include Job Start, Meeting, and Event.

Dates

Workflows contain the following types of dates.

• Forecast/Actual dates  begin as forecast dates: future dates when a task owner plans on starting and completing a 

task. These dates are specified while the task is still pending. When a team member a starts and completes a task, 

the same dates can be used or different dates that are supplied as the actual dates.

Actual  dates specify when tasks start and finish.

• Target dates  are dates that are used to plan the project  schedule. Typically, they are set at the beginning of the 

project.

• Anchored dates  are fixed dates that cannot change, even if the dates of the tasks, upon which they are dependent, 

change. You can set Anchored dates  only for Forecast/Actual dates  and not the Target dates.

• Non-work time  represents dates when people do not work, so the system skips those dates when it calculates 

durations for tasks. Unica Plan  currently supports system-wide non-work time that applies to all tasks. It is up to the 

project manager  to determine whether overriding any of these dates is necessary. System administrators enter and 

maintain these dates.

• Weekend dates  are dates that you use to specify work that occurs on a weekend on a per-task basis. You can 

schedule work on a weekend date by using the Schedule Through option for each task.

Duration

Duration is the actual number of days that are assigned to a task. When you assign start and end dates, the system 

automatically calculates the difference between the forecast or actual start date, and the forecast or actual end date for a 

task. The actual number of days between the start and end dates equals the duration of the task.

You can assign duration by using any non-negative number. For example, you can use 0.25 to assign a quarter of a day for 

the task duration.

Duration is the actual number of days that are assigned to a task. The duration control is in a DD-HH-MM  format. You can 

enter up to 999 days value for the DD  field, your applicable business hours that are based on the beginningOfDay and 

numberOfHoursPerDay configuration settings for the HH  field, and a value in 30-minute intervals for the MM  field.

Effort

The work effort in days (as opposed to duration) that it takes a user to complete a task. For example, a task takes three 

calendar days to complete, but the task owner spends only half a day on the task for each of the three days. In this case, the 

effort for the task is one and a half days even though the duration is three days.
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Locked tasks

When you edit a task, the task is locked so no other user can edit it at the same time. Additionally, when someone creates an 

approval process from an approval task, the approval task becomes locked permanently.

If anyone attempts to edit a locked task, they receive a warning message, indicating that it is in use.

People and roles

You can assign tasks to individual team members or you can assign tasks to all team members in each role. When you 

assign a task to one or more team members, they are considered to be task owners. You assign roles to team members on 

the People tab of the project.

Workflows use the following concepts to identify people in the workflow.

• Task owners  are the people responsible for running or managing workflow tasks.

• Reviewers  are responsible for approval tasks. These members become the approvers of the task.

• Roles  are used as a bridge between tasks and people. They are useful for assigning work on a generic basis. For 

example, each type of project you create can have its own workflow template, and the template can contain standard 

roles for certain tasks. Then, when you create a project, some (or all) of the tasks have a default role that is already 

associated with them.

Note:  Each workflow might contain users from different timezones. You chose whether Unica Plan  displays the 

timezone after the time stamps on the workflow and workflow columns. For more information, see Calendar display 

options  on page 191.

Schedules
There are two options for scheduling in workflows: baseline and up-to-date.

Baseline scheduling

You use baseline scheduling when you want to compare actual dates to fixed target dates. With baseline scheduling, you 

never change the target dates, allowing them to serve as a baseline. Users who are assigned tasks receive reminders on 

completing the actual/forecast  dates.

While you work with a baseline schedule, the owner of the project sets the initial Target Start and End dates for each task. 

These dates stay fixed throughout the entire workflow. As the project progresses, the owner can update the actual/forecast 

dates with real data based on status information received from team members.

Up-to-date scheduling

You use up-to-date scheduling when you want to use actual dates to update the official schedule (defined by the Target Start 

and End dates) regularly. This mode enables project managers to capture the most up-to-date, official schedule; however, it 

does not provide an easy way of viewing a baseline version of the schedule.
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Using a baseline schedule
System administrators set up permissions and reminders for baseline schedules. Schedule owners set the dates for each 

task in the baseline schedule. Team members update the progress for their tasks in the baseline schedule.

Before you begin

Before you create your projects, have the system administrator set up the following permissions and reminders:

• Set permissions so that only project  owners can update Target  dates.

• Set reminders (alerts) that are based on the Actual/Forecast  dates.

About this task

While you work with a baseline schedule, team members perform the following high-level steps.

1. The owner sets the Target Start  and End  dates for each task.

These dates stay fixed throughout the entire project.

2. As the project  progresses, team members update the Actual/Forecast  dates with real data.

Keeping an up-to-date schedule
System administrators set up permissions and reminders for schedules. Schedule owners set the dates for each task in the 

schedule. Team members update the progress for their tasks.

Before you begin

Before you create your projects, have your system administrator set up permissions and reminders as follows.

• Set permissions so that only project  owners can update Target  dates.

• Set reminders (Alerts) that are based on the Target  dates.

• Set reminders to be sent only to the owner or owners.

• Optionally, set reminders on the Actual/Forecast  dates to be sent to team members.

About this task

While you work with an up-to-date schedule, team members perform the following high-level steps.

1. The owner sets the initial Target Start  and End  dates for each task.

2. As the project  progresses, team members update the Actual/Forecast  dates with real data.

3. If a task is delayed (the owner receives reminders that are based on Target  dates), the owner assesses the situation 

and adjusts the Target  dates and durations as necessary.

Date dependency calculations
When you enter or change the date for a task, the system calculates other dates that are based on your entry. It uses an 

internal algorithm to bidirectionally calculate the dates of dependencies, starting with the cell where you entered the date.
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When you initiate date dependency calculations for a workflow, note the following issues:

• In addition to factoring in non-work days and hours, date dependency calculations use two additional system-wide 

properties: start time of day and number of hours per day. Your system administrator configures these settings.

• If a task row is anchored, the date dependency calculation does not update its dates (even if the date columns are 

empty).

• Date dependency calculations do not affect active and finished tasks; only tasks with a status of Pending.

• Date dependency calculations observe the per-task options for non-work time. The calculation algorithm takes into 

account whether a task is scheduled to progress during non-work time, weekends, or both.

• Do not log forecast  times outside of business hours if you intend to do date dependency or other automatic 

calculations afterward. That information is overwritten by the automated process.

Calculating workflow dates automatically
When you enter or change the date of a task, the system calculates other dates that are based on your entry.

About this task

To calculate workflow dates automatically, complete the following steps.

1. Enter or change the date for a task in any of the date fields.

2. Select the date and click anywhere on the screen except for another date field.

Result

The Date Dependency Calculation  icon ( ) is displayed next to the end date.

3. Click the Date Dependency Calculation  icon.

Alternatively, you can select one of the toolbar icons for recalculating dependency dates.

Results

The other dates in the workflow are updated, because of the new entry.

Calculating date dependencies above a locked task
If a workflow has a locked task, and you change the date of a task that is located above that task, you receive a warning 

when you calculate date dependencies.

About this task

To clarify this task, the procedure that follows assumes:

• Task 1.8 is locked.

• You need to change the duration of task 1.5 from five days to 10 days.

• All tasks depend on the previous task.
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1. Open the workflow for editing, and change the duration on task 1.5 from five days to 10 days.

2. Click the Date Dependency Calculation  icon ( ) next to the end date of task 1.5.

Result

The system displays a warning message, saying you cannot recalculate through the locked row.

3. Click the start date of task 1.8

4. Click the Date Dependency Calculation  icon.

Results

The system calculates the dates below the locked task.

Scheduling work time
You can use Unica Plan  to help you manage and allocate your resources effectively.

Unica Plan  offers the following settings to help manage and allocate resources:

• Specify non-work time: allows your organization to define a set of dates that, by default, are not included when the 

system calculates task dates and durations.

• Include weekends in work time: by default, weekends are not included when task dates and durations are calculated. 

However, you can override the default to schedule certain tasks through weekends.

By default, tasks do not include weekends or non-work dates when task dates and durations are calculated.

To view a list of defined non-work dates, click Non-working Business Days  from the Administration  page.

Note:  When you view the Unica Plan  calendar, any day that is specified as non-work time is indicated by a gray X in 

the background. In timeline view, non-work time appears in a gray-shaded column. Additionally, the name of the non-

work time (for example, Labor Day) displays when you point to the date.

Non-work time
You can set days on which no work is typically done by employees as non-work time in Unica Plan. Unica Plan  supports a set 

of system-wide non-work time, which is separated into user-defined types.

For example, assume that you have the following non-work dates set in Unica Plan.

Table  20. Non-work time example categories and dates

Category Dates

Corporate Holiday 1/1/2015, 7/4/2015, 12/25/2015

State Holiday 4/15/2015, 10/3/2015

Corporate Off-site 8/15/2015
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After you define non-work time, you can elect whether to schedule work on these days, for each project and its tasks.

If the active time for a task includes any non-work time, its end date is pushed out by an extra day for each of these dates. 

For example, assume 7/4/2015 is defined as non-work time. If Task 1.3 is scheduled to start on 7/3/2015, and has a duration 

of three days, its end date is 7/7/2015. Work is not scheduled for 7/4, since it is defined as non-work time.

For any task, you can choose to ignore the non-work time; if so, the workflow includes any non-work time as normal work 

days. So, if you choose to ignore non-work time for Task 1.3, its end date becomes 7/6/2015.

Weekends
For certain tasks, you might need to schedule work to proceed on weekends. For example, print shops often work 24 hours a 

day, 7 days a week. If you have tasks that go to a print shop, you can have these tasks take into account weekend days.

For example, you have a task that is called "Print Brochures at print shop." This task might start on Friday 6/15, and have a 

duration of three days. If you choose to include weekends for this task, its end date is end of business Monday, 6/18. If you 

choose not to include weekends for the task, it ends on end of business Wednesday, 6/20.

Work and non-work time settings
By using the Schedule Through  indicator on the workflow, you have many options for scheduling tasks.

You can schedule tasks in any of the following ways.

Table  21. Options for scheduling tasks

Flags Behavior

Bus. (Business)
Non-work time and weekends are excluded from task scheduling.

Note:  This option is the default setting for all tasks.

Wkd. (Weekends) The task is scheduled to include weekends, but not system-wide non-work time.

Off. (Days off) Weekends are excluded from task scheduling, but work is expected to be done during other 

non-work time.

All (All calendar days) The task is scheduled to include all days.

Note:  The Schedule Through column is a planning and targeting tool. Do not change this column after the actual 

dates and times are logged on a task. Doing so can overwrite the actual dates and times.

Editing workflow spreadsheets
When you create a project, a wizard that is based on the template you selected collects information. After you complete the 

wizard pages, you can customize the default workflow that is provided by the project  template.
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Before you begin

Before you can edit a workflow, the project must not be in the In Progress  state. If it is, you must pause it.

About this task

In addition to project templates, which can include workflow tasks and values, your installation can maintain a set of 

workflow templates. Workflow templates are template components that are independent from project templates. While a 

project is in the Not Started status, you can assess whether the workflow supplied by the project template is adequate or if a 

different workflow template provides a better starting point. For more information about workflow templates, see the Unica 

Plan  Administrator's Guide.

The ability to customize template-supplied workflows is controlled by your user permissions. If toolbar icons are unavailable 

or if values are read-only, you do not have the appropriate permissions to edit the workflow.

1. Open the new project  and click the Workflow  tab.

Result

The workflow displays as supplied by the template.

2. Click Edit  ( ).

Result

The spreadsheet displays in edit mode. For information about the options in this mode, see Edit mode toolbar  on 

page 124.

3. To replace all spreadsheet rows and values with data from a previously defined workflow template (if the project is in 

Not Started status), click Tools  > Import and save workflow.

A warning that this procedure deletes the current workflow displays. Click OK, then select a workflow template and 

click Import.

4. To change default task and stage names to reflect your specific tasks and stages, click in the cells in first column to 

make your edits. You can also change task dependencies. 

For more information about dependencies, see Task dependencies  on page 131.

5. To add rows to the spreadsheet, click Add Row  ( ) and then select Task, Form Task, Approval, Flowchart approval, 

or Stage.

Result

For more information, see Adding a stage or task  on page 128.

6. To add a stage, click the Add Stage Row  icon ( ).

7. To add a user task, click the Add Task Row  icon ( ).

8. Enter target or forecast/actual dates for the tasks, depending on how you want to use the schedule.

Example
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◦ You can enter a start date, end date, and duration for a task. If you enter any two of these values, the system 

calculates the third value automatically. For example, if you enter a target start and a target end date, the 

system calculates the duration.

◦ While the Schedule Through column indicates work days for a task, you can enter any date as a start or end 

date. For example, for a task that is not scheduled to include weekends you can still pick a Sunday as the end 

date.

9. To specify that a task is a milestone, such as a drop date, click the Milestone Type  column and select a milestone 

from the list.

Your administrator sets the milestones options in this list.

10. Select members or roles to assign the task to in the Members  and Member Roles  columns  or in the Reviewers  and 

Reviewer Roles  columns.

Result

For more information, see Adding roles and members to tasks  on page 139.

11. Make other selections and entries in the spreadsheet to reflect the workflow for your project.

12. Enter any instructions or notes about a task in the Notes  column.

13. Click Save  to save your changes.

◦ Click Save and Finish  to save your changes and return to spreadsheet view mode.

◦ Click Save and Resume  to change the status to In Progress  and return to spreadsheet view mode.

◦ Click Cancel  to undo any changes and return to view mode.

Edit mode toolbar
When you switch from a view mode to edit mode, you can change the workflow. You click the icons on the toolbar to add, 

move, and delete stages and tasks.

The following table describes the toolbar options.

Table  22. The edit toolbar for the Workflow tab

Icon Description

Add Row. To add a row after an existing row in the workflow, select the row then click this icon to 

specify the type of row. You can add:

• Task

• Form task

• Approval

• Flowchart approval

• Stage: stages organize tasks into groups

• User Task

• Flowchart Run

• List Review
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Table  22. The edit toolbar for the Workflow tab  (continued)

Icon Description

• Notify Field Marketers (Corporate Campaigns)

• Subscription (Corporate Campaigns)

• Recurrence

Unica Plan  adds the task and renumbers the subsequent tasks.

In Series. By default, the system adds rows to the spreadsheet in series, so each task depends 

on the task that precedes it. To use a different dependency option, click this icon and make a 

selection before you add the next task to the workflow.

Select a dependency option.

• No Dependencies: when you add a row, the system does not make it dependent on any 

other row

• In Series: when you add a row, the system makes it dependent on the row above it

• In Parallel: when you add a row, the system makes it dependent on the same task or tasks 

as the row above it

Each row that you add uses the same dependency option until you change your selection.

You can also change dependencies manually; click the task or stage name and supply a 

comma-separated list of numbers in parentheses. For more information, see Task dependencies 

on page 131.

Add Stage Row. Adds a stage in the spreadsheet. Tasks are grouped in stages.

Move row up. Click a task or stage name to select the row, then click this icon to move the 

selected row upward.

Note:

• When you move a row, its task dependencies do not change.

• When you move a stage, all of its associated tasks move with it.

Move row down. Click a task or stage name to select it, then click this icon to move the selected 

row downward.

Note:
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Table  22. The edit toolbar for the Workflow tab  (continued)

Icon Description

• When you move a row, its task dependencies do not change.

• When you move a stage, all of its associated tasks move with it.

Delete row. Click a task or stage name to select it, then click this icon to delete the component.

Note:

• You cannot delete the first stage in a workflow spreadsheet.

• When you delete a stage, its associated tasks are appended to the previous stage. 

The tasks are not deleted.

Recalculate Dates. Shift+click to select one or more adjacent cells in the spreadsheet, then click 

this icon to apply one of the following options:

• Preserving slack time between Tasks: recalculates all date dependencies that are based 

on your changes; any slack time between dependent tasks is not removed.

• Removing slack time between Tasks: recalculates all date dependencies that are based on 

your changes; any slack time between dependent tasks is removed.

Tools. Offers options that affect the values in specific spreadsheet cells, or that affect a column 

or the entire spreadsheet.

To apply any of the following options, you must first Shift+click to select one or more adjacent 

cells in the spreadsheet:

• Copy: copies the contents of the selected cells to the clipboard.

• Paste: pastes the contents of the clipboard, beginning at the selected cell.

• Paste Rows After: pastes the contents of the clipboard below the selected row.

• Mark as: changes the Status and % Complete values for the corresponding task or tasks. 

For example, Mark as Finished changes the Status to Finished and % Complete to 100%. 

You can mark tasks as Skipped, Finished, Active, or Pending.

• Fill Down/Up: copies the value in the selected cell or group of cells to the cells below or 

above it.

• Clear: erases all entries in the selected cell or group of cells.
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Table  22. The edit toolbar for the Workflow tab  (continued)

Icon Description

Note:  You must apply these options to cells that are adjacent; that is, Ctrl+click selections 

are not supported.

The other options on the Tools  menu function as follows:

• Import and save workflow: available if the project is in Not Started status only. Replaces 

the entire spreadsheet with the tasks and values in a previously defined workflow 

template.

• Clear Column: click a single cell, then select this option to erase all entries in that column. 

For columns that have a default value, such as Schedule Through, every cell is set to the 

default.

• Clear All: erases the entire spreadsheet.

Click to recalculate dependent dates while preserving slack time. Recalculates all date 

dependencies that are based on your changes; leaves any existing slack time between dependent 

tasks.

Click to recalculate dependent dates while removing slack time. Recalculates all date 

dependencies that are based on your changes; removes any slack time between dependent tasks.

Undo. Click to undo your last change.

Redo. Click to reapply a change you undid with the Undo action.

Save. Click this icon to select one of the following options:

• Save: Interim save, the spreadsheet remains in edit mode.

• Save and Duplicate: Saves your work and creates a project with the data supplied on all 

tabs.

• Save and Finish: Saves your work and displays spreadsheet view mode.

• Save and Return to List: Saves your work and displays the most recently selected list of 

projects and requests.

Cancel. Return to spreadsheet view mode without saving edits that are made since your last save.

Click one of the following options to complete your work:

• Cancel. Return to spreadsheet view mode without saving edits that are made since your last save.

• Save: Interim save, the spreadsheet remains in edit mode.

• Save and Finish: Saves your work and displays spreadsheet view mode.
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Adding a stage or task
To add a task or stage to a workflow, you must have the appropriate permission for the related template.

If the Add  option is missing from the toolbar, contact your administrator about obtaining the appropriate access rights.

Note the following information about stage and task rows.

• To differentiate stages from tasks, the rows for stages display in the spreadsheet with a shaded background. In 

addition, identifying icons differentiate tasks from approval tasks.

• When you add a stage or task, you can indicate where in the spreadsheet to insert it: enter the stage number and the 

task number before the task name.

For example, if you enter 2.3 Have team meeting  anywhere in the task list, the task is placed under the task that is 

labeled 2.2. Any subsequent tasks in that stage are automatically renumbered: the step that was previously labeled 

2.3 is now 2.4.

• You can move a stage or task to a different part of the spreadsheet. Use the up and down options on the toolbar to 

move the stage or task to the appropriate place.

• There are several options for managing dependencies on tasks as new rows are added and existing rows are 

removed. For more information, see Task dependencies  on page 131.

• After you create an approval from a workflow task, you can edit only the approval itself; you cannot edit the 

corresponding task in the workflow.

If you try to edit the approval from its workflow task, an error message indicates that the task row is locked. You must 

open the approval to update any of its fields.

Adding form tasks
Add form tasks to the workflow when the user needs to complete a specific form as one step in the workflow. Select one 

form to assign to each form task.

1. Decide what dependency option you want the new task or stage to use: Click In Series  ( ) and select No 

Dependencies, In Series, or In Parallel.

Your selection remains in effect until you change it again.

2. In the workflow spreadsheet, click the stage or task name that you want the new row to follow.

3. Click Add Row  ( ) and then select Form Task.

4. Select a form in the pop-up and click Ok.

Note:  You can only select one form for each form task. Your administrator populates this list on the project 

template.

What to do next



Chapter 6. Workflows

After you add form tasks to the workflow, you can configure approval tasks to send the completed forms for approval.

Adding rows to the workflow spreadsheet
Add rows to the workflow spreadsheet to add more tasks, form tasks,  approvals, and stages.

About this task

Before you can add a row to the workflow spreadsheet, you open the workflow in edit mode. For more information, see Edit 

mode toolbar  on page 124.

1. Decide what dependency option you want the new task or stage to use: Click In Series  ( ) and select No 

Dependencies, In Series, or In Parallel.

Your selection remains in effect until you change it again.

2. In the workflow spreadsheet, click the stage or task name that you want the new row to follow.

3. Add the stage, approval, flowchart approval, task, or form task: Click Add Row  ( ) and then select Task, Form Task, 

Approval, or Stage.

Unica Plan  adds the new row to the spreadsheet. Stages display with a shaded background; tasks and approvals have 

different identifying icons.

4. Add a stage or task.

◦ To add a stage, click the Add Stage Row  icon ( ).

◦ To add a user task, click the Add Task Row  icon ( ).

5. Optional: Change the dependency that is assigned by the system to the row. The numbers of the tasks that a task 

or stage depends on display in parentheses after the name. If a date for one task changes, the system changes the 

dates for all the dependent tasks.

Example

For example, suppose that you add a task and its name is 2.5 Deliver draft to vendor (2.4)2.5 Generate List (2.4). 

To make this task dependent on task 1.3 instead of task 2.4, change the task name to 2.5 Deliver draft to vendor 

(1.3)2.5 Generate List (1.3). To make this task dependent on both task 1.3 and task 2.4, separate the task numbers 

with commas: change the task name to 2.5 Deliver draft to vendor (1.3, 2.4)2.5 Generate List (1.3, 2.4).

For more information, see Task dependencies  on page 131.

6. When you finish editing the workflow, save your changes.

Results

The stage or task is added to the workflow after the insertion point.
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Adding rows below a locked approval task
When the approval process is in progress for an approval task, the approval task is locked. If a project manager clicks a 

locked approval task in spreadsheet edit mode, an error results. You might need to add another step after the approval 

process starts. To avoid this error, you add a task and then change number the system assigns to the task.

1. Decide what dependency option you want the new task or stage to use. Click In Series  ( ) and select No 

Dependencies, In Series, or In Parallel.

Your selection remains in effect until you change it again.

2. Select any row that is not locked.

Example

Select the row immediately below the locked approval task.

3. Add a stage, approval, or task. Click Add Row  ( ) and then select Task, Approval, Stage, or From Task.

4. Change the number that the system assigns to the new task or stage so that it follows the locked task. 

Example

Suppose that the locked task is 2.5 Review copy - informal (2.3). Click the name of the new task and change its 

number to 2.6. When you click in another spreadsheet cell, the system moves the new task so that it is after task 2.5.

Stage and task sequence
If you change the number for a task or stage, the task is inserted before the row that matches the new number.

For example, assume the following stage order:

1. Planning

2. Collateral Design

3. Lead Generation

4. Show Setup-to-Breakdown

5. Marketing Review

If you edit task 5, Marketing Review, changing its number to 3, the new order is as follows.

1. Planning

2. Collateral Design

3. Marketing Review

4. Lead Generation

5. Show Setup-to-Breakdown

Now suppose that you edit task 2, Collateral Design, changing its number to 4. The new order is as follows.

1. Planning

2. Marketing Review

3. Collateral Design
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4. Lead Generation

5. Show Setup-to-Breakdown

To move a task or stage to the end, give it any number higher than the final task or stage. For example, to move stage 2, 

Marketing Review to the end, change its number to 6  or higher.

Task dependencies
Unica Plan  offers different options for managing task dependencies as new rows are added to a workflow spreadsheet and 

existing rows are removed.

In spreadsheet edit mode, you click In Series  and select one of the following options:

• No Dependencies: the system does not create dependencies for new rows automatically. If you need dependencies 

for the new tasks and stages, edit the task name to add them manually.

• In Series: the system inserts new rows into an existing chain of tasks.

• In Parallel: the system inserts new rows in a dependency branch that is parallel to an existing chain of tasks.

Inserting tasks in series

Inserting In Series  makes a new task dependent on the task before it, and then makes all items that depended on that task 

dependent on the new task.

You insert a task in series when it can start only after the previous task is complete. For example, in this figure, if task X 

cannot be worked on until task B is complete, you insert task X in series.

Inserting tasks in parallel

Inserting In Parallel  makes the task dependent on the items (tasks or stages) that the task before it depended on. This 

action makes the items that are dependent on the previous task also dependent on the new task.

You insert a task in parallel when it can be worked on at the same time as another task. For example, in this figure, if task X 

can be worked on simultaneously with task B, you insert task X in parallel.
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Deleting tasks

Deleting a task removes the selected task from the chain. Then, the system relinks the two remaining segments of the chain 

together so that it is one continuous chain again.

When a task is deleted, its dependent tasks are made dependent on its dependencies before the deletion takes place. This 

practice preserves all sequential chains of dependencies.

Default and "last used" modes

To make adding a task as simple and consistent as possible, Unica Plan  provides the following behavior.

• The default mode is In Series. When you begin an editing session, this mode is used as the insertion mode.

• The "last used mode" is remembered for each editing session. When you select a different dependency mode, it is 

used each time that you add a task until you change it again or end the editing session.

• For example, to add several tasks in parallel, you need to select In Parallel  mode only one time. Then, every time you 

insert another task, the system inserts it in parallel unless you explicitly select another mode.

If needed, you can change the dependency that is assigned by the system manually. Click the task name, then edit the 

comma-separated list of task numbers that display in parentheses after the name.

Workflow spreadsheet columns
When the workflow displays in spreadsheet view mode (the default view) or in edit mode, data is presented in a spreadsheet 

of columns and rows. You review and enter information in the spreadsheet cells for each column.
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Table  23. Workflow spreadsheet columns

Column Description

Tasks, Stages Lists the tasks and stages that make up the project.

When in edit mode, click a stage or task to revise or change its sequence, name, or dependencies.

When in view mode, click a task to update status and scheduling information. For more 

information, see Post Task Update dialog  on page 108 or Starting an approval process from 

view mode  on page 112.

Status Displays an icon to indicate the status of the task. Tasks can have one of the following statuses.

• Pending

• Active

• Skipped

• Finished

Approval tasks can have one of the following statuses.

• Not Started

• In Progress

• On hold

• Completed

• Canceled

• Approved

When an approval task has a status of Not started, in edit mode you can change the status to In 

Progress or Canceled. When the approval process is in progress for an approval task, this field is 

read-only. For more information, see Starting an approval process from view mode  on page 112.

% Complete The percentage value that represents how complete a task is.

In edit mode, click the measuring bar for a task and enter a new % Complete number. The 

measuring bar expands to display a comparable level. For approval tasks, this field is read-only.

Forecast/Actual Start For tasks in the pending state, this field represents the Forecast Start date. Forecast Start dates 

display in italic font.  After you change a task from Pending to Active, this field represents the 

Actual Start date. Actual Start dates are in regular font.

In edit mode, click in the cell to use a calendar to select a date and time.

Forecast/Actual End For tasks in the pending state, this field represents the Forecast End date. Forecast End dates 

display in italic font.  After you change a task from Active to Finished, this field represents the 

Actual End date. Actual End dates are in regular font. 
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Table  23. Workflow spreadsheet columns  (continued)

Column Description

In edit mode, click in the cell to use a calendar to select a date and time.

Forecast/Actual 

Duration

The duration of the task, in days, hours, and minutes.

If you enter both start and end dates, the system automatically calculates a value for this field (the 

Forecast/Actual End date minus the Forecast/Actual Start date).

Actual Effort The actual effort that it took to complete the task, as opposed to calendar duration. Effort is 

measured in days, hours, and minutes.

Anchored Dates Indicates whether the task is anchored. If a lock icon displays, the dates for the task are anchored.

To specify anchored dates for a task, click the column, then select Anchored  from the menu. The 

task date cannot move even if the dates of the tasks it depends on change.

If a dependency is not met, the dates in conflict appear with a different icon and in a different font.

The Anchored  lock is applied to the Forecast/Actual start date  and the Forecast/Actual end date 

and not for the Target start date  and the Target end date.

For example, suppose task 2.2 depends on task 2.1. If the Forecast/Actual end date of task 2.1 is 

after the Forecast/Actual start date of task 2.2, both the Forecast/Actual end date of 2.1 and the 

Forecast/Actual start date of 2.2 appear in red. This action occurs only if you anchored the date 

for task 2.2 by selecting the lock icon in the Anchored Dates  column.

Schedule Through Indicators for which dates to use when you determine task dates. The following options are 

available.

• Bus. - Business days only: include only standard, non-holiday, non-weekend dates in date 

calculations that are made for this task. This schedule is the default for all tasks.

• Wkd. - Business days + Weekends: include weekends in date calculations that are made 

for this task.

• Off. - Business days + Days off: include predefined system-wide non-work time in date 

calculations that are made for this task.

• All - All calendar days: include all dates in date calculations that are made for this task. 

No dates are ignored when dates are calculated for this task.

Target Start
The targeted start date of the task. In edit mode, use the calendar to select a date.

You can add a custom milestone type to set a target and forecast dates for all tasks in a workflow 

in a project template. To do this, create a milestone with code START. Then, create a project 

template. In the workflow of this template, assign one task with this milestone type. When you 

create and save a project with a target start date that uses this template, the task with the new 
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Table  23. Workflow spreadsheet columns  (continued)

Column Description

milestone type copies the project start date as its own target start date as well as its forecast 

start date. These target and forecast dates are then rippled to all dependent tasks in the project.

The milestone type START  can only be assigned to one task in a workflow.

Target End The targeted end date of the task. In edit mode, use the calendar to select a date.

Target Duration The duration of the task, in days, hours, and minutes. The Target End minus the Target Start 

dates.

Target Effort The targeted effort that is estimated to complete the task, as opposed to calendar duration.

Milestone Type A task milestone that you choose from a list. Example options might be Meeting, Event, and Job 

Start. System administrators set the milestone types that are on the list.

For more information about setting up milestones, see the Unica Plan  Administrator's Guide .

Member Roles A role or roles that are associated with the task. These roles can be loaded automatically from the 

project template that is used to create the project, or the project owner can set them up manually.

When an approval task has a status of In Progress, On hold, or Completed, this field is read-only.

Members The people that are associated with the task.

If a workflow task has a role in its Member Role(s)  column, when you assign people to roles, the 

workflow automatically adds a person in the corresponding Members  column.

You can also add people to the Members column manually while you edit the workflow.

When an approval task has a status of In Progress, On hold, or Completed, this field is read-only.

Reviewer Roles A read-only field that shows the role or roles that are associated with an approval task.

These roles can be loaded automatically from the project template that is used to create the 

project, or the project owner can set them up manually.

Reviewer roles are used to pre-populate an approval process.

Reviewers A read-only field that shows the reviewers that are associated with an approval task. Reviewers 

are used to pre-populate an approval process.

If a workflow task has a role in its Reviewer Role(s)  column, when you assign people to roles the 

workflow automatically adds a person in the corresponding Reviewer  column.
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Table  23. Workflow spreadsheet columns  (continued)

Column Description

Enforce Dep. If this task depends on other tasks, determines how strictly the system interprets dependencies. 

When this option is selected, the system restricts project members from updating this task until 

the tasks it depends on are finished.

Required Indicates whether this task is required. Required tasks cannot be skipped or deleted and their 

names cannot be changed.

Task Code A read-only code that identifies each task uniquely within a project. System integrators use this 

code to implement custom business logic for tasks.

Notes Any comments about the task.

Filling data into a range of cells
To reduce data entry time, you can copy data that is entered for one or more tasks and supply it for another task or tasks by 

using Tools  options.

About this task

For example, you have 10 consecutive tasks with the same values for target start, target end, target duration, and target 

effort. You enter the data for the first task. To copy the values that are in the first row into the remaining nine rows, Shift+click 

to select the cells in those four columns for all 10 tasks. Then, use the Fill Down  option.

You can also copy the data in one or more adjacent cells and paste it into one or more adjacent cells. See Workflow copy and 

paste  on page 137.

Note:  The options for working with a range of cells apply to adjoining cells only: use Shift+click to select the cells.

1. Open the project  that has the task values to duplicate, and click the Workflow  tab.

2. Click Edit.

3. Shift+click in the first cell to select it.

4. Move the cursor to the last cell you want to include, then Shift+click in this cell.

Result

The range of cells you selected is highlighted.

Note:  You must select a continuous range of cells, rather than selecting multiple, disconnected cells.

5. Click Tools  ( ) and select one of the following options:
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Option Description

Fill Down Copies the values in the top-most selected cell (or cells) 

to all the other selected cells, including the bottom-most.

Fill Up Copies the values in the bottom-most selected cell (or 

cells) to all the other selected cells, including the top-

most.

6. Click Save.

Workflow copy and paste
For efficiency, you can copy and paste most kinds of tasks in the workflow.

Note:  You cannot copy and paste form tasks in the workflow spreadsheet.

When you are copying and pasting tasks, note the following behavior.

• To copy, you must select a continuous range of cells by using Shift+click. You cannot select multiple, disconnected 

tasks by using Ctrl+click.

• To select a single cell, you must use Shift+click.

• If you do not insert enough blank tasks to correspond to the ones you are copying, existing task values are 

overwritten.

• To paste rows at the insertion point, you can click Paste  from the Tools  menu or press Ctrl+V. To paste rows after the 

selected row, you must click Paste Rows After  from the Tools  menu.

• You can copy the status from one approval task and paste it in another approval task status column. You cannot 

paste the status into a standard task status column.

• Approval statuses do not copy. If you copy the status from one approval and paste it in a new row of an approval that 

is not saved, the status of the new approval is Not started.

Copying tasks on Macintosh/Safari
Copying and pasting tasks on a Safari browser is slightly different than the procedure described for Internet Explorer.

About this task

When you use the Shift key to select multiple task rows on the Macintosh, it can be difficult to determine which rows are 

selected by their appearance. Take extra care to make sure that you know which rows you selected.
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Note:  You cannot copy form tasks on the workflow spreadsheet.

1. Select and copy tasks.

a. Select the task, tasks, or the block of cells to copy.

b. Select Copy  from the Tools  menu or press Ctrl+C.

Result

The Text To Copy dialog appears with the information from your selection already highlighted.

c. Press Apple+C to copy all text in the dialog to your clipboard.

d. Click Continue  to close the dialog.

Result

You can now paste the information to another application or to another area on your spreadsheet.

2. Paste selected tasks.

a. Copy information from another application or from another area on your spreadsheet.

b. In Unica Plan, select the destination row, rows, or block of cells in the workflow.

c. Select Paste  from the Tools  menu or press Ctrl+V.

Result

The Text To Paste dialog appears containing an empty text box.

d. Press Apple+V to paste your clipboard information into the text box.

e. Click Continue  to paste that information into the spreadsheet at your previous selection location.

Copying data in Internet Explorer
You can copy data from a continuous group of cells to another place in the same workflow, or into the workflow for another 

project.

About this task

Note:  You cannot copy and paste form tasks in the workflow spreadsheet.

1. Open the project  that has the tasks to copy and click the Workflow  tab.

2. Click Edit.

3. Shift+click to select the first source cell. If this value is the only one that you are copying, skip to step 5.

4. Point to the final source cell, then press Shift+click over this cell.

Result

A range of cells you selected is highlighted.

5. From the workflow toolbarTools  menu, select Copy  to copy the selected task or tasks.
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If you are pasting the tasks into the same workflow, skip to step 7.

6. If you are copying the tasks to another project workflow, go to the destination Workflow tab, and open it for editing.

7. Optional: Insert enough blank rows below the destination to act as placeholders for the task values you are copying.

Example

For example, if you copied data from six tasks, make sure that there are six consecutive task rows available. If you do 

not create the necessary rows, existing values for tasks below the insertion point are overwritten.

8. Shift+click the destination cells.

9. From the workflow toolbar, select Paste  from the Tools  menu item to paste the values.

Results

The source data is placed in the workflow, starting from the selected destination task.

Adding roles and members to tasks
When you create a project, the workflow automatically includes member and reviewer roles for all tasks if the template you 

selected provides this information. However, you can edit workflow tasks to assign different roles.

About this task

To add roles and members to tasks, complete the following steps.

1. Navigate to the Workflow  tab of your project.

2. Click Edit  ( ).

3. To select or change the member roles, click in the Member Role  cell for the task you want to change.

4. Click the turndown icon ( ) to view the list of available roles.

5. Click to select one role, or Ctrl+click to select more roles to assign to this task.

6. To select or change specific members, click in the Member  cell for the task you want to change.

7. Click the turndown icon to view the list of available members.

8. Save your work.

What to do next

If you have the "View people tab" and the "Edit team members and roles" permissions, you can select any users or roles, even 

if they were not included on the People  tab. When you add a user to the project workflow, the system adds the user to the 

People  tab automatically.
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Note:  For approval tasks, the Reviewer  and Reviewer Role  cells cannot be edited directly on the workflow 

spreadsheet. You select reviewers and reviewer roles when you start an approval process. For more information, see 

Starting an approval process from view mode  on page 112.

Roles, people, and approval tasks
You can assign an order to roles when you add them to an approval task in a workflow. This order is saved if you save the 

workflow as a template.

When you add people to the roles and then assign work, the spreadsheet lists the people alphabetically by their name. When 

you create an approval from the task, the reviewers are ordered according to their role order. However, in the To field of the 

approval, they are still listed in alphabetical order. If more than one user is in a role, those users are sorted alphabetically by 

their name.

Example: Order of reviewers for an approval task
You can specify the order of reviewers for an approval task.

Example

Assume that your workflow has approval task 1.5 Review printed Brochure. For reviewer roles, you add roles in the following 

order.

1. Legal reviewer

2. Marketing manager

3. Content reviewer

If you save this workflow as a template, and later create a project that uses this template, this order is preserved.

Now assume that you assign people to roles as follows.

1. Legal reviewer: Nancy Chan

2. Marketing manager: Brian Doyle, Andy Proctor

3. Content reviewer: Elaine Jones, Mark Davis, Brad Johnson, Wilson Alverez

When you click task 1.5 and create the corresponding approval task, the reviewers are listed in the following order 

(alphabetically within their respective roles):

1. Nancy Chan

2. Andy Proctor

3. Brian Doyle

4. Brad Johnson

5. Elaine Jones

6. Mark Davis

7. Wilson Alverez
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To list the reviewers in a different order, move them up and down within the approval task.

The My Tasks  list
Unica Plan  allows users to view the list of tasks that are assigned to them.

This list is called My Tasks. Each user sees a customized view when they select Operations  > Tasks.

On the My Tasks  list, you can see all tasks to which you are assigned, which allows you to view tasks across multiple 

projects. This feature consolidates the information that you would otherwise retrieve by navigating to each project 

individually, clicking its Workflow  tab, and searching for all tasks to which you are assigned.

From this screen, you can perform the following actions.

• Get a summary view of all your tasks and approvals.

• Mark selected tasks as completed or skipped.

• Navigate to the Workflow tab for a task.

• Update task properties.

• Search or filter the task list by criteria you choose.

Filters on the My Tasks  page
By default, the My Tasks  page displays all of your tasks, for all projects and requests.

You can filter the list of tasks that are displayed by clicking the Actions  icon ( ) at the top of the page.

This table describes the available filters.

Table  24. Task Filters

Filter Description

All My Teams tasks Lists the tasks that are assigned to all teams of which you are a member.

All My Teams 

Unassigned Tasks

Lists the tasks that are assigned to a team of which you are a member but that are not yet 

assigned to an individual.

All Tasks Lists all tasks in the system.

My Active Tasks Lists your assigned tasks for all projects that are currently active (started but not yet completed).

My Completed Tasks Lists tasks that are assigned to you that are marked as completed.

My Future Milestones Lists tasks where all the following criteria are met.

• The task has a milestone flag specified.

• The task is assigned to you.

• The task is not completed or skipped.

My Milestones Lists all milestones in tasks that are assigned to you.
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Table  24. Task Filters  (continued)

Filter Description

My Recent Tasks Lists all upcoming and in progress tasks that meet the following criteria.

• The task is assigned to you.

• The task is not completed or skipped.

• The task has a start or end date that falls within the past 14 days.

My Pending Approvals Lists all the approval tasks that are waiting for your response.

My Tasks Lists all assigned tasks. This list is the default view when you select Operations  > Tasks.

My Upcoming Tasks Lists tasks that are assigned to you that are scheduled to end within the next 14 days.

Task pane
When you click a task in the My Tasks  page, its parent object opens on the left and the task pane opens on the right. The task 

pane provides shortcuts to many Unica Plan  functions, context for the task you are working on, and tools to move directly 

through the workflow.

Depending on the parent object you are working on and your permissions, you can click links in the task pane to do the 

following tasks.

• Edit project tabs.

• Add attachments.

• Read and post messages.

• Manage team members and reviewers.

• Find and replace task owners.

• Edit the workflow.

• Edit budget allocations and line items.

• Edit tracking.

• Add a child object or request.

• Link an existing program, project, or request to the parent object.

• If you are a project owner, you can change the form linked to a form task in the workflow.

The task pane also provides context while you work by showing the next task in the workflow (that you have permission to 

see) on the bottom of the task pane. If you do not have permission to edit it, the task is in view mode. You can also record 

effort time and write hand-off comments.

Use the following tools to move through multiple tasks and approvals directly on the task pane.

• Save the task to work on later by clicking Save for Later.

• Go to the linked form for form tasks.
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• Mark the task complete by clicking Finish.

• Skip the task by clicking Skip.

Note:  You cannot Skip  or Finish  form tasks from the task pane. To finish the form task, follow the link to the form 

and complete it.

Defining a milestone for a task
You can set a milestone for a task to ensure that task is complete before the workflow proceeds.

Before you begin

Before you can define a milestone for a task:

• You must define milestones by going to Plan Settings > List Definitions > Workflow Milestone Types.

Note:  You must have administrative privileges to define milestones.

• The Milestone Type  column must be present in the workflow layout. You can ensure that it is present by basing the 

project on a template that uses milestones or by editing the workflow layout.

1. Open the project, then open the Workflow tab.

2. If necessary, change the layout of the spreadsheet view to show the Milestone Type  column.

3. Click Edit  to make the workflow spreadsheet editable.

4. In the Milestone Type  column, in the task row for which you want to set a milestone, select a milestone from the 

drop-down list.

5. Click Save  or Save and Finish  to save the milestone you set.

Results

The milestone is now in effect for the project.

Workflow task status
Each new workflow task has a status of Pending. As project managers and participants work on tasks, they update the 

status to indicate the current progress.

You can change the status of a task when you are working in spreadsheet view mode or timeline view mode by clicking the 

task name. For more information, see Post Task Update dialog  on page 108. You can also change the status of a task 

when you are in edit mode: Click the Status  column of the task, then choose the appropriate status from the drop-down list.

143



Unica Plan V12.1.7 User's Guide

144

Table  25. Task status

Status Description

Pending Indicates that a task is not yet in progress. When you create a task, it defaults to the 

pending state. The pending state is symbolized by a blank status field.

Active
Indicates that a task is in progress. Symbolized by the  icon. You can also type A  to 

place a task in the active state

Skipped
Indicates that a task was skipped. Symbolized by the  icon. Skipped tasks are tasks 

for which members no longer do work. Any dependencies of this task are also disregarded. 

You can also type S  to place a task in the skipped state.

Finished
Indicates that a task is complete. Symbolized by the  icon. You can also type F  to 

place a task in the finished state.

Note the following relationships between the task status and the % Complete  for a task.

• If you enter 100  as the % Complete  for a task, the status is updated to Finished.

• If you enter 0  as the % Complete  for a task (if it was previously finished), the status is updated to Pending.

• If you enter any number from 1  to 99  as the % Complete  for a task (if it was previously finished), the status is updated 

to Active.

• If you mark the status for a task as Skipped, all of the dates for the task are cleared. Until you click Save  (or Save and 

Finish), you can retrieve the dates by canceling the editing session. However, after you save the spreadsheet with the 

dates cleared you cannot retrieve them.

Note:  Form tasks in the workflow can have only a status of Pending  or Active. To finish a form task, you must 

complete the linked form.

Approval task status

The approval process updates the status for approval tasks. When the approval process starts for an approval task, you can 

no longer edit the task on the Workflow tab.

For more information, see Starting an approval process from view mode  on page 112.

Completing multiple tasks
If you are assigned tasks for one or more projects, you can set them to complete at the same time.

About this task

To complete multiple tasks at one time, complete the following steps.
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1. Open the Tasks  list page to view all of your assigned tasks.

2. Select the check box for each task you want to complete.

3. Click Complete Selected.

4. In the Complete Selected Tasks  dialog box, select one of the following options:

Choose from:

◦ Leave all dates as they are  - The tasks are marked as complete, but no end dates are modified.

◦ Set all actual end dates to now  - Each selected task is marked complete, and its actual end date field is set to 

the current date and time.

5. Click Continue  to complete the selected task or tasks or Cancel  to return to the list page without saving your 

changes.

Results

Any tasks that you selected are removed from the Tasks  list page and their status is changed to complete. Additionally, their 

end dates are set, if you selected that option.

Skipping multiple tasks
You can skip tasks when you are assigned tasks for one or more projects.

About this task

Note:  You cannot skip form tasks in the workflow.

1. Open the Tasks  list page to view all of your assigned tasks.

2. Select the check box for each task to skip.

3. Click Skip Selected.

4. In the confirmation dialog box, click OK  to skip the selected tasks, or Cancel.

Results

Any tasks that you selected and skipped are removed from the Tasks  list page, and their status is changed to Skipped.

Skipping an approval task
You can skip an approval process from a task on the Workflow  tab.

About this task

Note:  You cannot skip form tasks in the workflow.

1. Go to the Workflow  tab of the project that contains the approval to skip.

2. Click the name of the approval task to skip.

Result

The Approval  dialog appears.
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3. Click Status  > Cancel Review.

4. Close the dialog.

Results

The approval task is crossed out and can no longer be accessed. If necessary, you can also delete the approval.

Importing workflow templates into projects
You can import a previously saved workflow template into a new project instance.

About this task

Note:  Administrators can also import saved workflow templates into project templates so every project instance has 

the same workflow. However, administrators cannot import saved workflow templates with form tasks into project 

templates.

1. Open Workflow tab of the project instance.

2. Click Edit  ( ).

3. In Edit mode, click Tools  ( ) and select Import workflow and save  from the menu.

4. Unica Plan  warns you that importing a workflow template deletes the current workflow. Click OK  to continue.

5. Select a workflow template and click Import.

Results

Unica Plan  imports the new workflow, saves it automatically, and warns you if you imported form tasks with broken links or 

approval steps with invalid users, teams or rules.

What to do next

Click Edit  ( ) to modify the workflow you imported.

Considerations for importing and exporting form tasks in workflow templates
You can save a project workflow as a template to use in other projects. You can export the template from the project and 

import it into another project. If the workflow template contains some flowchart approval and you cannot import it in an non 

Campaign project.

The following situations apply to importing a saved project workflow template into a new project instance. Administrators 

can also import workflow templates into templates for projects if the workflow template does not contain form tasks.

• When you save a project workflow as a template with a linked form task and export it, then the link to the form is 

maintained. However, the form is not exported with the workflow template.

• You can import Approver steps as part of workflow import. This saves your time to set-up approvers again at both the 

template and project instance level.
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The following situations apply to importing a project workflow template into a new project.

• If you import a workflow template and the linked form is present in the new project, then the link to the form works as 

expected.

• If you import a workflow template and the linked form is not present in the new project, then the link is broken.

◦ A warning lists form tasks with broken links. The form task is shown with an icon that indicates a broken link 

( ).

◦ If you copy or clone the workflow, broken link copies as they are. The links remain broken in any copies.

◦ You can save the workflow with broken links. A user who tries to complete a task with a broken link cannot 

access the form.

If you encounter a broken link in the workflow, the project owner can open the form task pop-up and select an available form 

before assigning the form task to a team member.

Considerations for importing and exporting approvals with approval steps in workflow 
templates

• if a user does not exist - step is not created

• if a team does not exist -> step is not created

• if a team exists but with different users -> it is not checked

• if a rule refers to a form that is not part of the template -> step is not created

• if a rule refers to a user or team that does not exist -> step is not created

• if a role does not exist it will be created in the system. There is no verification of rule having criteria on form attribute 

of type user selection.

In case some steps could not be created a warning message is shown and user can get the detail about these steps that 

were not created and can export it for reference and be able to recreate these steps manually.
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An approval process streamlines the process of having your work reviewed and approved. Multiple users can review work in 

parallel or in an order that represents your business processes.

Reviewers (or approvers) can electronically mark up content that is submitted for review. Then, Unica Plan  records approvals 

and denials for audit purposes. You can tie approvals to a project or they can exist independently from any project.

You can use some approval features on mobile devices.

Approval concepts
An approval is an item or group of items that approvers review and respond to, either by approving, suggesting changes, or 

denying. The approval process makes sure the right people view and sign off on content, creatives, and marketing objects.

The approval process is the lifecycle of an approval. It is set up by a project owner, and contains all the details about what 

to approve, who approves, and when to approve. Typically, an approval goes through four stages: it is created, submitted, 

active, and completed. The system notifies the required approvers by sending alerts and emails. The approvers can pose 

comments or questions before they decide. And when the approval is completed (either approved or denied) the approval 

owner or reviewer gets notified about the results.

Note:  You can create an approval process without any approval items, and approvers can still respond to it.

An approval owner is the person who created the approval. Normally, the owner has all of the capabilities that are associated 

with the approval, such as being able to delete it or change its status. However, this feature set can be different depending on 

the security policy that is associated with the approval.

An approver is someone who is designated to review a particular deliverable and approve or deny it. There are several ways 

an approver can be designated:

• Add the person directly to the approval process itself.

Add the person as a reviewer to the project. This procedure can auto-populate approval processes that are created 

from the workflow, depending on how your administrator set up the project templates.

A required approver is an approver who is designated as required, as opposed to optional. For an approval process to be 

marked complete, all required approvers must respond to the approval.

An approval round indicates how many times an approval is submitted. The first time an approval owner submits an 

approval, its round number is 1. The system increments the round number each time the approval is resubmitted.

From version 12.1.6, you can adjust the width of only the Name column in the Approvals listing page. This helps you view the 

complete Approval name rather than having to hover the mouse over the Approval to view the complete Approval name in the 

tooltip.



Chapter 7. Approvals

Approval Status

The following list describes the valid approval status:

• Not Started: An owner creates an approval, beginning the approval process.

• In Progress: When ready, an owner submits the approval, changing its status from Not Started to In Progress.

While the status of the approval is In Progress, approvers review it, comment on it, and respond. Additionally, if the 

approval is linked to a task in a workflow, its progress is tracked in the % Complete column.

• On Hold: An owner can temporarily stop an approval, if necessary, changing the status of the approval to On Hold.

• Canceled: An owner can cancel the approval, changing its status to Canceled.

• Completed: The owner marks the approval as finished, changing its state to Completed.

Note:  If the approval process contains multiple approval items, the overall status depends on the status of each 

approval item. For example, if an approval contains two items to approve, and an approver approves (or approves 

with changes) both the items, then the overall response is Approved. But if an approver denies one of the items, then 

the overall response is Denied, and the approval state is changed to Rejected.

Stand-alone approvals
Stand-alone approvals exist apart from any projects or other business process. They are not connected to any workflows and 

their security permissions are configured differently.

To create a stand-alone approval, select Operations  > Approvals  and click the Add Approval Process  icon ( ).

Note:  You cannot review forms in stand-alone approvals. This feature applies only to approvals in the project 

workflow.

Approval tasks
A Flowchart approval task is an approval process that is connected to a step in a workflow.

An approval that is linked to an approval task in a workflow can be updated in either the workflow or in the approval itself. 

Additionally, changes made to one are automatically propagated to the other.

If you want the approval process to be connected to an approval task in a workflow, create the process from the Workflow 

tab of the project. To add an approval task to a workflow, your security role must have the Add/Edit/Delete, Tasks/Approvals, 

Dependencies, and Targetssetting  enabled.

An approval that is created from a workflow task can have some information that is filled in already, based on the approval 

task it represents.
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Reapproval rules for form approvals
You can link forms to approvals in the workflow to send completed forms for approval. After the user completes a form task, 

the next task in the workflow can include approving the form.

When you add a form to an approval task, the following reapproval options are automatically selected.

• The repproval rule If approval is edited/resubmitted, approval is processed through all review steps  is selected 

automatically and disabled. Approvals with linked forms must use this reapproval rule.

Based on these automatic selections, the reapproval cycle for an approval process includes the following stages.

• After the requester submits the approval process, any forms linked to the approval process lock.

• The approver rules on each item in the approval process and clicks Post Complete Response. If the approver rejected 

any of the approval items, the approval process is placed On Hold and resubmitted to the requester.

• While the approval process is On Hold, the forms linked to the approval unlock so the requester can make changes. 

The forms unlock even if the approver rejected another linked item and approved the forms. In this case, the status of 

a linked form task changes from Finished  to Active.

• After the requester makes changes, they resubmit the approval. The forms lock.

• The approver receives the modified approval items and rules on them. To approve the modified approval process, the 

approver must mark the original approval process Approved and then click Post Complete Response.

• Post Complete Response  finishes the approval process.

Note:  You can only approve forms in a workflow task. If you copy an approval task with attached forms, the approval 

task becomes a stand-alone approval process and the linked forms are removed.

Configuring form approval tasks
You can use approval tasks to send forms that were completed earlier in the workflow for review.

About this task

The Allow approvers to approve with changes  is available and can be edited based on the configurations for Approvals.

1. Open the workflow where you want to add the form approval task in Edit mode.

You can add forms to workflow approval tasks only. This option is not available for stand-alone approvals.

2. Add a row to the workflow. Click Add row  and select Approval. For more information, see Adding rows to the 

workflow spreadsheet  on page 129. Click Save >> Save and finish  to exit Edit mode.

3. Double-click the approval to open it. At the bottom of the new window, click Add Item(s) to approve. Select a form 

from the list.

4. From the Add Item to approve  menu, select Plan Form.

Result

A new menu appears containing forms that are associated with the template. This menu contains only forms that 

your administrator associated with the template.

5. Click Add more  and select a form from the menu.
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Note:  You can add only one form per approval task.

6. Click Save Changes.

7. Click Send Approval  to start the approval process immediately. Otherwise, click Save for Later.

Approval dates
When you create an approval from a workflow task, the approval must include a Target Due Date.

Note the following behavior about the Forecast/Actual and Target dates for the approval:

• If the task contains a date in either the Target End Date or Forecast/Actual End Date field, the system automatically 

copies the date into the Target Due Date for the approval.

• If you modify the date in the Target Due Date field, the Forecast/Actual End Date in the corresponding workflow 

approval task is updated with the new date.

Note the following methods that Unica Plan  uses to calculate duration when the project owner enters the start and end dates 

for an approval from a workflow task.

• If the duration is less than what is specified in the approval for each approver, an equal amount of time is deducted 

from each required approver.

• If the duration is more than what is specified in the approval for each approver, an equal amount of time is added to 

each required approver.

• When an approver responds, the duration for that approver is not adjusted. The durations for the remaining approvers 

are adjusted if possible or an error message displays.

• If for any reason the duration for an approver cannot be adjusted automatically, an error message displays requesting 

different values.

• The Forecast/Actual Duration field in the workflow is overwritten with the sum of approver durations if the duration 

for an approver is changed and saved.

• Unica Plan  automatically calculates the approval start date if the Forecast/Actual duration and Forecast/Actual end 

date are changed.

Due dates for approvals
Unica Plan  determines individual due dates for approvers to complete their reviews. Due dates for approvals depend on 

whether the approver is required or optional and the approver's place in the sequence.

Approval due dates are determined differently for required reviewers than they are for optional reviewers.

• For optional reviewers, the due date is the date that the approval was submitted plus the duration that is specified for 

the reviewer. The place in the sequence does affect the due date for optional reviewers.

• Due dates for required approvers do not reserve time for optional reviewers to respond.Unica Plan  calculates due 

dates for required approvers as follows:
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  Approval submission date
+ sum of previous required approvers' durations
+ duration for this required appprover
= current approver's due date

For example:

• Three approvers are required

• Each one approves in sequence

• The duration for each approver is one day

In this case, the due date for the third approver is three days after the approval was submitted.

The durations for approvers that work in parallel (that is, they have the same sequence number in the process) is calculated 

as follows.

• The duration is counted one time; it is not summed.

• If the durations have different lengths, the longest duration is used.

Note:  When Unica Plan  calculates dates, the system-wide setting for non-work time is considered. Depending on the 

value of this setting, weekend or other non-business days can also be included in the calculation. Unica Plan  also 

accounts for each user's timezone.

Example

Approval due date calculation example

For example, consider an approval process that is configured as follows.

• Approval submission date: 25 August 2008 03:00 PM

• Target due date: 30 August 2008 05:00 PM

• Four approvers:

Table  26. Sequences and durations for example

Appr

over Sequence Duration

Requ

ired?

A 1 01D-00H-00M yes

B 2 01D-00H-00M yes

C 2 01D-00H-00M yes

D 3 01D-00H-00M yes

The due dates for the approvers are as follows:
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• Approver A: 26 August 2008 03:00 PM

• Approver B: 27 August 2008 03:00 PM

• Approver C: 27 August 2008 03:00 PM

• Approver D: 28 August 2008 03:00 PM

Example

Different approver durations example

Unica Plan  can give different approvers different amounts of time to complete their review. For example, change the duration 

of time that is given to Approver C in the previous example to two days.

Table  27. Sequences and durations for example 

2

Appr

over Sequence Duration

Requ

ired?

A 1 01D-00H-00M yes

B 2 01D-00H-00M yes

C 2 02D-00H-00M yes

D 3 01D-00H-00M yes

If the duration for Approver C is two days, then the due date is 28 August; the due date for Approver D is 29 August. There are 

now three days between Approvers A and D.

• Approver A: 26 August 2008 03:00 PM

• Approver B: 27 August 2008 03:00 PM

• Approver C: 28 August 2008 03:00 PM

• Approver D: 29 August 2008 03:00 PM

Approval Sequence
Approval processes can contain sequential and parallel portions for required approvers. Sequential approvers review 

one after the other; an approver with a later sequence number must wait for the previous approvers to finish. By contrast, 

approvers with the same sequence number review at the same time.

For example, suppose that the following approvers are set with the following sequence numbers.

• Mary Manager: 1

• Connie Contact: 2

• Larry Lawyer: 2

• Pablo Picasso: 2

• Charlie CFO: 3
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This approval process has sequential and parallel portions.

Mary Manager must act first. She is the only approver with sequence number 1. If any other approvers try to respond before 

Mary Manager, they receive a warning message. After Mary Manager finishes her review, Connie Contact, Larry Lawyer, and 

Pablo Picasso can start because they have sequence number 2.

Connie Contact, Larry Lawyer, and Pablo Picasso all act simultaneously, in parallel. They can review in any order. They do not 

prevent each other from approving.

After Connie Contact, Larry Lawyer, and Pablo Picasso all respond, the parallel portion of the review is completed. Now, 

Charlie CFO can begin his review because he has sequence number 3.

Note:  You cannot respond to the approval if it is not your turn. If you try to respond to the approval, you receive a 

warning message. After the required approvers ahead of you respond, Unica Plan  notifies you that you can complete 

your review.

Note:  The approval sequence applies only to required approvers. Optional approvers can complete their review in any 

order.

Rejected approvals
If a required approver denies the approval, the approval process stops and the status changes to On Hold. The approval 

owner must resubmit the approval for the approval process to continue.

If a required approver denies the approval, the approval status changes to On Hold  and no other required approvers can 

respond. For example, if the third of five required approvers denies the approval, the fourth and fifth required approvers 

cannot respond. Instead, the system sends a notice to the approval owner and approvers who completed their reviews that 

the approval status changed to On Hold.

If a required approver denies the approval, the owner must update the approval and request reapproval from the person who 

denied it. Resubmitting the approval starts a new round of review, starting with the approver who denied it. After that person 

approvers the approval process, the next required approver can respond and sequential review continues.

Approval organization
When you select Operations > Approvals, My Active Approvals  is the default page. The My Active Approvals  page lists any 

active approvals to which you can respond.

From My Active Approvals  page, you can also select any of the following approval views:

Table  28. Views for approvals

View Description

All Approvals Lists all approvals. It also contains links to the other approval views. Additionally, any saved 

searches for approvals appear as links.
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Table  28. Views for approvals  (continued)

View Description

My Active Approvals Lists any active approvals to which you can respond. It also contains a link to the Approvals 

Pending My Response view under Saved Searches. The My Active Approvals view is the default 

view.

Approvals Pending My 

Response

Lists all of the approvals that are waiting for your response. This list is a subset of the My Active 

Approvals view. It includes any approvals that are waiting for your approval (that you have not 

responded to already).

You can also see approvals that are pending your response on the My Tasks  page. These 

approvals are also listed in the Interactive Approvals Portlet for easy access from the dashboard.

All My Teams 

Approvals

Lists all approvals that are assigned to members of your team.

All My Teams 

Un-Assigned Approvals

Lists all approvals that are assigned to your team but not yet assigned to an individual team 

member by your team leader.

Approval process workflow
To begin the approval process, you create an approval, add approvers, and add approval items. Then, you submit the approval 

and the review process begins. Unica Plan  sends the approval process to approvers based on their sequence and whether 

the reviewers are required or optional. The approval process can go through several iterations as all the approvers complete 

their review.

About this task

Several things to note about approval processes.

• The approval owner can cancel the approval process at any time in the process.

• Approvers provide a separate opinion about each item in the approval: approve, approve with changes, or deny. They 

then post the entire response.

• Unica Plan  organizes approvals in views. When you click Operations  > Approvals, by default the My Active Approvals 

view displays. This list shows only approvals that are active and you are a member of (as either an owner or 

approver).
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Note:  You can also view the approvals that are waiting for your response to through the My Active Approvals 

portlet on your dashboard.

• Approvals display on your approval list when it is your turn to respond. When you are next in the approval sequence, 

Unica Plan  notifies you. To see all approvals, navigate to the All approvals  view.

• If an approval is linked to a task in the workflow, then the system considers the Schedule Through setting for the 

task. Unica Plan  also considers the system-wide setting for non-work days and individual users' timezones when it 

schedules approvals.

1. You create the approval process, either as a stand-alone approval or as an approval task in a workflow.

2. Add approvers.

◦ You can add as many approvers as you need.

◦ You specify whether each approver acts in parallel with other approvers or before or after any other approver 

by specifying a sequence number.

◦ You specify approvers as required or optional.

◦ You can create individual instructions for each approver.

◦ If you are adding an approval workflow task, you can select project roles for the approvers, for example legal 

approver and subject approver.

3. Submit the approval.

4. The system immediately notifies all the approvers with the sequence number of "1."

No other required approvers can respond to the approval yet; they must wait their turn, which is based on the 

sequence order specified. However, optional approvers can respond at any time; optional approvers are not tied to the 

established approver order.

5. Approvers respond to the approval. Depending on how Unica Plan  is configured, the approver might also be able to 

place comments in approval items.

6. Approvers assess each item that is attached to the approval and then post their completed response.

7. The system notifies the next approver, which is based on the sequence numbers that are set in the approval.

Creating Approval Processes
You create approval processes to organize the review process. After you create the review process, you can assign approvers 

and add approval items.

About this task

The Allow approvers to approve with changes  is available and can be edited based on the configurations for Approvals.

1. Click Operations > Approvals  to open My Active Approvals.

2. Click  to add an approval process.

3. Complete the fields and click Save Changes.
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The required fields are Owner/Sent By, Subject, and Target Due Date. By default, Enable comment attachments  is 

checked. You can add multiple approval items and multiple approvers. If you add approvers, you must specify each 

approvers place in the sequence and the Default Duration for their reviews.

When you create a standalone approval here, the Template name column will be blank. If you have created a project 

as described in Chapter 5. Projects, the Template name column will show the project’s template name. The template 

name is indicative of the project template the approval belongs to.

For more information about assigning approves, see Assigning Approvers  on page 157. For more information 

about adding approval items, see Adding approval items  on page 158.

Assigning Approvers
When you create an approval, you add the people who must offer feedback. Approvers can be required or optional. After they 

are added, Unica Plan  informs approvers of the status and changes to the approval process.

About this task

When you make assign approvers, consider the following functions.

• You can assign as many approvers as you need.

• The sequence number that you assign specifies the order in which approvers work and whether any of them work in 

parallel.

• You specify approvers as required or optional.

• If you are adding an approval workflow task, you might select project roles for the approvers: for example, legal 

approver and subject approver.

1. Create or open an approval process.

2. In the Approvers section, click the Add Approvers  link.

3. In the Select Member Access Levels  window, approvers are organized in folders by role. Expand the appropriate 

folder, select the approver, and click >>  to add the person to the Selected Reviewers column. You can use Ctrl-click to 

add several approvers at the same time. 

Result

When you finish selecting approvers, click Save.

4. Click the clock  to specify the duration of the review for each approver. The default duration is one day.

5. Specify each approver's place in the sequence. Enter integer values in the field for each approver.

◦ By default, approver sequence is based on the order in which you add the approvers to the approval process.

◦ Use the sequence numbers to specify the order in which approvers act, and whether some approvers act in 

parallel or in sequence.

◦ Assigning the same number to more than one approver means that these approvers act in parallel, and can 

respond to the approval simultaneously.

◦ When a user revisits the approval, approvers are listed by their sequence number, rather than the order they 

were added to the approval.
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6. Set at least one approver as Required.

Although a user can save the approval with all optional approvers, such an approval process cannot be started. 

If someone tries to start an approval that does not contain a required approver, Unica Plan  generates a warning 

message.

◦ By default, all approvers are Required.

◦ If an approver is required, the next approver in sequence is not notified and cannot respond until the current, 

required approver responds.

◦ If an approver is required, and that approver denies the approval, then the next sequential approver is not 

notified. Instead, the approval is placed on hold and the owners are notified.

◦ If you have multiple simultaneous approvers and one required approver rejects the approval, the system 

notifies the approval owner. The approval process continues until all simultaneous required approvers 

respond. However, the approval process status changes to on-hold and approvers later in the sequence 

cannot respond.

7. Optionally, you can add individualized instructions for each reviewer. The instructions field is not available for stand-

alone approvals.

8. When you finish adding approvers, click Save Changes.

Note:  If you click Cancel, you are canceling the whole approval process, not just the approvers section. You 

lose unsaved work elsewhere in the approval if you click Cancel.

Adding approval items
Add the items that require feedback to the approval process, such as images, documents, and templates.

About this task

You can add URLs and marketing objects. You can also add items from your computer and the Unica Plan's asset library. You 

can add Unica Plan  forms to approvals in the workflow, but not in stand-alone approvals.

Note:  You can create an approval process without any approval items or as many as needed.

1. Create or open an approval process.

2. Click Add Item(s) to approve.

3. Add approval items from your computer as necessary.

a. Select Add Item to Approve:  > From My Computer.

b. Browse to an asset, add comments if needed, and click Save Changes.

4. Add approval items from the Unica Plan  Asset Library as necessary.

a. Select Add Item to Approve:  > From the Asset Library.

b. Click Browse, which opens the Asset Library in a new window.

c. Navigate to the asset you want. Click Accept Asset  on the right pane to select it and return to the Add Item(s) 

to approve  window.

5. Add URLs to the approval process as necessary.
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a. Select Add Item to Approve:  > URL.

b. Enter the URL and any comments.

c. If needed, you can click the External CMS  button and access a thrid-party CMS URL for approval. For more 

information see Step 8.

6. Add marketing objects to the approval items as necessary.

a. Select Marketing Object  from the menu. Search or browse for marketing objects in the new window.

b. Click Browse, which opens a new window.

c. Select an asset and click Accept and Close  to return to the Add Item(s) to approve  window.

7. If you are adding approval items to a workflow approval, add forms to the approval items as necessary.

a. Select Unica Plan  Form  from the menu.

Result

A new menu appears containing forms that are associated with the template. This menu contains only forms 

that your administrator associated with the template.

b. Select a form from the menu.

8. Add third-party CMS content to the approval items as necessary.

a. Select External CMS  from the menu.

b. Select values for the following fields:

▪ Select repository  - The third-party CMS configured in Unica Content Integration is listed here.

▪ Select content type  - The type of content to be sent for approval. Available options are Documents  and 

Images.

▪ Click Done. The artifact is added to the list of items to be approved.

c. Click Browse, which opens a new window.

9. Optional:  To add more assets, click Add More  and repeat the steps for each asset.

10. Click Save Changes  on the Add Item(s) to Approve  window.

Result

The window closes.

11. Click Save Changes  on the approval process.

Submitting approval processes for review
After you add an approval process, you must submit the approval to notify the approvers that they take action. Submitting the 

approval begins the review process.

1. Navigate to the Summary tab of the approval you want to submit.

2. Click Change Status  and select Submit for Review  or Submit for Review with comments  from the menu.

3. If you chose Submit for Review with comments, enter comments that you want the approvers to see when they 

receive notification of your approval, and click Continue.
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Result

After an owner submits an approval, the status changes to In Progress. If an owner makes any further changes to the 

approval, Unica Plan  sends notifications to all owners and approvers.

Methods of evaluating approvals
When you are notified that it is your turn to review, you can evaluate the approval process in the Unica Plan  user interface, 

through the Approval Portlet, or on a mobile device.

Each method has different benefits.

• Full user interface

Evaluating approvals through the Unica Plan  user interface is the most robust method. Use this method when you 

need to extensively markup attachments or if you also need to create approvals. In addition to reviewing approvals, 

you can also copy, cancel, create, modify, and finish approvals processes in the user interface.

• Approval Portlet

The Approval Portlet on your dashboard is a quick, easy method to efficiently access the approvals you need to 

review. The Approval Portlet contains all the same review and markup features of Unica Plan. However, you cannot 

copy, cancel, or create approvals in the Approval Portlet.

• Mobile approvals

Use Unica Plan  approvals on mobile devices for quick access to your approvals away from your computer. Follow the 

link in the email that notifies you that it is your turn to review to immediately evaluate the approvals on your mobile 

device. Mobile approvals are especially useful for approvals without creative attachments or when you can describe 

the changes in comments.

Mobile approvals are especially useful for approvals without creative attachments or when you can describe the 

changes in comments.

Note:  At this time, you cannot view or markup attachments when you review approvals on mobile devices.

Evaluating approval processes
When it is your turn, you provide feedback on the approval process and any approval line items. You provide feedback 

by approving or denying the approval process and individual line items. You can also add comments or markup for more 

detailed feedback.

About this task

When it is your turn to respond to an approval process or complete an approval task, Unica Plan  notifies you with an alert and 

an email message. Both the alert and the email message contain a link to the approval. You can also access the approval 

from the link in the email or alert. The approval process appears in the My Active Approvals  and Approvals Pending My 

Response  views.
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1. To open the approval process with line items you want to review, do one of the following options:

Choose from:

◦ Select Operations  > Approvals.

◦ Click the link to the approval in an alert or email notification.

◦ Click an approval task in the workflow.

2. Review the description and any notes or instructions that are provided for the approval process.

3. Complete the following steps for each approval line item.

a. To view an item, click its thumbnail image or file name.

Result

Note:  Select View/Add Markup  to add in-document comments to a PDF file. If you do not choose this 

link, any comments you make are lost when you close the file.

b. Click Post Feedback. A dialog opens for your response.

c. Enter your comments in the Your Response  section.

Alternatively, attach a file with detailed comments. Click Attach Comments File  and browse to the file.

d. Select the appropriate response:

▪ Approve  indicates that you approve the item as it is.

▪ Approve w/Changes  indicates that you approve the item with the exceptions noted in your comments 

or attachment.

This option is available based on the Approval configurations and approval task settings.

▪ Deny  indicates that fundamental changes must be made to the item by the approval owner. If your 

organization requires you to supply a reason, select a Deny reason  from the list.

4. After you respond to every item in the list, or supply comments and a response for an approval with no attachments, 

click Post Complete Response.

Note:  You cannot change your response after you click Post Complete Response  unless the approval process 

owner resubmits the review.

Result

The response form displays with your response listed next to your name in the list of approvers. Unica Plan  sends an 

alert and an email message with your response to the approval owner and sends an alert to the next reviewer, if any.

Approval portlet
The approval portlet allows you to access the approvals that require your response from your dashboard.
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You can add the Manage My Approvals  portlet to your dashboard to streamline your work. The approval portlet is most 

useful if you frequently evaluate approval processes, but do not create approval processes or submit approval processes for 

review. For more information on adding portlets to your dashboard, see the Unica Plan  Administrator's Guide.

Evaluating approval processes in the Approval Portlet
Use the approval portlet to quickly respond to approvals directly on your dashboard. You can approve all approvals that are 

waiting for your response with one click, or assess approval processes and approval line items one at a time.

1. Start Unica Plan. Your dashboard is the default start page. If you set a different default start page, navigate to your 

dashboard.

2. You can approve all approvals that require your response. Click Approve all (#) approvals.

3. You can respond to individual approval process and any approval items by clicking the My Actions  menu.

From the My Actions  menu, you can perform the following actions on the approval items.

◦ Send as email attachment(s)

◦ Approve all with comments

◦ Approve all with changes

◦ Approve all without comments

◦ Deny all with comments

◦ Deny all without comments

◦ Post complete response

Note:  If the approval has line items, you cannot click Post complete response  until you approve or 

deny the line items.

4. Alternatively, you can approve or deny line items one at a time by clicking the My actions  menu on an individual line 

item.

From the My actions  menu, you can perform the following actions on the approval items.

◦ Send as email attachment(s)

◦ Approve with comments

◦ Approve with changes

◦ Approve without comments

◦ Deny with comments

◦ Deny without comments

5. After you respond to all the line items, click Post complete response  to finish the approval. After you click Post 

complete response, you cannot make any more changes unless the approval process owner starts a second round of 

review.

Mobile features in Unica Plan
Unica Plan  includes limited features that are optimized for a mobile browser. Unica Plan  now includes support to evaluate 

approval processes on mobile devices.
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Mobile approvals are especially useful for approvals without creative attachments or when you can describe the changes in 

comments. They are aimed at cases where a text description captures the essence of what needs to be approved, such as 

"Requesting approval to increase the number of mailings from 10,000 to 15,000."

These approvals might include one or more attachments to approve as well, but only the names of those attachments are 

visible in the mobile approval. A requester should include descriptive text with each attachment to enable the approver to 

make a decision, such as, "changed the Corporate logo to the one on file as you requested."

At this time, mobile approvals have the following limitations.

• You cannot open items that are attached to approvals on mobile devices.

• You cannot use markup features on mobile devices.

• Mobile features are supported on the following devices:

◦ Android devices 4.4.x and higher, using Chrome 3.6 browser.

◦ iPads

◦ iPhones

You must have permission to access your organization's network on your mobile device to use these features. Your 

organization can enforce the same security and VPN protection on the mobile browser.

Evaluating approval processes on mobile devices
Evaluating approval processes on a mobile device increases efficiency and streamlines work. You can response to approval 

processes immediately after you receive a notification, without going to a computer to access the Unica Plan  user interface.

About this task

You can access the approval process on your mobile device, if you receive an email notification that a requester sent an item 

to you for approval. You can also bookmark the approval process page to check your approvals frequently and quickly on 

your mobile device.

1. Follow the link in the email notification and sign in to Unica Plan  on your mobile device. If you access the notification 

on a mobile device, the url in the notification automatically directs you to the mobile version.

Note:  To use this feature, configure approval alerts and your email address in Unica Plan

2. Select Approve  or Deny  for each approval item. If you need to view attachments or add markup, consider viewing the 

approval item in the Unica Plan  user interface.

Result

A red "X" or green check mark visually indicates your denial or approval of each item.

3. Optional:  Enter comments to explain your response.

4. After you Approve  or Deny  each approval item, select Post complete response.
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Post complete response
To finish an approval process with multiple approval items, you click Post complete response. To finish an approval process 

without approval items, you click Post Feedback. After you click Post complete response  or Post Feedback, you cannot 

change your response to the approval process.

Click Post Complete Response  after you respond to all of the approval items. A confirmation page displays and you can add 

any final comments.

Note the following.

• If the approval owner requires disposition of all items, and you click Post Complete Response  before you respond to 

all items, this warning displays: "Please respond to all documents before marking the process as complete."

• If the approval owner does not require disposition of all items, you must respond to at least one approval item, or this 

warning displays: "Please respond to at least one document before marking the process as complete."

• You can respond to an approval item multiple times before you complete your response to the entire approval 

process. However, after you click Post Complete Response  to complete the review you cannot respond to the 

approval again.

• If you do not press Post complete response  before navigating away from the Approval page, the responses are not 

saved.

After you complete your review, the Post Feedback  link changes to View Item Responses. You can then view the item 

responses and response history only.

Modifying approval processes
The owner of an approval process can modify the approval process after it is created and even after it is submitted. The 

owner can add new items for approval, or assign new approvers. The owner can also delete items and approvers, or update 

existing items to be reviewed.

The process of modifying an approval is similar to creating one. If you are an owner of the approval process, you can change 

it at any time. If the approval process has multiple owners, any owner can modify it.

By default, approvers cannot modify the information in the approval; they can respond only to the approval. In some cases, 

the security policy of the approval might allow approvers to modify the approval process.

After you modify the approval, you chose whether to resubmit the approval process to approvers. When you modify a 

submitted approval, the Approvals  window displays and prompts you to add comments to send to new and existing 

approvers. If you want an approver who already responded to view your changes, check the approver's Request Reapproval 

check box. Whenever you want an approver to reapprove, the system increments the approval round number.

Canceling approval processes
You can cancel the approval process at any time. Canceling the approval process does not delete the approval. You might 

decide to cancel rather than delete an approval process if you think you might need details from the approval process in the 

future.
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About this task

If you cancel the approval process, you cannot submit it for review later. Any responses or comments that were made before 

you canceled the process are saved, essentially "freezing" the approval with all of its current details.

1. Open the approval process.

a. Select Operations  > Approvals. The My Active Approvals  view displays by default.

b. If the approval process you want to cancel is not available in this view, select All Approvals.

2. Click Change Status  and select Cancel Review  or Cancel Review with comments  from the menu.

3. Optional:  If you chose Cancel Review with comments, add comments that you want to add to the approval. You 

might add reasons why you are canceling the review. Click Continue.

Results

The All Approvals  view shows the approval status as Canceled.

If you cancel an approval that is linked to a workflow task, the task is "crossed out" on the workflow tab. That is, the font for 

the task and all of its details changes to italics, strikethrough. Additionally, there is an 'x' in the status column, indicating the 

workflow is considered "Skipped."

Copying approval processes
You can copy an approval process to create another approval process that is similar to an existing one. You can make a copy 

of the existing approval process and modify the copy, leaving the original approval process intact.

About this task

The following details are copied.

• List of approvers and whether they are required or optional

• List of owners

• The subject, with "Copy of" before the original approval name

• Target Due Date

• Sequence

• Description

• Items to approve, except for forms

The following items are not copied.

• Any instructions for individual approvers are not copied.

• The contents of the message board are not copied.

• Information from the Analysis tab is not copied.

• The copy is not linked to any project workflow, even if the original is. That is, copying an approval creates a stand-

alone approval.

• Linked forms are not copied because stand-alone approvals do not support forms.
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1. Open the approval process that you want to copy.

a. Select Operations  > Approvals.

Result

The My Active Approvals  view displays by default.

b. If the approval process you want to copy is not available in this view, select All Approvals.

2. Click the Copy this Item  icon ( ).

3. Click OK  when Unica Plan  prompts to copy the approval.

Result

The copy of the approval process opens. The copy is titled "Copy of original approval name." Its status is Not Started.

4. Modify any information that you want to change in the copy and click Save Changes. 

Result

The copy appears in your All Approvals  view.

Deleting an approval
As the owner of the approval process, you can delete it at any time.

About this task

To delete an approval, complete the following steps.

1. Select Operations  > Approvals.

2. Select the check box next to the approvals you want to delete.

3. Click Delete this Item  ( ) and click OK  when Unica Plan  prompts you to confirm the deletion.

Result

Note:  You cannot delete an approval that is linked to a workflow task.

Completing approval processes
If the approval process does not have the Enable approval auto completion  flag enabled, only the owner can change its 

status to Completed. Marking approval processes complete helps organize approval processes. Approval processes with a 

status of Completed  display only in the All Approvals  view.

About this task

Unless the approval was created with the Enable approval auto completion  flag enabled, it is entirely up to the approval 

owner as to when to complete the approval. If auto-completion is enabled, the approval is automatically marked Completed 

when the last required approver approves.
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Marking the approval process complete signifies that the review is finished. The following are some examples of when you 

might want to mark an approval as complete.

• After all approvers respond

• After the Target Due Date  passes

• After all suggested changes to approval items are made

1. Open the approval process that you want to complete.

a. Select Operations > Approvals. The My Active Approvals  view displays by default.

b. If the approval process you want to complete is not available in this view, select All Approvals.

2. Click Change Status  and select Finish Review  from the menu.

3. Enter a comment about why you want to complete the review in the Approvals  window, and click Continue.

Results

The approval now has a status of Completed; Unica Plan  sends a notification that the approval process is finished.

Putting approval processes on hold
After you submit an approval process for review, you can put the approval process on hold. You might put an approval 

process on hold to revise the approval items and request reapproval. Putting an approval on hold is different from canceling 

a review of an approval process because you can modify it and continue the review.

About this task

Note the following behavior when you put an approval on hold.

• Unica Plan  notifies the approvers that the approval process is on hold.

• Approvers cannot approve or reject the approval process during the time it is on hold.

• Owners can view the approval process and comment on approval items while the approval is on hold.

1. Open the approval process that you want to put on hold.

a. Select Operations  > Approvals. The My Active Approvals  view displays by default.

b. If the approval process you want to put on hold is not available in this view, select All Approvals.

2. Click Change Status  and select Stop Review  or Stop Review with comments  from the menu.

3. Optional:  If you chose Stop Review with comments, type your comments explaining why you want to stop the review 

and click Continue.

Results

The approval process status is set to On Hold. Unica Plan  sends a notification to the approvers that informs them that the 

approval process is on hold.

Reactivating approval processes that are on hold
After you put an approval process on hold, you can reactivate it to resume the review process.
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1. Open the approval process that you want to reactivate.

a. Select Operations > Approvals. The My Active Approvals  view displays by default.

b. Approval processes that are on hold are not active, so they are not available in this view. Select All Approvals.

2. Click Change Status  and select Continue Review.

3. Enter comments about why you want to continue the review, and click Request Approvals.

Note:  Whenever any approver is checked and you want them to reapprove, the approval round number is 

incremented.

Results

The approval process status changes to In Progress. Unica Plan  sends a notification to the approvers that the approval 

process is active and they can respond.

Reassigning team approvals
When your team is assigned as an approver, you can accept the approval or reassign it to someone else on your team. 

Reassignment options depend on how your team is configured.

About this task

A team can be assigned as an approver. The routing options for the team determine whether team members can respond to 

such an approval, or whether the team manager must assign it.

• If the team has Managers can route approvals to members  enabled, the manager can assign approvals to members.

• If the team has Members can accept team-assigned approvals  enabled, team members can assign themselves 

approvals, without manager input.

• If the team has Members can return team-assigned approvals back to the team  enabled, team members can return 

approvals back to the queue for the team.

1. Select Plan  > Operations  > Approvals.

2. Click the Actions  icon ( ) and select one of the following searches.

Choose from:

◦ All My Team Approvals

◦ All My Team Unassigned Approvals

3. Select the approval or approvals to assign.

4. Click the Reassign Selected  icon ( ).

5. For each selected task, select a team member for the assignment in the Assign To  field.
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Note:  Team members can assign tasks to themselves or back to the team.

6. After you make all the assignments, click Save Assignments  to save your changes and return to the Approvals list 

window.

Approval processes linked to workflow tasks
Approval processes can be linked to workflow tasks. If an approval process is linked to the workflow, editing the approval 

process changes the workflow task.

Both stand-alone approvals and workflow approvals are listed in the approval views. When you edit an approval that is linked 

to an approval workflow task, your work is reflected in the workflow task as follows.

Table  29. Results of editing an approval to a linked workflow task

Your action Changes to the linked workflow task

Cancel the approval The task status changes to Canceled.

Change the approval 

due date

The task Forecast/Actual End Date  changes to match.

Start the approval The task status changes to Active, and the Forecast/Actual Start Date  is set to the current date.

Pause the approval The task status changes to On Hold.

Complete the approval The task status changes to Finished, and the Actual End Date  is set to the current date.

Delete the approval You cannot delete a linked approval from the approval itself. You must delete the approval task 

row from the workflow.

Attachment markup types in Unica Plan
You can use markup tools to add feedback directly on top of an attachment. Unica Plan  has different methods for marking 

up attachments: native Unica Plan  markup, Adobe markup, and PDF Embed API markup. Your administrator chose one of 

these methods for markup during installation.

Unica Plan  users can mark up attachments for plans, programs, projects, and marketing objects in either of the following 

ways.

• Unica Plan  can be set up to use native markup function, which allows users to mark up the following file types.

◦ PDF (each page of the PDF is converted to an image for markup)

◦ GIF

◦ JPG (RGB only, not CMYK)

◦ PNG

◦ BMP

◦ HTML pages and hosted websites
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• Unica Plan  can open a PDF document in Adobe™  Acrobat. Users can use all of the markup features in Acrobat to 

make comments, then save the comments in Unica Plan.

• Introduced in version 12.1.4, PDF Embed API can open a PDF document in Adobe™  Acrobat. Users can use all of the 

markup features in Acrobat to make comments, then save the comments in Unica Plan. PDF Embed API works on 

Google Chrome, Microsoft Edge, and Safari, and also works with annotations (update, remove, and reply).

During installation, an administrator chooses which type of markup to enable throughout the application.

For all markup tools, note the following behaviors.

• You access the Unica Plan  markup tool by clicking the View/Add Markup  link for an individual approval item.

• Unica Plan  tags markups with the name of the person who made the comments, so everyone can view all review 

comments at once, or one reviewer's comments at a time.

Native markup for websites

You can upload an entire website for review. However, the following limitations apply.

• Unica native markup does not support markup on websites that include or are built entirely in Flash.

• Pages that require server-side processing, such as CGI, ASP, ASPX, CFM, do not work properly in the markup tool.

• Framed sites are not supported.

As an alternative to uploading HTML files, consider a URL to link to externally hosted content.

Marking up attachments
Anyone who has permission to view an approval process can add comments to attached approval items.

Before you begin

During installation, Unica Plan  was configured to use Adobe™  Acrobat markup, PDF Embed API markup, or native Unica Plan 

markup.

About this task

Note the following restrictions.

• Markup is only for latest/last version of the approval item.

• You can mark up items for an approval with a status of In progress or On hold only.

1. Navigate to the approval that contains the item to edit.

2. Click View/Add Markup  next to the item on which to add comments.

Note:  If the link is unavailable, the owner of the approval chose not to enable markup for the item.

Result
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The document opens in a browser.

3. Mark up the item with Adobe™  Acrobat markup tool, PDF Embed API markup tool, or native Unica Plan  markup tool, 

depending on your installation.

◦ If your system uses Adobe™  Acrobat markup or PDF Embed API, only PDFs can be marked up. Use the 

Acrobat Comment toolbar to add your markups and comments to the PDF. When you are done with your 

markups, click Send Comments.

◦ If your system uses the native Unica Plan  markup, use the icons and controls in the markup tool. All icons 

include mouse over help. Inactive controls are gray and cannot be selected.

4. Close the window that contains the marked-up item.

Results

Any member can see the marked-up item by opening the container object and clicking View/Add Markup. Members keep 

adding markups to the file this way. To view the original file without the markups, click the link that contains the name of the 

attached item instead of View/Add Markup.

Adobe™  Acrobat markup in Unica Plan
Adobe Acrobat markup is one option for marking up attachments.

To use the Adobe™  Acrobat markup feature effectively, you or your Unica Plan  administrator must set the Internet Explorer 

preferences to display PDF files in the browser.

Due to limitations in the Adobe Acrobat API, if you use Adobe Acrobat to markup attachments in Unica Plan, you cannot 

record audio comments and cannot attach files as comments.

Note:  Adobe Acrobat markup in Unica Plan  does not support Google Chrome.

Native Unica Plan  markup
Use native Unica Plan  markup to comment on attachments.

The native Unica Plan  markup tool uses the following icons and controls. All icons include mouse-over help.

Note:  If another user is marking up a document at the same time as you, refresh the browser page to see those new 

comments.

Menu bar

This table describes the items in the menu bar.

Table  30. Icons and controls for the  markup tool

Icon Description

Click Add Note, then drag to a specific location on a page to add feedback.
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Table  30. Icons and controls for the  markup tool  (continued)

Icon Description

You cannot move a note after you save. Each note is fixed to a location that is important to the 

context of the feedback and any replies.

You can attach a file to a note.

Use the action links in a note to reply to, update, or delete the note.

Click Add Scribble. With this tool, you can draw a free-from "scribble," straight line, or arrow on 

the page. You can also add squares and ellipses with fill or no fill. You can select a color for all of 

these options.

Click Zoom In  to zoom in.

Click Zoom Out  to zoom out.

Click Zoom Reset  to reset the size of the page to the original display.

Click Download Original  to acquire a copy of the original attachment that you can save to your 

local computer.

Click Toggle Annotations  to display or hide comments.

Click Help  for tips on using this markup tool.

Click Close Markup Window  to close the markup tool.

Annotations list

This table shows the items available in the annotations list. You can sort on any column by clicking its header.

Table  31. Columns in the annotations list

Item Description

Page filter Provides options to view annotations for the current page only, or for all pages in the document. If 

you select All Pages, you can sort in ascending or descending order by clicking the heading of the 

Source  column.

Annotations filter Provides options to view all annotations, only active annotations, or only archived annotations.

Author filter Provides options to view annotations from all authors or a single selected author. If you select 

Any Author, you can sort by ascending or descending order by clicking the heading of the Author 

column.

Actions column
Offers the following options.
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Table  31. Columns in the annotations list  (continued)

Item Description

• Click Show Reply Dialog  to reply to the comment. Your reply can include a heading, a 

body, and an attachment.

• Click  Update  to edit the comment. You can archive the comment, change the text in 

the heading and body, and add an attachment.

• Click  Delete  allows to delete the comment

If you are viewing annotations for all pages, this column includes a V (View) option for comments 

that are found on other pages. Click this option to view the comment in context by opening a view 

of that page.

Created Date column Shows the date on which the comment was added.

Author column Shows the author of the comment.

Title Shows the title of the comment.

Attachments Provides links to any attachments to the comment.

Archived A check in this column means that the comment is archived.

PDF Embed API markup
Since the Adobe SOAP markup only works with Microsoft Internet Explorer browser and since the Microsoft Internet Explorer 

browser has reached its end-of-life cycle, Unica Plan introduced the PDF Embed API Markup in version 12.1.4.

PDF Embed API is similar to Adobe™  Acrobat markup but works on Google Chrome, Microsoft Edge, and Safari, and also 

works with annotations (update, remove, and reply).

Note:  If you create Annotations using Native markup (MCM) or Adobe™  Acrobat markup (SOAP), they will not be 

visible in PDF Embed API markup. Similarly, if you create Annotations using PDF Embed API markup, they will not be 

visible in Native markup (MCM) or Adobe™  Acrobat markup (SOAP).

The functionality is similar to Adobe markup tool and you can refer Adobe Acrobat markup in Unica Plan  on page 171 for 

more information.
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Chapter 8. People  and teams
In  Unica Plan, you assign work to teams or  individual users.

You assign people  or teams  to units of work. You make assignments primarily through the People tab on a project.  You can 

also add and assign members, teams, and roles when you edit the workflow tab.

Note:  You might see only a subset of the people  and teams  available. Your organization can limit the view of 

available resources.

People tab
Each project  contains its own People tab.

Use this screen to do the following activities.

• Manage the members of a project.

• Edit the access level for a member.

• Replace a person in a role when a team member  becomes unavailable.

• Add or remove a role.

• Track team members or request recipients who are out of the office, their delegates, and start dates. (Displays for 

project or request owners only.)

A project  template can contain information about the functional roles for the project. A template can reduce some of the 

work necessary to assign people or teams to units of work within the project.

Project member management
You manage project members on the People tab. For example, you can manage teams and security permissions.

On the People tab, you can do the following actions.

• Add team members to the project.

• Remove team members from the project.

• Change a role for a member.

• Add and remove roles.

Note:  A role must exist within the project before you can assign a team member to it.

• Review a list of team members or request recipients who are out of the office, their delegates, and delegation start 

dates. (Displays for project or request owners only.)

The People tab controls the following security permissions.
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• View People tab.

• Edit Team Members, Roles, and Access Levels.

• Assign Work by Role. Users with this permission can also access the Assign Work by Role and Find/Replace dialog 

boxes.

Note:  Users with View People tab  and Edit Team Members, Roles, and Access Levels  permissions can automatically 

add members and member roles on workflow spreadsheets without adding them to the People tab first.

Notes on managing project members

• If a role is not listed for the project, you (or an administrator with the appropriate permission) can create it using 

Setting > Unica Plan  Settings > List Definitions > Roles.

• When you edit members, the list of people in the Available resources section of the Select Team Members dialog is 

populated from Unica Platform. This list reflects limitations based on your role and permissions. For details, consult 

your Unica Plan  administrator or the Unica Platform  Administrator's Guide.

The list of teams in the Select Team Members dialog is based on the teams that are defined in Unica Plan. As with 

the list of people, the list of teams is limited based on your role and permissions.

• The email address displays for a team member only if this information is available in Unica Platform.

• You cannot remove project members (or roles) who have tasks that are assigned to them. You must remove them 

from all future workflow tasks before you can remove them from the project.

• In the Project Members column, teams are in italics and are preceded by the  icon. Individuals are in bold font 

and preceded by the  icon.

Managing project  members
Use the People  tab of the project  to manage team members.

About this task

To manage project  members, complete the following steps.

1. Click Edit Member/Role Settings  icon ( ).Members.

Result

The Select Team Members  dialog box opens.

2. Do any of the following options:

Choose from:

◦ To add a person  or team, select the name from the left pane of the dialog, and click >>.

◦ To remove a person  or team, select the name in the Select Team Members  list box and click  <<.
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◦ To change the role for a person  or team, select the name in the Select Team Members  list box then clickUp 

and Down  to move it to the required role.

Note:  You cannot remove a user or team that is assigned to a task.

3. Click Save Changes.

Result

The Select Team Members  dialog box closes. The People  tab becomes the active window.

Results

The changes that you make are reflected in the list of people and roles. For example, if you added a creative lead, the screen 

would contain a line similar to the following example:

 

Member/Access Level        Role             Email Address
P Picasso (participant)    Creative Lead    ppicasso@mycompany.com

Managing teams
Use the My Teams  page to manage teams.

Selecting Operations  > Teams  opens the My Teams  page. Use the My Teams  page to do the following tasks:

• Create and remove teams

• Assign team managers and members

• Set the work routing model

• Enable and disable teams

These groups of people are available across templates and object instances. Project Managers can assign tasks to teams, in 

addition to being able to assign them to individual members.

Wherever you can assign or work with individuals, you can also work with teams. For example, the procedure Assigning 

people to roles  on page 189 can be used to assign individuals or teams to roles.

Team alerts
Unica Plan  sends alerts for team-related events in the same way it sends alerts to individuals.

Alerts for teams have the following behavior.

• For tasks assigned to a team, all the team members and managers receive the alert

• After a task is assigned to a team member, only the member and managers receive the alert

For the following events, only the specific team member that is affected by the event receives the alert
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• A member is added to the team

• A member is removed from the team

• A team-task is assigned to a member of the team

• A team-task that is assigned to a user is reassigned back to the team or to another member

Team summary page
When you first go to a team, its summary page appears. The team summary page displays basic information about the team.

Table  32. Team summary page fields

Field Description

Name Displays a name for the team. This name appears on the Teams list page, and selecting project 

members or reviewers.

Note:  This field is required.

Description Displays a short description for the team.

Skill Sets Displays a list of skills that are associated with the team.

Add terms here that might be useful when you describe team. For example, you can enter "Adobe 

Photoshop proficiency as a skill, so that anyone who views the team knows that at least one 

person on this team has this skill.

Suggested Security 

Policies

Displays the security policy or policies that apply to the team.

Note:  This field is required.

Routing Models Check any combination of the work routing option check boxes.

Members and 

Managers

Displays the managers and members of the team. Use the scroll bar to view the entire list.

From the Team Summary screen, you can perform the following actions.

Table  33. Actions available from the Team summary page

Action Details

Edit the team Edit the fields for the team and members by clicking the Edit  icon ( ).

Change alert 

subscriptions

Click Set Alert Rules  to change the way team members and managers are notified of task 

assignments.

Delete the team
Click Delete this Item  ( ) to remove the team.
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Table  33. Actions available from the Team summary page  (continued)

Action Details

Copy the team Click Create a duplicate Team  to create a copy of the team. The system opens the summary page 

of the new team in edit mode. Then, you can modify the copied team to make a similar team.

Add a team
Click Actions  ( ) and select Add Team  to add a team.

Go back to the Teams 

list page

Click All Teams  or My Teams  in the breadcrumb; either or both of these links are displayed, 

depending on how you navigated to the current summary page.

Or, click the Action  icon ( ) and select All Teams  or My Teams.

Print team details
Click Print  ( ) to print the details of the team.

Adding and editing teams
If you have the appropriate permissions, you can add or edit teams as personnel changes.

About this task

To add or edit teams, compete the following steps.

1. Select Operations  > Teams.

2. On the Teams list page, take one of the following options.

Choose from:

◦ To create a team, click Add Team  ( ).

◦ To edit an existing team, click a team to display its summary page, then click Edit  ( ).

3. Complete the fields on the Team summary  page.

4. Click Save Changes.

Editing team members
You can set team members and managers when you create a team. Additionally, you can edit the members of a team any 

time during the existence of the team. You manage team members by using both Unica Plan  and Unica Platform.

Before you begin

If the people you want to add to a team do not appear in Select Team Members and Roles, you must add them as Unica Plan 

users in Unica Platform.

1. Select Operations  > Teams.

2. On the Teams  list page, click the team to edit.
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To edit a team that is not listed, click All Teams  to display all available teams. If it is still not visible, you might not 

have the appropriate permissions to view the team.

3. On the Team summary  page, click the Edit  icon ( ).

4. Click Add/Remove Managers and Members.

5. On the Select Team Members and Roles  page, move people into and out of the team.

Task routing options
When you edit a team, you can choose how tasks, approvals, and project requests are routed for that team. You can assign 

several different task routing options to teams and team members.

You can select any of the following options under the Task Routing Model  section of the Team summary  page:

• Managers can route tasks to members

Tasks that are assigned to the team appear on the team manager tasks page. The manager can then assign these 

tasks to team members.

• Members can accept team-assigned tasks

Tasks that are assigned to the team appear on the My Tasks  page for each team member. Then, team members can 

assign a task from the list to themselves.

• Members can return team-assigned tasks back to the team

Members can return their tasks back to the team.

When you set up a team, you must select one or both of Managers can route tasks to members  and Members can accept 

team-assigned tasks.

Note:  To view team tasks, you must apply either the All My Team Tasks or All My Teams Unassigned Tasks filter 

from the Tasks  list page.

The task routing options function independently, and you can choose any combination for the team. For example, you 

want the manager to be able to assign tasks to members and the members to be able to return assigned tasks back to 

the unassigned queue. Therefore, you select both Managers can route tasks to members  and Members can return team-

assigned tasks back to the team. If you want the manager to be able to assign tasks to members, but not allow the members 

to return assigned tasks back to the unassigned queue, select only Managers can route tasks to members.

Approval routing options
Unica Plan  provides the same routing options for both task approvals and stand-alone approvals as for standard tasks. For 

standard tasks, a team can have any combination of routing options for approval tasks.

You can select any of the following options under the Approval Routing Model  section of the Team summary  page:
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• Managers can route approvals to members

The manager can assign these approval tasks to team members.

• Members can take ownership of team-assigned approvals

Team members can then take ownership of these approval tasks.

• Members can return team-assigned approvals back to the team

Members can return their approval tasks back to the team.

When you set up a team, you must select one or both of Managers can route approvals to members  and Members can take 

ownership of team-assigned approvals.

Request routing options
Unica Plan  provides similar routing options for project requests as for tasks.

You must select at least one of the following options under the Project Request Routing Model  section of the Team 

summary  page:

• Managers can route project requests to members

The manager can assign these requests to team members.

• Members can accept team-assigned project requests from the team.

Team members can take ownership of these requests.

• Members can return team-assigned project requests back to the team

Members can return requests that they previously accepted

Virtual project participants
A virtual project participant can assist with a project if the user is a member of a team that is working on the project, but 

not a project participant. The virtual user can see team tasks that are assigned for the team, and be assigned such tasks. 

Additionally, a virtual user can view the project and all of its tasks.

About this task

Consider the following scenario.

• Don is a member of the "Major Accounts" team.

• The Major Accounts team has Members can accept team-assigned tasks  enabled.

• The Major Accounts team is assigned in the Members column of the "Handouts - design" workflow task for the Fall 

2016 Tradeshow project.

• Don is not a project member for the Fall 2016 Tradeshow project.
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Even though Don is not a member of the Fall 2016 Tradeshow project, Don can view and update the "Handouts - design" 

task. Don can go to the All My Team Tasks  page and selecting the "Handouts - design" task. In this case, Don is a "virtual 

participant" for the Fall 2016 Tradeshow project, and can view all of its project and task information.

Assigning team tasks
On some teams, managers assign tasks to team members. On other teams, members can assign themselves tasks from the 

queue.

About this task

Depending on the following work routing options, team managers can assign tasks to team members, or members can pull 

tasks off the queue themselves.

• If the team has the Managers can route tasks to members  option enabled, team managers can assign tasks to team 

members.

• If the team has the Members can accept team-assigned tasks  option enabled, team members can assign 

themselves any unassigned team tasks.

• If the team has the Members can return team-assigned tasks back to the team  option enabled, team members can 

return tasks that are assigned to them back to the pool of unassigned team tasks.

1. Select Operations > Tasks.

2. Click \ Actions  ( ) to display all saved searches/filters for tasks.

3. Choose one of the following searches.

◦ To display all tasks that are assigned to the team, grouped by assignment, click All My Team Tasks.

◦ To display all tasks that are assigned to the team that are not assigned to any team members, click All My 

Team Unassigned Tasks.

Note:  You cannot reassign tasks from the All Tasks  page. To reassign tasks, select another filter; for 

example, All My Team Tasks.

4. Check the boxes for all the tasks to assign. To select all listed tasks, you can check the box for the Name  column.

Result

The Reassign Selected  page appears. If you do not have permission to assign the selected tasks, a message informs 

you that you cannot reassign the tasks.

5. For each selected task, select a team member for the assignment in the Assign To  field.

Note:  Team members only can assign tasks to themselves or back to the team.

6. After you make all the assignments, click Save Assignments  to save your changes and close the page.

181



Unica Plan V12.1.7 User's Guide

182

Assigning team requests
You can assign a request to a whole team instead of a single member. You must have appropriate permissions to assign a 

team to a project request.

1. Go to the People  tab of the project and click Members/Roles  ( ).

2. Select a role in the Selected Members and Roles  area, and move a team from the list of teams and team members to 

assign that team or team member to the selected role.

If you assign a team member to a role, the team is not automatically assigned.

Changing the access level for a project member
You might want to change the security access level and permissions for project members. While all Unica Plan  objects have 

access levels, it is useful to change access levels for projects only.

About this task

Note the following behavior:

• The list of people in the Team members section of the Change Member Participation Level  page is populated from 

Unica Platform. This list of people might be limited based on your role and permissions. For details, consult your 

Unica Plan  administrator or the Unica Platform  Administration Guide.

The list of teams is based on the teams that are defined in Unica Plan. As with the list of people, the teams you can 

view might be limited based on your role and permissions.

• You can also use the Change Member Participation Level  link to add users to the project. They are added with the 

selected access level and placed by default into the Unassigned role.

• Access levels are associated with objects and cannot be created or removed. For example, approvals always have 

two access levels: owner and approver.

1. Go to the People  tab of the project.

2. Click Change Member Participation Level.

This icon is not available unless you have the appropriate permission. Typically, project owners and Unica Plan 

administrators have this permission, but it can be assigned differently depending upon the security policy for the 

project.

Result

The Change Member Participation Level  page appears.

3. In the Selected Team Members  list box, select the member who has an access level to change.

4. Use the Up  or Down  controls to move the member to the new access level.

5. Repeat Steps 3-4 as necessary.

6. Click Save Changes.
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Results

The Change Member Participation Level  dialog box closes, and your changes are applied. The People  tab becomes the 

active window.

Find and replace task members or reviewers
You can replace any member or reviewer with any other current member of the project. To replace with someone not on the 

project list, you first need to add that person to the project. This requirement applies only to owner-assigned task members 

and reviewers. To remove a member or reviewer that is assigned by an administrator when a template was created, you must 

go to the approval and remove them. You can only remove the memeber or reviewer if you have the proper permissions.

To open the Find and Replace Task Members  or Find and Replace Task Reviewers  page, click Find and Replace  > Find and 

Replace Task Members  or Find and Replace  > Find and Replace Task Reviewers.

The following table describes some uses for the search and replace feature.

Table  34. Search and replace use cases

Goal Select Replace with

Switch specific resources: replace a user, 

in a specific role, with another user for all 

tasks in the project.

task member/reviewer = Karen

role = Project Manager

Connie Contact

Switch specific users: replace a user, 

anywhere on the project, regardless of 

role.

task member/reviewer = Karen

role = Any Role

Mary Manager

Add a backup to a role: add another 

person to a role, as a backup or extra 

resource.

task member/reviewer = Karen

role = Project Manager

Connie Contact

Assign tasks to a role: newly assign a user 

to tasks, by role.

task member/reviewer = Any User

role = Project Manager

Mary Manager

Note:  To delegate tasks to another user temporarily, each user can define Out of Office settings. For more 

information, see Defining Out-of-office settings  on page 24.

The components tools help you refine your search.

• Filters: Filter the search by role, task member, or a date range.

• Preview and Update search Buttons: Preview and update the search.

• Search results: Displays tasks that meet the search criteria. Use it as a preview of the tasks that change if you click 

Update All Occurrences.
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Filters

Use the top-most fields in the Find and Replace Task Members/Reviewers dialog to filter the results. You can search by role, 

task member, or project date ranges.

Table  35. Filters on the Find and Replace Task Members/Reviewers dialog

Field Description

Task member or 

reviewer is

Select the name of the member to replace.

The list contains all team members and reviewers on the project. It also contains a choice for "any 

user", which is the default.

Role is Select the role of the task member to replace.

The list contains all roles in the project, and also contains a choice for "any role", which is the 

default.

Date Constraint Check this box to search by using a date range. If selected, you can choose the following 

information.

• Type of task: supply the type of date to search, either forecast or target, in the for tasks 

box.

• Range: choose dates for the search range.

Status Select the status on which to filter. You can choose Pending/NotStarted, Active/In progress, or 

both.

Replace with/Add this 

task member

Select one of the radio buttons, depending on whether to replace or add members/reviewers. 

Then, enter the person that you want to fill the selected role on the tasks in the search results.

Buttons

Table  36. Buttons on the Find and Replace Task Members/Reviewers dialog

Button Description

Find All Occurrences Preview search results. You can view the list of tasks that meet your search criteria in the Search 

Results area of the page.

Update All Occurrences Update members, after you confirm that the list of tasks is correct. As a best practice, click Find 

All Occurrences  before you start the update.

Cancel Close the page without any changes.
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Select project members and reviewers  page
The Select Project Members  page appears when you are adding or removing project members, and the Select Reviewers 

page appears when you are adding or removing reviewers.

Note:  You might see only a subset of the people and teams available in Unica Plan, since your organization can limit 

the view of available resources.

Table  37. Fields on the Select Project Members/Reviewers page

Field Description

Available resources Displays a list of users you can choose from.

• The list of people is set up by an administrator in Unica Platform.

• The list of teams is based on the teams defined in Unica Plan.

Roles Displays a list of roles in your system in alphabetical order. It is set up by an administrator and 

contains all the roles defined in Unica Platform  and Unica Plan  template files.

In the Select Project Members  or Select Reviewers  page, use the Roles tab to add roles for the 

members and reviewers.

Selected Project 

Members / Reviewers

Displays the current list of members or reviewers for the project. You can move people and roles 

to and from the list and reorder them using the buttons.

Note:  An asterisk (*) next to a role indicates that the role is used in the workflow, and therefore cannot be deleted.

Managing reviewers
Reviewers are different from project members because they do not have access to the project. Reviewers approve other 

project members work. Both reviewer roles and users are defined in the People tab for use in the workflow, mostly for 

approval tasks.

About this task

Use the  Select Reviewers  page to perform the following tasks.

• Add a reviewer

• Remove a reviewer from the project

• Change the role for a reviewer

1. Go to the People tab for the project.

2. Click Manage roles  > Reviewers.

3. In the Selected Reviewers list box, select a person or team.
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4. Take one of the following actions.

◦ To add the person or team to the project, select them from the left pane of the page, and click >>  to move 

them to the right pane. The right pane contains people and teams who are active on the project.

◦ To remove the person or team from the project, click <<. This action moves the person or team back to the 

inactive pane.

◦ To change the role for a person or team, use the Up  and Down  controls to move them to the necessary role.

5. Click Save Changes.

Results

The Select Team Reviewers dialog box closes and your changes are applied. The People tab becomes active.

Object access levels
Access levels are default roles that exist for different types of objects. For example, a project has an owner, a participant, 

a requester, and an approver. A request has an owner and recipient. While the names of the object access roles are fixed, 

the security permissions granted by them depends on the security policy assigned to the object. In other words, different 

members of a project might need different access roles. Object access roles are also sometimes called access levels.

Unica Plan  is a collaborative tool, and users might need varying degrees of access to projects. With Unica Plan, you can 

assign different object access roles to project members.

Unica Plan  objects contain the following access levels.

Table  38. Object access levels

Access level Description

Owner All object types have owners, usually the person who created the object. Owners can typically take 

any action that is associated with an object, such as adding members to the team or editing the 

properties of the object.

Participant
Participants can typically view the object, but not edit it.

For projects, when the wizard creates a project, all members added to the project become 

participants by default.

Requester (projects 

only)
Requesters can typically view the project, but not edit it.

If you create a project from a request, the owner of the request becomes the requester of the 

project.

Recipient (requests 

only)

Recipients can accept or return a request. A requester submits a request to the recipient, who 

then decides what to do with the request.

Approver (approvals 

only)

Approvers can approve, deny, or suggest changes to an approval assigned to them.
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Sometimes, a project owner needs to change the access levels of a member or members. For example, after you assign 

people to roles, there are many people with the Participant access level. You can grant some of them owner-level access or 

deny some of them even participant privileges.

Roles and permissions
Different users and roles have different permissions.

Note:  If you need help with permissions, talk to your Unica Plan  administrator.

The following list describes the permissions:

• View People tab

Users with this permission can view the People  tab.

• Edit Team Members, Roles, and Access Levels

Users with this permission can edit members, roles, and access levels.

• Assign Work by Role

Users with this permission can assign tasks to roles and people, and access the Assign Work by Role  and Find/

Replace  dialog boxes.

Assigning work by role
Typically, at the beginning of a project, the project owner or manager assigns work to the members of their team.

About this task

Note the following issues when you assign work:

• When you access the Assign All team members and reviewers to their respective tasks  dialog, the project workflow 

is locked. Any other user who attempts to access it receives a warning message, indicating that the workflow is in 

use.

• Only tasks with a status of Pending have people who are assigned to them. All other tasks remain unchanged.

To assign work by role, complete the following steps.

1. Click Manage roles  > Assign work by role.

Note:  If the project started, a warning dialog box appears. Click  OK  to proceed or Cancel  to cancel the 

assignment process.

Result
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The Assign All team members and reviewers to their respective tasks  page appears.

2. Select one of the following options:

Choose from:

◦ To add members to the existing assignments, select append the new user.

◦ To replace anyone who is in a role, select replace the existing assignment.

3. Click OK.

Result

A confirmation dialog box appears.

4. Click Close.

Results

In the workflow, all users who are assigned to roles are also assigned to the tasks associated with their roles.

Removing a role
You can remove member and reviewer roles from projects.

Before you begin

If you are removing a role, note the following issues:

• If you delete a role that has people or teams assigned to it, they are not removed from the project. Instead, they are 

reassigned to the Unassigned role.

• The Unassigned role cannot be removed.

• You cannot remove a role that has work assigned to it. You must first either assign a person or team to that role, or 

assign the work to a different role.

• You cannot remove a user who is assigned to a workflow task.

1. Navigate to the People  tab for the project.

2. You can remove a member or a reviewer role.

Choose from:

◦ To remove a member role, click Manage roles  > Members.

◦ To remove a reviewer role, click Manage roles  > Reviewers.

3. Select a role to remove, and click <<.

If the role selected for removal has people or teams assigned, a warning dialog box opens. Click OK  to remove the 

role, or Cancel  to keep it.

4. Click Save Changes.

Results
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The Select Project Members/Reviewers  dialog box closes. The People  tab becomes the active window. Your changes are 

reflected in the list of people and roles.

Adding a role
A project owner or manager might realize that the project needs another project role. For example, the organization decides 

that a certain project needs the Legal department to approve its collateral. If this role is not added when the project is 

created, the project owner can add it to the project later.

About this task

Note the following issues when you add roles:

• You cannot add a role that already exists in the project. However, this action does not result in a duplicate or copy of 

the role.

• Permissions based on project roles can be configured at the template level only. You cannot configure custom 

security for project roles that are added to a project after the project was created.

• A project role must exist before you can add it to a project. To create a project role, select Administration  > List 

Definitions  > Roles. You must have the appropriate permission to access this item. Then, you can add the role to your 

project by using the steps that follow.

1. Navigate to the People  tab for the project.

2. You can add a member or reviewer role.

Choose from:

◦ To add a member role, click Manage roles  > Members.

◦ To add a reviewer role, click Manage roles  > Reviewers.

3. Click the Roles  tab in the list box on the left side of the page.

4. Select a role to add, and click >>.

5. Click Save Changes.

Results

The Select Project Members/Reviewers  dialog box closes. The People  tab becomes the active window. Your changes are 

reflected in the list of people and roles.

Assigning people to roles
Roles define tasks and permissions in projects. Assign users to roles before starting work on a project.

Before you begin

Before you can complete this task, the workflow must be set up to include the necessary tasks and approvals, and a role 

must be assigned to each task that should have one. The requirements for a project derive from the template that it is based 

on.

About this task
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Note the following behavior.

• Administrators create roles using the List Definitions section of the Administration menu item.

• The list of people in the Team members section of the Select Project Members page is populated from Unica 

Platform, and may be limited based on your role and permissions. For details, consult your Unica Plan  administrator 

or the Unica Platform  Administration Guide.

• Administrators can define assignments using the Request tab of the template. Therefore some roles can be pre-

assigned.

• The list of teams in the Select Project Members page is based on the teams that defined in Unica Plan. As with the 

list of people, the teams you can view may be limited based on your role and permissions.

1. Go to the People tab of the project.

2. You can assign work to project members or reviewers.

◦ Click Manage roles  > Members  to add project members.

◦ Click Manage roles  > Reviewers  to add reviewers.

Result

The Select Project Members or Select Reviewers dialog box appears.

Note:  If the template used to create the project already contains the necessary roles, skip the next step.

3. Click the Roles tab on the left side of the dialog and add all the roles you might need for the project.

4. In the Selected Team Members/Reviewers list box, select the role you want to assign.

5. Click the Available resources  tab, and navigate to the person or team to assign.

6. Select the person or team and click >>.

Result

The selected person or team is assigned to the selected role.

7. Repeat Steps 4 through 6 until each member and reviewer role has at least one person or team assigned to it.

8. Click Save Changes.
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Historically, organizations produced paper-based calendars and updated them with the latest information. The calendar 

feature provides marketing groups with electronic means to view and update calendar data.

Field marketers and corporate marketers can use the Unica Plan calendar to view the time horizon for marketing campaigns.

Marketing organizations typically organize their work with calendars. For example, seasonal events drive marketing 

programs, and other external dates, such as store openings, and seasonal product announcements.

You can use the calendar as an aid for planning marketing campaigns.

• You can view and update the timelines for Lists.

• You can get an up-to-date view of planned or run marketing efforts over time.

You can customize the appearance of the calendar in the following ways.

• You can set a default view of the calendar: Click Settings > Unica Plan  Settings > Calendar/Timeline Settings.

• You can choose the look of the calendar in the Set View options  dialog box. In Unica Plan 12.1.3, we have introduced 

a new option for Display as  named Enhanced calendar.

• You can filter the items that are displayed on the calendar with Advanced Search.

Customizing the calendar appearance
The calendar displays a time-centric view of your business processes. You can customize the appearance of the calendar to 

suit the needs of your organization.

About this task

When you view the calendar, its appearance depends on several options that you can set.

• Open the calendar by selecting Local Marketing  > Calendar  Operations  > Calendar.

• To change to the calendar view from the list pages for Projects, Programs, Plans, and Tasks, click View Options.

• To change to the calendar view from the list pages for projectss, click View Options.

• To set the default appearance for the calendar, use the Calendar/Timeline Settings  page. Select Settings  >  Unica 

Plan  Settings  > Calendar/Timeline Settings.

• To change calendar appearance, select Operations  > Calendar. Then, click View Options  ( ).

• To choose the type of calendar (timeline, text calendar, or graphical calendar) and the time scale (such as fiscal year, 

quarter, or month), click View Options.

Calendar display options
You can customize the appearance of the calendar and timeline to suit your needs.

You can set the appearance of the calendar in the following ways:
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• Set an initial, default view of the calendar.

• Change options while you view the calendar.

You set the default view on the Calendar/Timeline Settings  page (Settings  >  Unica Plan  Settings  > Calendar/Timeline 

Settings).

Table  39. Fields on the Calendar/Timeline Settings page

Field Description

Include Weekend Days You can choose whether the calendar shows a five-day week or a seven-day week with this 

option.

Select Yes  to display a seven-day week.

Weeks Should Begin On You can specify whether the calendar displays Monday as the first day or Sunday as the first day, 

even if weekends are shown on the calendar.

Select either Sunday or Monday. Sunday is the default.

Default Content of 

Calendar Section

You can choose the objects to display on the calendar. Select:

• Plans (the default)

• Projects

• Tasks

• Programs

Default Search of 

Calendar Section

Selects the filter for the objects that display on the calendar.

Select a saved search to be the default when you click the Calendar  menu item. The list of 

available items depends on which objects you selected for the Default Content  field. For example, 

if you selected Projects for the default content, you can choose Active Projects for the default 

search.For example, if you selected Corporate Campaigns for the default content, you can choose 

Active Projects for the default search.

Display the timezone 

for the logged in user

Displays the timezone in which all times are shown in workflow columns.

If you have users in many locales, selecting this option can help you track of work across different 

timezones. If all your users are in the same timezone, you can turn this option off to save screen 

space.

The following parameters are available on both the Calendar/Timeline Settings  page and on the Set View Options dialog that 

opens when you click Options  (Local Marketing  > Calendar  Operations  > Calendar  or list pages).
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Table  40. Fields on the Calendar/Timeline Settings page and Set View Options dialog box

Field Description

Default Layout of 

Calendar Section |

Display as / Time Scale

On the Calendar/Timeline Settings  page, you use this option to choose timeline view and a time 

range to display, or a one month text or graphical calendar.

On the Set View Options  dialog, you use the Display as  and Time Scale  fields to make these 

selections. In Unica Plan 12.1.3, we have introduced a new option for Display as  named Enhanced 

calendar.

In version 12.1.3, the Enhanced calendar option is available only for the Task list object for 

registered searches and customized searches. The Enhanced calendar option will not be available 

for Projects or any other object lists. Additionally, if you filter Task list or Task calendar using a 

temporary filter, the Enhanced calendar option will not be available.

If you select the Enhanced calendar option it disables the field and the reset button disappears. 

You cannot use Enhanced calendar option to make any temporary changes in the fields values. 

The default values will be the ones that you have set in Plan Settings.

Enable Color Coding Color codes the calendar based on an attribute you select. Check this box, and then select the 

attribute to use for color coding objects on the calendar.

When displaying 

tasks, only show 

milestonesShow only 

selected milestone 

types in tasks

Limits the amount of information to show when the calendar displays tasks. Check this box, and 

then choose the milestone types to display. Only the selected milestone types display.

The following option is available only on the Set View Options  dialog when selected for tasks.

Table  41. Fields on the Set View Options dialog box

Field Description

Brief/Detailed Determines the amount of information that is displayed for tasks. This option is available for 

tasks only.

Setting your default calendar options

About this task

You set all available options for the calendar by using the Calendar/Timeline Settings page. The settings that you choose 

remain in effect between your sessions. That is, if you log out of Unica  and then log back in later, your calendar appears with 

the options you last set on this screen
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1. Select Settings  > Unica Plan  Settings.

2. Click Calendar/Timeline Settings.

Result

The Calendar/Timeline Settings page appears.

3. Supply the details on the Calendar/Timeline Settings page.

4. Do one of the following actions:

◦ Click Save Changes  to save your changes.

◦ Click Revert to Saved  to discard your changes, and reload the settings from your previous save.

◦ Click Cancel  to exit the page.

Changing your view of the calendar
You can temporarily change your view of the calendar, but the changes do not persist for your next session.

About this task

You can access the different views of the calendar by clicking View  ( ) on the Calendar  page.

1. Select Operations > Calendar.

Result

The calendar appears in the default view. This view depends on settings in the Calendar/Timeline Settings page.

2. Click View  ( ).

3. Supply the details on the Set View Options  dialog box. In Unica Plan 12.1.3, we have introduced a new option for 

Display as  named Enhanced calendar.

4. Take one of the following actions.

◦ Click Apply  to view your changes.

◦ Click Reset  to discard changes.

◦ Click Close  to exit the screen.

Results

Your changes are applied. However, unlike the Calendar/Timeline Settings  page, the changes you make here do not persist. 

After you leave the Calendar  page, your settings return to the default values.

Timeline view of the calendar
If you choose a timeline view, you can choose from several date ranges. The screen can display data for a single week, up to 

data for an entire year.

The timeline view displays a grid-like view of the objects, such as projects, programs, or plans that you selected and filtered 

(for example, Active Projects). The objects are organized by a unit of time, depending on which timeline view you selected.
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Each object is displayed in a horizontal bar across its date range. The name of the object displays on the bar.

Note:  If you select Enable Color Coding  from the calendar view options screen, the bar for each object is displayed in 

a color that is based on an attribute you chose.

Choose a date-range for the timeline.

• Week: displays one week, with each day listed as a column. The starting day is either Sunday or Monday depending 

on the option that is selected in the Calendar/Timeline Settings  page.

• Month: displays a single calendar month. Each day is listed as a column, and days are grouped into weeks.

• Quarter: displays three calendar months. Each week is listed as a column, and those weeks are grouped into months.

• Fiscal Year: displays a fiscal year. The starting month depends on a configuration setting, firstMonthInFiscalYear. 

Each month is listed as a column, and the months are grouped into quarters.

• Calendar Year: displays a calendar year, which starts in January and ends in December. Each month is listed as a 

column, and the months are grouped into quarters.

Note:  Any day that is specified as non-work time has its column that is disabled. Additionally, the name of the non-

work time (for example, "Labor Day") displays when you point to the date. This feature is not available when the time 

scale is Quarter, Fiscal Year, or Calendar Year.

Text or graphical calendar views
The calendar views display data for a selected month. The view contains a cell for each day of the selected month. The 

cell for a day contains either a list of items active on the day (text) or a portion of a horizontal bar for each active item 

(graphical).

The page displays a grid that contains a column for each day of the week: either five columns that represent the weekdays, 

or seven, if you choose to display weekend days. You set this option on the Calendar/Timeline Settings  page. The page 

contains either five or six rows, each representing a week.

Monthly calendar
The monthly calendar view displays a calendar of the selected month. It lists the objects (Projects, Programs, or Plans)  you 

selected and filtered on  (for example, Active Projects).

Choose either of these monthly calendar views.

• 1-Month Text: Each day contains a list of objects. An object is displayed for all days in its date range.

• 1-Month Graphical: Each object is displayed in a horizontal bar that begins on its start date and ends on it end date. 

If you select Enable Color Coding  from the calendar view options page, the bar for each object appears in a different 

color.
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Note:  Any day that is specified as non-work time is indicated by a gray X in the background. Additionally, the name of 

the non-work time (for example, "Labor Day") displays when you point to the date.

Calendar color coding
You can display objects in a color-coded manner on either the graphical calendar or in the timeline views.

First, select the Enable Color Coding  check box in either the Calendar/Timeline Settings  page or the Set View Options  dialog 

box. After you check the box, the Based on values for  menu opens. This list contains attributes for your projects, programs, 

or plans (depending on which objects you are currently displaying in the calendar).

From this list, you can choose any attribute that is an enumerated type. For example, consider the following attribute:

• Name: Product Family

• Valid values: CDs, Credit Card, Home Mortgage

If you choose to group objects by this attribute, your calendar contains four colors: one for each valid value, CDs, Credit Card, 

and Home Mortgage, and N/A. N/A  corresponds to any objects that do not contain a value for the Product Family attribute.

The calendar also displays a legend in the lower-right corner of the screen. The legend lists all valid values (CDs, Credit Card, 

and Home Mortgage, and N/A) along with the color corresponding to that value.

Note:  You can also color code by the template on which the project or program is based.

Horizontal bars on the calendar
The timeline view and graphical calendar view display horizontal bars. The bars help illustrate the duration and dates of 

calendar objects.

Note the following information.

• The bars represent the date range for objects that are displayed on the calendar.

• The name of the object displays on the bar.

• The bars can be colored based on an attribute you select.

• The shapes of the bars indicate the following conditions of the object.

◦ Rounded-end "start": indicates that the object starts on the date where the bar has a rounded end.

◦ Rounded-end "end": indicates that the object ends on the date where the bar has a rounded end.

◦ Flat-end "start": indicates that the object starts before the visible date range.

◦ Flat-end "end": indicates that the object ends after the visible date range.

Brief and detailed views of tasks
The brief view mode contains only the most essential information about a task: the task name and task ID. Detailed mode 

contains additional information about the project to which the task belongs. Use the Set View Options  dialog box or the 

Calendar/Timeline Settings  page to choose brief or detailed mode to view information about tasks on the calendar.
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Brief mode is the default. Brief view mode presents only the most essential information and can reduce clutter. In brief mode, 

the calendar text contains the following items.

• Task ( ) or approval ( ) symbol

• Task ID

• Name of the task

Detailed mode provides all important information at a glance. In detailed mode, the text contains the following items.

• Task ( ) or approval ( ) symbol

• Name for the project that contains the task

• Code for the project that contains the task

• Task ID

• Name of the task

Publishing the calendar
You can save a snapshot of the calendar at a certain moment in time. When you publish the calendar, you chose which 

information you want to display and how you want to display it.

About this task

To get a snapshot of the current calendar, save it in HTML format (into a ZIP compressed archive file).

1. Choose the calendar view to publish.

Select the objects, time range, and appearance for the calendar view. You can make selections in either of the 

following ways:

◦ From the Operations  menu, select Calendar. Then, select items to view.

◦ At a list page for plans, programs, projects, or tasks, click the View  icon ( ) and choose a calendar view.

Note:  If the current calendar view includes projects, Project data is exported as well. The exact data that is 

exported depends on how the project template was set up; Summary and custom tabs might be exported for 

some or all projects.

2. Click the Print  icon ( ) and select Export.

3. Take one of the following actions.

◦ Click Open  to open the compressed file of the calendar.

◦ Click Save  and choose a location to save the calendar to disk.

◦ Click Cancel  to return to the Calendar  page without publishing.

197



Unica Plan V12.1.7 User's Guide

198

Results

The system publishes the calendar into a compressed file archive. You can use any application for working with compressed 

files to access the calendar HTML pages. You can go to the next and previous pages of the calendar view in your web 

browser. If you exported any project data, you can also go to that data from the calendar HTML pages.
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A grid is a spreadsheet-like presentation of data. Grids allow Unica Plan  users to store all campaign- and project-related data 

within the project.

With grids, users no longer need to search through email, a file folder, or another computer to find information about 

a campaign or project. Unica Plan  serves as the system of record and offers enterprise-wide access to data stored in 

grids. Any Unica Plan  user who has access to the project can view and edit the grid, if that user has appropriate security 

permissions.

Users can move the traditional spreadsheet information into a grid within Unica Plan. Then, marketing managers can analyze, 

measure, and report on the project- and campaign-related information within and across multiple projects or campaigns.

Depending on how your templates are defined, grids can appear on marketing object, plan, program, and project tabs. 

Campaign projects include a TCS®  tab that displays a special grid that is called the Target Cell Spreadsheet (TCS®). You can 

create campaign projects only if Unica Plan-Unica Campaign  integration is enabled.

A template creator configures grids, specifying the data source, whether data is grouped, whether a user can sort the data, 

and other grid characteristics. Then, administrators and users can use them when they create marketing object tabs and 

project tabs.

A grid can also be read-only, displaying data that you cannot edit.

Grid edit mode
When you work with grids in edit mode, you can add rows, delete rows, and edit existing data. In a single editing session, you 

can do all of these tasks if you have the appropriate permissions.

Permissions

You must have the following permissions to work with grids. Ask your administrator if you need help.

• To add a row, you must have the View Tab, Edit Tab, Edit Grid, and Add Grid Row permissions for the tab with the grid.

• To edit a row, you must have the View Tab, Edit Tab, and Edit Grid permissions for the tab with the grid.

• To copy and paste a row, you must have the View Tab, Edit Tab, and Edit Grid permissions for the tab with the grid.

• To delete a row, you must have the View Tab, Edit Tab, Edit Grid Row, and Delete Grid row permissions for the tab with 

the grid.

Locked data

The system prevents you from editing a row that is being edited by another user. For a Target Cell Spreadsheet in a campaign 

project, the entire grid is locked for editing instead of individual grid rows.

Revision history

Unica Plan  maintains an audit log for grids. The audit log contains the user details and the time it was saved. This 

information is available on the Analysis tab.
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Grid controls
You use a consistent set of controls to organize grids, such as sort ascending.

The following tables describe the controls you use when working with grids in the View and Edit modes.

The following features are available in both modes.

• Data displays in pages. To navigate, click the arrows to go to the next, previous, first, and last pages, or enter a 

number in the box and press Enter.

• You can sort by column by pointing to the column heading, clicking the down arrow, and selecting Sort Ascending 

or Sort Descending  in the drop-down menu. Depending on how the grid was designed, some columns do not have 

sorting enabled.

• You can view or hide columns by pointing to any column heading, clicking the down arrow, pointing to Columns  in the 

menu, and selecting or clearing the check box next to the column name.

• You can reorder columns by dragging and dropping the column heading. (This ability is not available in grids that 

have column grouping.)

• You can change column width by dragging the edge of the column headings.

View mode

Table  42. View mode controls

Control Description

Switch to Edit mode.

Copy selected grid rows. Click in the first column to select a row.

Import a CSV file that contains grid rows.

Export all the data in the grid in a comma-separated list.

Use advanced search to filter grid data.

Select the calculation used for each column in the Summary row. The options are: Sum, 

Avg (average), Min (lowest value in the column), and Max (highest value in the column). In a 

multi-page grid, calculations are performed across all the data, not just for individual pages. This 

control is available only in view mode.

Save Preferences Save your customized view of the grid.

In addition, the following controls are available for the Target Cell Spreadsheet (TCS®) available in campaign projects. You 

can create campaign projects only if Unica Plan-Unica Campaign  integration is enabled.
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Table  43. View mode controls (Target Cell Spreadsheet grids only)

Control Description

Approve All Approve all the rows in the TCS®.

Deny All Deny approval to all the rows in the TCS®.

Clear All Delete all the rows in the TCS®.

Publish Send the current TCS®  data to Unica Campaign  so the flowchart designer can access it.

Get cell status Retrieve the latest flowchart and cell count information from Unica Campaign.

Edit mode

In edit mode, you can click single line text, multi-line text, or numeric and money type column contents, and then begin typing 

to overwrite existing data. For any editable column, you can double-click a cell to open the content editor for that column 

type.

If the row is currently in use by another user, the system displays an error message. Before you save your changes, edited 

cells contain a small red triangle in the corner; these markers disappear after you save.

Table  44. Edit mode controls

Control Description

Add a row. The row is added below the currently selected row. The first row is selected by default 

when you enter edit mode.

Copy selected grid rows. To select a row, click in the first column.

Paste grid cells and rows.

Mark a selected row for deletion. The row is deleted when you save. Within a row, the same icon 

indicates the row status.

Unmark a selected row for deletion. Within a row, the same icon indicates the row status.

Save your changes and remain in edit mode.

Save your changes and return to view mode.

Revert all changes made since your last save and return to view mode.

Importing grid data
To quickly add data to a grid, use the import feature. You can import data to a grid in comma-separated value (.csv) format.
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1. Go to the grid that you want to import.

2. Click Import  ( ).

3. Browse to the CSV file that contains the data to import.

4. If the first row of the file contains header information, select the First row is header row  box.

5. Click Save  to import the file or Cancel  to quit the import process.

If the CSV data does not match the number and data type of the grid columns, you receive an error message. The 

message describes the differences between the grid and the CSV file.

6. Click Finish  to close the dialog and return to the grid tab.

Exporting grid data
You can export grid value to use it elsewhere in the product.

About this task

You can export grid data in comma-separated value (.csv) format. Note the following criteria.

• All pages (if the data is paginated) are exported.

• All rows except the Summary row are exported.

• All columns (including hidden columns) are exported.

• Exported rows are in the same order as in the current view. If you are viewing the grid alphabetized by ID, the exported 

data is also alphabetized by ID.

1. Go to the grid to export.

2. Click the Export  icon ( ).

3. In the File Download dialog box, choose one of the following.

◦ Click Open  to display the file in Microsoft™  Excel.

◦ Click Save  to save the file to disk.

◦ Click Cancel  to close the dialog box without exporting the data.

Posting read-only grid data to URLs
You can select rows of a read-only grid to post to a URL.

About this task

If the template creator enables a read-only grid for data that you are posting, the screen contains a Post Data  link.

1. Go to the read-only grid that contains the data you want to post.

2. If the grid contains more than one page, click Show All  to view the entire grid on the screen.

3. Check the box for each row you want to post.
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Note:  As a shortcut, you can check the box in the grid header to select all currently displayed rows.

4. Click Post Data.

Unica Plan  calls the specified URL with the selected data.

Grouping read-only grid data
If the template enables data grouping for a read-only grid, you can group data in the grid by any of its columns.

About this task

To group read-only grid data, complete the following steps.

1. Navigate to the read-only grid you want to view.

2. Click View.

3. Check Enable Grouping. To turn off grouping, clear this field.

4. In the Group By Column  field, select the column for grouping.

5. Click Apply  to save your changes and close the dialog box.
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Chapter 11. Marketing objects
A marketing object is any work product a team develops and reuses in the course of its marketing activities. Marketing 

objects can represent physical items (such as a letter or banner ad) or a business component (such as a credit card offer, a 

target segment definition, or a rewards program definition).

You can create new marketing objects if you have permission to do so. After you create a marketing object, you can start it at 

any time. Starting the marketing object makes it active.

• You define and manage marketing objects that represent all reusable work products.

• You can perform basic operations (create, edit, change state, copy, link, and delete) on marketing objects.

• You enter and manage all of the attributes that define a particular marketing object, such as name, owner, state/

status, description.

• You can define and manage business processes (such as projects) that produce, modify, and retire marketing 

objects.

• You can construct robust projects that define multiple marketing activities by "assembling" each discrete marketing 

activity from existing marketing objects.

Unica Plan  marketing objects are defined in stages, and how they are defined influences how they are organized and 

presented to users. The following terms are important in understanding the definition and organization of marketing objects.

Marketing object type

A marketing object type is the highest-level division for marketing objects. An administrator creates marketing object types. 

Each marketing object type has a menu item, but the menu on which it appears depends on how the administrator configured 

the marketing object type.

Marketing object template

A marketing object type is broken down into one or more marketing object templates. Typically, an administrator creates a 

marketing object template for each significant characteristic for the marketing object type.

Marketing object instance

A marketing object instance is a single marketing object. Users with appropriate security permissions create marketing 

object instances from marketing object templates. Within Unica Plan, marketing object instances are called "marketing 

objects".

Offer object type
Depending on whether you only installed Unica Plan  or if you integrated Unica Campaign, you have different options for offer 

objects.

If your installation contains only Unica Plan, your system administrators can set up a custom marketing object type to 

represent offers or promotions. However, if Unica Plan  is integrated with Unica Campaign, your installation includes a 

system-provided marketing object named "offer."
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When Unica Plan  is integrated with Unica Campaign, there are two options for offer management:

• If your system is configured with optional offer integration enabled, offers are managed through Unica Plan. Use the 

Offers  option from the Operations  menu. For information about creating offers in this way, see the Unica Plan  and 

Unica Campaign  Integration Guide.

• If your system is configured so that offer integration is not enabled, offers are managed through Unica Campaign. 

Use the Offers  option from the Campaign  menu. For information about creating offers in this way, see the "Offers" 

chapter in the Unica Campaign  User Guide.

Ask your system administrator about how your system is configured for offer management.

Creating marketing objects
Marketing object types are specific to each organization. The marketing object types that are available to you and how they 

are organized on the menus depend upon your template creator.

Before you begin

You must have the appropriate permission to add a marketing object. When you add a marketing object, you become an 

owner of that marketing object.

1. From the menus, select the marketing object type that you want to create.

Result

The list page for that marketing object type appears.

2. Click the Creation  icon.

Result

The Select a Template  dialog box appears, containing all the templates available for this marketing object type.

3. Select a template and click Continue.

Result

The first step of the wizard for the selected marketing object template appears.

Note:  Each marketing object can contain any number of custom pages and fields. All marketing object 

templates contain at least one page, with a name, membership list, and security policy field, as a minimum.

4. Follow the wizard, entering information on each page.

5. When you finish configuring your object, take one of the following actions.

◦ Click Finish  to save the object. The system displays the list page for the marketing object type, with the new 

marketing object included in the list.

◦ To create another object that is similar to the one you created, click Save and Duplicate. The current object is 

saved, and you then see the Summary  page of a new object, with data already populated. Change the default 

name and edit the new object as needed.
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Marketing object cross-reference report
All projects and marketing objects contain a report that describes cross-references to and from other marketing objects. This 

report appears on the Analysis tab, and is titled "Marketing Object Cross-Reference."

For projects, the report contains the following sections.

• Marketing objects that are referenced by this project

• Marketing objects that are modified by this project

For marketing objects, the report contains the following sections.

• Marketing Objects that Reference This Item: other marketing objects that contain a link to this marketing object.

• Marketing Objects that This Item References: other marketing objects to which this marketing object links.

• Projects that Modify This item: projects that can change this marketing object.

• Projects that Refer to This Item: projects that contain a link to this marketing object including offers. Marketers can 

see the list of Campaign Projects where an offer or offer list is referenced. The information can be useful when the 

user wishes to update, cancel or delete an offer or an offer list.

• Approvals that Refer to This Item: approvals that contain a link to this marketing object.

Modifies and references relationships
Some projects reference or modify other marketing objects.

Whether a project references or modifies a marketing object is determined by how the template creator configured the 

marketing object reference field.

• Modifies: The project or marketing object that contains this marketing object is intended to change or update 

the contents of a marketing object. For example a Change Order or Work Request project, modifies the project or 

marketing object.

• References: The project or marketing object that contains this marketing object does not change it, but references it 

only.

Select marketing objects
You select marketing objects by checking boxes on the Marketing Objects  list page.

When you select check boxes on the Marketing Objects  list page, Unica Plan  retains your selections during a session as 

follows.



Chapter 11. Marketing objects

• In View mode, your check box selections are retained until you go to a list page for a different object. For example, 

if you make a selection on page 1 of a multi-page project list, go to page 2, and back to page 1, your selections are 

retained. Your selections are retained whether you move between pages by clicking the number at the bottom of the 

page or opening the Recent  menu. However, your selections are discarded if you navigate to the Tasks  page.

• If you edit a marketing object by clicking the Edit a Tab  icon on the list page, your selections are retained if you click 

Save and Return to List.

Deleting marketing objects
If you no longer need a marketing object, you can delete it.

Before you begin

You cannot delete a marketing object if a project or another marketing object is linked to it. You must first remove the link 

before you delete the marketing object.

1. From the menu, select the marketing object type of the marketing object that you want to delete.

2. Select the check box next to each marketing object that you want to delete.

3. Click Delete this Item  ( ) in the left toolbar.

4. When Unica Plan  prompts you to verify that you want to delete the marketing objects, click OK.

What to do next

You can also delete a marketing object from its Summary tab. To do so, click the Delete this Item  icon ( ) in the Unica 

Plan  toolbar.

Adding marketing object references to forms or grid rows
Forms and grids can contain columns that hold references to marketing objects. Unica Plan  makes it easy to find the specific 

marketing object to reference in such a column.

About this task

Note the following behaviors:

• For simple searches, attributes of linked marketing objects are not searched.

• Fields that hold marketing object references can be set up so they are limited to holding one particular type of 

marketing object, such as Offer Letters. In this case, the Browse  tab contains only those saved searches that apply to 

that particular marketing object type.

1. Go to a form or a grid that contains a field or column to hold a marketing object reference.

2. If the marketing object reference field is on a form, switch to the Edit  tab. In the Marketing Object reference  field, 

click Select.

3. If the marketing object reference field is on a grid, do one of the following actions:
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Choose from:

◦ To add a row, switch to Edit mode and click the Add Row  icon. Then, double-click the Marketing Object 

column cell.

◦ To edit an existing row, switch to Edit mode. Then, double-click the Marketing Object  column cell.

Result

A dialog box appears for the Marketing Object search.

4. To complete a search, choose one of the tabs.

Choose from:

◦ To do a simple search for a marketing object: In the Search  tab, type your search criteria. The system 

searches all of the marketing object attributes to match your criteria. All attributes are searched except for 

attributes of linked marketing objects.

◦ To use a predefined search for a marketing object: In the Browse  tab, select a predefined saved search.

Result

The system returns the results of your search.

5. To accept a marketing object, select the object and click one of the available options:

Choose from:

◦ To accept the selected object and close the dialog box, click Accept and Close.

◦ To accept the selected object and continue selecting objects, click Accept.

◦ To close the dialog without choosing the selected object, click Close.

Result

The marketing object that you selected appears in the marketing object reference field. If you selected more than one 

object, and the field accepts multiple marketing objects, then all the objects you selected are listed.

Marketing object references in approvals
You add marketing object references to approvals in the same way you add them to forms and grid fields. However, the 

options for searching for marketing objects are slightly different.

Simple search (Search tab)

The simple search screen in the marketing object selection box for approvals contains an extra drop-down list. You use this 

control to select a single type of marketing object for your search. You must select one type of marketing object before you 

can begin the search.

Saved search (Browse tab)

The drop-down list of saved searches contains previously saved searches for all enabled marketing object types. For 

example, if you have marketing object types for Creatives and Envelopes, all saved searches for Creatives and Envelopes 

appear in the list.
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Unica Plan  provides centralized management, secure storage, and web-based access for digital assets.

In Unica Plan, you store your assets in libraries.

• An asset library is the highest level organizational structure in the digital asset repository.

• You can access libraries and add assets to the libraries if your Unica Plan  administrator grants you permission in the 

security policy that is assigned to the asset).

• You can organize assets by using folders.

• You can view all the assets that you own.

• If you do not own an asset, you can view it when it has a status of finalized.

• You must have administrative access to Unica Plan  to create a library.

You can view assets in a library in either a list view or thumbnail view. By default, Unica Plan  displays assets in a list view 

when you select an asset library.

Table  45. Views for assets

View Description

Asset List Displays all the assets in the current library, listed alphabetically in ascending order. Change the order by 

clicking on the Name  column.

To sort by any of the other columns, click that column. Click the column a second time to change the order of 

the column from ascending to descending.

Asset 

Thumbnails

Displays a thumbnail image for each asset in the library. You can upload a thumbnail image for an asset 

when you add the asset to a library.

Asset libraries
Digital assets are stored in libraries, which are the top-level organizational structure in the digital asset repository.

You can access libraries and add assets to the libraries. You can access a library only if your Unica Plan  administrator grants 

you permission in the security policy that is assigned to the asset.

After you click the library that contains assets or folders you want to view, the Asset List  page appears.

Note:  You must have administrative access to Unica Plan  to create a library.

Changing from asset list view to thumbnail view
By default, Unica Plan  displays assets in a list view when you select an asset library.

About this task
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To change to a thumbnail view, complete the following steps.

1. Select Operations  > Assets.

Result

A list of all available asset libraries displays.

2. Select an asset library from the list.

Result

A list of assets in the current library displays.

3. Click the List View Mode  icon ( ) and select Asset Thumbnails.

Result

The thumbnails view appears. For all assets that have an associated thumbnail image, the thumbnail is displayed 

next to the asset.

Adding an asset
You can add an asset to a library.

About this task

To add an asset to a library, complete the following steps.

1. Log in to Unica.

2. Select Operations  > Assets.

Result

A list of libraries appears. An administrator created these libraries to organize the assets.

3. Click the library that you want to contain the new asset.

Result

The library opens. If it contains folders, they appear at the top of the screen.

4. If the library contains folders, navigate to the folder that you want to contain the asset.

5. Click the Add Asset  icon ( ).

6. Complete the New Asset  screen.

7. Click Save Changes to create the asset.

Result

The asset appears with a status of Draft.

New Asset page
When you add an asset, the system displays the New Asset  page.
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Table  46. Fields on the New Asset  page

Field Description

Asset Name Enter a descriptive name for the asset.

Description Enter a short, text description for the asset.

Owner(s) Click Add/Remove Members to use the Select Owners dialog to designate additional 

asset owners.

Asset Code To manually enter a code for an asset, clear the Auto-generate on save  box. Then, type 

a code for the asset. The code can be any alphanumeric string.

To have Unica Plan  automatically create an asset code, leave the Auto-generate on 

save  box checked.

Note:  You can configure Unica Plan  to generate a code according to an 

algorithm your administrator specifies.

Keywords Enter comma-separated keywords for the asset. When users search on these 

keywords, Unica Plan  retrieves this asset.

Usage guidelines Enter any guidelines for how you want people to use this asset. For example, if it is a 

logo, you can tell users where this type of logo should appear.

Expiration date Enter an expiration for the asset or select the arrow in the drop-down list to choose a 

date from the calendar.

After you enter a date, you can use the arrow icon to incrementally move the date 

forward or back.

Note:  Unica Plan  sends a notification to the owners upon expiration, but the 

status of the asset does not automatically change to expired. At the expiration 

date, you should archive the asset or change the expiration date.

Version name Enter the version number of the asset. Note the following issues:

• This field defaults to version 1.0.

• Each version that you add, by default, increments the version number.

• To override the default value, enter your own version number.

Files Click Upload  to open the Add Asset Files  dialog. Check one or more of the check 

boxes.
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Table  46. Fields on the New Asset  page  (continued)

Field Description

• File: Specify the file for your asset. This field is required.

• Preview File: You might want users to access the preview file for reasons of 

security, speed, or convenience. For example, if the source file is an image, you 

might want to provide a PDF file as the preview so that all users can still view 

it.  recommends that you use a PDF, GIF, or JPEG file as a preview of the asset. 

This field is optional.

• Thumbnail File: You can upload a smaller version of the file that users see 

when they open the asset or when they view their library with the Asset 

Thumbnails view. This field is optional.

For each box you check, browse to the appropriate file and add it to the Add Asset 

Files dialog box.

Security considerations

For more information about setting up security to allow some users to view only the preview of an asset, see the Unica Plan 

Administrator's Guide. If you have security concerns, consider the following options:

• Adding a watermark to the preview file

• Providing a low-resolution version

• Providing another method to protect the file and prevent copying and saving of the file

Editing an asset
You can edit only assets that are in a draft state.

About this task

If you upload a new file while you edit the asset, the system replaces the file but does not create a new version of the asset. 

It is the same version as before you edited it, even if you change the Version Name  field to a higher number. You can correct 

the file if you accidentally added the wrong version.

1. Select Operations  > Assets.

2. Select the library that contains the asset you want to edit.

3. Click the asset that you want to edit.

4. Click the Edit  icon ( ) and change any of the fields on the page.

5. Click Save Changes  when you finish editing.

Results

The asset is saved, with the same version number it had before the editing session.
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Adding a version of an asset
You can add a version of an asset instead of replacing the asset.

About this task

Note the following issues:

• You can download, preview, or delete older versions of an asset in the Version History  section.

• If you delete the current version of an asset, the previous version becomes the current version.

• The current version of an asset displays when users navigate the library and try to attach assets.

• You cannot delete an asset version if it is the only version of the asset.

To add a version of an asset, complete the following steps.

1. Select Operations  > Assets.

2. Select the library that contains the asset you want to edit.

3. Click the asset for which you want to add a version.

4. Click the New Version  icon ( ) and change any of the fields on the page.

Result

The Version Name  field automatically increments to the next version number.

5. Click Upload  under File to upload the new version of the asset.

6. Upload files for the asset. You must at least upload a source file.

7. Click Save Changes  to create the asset.

What to do next

The asset is saved and the version number is incremented.

Asset statuses
You must own an asset to change its status, or have the appropriate permissions.

An asset can have any of the following statuses.

Table  47. Asset statuses

Status Description

Draft Indicates that the asset is in a draft state. All owners can edit the asset. Other users can 

view it or select it as an attachment.

When you first add an asset, it has a status of Draft.
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Table  47. Asset statuses  (continued)

Status Description

Locked Indicates that the asset is in a locked state. No one can edit the asset until it is 

unlocked.

You can lock an asset for a period if you do not want anyone to edit the asset.

Finalized Indicates that the asset is finalized. Everyone with permission to do so can access the 

asset (and attach it to a business process), but no one can edit it.

Archived Indicates that the asset is no longer available. No one can access the asset nor retrieve 

it.

If this asset is attached to an object (such as a project or plan), it is still available from 

that object.

Changing the status of assets
Change the status of an asset to move the asset through its lifecycle.

1. Select Operations > Assets.

2. Select the library that contains the asset you want to edit.

3. Click the asset whose status you want to change.

4. Click Change Status  and select one of the available statuses transitions from the menu.

Note:  You can choose most status transition options with or without comments. If you want to add more 

information, select a status transition with comments. If you want to change the status with fewer clicks, 

select a transition without comments.

5. If you chose a status transition with comments, enter comments and click Continue.

Viewing an asset
After an asset has a status of Finalized, all authorized users can view and use the asset.

About this task

To view an asset, complete the following steps.

1. Select Operations  > Assets.

2. Select the library that contains the asset you want to view.

3. Click the asset that you want to view.

4. Perform one of the following actions:

Choose from:
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◦ To view the asset, click Download  next to the asset file.

◦ To preview the asset, click Preview. Use this option if you do not have permission to download assets or if 

you are not sure if this asset is the asset you need.

◦ To save the asset file or the preview file and download it to your computer, right-click Download  or Preview 

and select Save Target As. Browse to the location where you want to save the file and click Save.

5. When you finish viewing the asset, close the window that contains either the downloaded file or the preview.

Viewing history of an asset
When an asset has a status of Finalized, all users who have permission can view the revision history and download history 

for the asset. Owners can view the revision history when the asset has any status.

About this task

To view the history of an asset, complete the following steps.

1. Select Operations  > Assets.

2. Select the library that contains the asset that you want to view.

3. Click the asset that you want to view.

4. Click the Analysis  tab.

Result

The revision history for the asset appears. The revision history displays status changes for the asset, version 

changes, updates to fields in the asset, and any comments that were entered during the changes.

5. Select Download History  in the View  field to view the download history for the asset.

Results

The download history displays the date, time, file name, user who downloaded it, and the version of each asset that the user 

downloaded by clicking Download.

Adding an asset folder
Use folders as a way to organize assets in a library. You must have permission to create folders before you can add them.

About this task

To add an asset folder, complete the following steps.

1. Select Operations  > Assets.

2. Select the library to which you want to add a folder.

3. Click the Add Folder  icon ( ).

Result

The New Folder  page appears.
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4. Enter a name and a description for the new folder.

5. Click Save Changes.

Results

The folder opens. You can now add or move assets into this folder.

Deleting assets and folders from the Asset list page
From the Asset  list page, you can delete multiple assets and empty asset folders.

About this task

Asset folders have the following characteristics.

• From within any library, you can delete assets and folders if you have the appropriate permissions.

• You can delete only empty folders.

• Asset folders do not have owners. Different owners can own different assets in a folder, so the permission to delete 

an asset folder is not based on ownership.

To delete an asset or folder from the Asset  list page, complete the following steps.

1. Select Operations  > Assets.

2. Select the library that contains the assets and folders that you want to delete.

3. Select the check boxes next to all the folders and assets that you want to delete.

You cannot delete asset folders unless they are empty.

4. Click the Delete Selected Items  icon ( ).

5. Click OK  when Unica Plan  prompts you to confirm the deletion.

Results

The selected assets or folders are removed.

Deleting an asset from within the asset
As an owner of the asset, you have permission to delete the asset. However, you might have another security role with 

permission to delete assets only if you inherit that permission from another role. In that case, you cannot delete an asset 

from the list of assets. You can delete the asset only from within the asset itself.

About this task

To delete an asset or folder from within the asset, complete the following steps.

1. Select Operations  > Assets.

2. Select the library that contains the asset that you want to delete.
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3. Click the asset that you want to delete.

4. Click the Delete Selected Items  icon ( ).

5. Click OK  at the confirmation prompt.

Moving assets and folders from the Asset list page
From within any library, you can move assets and folders, if you have the appropriate permissions.

About this task

To move assets and folders from the Asset  list page, complete the following steps.

1. Select Operations  > Assets.

2. Select the library that contains the assets and folders that you want to move.

3. Select the check boxes next to all of the folders and assets that you want to move.

To move assets to different locations, repeat this procedure for each destination.

4. Click the Move this Item  icon ( ).

5. Select the destination directory and click Save Changes  or double-click the destination directory.

Results

The destination directory opens with the folder or asset displayed in it.

Moving an asset from within the asset
As an owner of the asset, you have permission to move the asset. However, you might have another security role with 

permission to move assets only if you inherit that move permission from another role. In that case, you cannot move an 

asset from the list of assets. You can move the asset only from within the asset itself.

About this task

To move an asset from within the asset, complete the following steps.

1. Select Operations  > Assets.

2. Select the library that contains the asset to move.

3. Click the asset to move.

4. Click the Move this Item  icon ( ).

5. Select the destination directory and click Save Changes  or double-click the destination directory.

Results

The destination directory opens with the folder or asset displayed in it.
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Chapter 13. Budgets
In Unica Plan, a budget coordinates expenses of plans, programs, and projects. After you establish the plan budget, you can 

fund linked programs, and ultimately projects, from it. Unica Plan  tracks budgets of child programs and projects in the form 

of allocations, forecasted or committed spending, and actual expenses.

Unica Plan  tracks budgets of child programs and projects, although these objects can have different owners. For example, a 

program that is linked to a plan can have a different owner than the plan itself. As such, the person who allocates a budget 

from a plan down to a program can be different from the person forecasting expenses from a program up to a plan. A plan 

owner, such as a marketing manager, can track expected expenses from child programs, projects, and the plan budget itself, 

to remain responsive to budgetary needs.

Note:  Budgets are available only when the  Unica Plan  financial module is enabled.

Fiscal year

You can view the total budget for all years, or see a detailed view for a particular year that is broken down into weeks, 

months, or quarters.

Unica Plan  keeps budget information for the current fiscal year, the next two fiscal years, and any past fiscal years that date 

back to when you first installed Unica Plan.

On the plan level, to view or edit a different fiscal year, change the Fiscal Year  field value on the Plan Summary  tab. Linked 

programs and projects take the financial year from the parent plan; stand-alone programs and projects use the system's 

current fiscal year.

Granularity

With Unica Plan, you can break fiscal years into weeks, months, or quarters. When you create a plan, program, or project, 

choose the wanted increment from the Budget Granularity  list on the Summary  tab.

Users cannot edit budget granularity. Plans, programs, and projects with different budget granularities are not allowed to be 

linked together.

For example, if a plan's fiscal year is broken into months, you can only link it to programs and projects that also use months 

as the budget granularity. In this scenario, programs and projects with weeks or quarters as their granularity are unavailable 

for linking.

Budget funding
Although you can plan your budget by using either top-down or bottom-up methods, the flow of actual money travels down 

the linked plan, program, project hierarchy. Regardless of how you plan your expenses, plans fund programs, which fund 

projects, which in turn fund any child or subprojects.
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For more information about budget planning, see Planning budgets from the top down  on page 219 and Planning budgets 

from the bottom up  on page 220.

Note:  Since stand-alone programs and projects are not linked to plans, they have their own budgets that you enter 

directly on their respective budget tabs.

Planning budgets from the top down
Top-down planning is useful if a plan has predictable expenses from year to year.

About this task

For example, every year you create a plan that is called New Product Launch that includes trade shows. You can create 

programs such as Trade show 1 and Trade show 2, and assign funds to each program.
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The Trade show 1 program might include a project that is called New Customer Acquisitions. You can allocate funds from 

Trade show 1 to make New Customer Acquisitions successful. Since the flow of funds is from the plan down to associated 

programs and projects, top-down planning is highly useful and easy.

You manage budgeting from plans down to programs and projects in the following way.

1. Allocate funds to the plan budget.

2. Allocate funds from the plan budget its child programs.

3. Allocate funds from the programs to it child projects, which are grandchildren of the plan.

4. Allocate funds from the projects to it child subprojects, which are great-grandchildren of the plan.

Planning budgets from the bottom up
Bottom-up budget funding is useful if you are not sure how much funding to allocate from the plan to the child objects but 

can forecast line items for programs and projects. After you predict all project expenses, you can roll them up to parent 

programs and plans.

About this task

(See the top-down budget example Planning budgets from the top down  on page 219.) If you can predict the line item 

expenses of the New Customer Acquisition project in your Trade show 1 program, you can finalize those line items to roll 

them up into the expenses for Trade show 1. You can add line item expenses to Trade show 1, if necessary. You can finalize 

the expenses and roll them up from Trade show 1 to the parent plan, New Product Launch. Start from the bottom-most level 

and add expenses to projects, programs, and plans until the parent plan accounts for all necessary allocations.

You manage budgeting from projects up to programs and plans in the following way.

1. Create projects and forecast their line item expenses.

2. Link the projects a parent program and plan.

3. Finalize the line items on each child object in the plan to roll up the expenses. You can now see how much funding 

the programs and projects need for successful completion.

Effects of deleting links between plans, programs, and projects
When you remove links between plans, programs, and projects, the budgets of both parent and child objects are affected.

In general, removing the link between a parent object and a child object affects the budgets of both objects in the following 

ways.

• The parent object no longer allocates money to the child object.

• The expenses for the child no longer count against the parent.

• Funds that are allocated from the parent remain with the child, but have no source. In other words, the child object 

still accounts for having the money, but the parent object no longer accounts for giving it.

For example, removing the link between a program and a plan affects the budgets of both objects in the following ways.
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• The plan no longer allocates money to the program, so the budget for the corresponding program area is decreased 

accordingly.

• The expenses for the program no longer count against the plan.

• The program still accounts for funds that were formerly allocated from the plan, so these funds either need to be 

removed from the program or funded from another source.

Budgets and accounts
In Unica Plan, budgets and accounts do not have predetermined relationships. Accounts represent the financial element of 

an organization, while budgets represent the marketing side.

Typically the financial element is not granular enough to capture marketing needs in detail. Budgets make up for this lack. A 

plan, program, or project can be funded from one or more accounts.

For more information about accounts in Unica Plan, see Accounts  on page 242.

Budget views
There are two budget views on all budget tabs.

• Total view ( ) is the default. It displays the total amount that is budgeted and remaining for forecasted, 

committed, and actual spending, for all fiscal years that the plan, program, or project existed.

• Detailed view ( ) displays budget information for a specified fiscal year, which is broken down by week, month, or 

quarter.

Across all budget tabs for a plan, child programs, and child projects, the totals reflect the total amounts for the life of the 

plan, program, or project. Therefore, the individual rows and columns in edit screens or the detailed view often do not add up 

to match the values that are displayed in the total view. This difference is not an error, but reflects the fact that the data, other 

than the total, corresponds to values for the currently selected fiscal year.

Note:  The views on the budget tab depend on the in-use budget allocation version. By default, you navigate to 

the budget tab of an object for the first time after login, the in-use version of the current fiscal year displays. The 

total view shows totals for the in-use version for all previous fiscal years and the current in-use budget allocation 

version. Detailed view also shows information based on the in-use budget version. For more information, see Budget 

allocation versions  on page 225.

The Plan Budget tab
The Plan Budget  tab displays information about the entire budget and allocations to child programs.

From top to bottom, the Plan Budget  tab contains the following tables.
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• The Plan Budget Summary table provides an overview of the entire budget.

• The Program Cost Summary table shows allocations to child programs.

Plan Budget Summary table
The Plan Budget Summary table is the topmost table on the budget tab of a plan. It summarizes funds that you expect to 

spend in the plan and the programs that it contains. The Plan Budget Summary table monitors finances for the entire plan.

• Plan Budget is the total budgeted amount. In total view, the Plan Budget Summary table displays the total budget for 

the plan's entire life; detailed view separates it into increments of the currently selected fiscal year. Change the fiscal 

year on the Summary tab if necessary.

• Program Allocations shows the total budget of all the plan's programs.

• The Forecast Total is all predicted spending across the plan.

• The Committed Total is all the money that is spoken for in the plan up to this point. Even though the money is not yet 

spent, the committed total represents costs that will occur even if the plan is canceled.

• The Actual Total is all funds spent so far on the plan. Unica Plan  calculates the actual amount that is spent through 

the invoice functions. This total is likely to be much lower than the others due to time lags between planning 

expenses and paying bills.

The Remaining column

In each row, the Remaining  column is the difference between the Plan Budget and the entry in the Amount  column. For 

example, Unica Plan  calculates the forecast remainder by subtracting the forecast total from the Plan Budget.

Although calculated by a simple subtraction, the Remaining  column provides high-level information and potential warnings 

about the financial state of the plan's budget. The Remaining  column summarizes how much money was allocated or 

planned for use, how much remains for additional spending, and how much you might recover if you canceled unfinished 

efforts.

• In the Program Allocations  row, the Remaining  column represents additional money the plan owner has left to 

distribute to existing or not-yet-created programs. If the total allocation of funds to child programs exceeds the total 

budget of the plan, the remainder is negative. The plan needs more funding to successfully complete the programs.

• In the Forecast Total  row, the Remaining  column indicates the amount of money the plan owner has left if current 

forecasts are accurate. If the figure is negative, the plan needs more funding to succeed at expected costs.

• In the Committed Total  row, the Remaining  column indicates how much money the plan owner has left if the plan and 

all its programs and projects are canceled. The plan owner needs to understand how much money can be returned if 

associated programs are canceled, if budgets are tightened.

• In the Actual Total  row, the Remaining  column represents the real balance that the plan owner has at the current 

time. This figure is useful for monitoring cash flows, although it is likely lower than the forecast total or committed 

total remainder due to time lag between planning expenses and paying bills.
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Note:  Programs and projects also have a Budget Summary table with the same layout and information about their 

respective Budget tabs.

Program Costs table
The Program Costs table is under the Plan Budget Summary table on the Budget  tab for plans. The table rows list programs 

by area. The columns provide figures for Actual, Committed, Forecast, and Allocated spending.

On the plan Budget  tab, the program costs table shows only programs, without breaking them down into their respective 

projects. However, even though you do not see the project expenses directly, Unica Plan  accounts for them through their 

parent programs.

The program name in each row of the Program Costs table provides a direct link to the budget for that program. This link is 

helpful because the program Budget tab provides a breakdown of its child-project expenses in the corresponding Project 

Costs table.

Note:  The Budget  tabs for programs and projects also include Costs tables that detail expenses for their respective 

child objects with the same layout and information.

The Program Budget tab
The Program Budget  tab is similar to the Plan Budget  tab but is one level down in the plan, program, project hierarchy. 

While the Plan Budget  tab breaks down into information about linked programs, the Program Budget  tab breaks down to 

information about linked projects. The Program Budget  tab also contains an additional table about the program's line items.

After budget ancestors, from top to bottom, the program Budget  tab contains the following tables.

• The Program Budget Summary table provides an overview of the entire budget.

• The Project Cost Summary table shows allocations to child projects.

• The Line Item Details table organizes line items for the program.

Navigating with budget ancestors

The top of the Budget  tab for projects and programs displays the Parent Budget(s). Parent Budget(s)  shows a hierarchical 

view of the current object, its parent, and all ancestors back to its root plan. The name and ID code displays for each object 

as well as direct links to each of the ancestor objects.

Use these links for easy navigation through the plan, program, project budget hierarchy.

Program Budget Summary table
The Program Budget Summary table monitors finances for the entire program. This table summarizes funds that you expect 

to spend in the program and the projects that it contains.
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The Program Budget Summary table is the top table on the Budget tab of a program. In total view, the Program Budget 

Summary table displays the total budget for the program's entire life. The detailed view separates budget information into 

increments for the currently selected fiscal year and up to two previous fiscal years.

The Program Budget Summary table contains the same data as the Plan Budget Summary table, except on the program 

level. For more information about the table's fields and their meanings, see Plan Budget Summary table  on page 222.

Project Costs table
The Project Costs table, on the Program Budget  tab, lists the total costs that are associated with all of the projects that this 

program contains.

The Project Costs table has the same layout and information as the Program Costs table on the Plan Budget  tab.

For more information, see Program Costs table  on page 223.

Program Line Item Details table
The Program Line Item Details table summarizes line item information that is entered for individual expenses on the program 

level. These expenses belong to the program itself, not the projects that are linked to it.

The Program Line Item Details table is the third table on the Program Budget  tab. This table works with invoices to track 

spending. For more information about line items and invoices, see Line item rollups  on page 235.

If the program requires approvals for line items, the Line Item Details table shows the approval status for each line item in 

the second column.

•  = In Progress

•  = On Hold

•  = Canceled

•  = Completed

Note:  Projects also have a Line Item Details table with the same information and layout on their Budget tabs.

The Project Budget tab
The Project Budget  tab has the same tables, layout, and information as the Program Budget  tab but is one level lower in the 

hierarchy. While the Program Budget  tab breaks down into information about linked projects, the Project Budget  tab breaks 

down to information about any subprojects.

After budget ancestors, from top to bottom, the Project Budget  tab contains the following tables.



Chapter 13. Budgets

• The Project Budget Summary table provides an overview of the entire budget.

• The Subproject Cost Summary table shows allocations to child projects.

• The Project Line Item Details table organizes line items for the project.

For more information, see the following topics:

• For the Project Budget Summary table, see Plan Budget Summary table  on page 222.

• For the Subproject Cost Summary table, see Program Costs table  on page 223.

• For the Project Line Item Details table, see Program Line Item Details table  on page 224.

Budget allocation versions
Budget allocation versions are a powerful tool for financial planning. You can use budget allocation versions to explore 

different financial possibilities without overwriting the previous budget. You can create multiple budget versions with 

different allocations for expenses, compare versions, and then chose the most appropriate one for the plan, program, or 

project.

Use the options on the budget version drop-down list ( ) to create, delete, and compare potential budgets until you find 

the best fit for your plan, program, or project. Then, you can activate or finalize that version to mark it "in-use". Unica Plan  rolls 

the allocations from the in-use version up to linked parent objects and down to linked child objects.

The budget version drop-down list ( ) also lists all budget versions. The name of the budget version you are viewing is 

shown in red. The name of the in-use version is marked with a "^."

Note:  Budget versions account for different allocations, not different line items. Adding a line item to one budget 

version adds the item to all versions. However, you can use budget versions to determine how much to allocate to 

the line items. You can use budget versions to explore the effects of spending different amounts of money on the 

same expenses. For more information, see Program Line Item Details table  on page 224 and Adding and editing 

line items  on page 229.

Note:  To view and compare budget versions, you must have the security permission "view budget tab." To create, edit, 

delete, update, and mark in-use, you must have the security permissions "edit budget tab."

Creating budget versions
Create different budget versions for financial forecasting of different scenarios. Then, you can choose the most appropriate 

budget by comparing them.

About this task

To create budget versions, complete the following steps.
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1. Navigate to the Budget  tab of the plan, program, or project.

2. Click the versions icon ( ). Choose the new version option most helpful to you from the drop-down list.

Option Description

Create a new version Create a blank allocation version and opens it in edit 

mode.

Copy Current Version Copy allocation data from the version currently being 

viewed and opens it in edit mode. This method is helpful 

for making subtle changes between versions.

Copy Version From Different FY Copy any version from any fiscal year and open the copy 

in edit mode. This tool is useful if the budget you are 

working with closely resembles the one for a prior fis­

cal year. For example, if the budget for year D resembles 

year A, you can copy the year A budget and use it as a 

starting point.

3. Give the new version a unique, descriptive name.

The default names are of the form "version #x," where x is one greater than the number of versions currently existing 

in that fiscal year. Version names must be unique within each financial year, but you can have the same name in 

different fiscal years.

4. Enter or edit allocations for the new budget version.

5. Click Save and Finish  to return to the Budget  tab.

Result

You can now access the new version from the versions drop-down list.

Deleting budget versions
You cannot delete the currently selected, or "in-use", version of the budget. If you want to delete the in-use version, you must 

first mark a different version as in-use.

Before you begin

Note:  To create, edit, delete, update, and mark in-use, you must have the security permissions "edit budget tab."

About this task

To delete budget versions, complete the following steps.
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1. Navigate to a version other than the one you want to delete by clicking its name in the version ( ) drop-down list. 

The name of the currently selected version appears in red on the drop-down list.

2. Select the check box next to the names of one or more versions to delete.

3. Without leaving the drop-down list, click Delete Selected Version(s).

4. When prompted, click OK  to confirm the deletion.

Comparing budget versions
You can view allocations for up to six budget versions on the same screen to select the most appropriate version.

About this task

To compare budget versions, complete the following steps.

1. Navigate to the version that you want to compare by clicking its name in the versions ( ) drop-down list. The 

name of the currently selected version appears in red on the drop-down list.

2. Select the check box next to the names of up to five other versions in the drop-down list.

3. Without leaving the drop-down, click Compare Current with Selected.

Result

The comparison screen appears. Colors differentiate each budget version. Red arrows indicate whether the 

allocations for each area are higher or lower than the current budget. You can show and hide versions by using +  and 

-  to isolate specific versions in the comparison.

4. When you finish, click End Comparison  in the yellow box at the top of the screen.

Marking a budget version "in-use"
The active or finalized budget version of a plan, program, or project is the "in-use" version. Unica Plan  rolls this version down 

to linked child objects and up to linked parent objects.

Before you begin

Note:  To create, edit, delete, update, and mark in-use, you must have the security permissions "edit budget tab."

About this task

When you work with budget versions, note the following restrictions:

• Only one version can be active or finalized at a time.

• The default budget version is active and in-use for new plans, programs, and projects.

• After you finalize a version, you can no longer activate versions.

• After you finalize a version, you can finalize a different version, but you cannot remove the finalized status from all 

versions. After you finalize one version, one version from that fiscal year must always have the finalized state.
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Note:  When you upgrade to a new version of Unica Plan, the previous budget is automatically finalized.

1. Navigate to the version you want to activate or finalize by clicking its name in the versions ( ) drop-down list. The 

name of the currently selected version appears in red on the drop-down list.

2. Click Make Current Version Active  or Finalize Current Version  from the versions drop-down list.

Result

The version is marked active or finalized and is in-use. On the drop-down list, the in-use version is marked with "^" 

before the name.

Allocating funds
A parent plan, program, or project allocates funds down to individual child programs and projects that are contained within it. 

Plans fund programs, programs fund projects, and projects fund subprojects.

About this task

Add and edit allocations on the parent Budget  tab. Begin by allocating money to a plan. Then, allocate down the program, 

project, subproject hierarchy that uses the same procedure.

Note:  The "parent" object is the plan, program, or project from which you are allocating funds. A "child" object is the 

next level down in the plan, program, project, subproject hierarchy. For instance, if you allocate from a program to a 

project, the program is the parent object and the project is the child object.

1. Navigate to the Budget  tab for the parent object from which you want to allocate funds.

2. Select the allocation version that you want to edit or create an allocation version.

3. Click the Allocations  icon ( ) to modify allocations to the child project.

Result

The Cost Summary table opens in edit mode.

◦ If you are working below the plan level, the first row of data is bold and controls allocations for the objects line 

items. See Adding and editing line items  on page 229.

◦ The table lists the child objects in normal font below the parent's line items.

4. Add or edit allocations by clicking cells in the table and entering the appropriate value by week, month, or quarter.

◦ For reference, the top row displays total funding for the parent object from which you are allocating funds for 

each week, month, or quarter.

◦ The Remaining  column shows the amount of money that is left in the parent object budget with the current 

allocations.

5. Click Save and Finish  to save your work and return to the Budget  tab.

What to do next



Chapter 13. Budgets

To continue funding, click a child object in the Total Costs table to navigate to its Budget  tab. Repeat the process by 

allocating funds from the new object to its child objects.

Note:  To link additional parent and child objects, use the Summary  tab. Then, return to the Budget  tab to allocate 

funds to the new child objects.

Allocating funds for stand-alone programs and projects
A stand-alone program or project is not linked to a parent plan. When you create a budget for a stand-alone program, the 

budget reflects costs that are associated with the program and any costs that are associated with any projects that are 

linked to the program.

About this task

Note:  For stand-alone programs, the fiscal year is assumed to be the current year that is defined by the system clock.

To allocate funds for stand-alone programs and projects, complete the following steps.

1. Navigate to the Budget  tab for the stand-alone program or project.

2. Allocate money directly in the total budget  row at the top of the table.

Note:  This row is only editable for stand-alone programs and projects. Linked programs and projects have a 

read-only total budget row because they receive funding from parent objects.

3. Click line items  ( ) and add line items as needed. For more information, see Adding and editing line items  on 

page 229.

4. Enter a budget amount for each week, month, or quarter.

5. Click Save and Finish to return to the Budget tab.

Result

The system populates total budget row at the top of table with the information you entered.

Adding and editing line items
Line items outline the forecasted and committed costs for a program, project, or subproject so a manager knows whether 

the allocated or planned budget is sufficient. Additionally, forecasted and committed amounts, after they are finalized, are 

rolled up to the accounts affected, providing visibility into budget and cash flow needs for higher-level objects.

About this task
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Note:  Adding line items to one budget version adds them to all budget versions. For more information, see Budget 

allocation versions  on page 225.

To add or edit line items, complete the following steps.

1. Navigate to the program, project, or subproject Budget  tab.

2. Click the Line Items  icon ( ).

Result

The Edit Program/Project/Sub-Project Line Items  page appears.

3. To add a line item, double-click an empty cell in the Item Description  column. Enter an item name or description.

Note:  The # field populates automatically after you enter an item in the Item Description  field.

4. To edit a line item, double-click it in the Item Description  column and make your changes.

5. If the line items table contains custom text fields, enter appropriate values.

6. In the Expenditure Date  field, enter the anticipated date that funds will be spent. Click the arrow to open a menu from 

which you can select a date. You must enter an expenditure date for the budget to be finalized.

Note:  To track a certain expense on different dates, use separate line items. For example, to track the 

expense for Printing in May, June, and July, enter one line item for each month.

7. Select a source account from the Source Account  drop-down menu.

The funds for this program, project, or subproject are posted against the account you choose when the line items are 

finalized.

8. Select a cost category from the Cost Category  drop-down menu.

9. In the Committed Amount  field, enter any committed funds that are related to the line item. Leave this field blank if no 

portion of the line item is committed.

10. In the Forecast Amount  field, enter the amount that you predict or forecast that the line item will cost.

11. Click Save and Finish  to save your changes and go to the object Summary  tab.

Results

Unica Plan  totals the line items, but they are not rolled into the parent object budget until you finalize them. Finalizing line 

items can require approval. For more information, see Finalizing budget line items  on page 230.

Finalizing budget line items
When you finalize budget line items for projects or programs that are linked to a parent program or plan, the forecasted and 

committed line item amounts roll up to the parent program or plan.

Before you begin

To finalize line items, they must have an assigned expenditure date.
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About this task

If the project or program requires line item approval, finalizing the line items triggers the approval process. When a line item 

requires approval, it rolls up to the parent program or plan only after the approval process completes. The first column of the 

Line Item Details table shows the approval status. For more information, see Program Line Item Details table  on page 224.

Note:  Finalizing line items and finalizing budget allocation versions are unrelated. Finalize line items to roll them up 

to all budget versions, then activate or finalize the most appropriate budget version to use for your plan, program, or 

project. For more information, see Budget allocation versions  on page 225.

1. Add budget line items. For more information, see Adding and editing line items  on page 229.

Result

Finalize  and Discard Changes  links appear on the Budget  tab.

2. Navigate to the object Budget  tab and click Finalize.

Result

◦ For either of the following situations, you are prompted to confirm that you want to finalize your changes:

▪ The program or project does not require line item approval.

▪ The line item is automatically approved because of rules that your administrator established in the 

object template.

◦ If any or all line items require approval, you are prompted to send an approval. For more information about 

the approval process, see Approvals  on page 13. Line items that require approval are rolled up to the parent 

object only after the approval process is completed.

3. Click OK  to finalize your changes or send the approval. Click Cancel  if you do not want to finalize changes or send 

approvals.

Results

After the budget line item changes are finalized and approved (if required), they roll up to their parent objects.

Discarding budget line items
Instead of finalizing budget line item edits, you can discard all changes that you made since the last time you finalized 

budget line items.

About this task

To discard budget line items, complete the following steps.

1. Add budget line items. For more information, see Adding and editing line items  on page 229.

Result

Finalize  and Discard Changes  links appear on the Budget  tab.

2. Click Discard Changes.
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Result

You are prompted to confirm that you want to discard your changes.

3. Click OK.

Results

Unica Plan  discards the changes that you made to budget line items since the last time you finalized them. It then restores 

the previous finalized version of the budget line items. Unica Plan  does not trigger the approval process.

Budget line item approvals
Depending on the rule criteria that your administrator established in the project and program templates, budget line items 

might be automatically approved or sent through the Unica Plan  approval process.

For example, your administrator might define rules based on the line item expenditure date, source account, or cost category. 

Your administrator can also select default approvers for each rule, such as object or account owners. If your administrator 

wrote these rules in your organization's project and program templates, budget line items must be approved before they are 

finalized and rolled up to the parent program or plan. Approval can be accomplished either automatically by using the rules 

or by the assigned approvers. However, if your projects and programs use templates that do not contain budget line item 

approval rules, line items can be finalized directly on the object Budget  tab without an approval process.

Approval status for line items can be seen on the object Budget  tab in the second column of the Line Item Details table.

•  = In Progress

•  = On Hold

•  = Canceled

•  = Completed

After an approval is sent, you might not be able to edit the line item.

• If the approval status is canceled or completed, the approval can be edited. Finalizing any changes to the updated 

line item might trigger a new approval process.

• When the approval status is in progress, the approval cannot be edited. You must cancel the approval first. For more 

information, see Canceling approval processes  on page 164.
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In Unica Plan, you can view all changes that were made to an invoice, including the time and date of the changes and the type 

of changes made.

An invoice typically bills for multiple items or services, and itemizes them. It is important to be able to capture each item or 

service separately. Different line items can be attributed to different projects, programs, and accounts.

For example, one invoice contains two line items, the first associated with a project called Trade show, and the other 

associated with a program called Database Marketing Campaign. One line item can be associated with Account 1, and the 

other, with Account 2.

From version 12.1.6, you can adjust the width of only the Name column in the Invoice listing page. This helps you view the 

complete Invoice name rather than having to hover the mouse over the Invoice to view the complete Invoice name in the 

tooltip.

After you create an invoice, you can do any of the following actions from its Summary tab.

• Edit the summary information of the invoice.

• Add or edit line items for the invoice.

• Delete the invoice.

• Change the status of the invoice.

• Print the Invoice summary page.

Adding an invoice
Use the New Invoice  page to add an invoice.

About this task

To add an invoice, complete the following steps.

1. Select Financials  > Invoices.

Result

The My Active Invoices  page appears by default.

2. Click the Add Invoice  icon ( ).

3. Type information in the fields on the New Invoice  page.

For more information, see New Invoice page  on page 234.

4. To add line items, click Save and Edit Line Items.

For more information, see Adding and editing invoice line items  on page 237.
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Note:  You must add line items to move the invoice out of Draft  state, mark it as Paid, and roll up the 

expenses.

5. Save  the invoice.

New Invoice page
The following table describes the fields available on the New Invoice  page.

Table  48. Fields on the New Invoice  page

Field Description

Invoice # Enter an invoice number:

• A number that is provided to you by an external vendor or supplier in a paper invoice

• An original number based on your company's code schema for internal invoices or 

expense reports

Note:  Invoice numbers are not required to be unique across all the invoices in Unica Plan, 

but they must be unique among all invoices for a particular vendor.

Vendor Name Select a vendor from the drop-down list.

Unica Plan  administrators populate this list. If you cannot find a vendor on the list, ask your 

administrator.

Owner(s) Click Add/Remove Members  to add or remove owners. By default, this field contains the name of 

the invoice creator.

Security Policy Select the invoice security policy from the drop-down list.

The default value is Global.

Purchase Order # Enter the purchase order number that is associated with the work now being invoiced. Typically, 

this value is an internal company number. In some cases, the purchase order number is used to 

track preapproved invoices.

Invoice Date Enter the billing date of the invoice or select it on the calendar.

Due Date Enter the date by which the vendor expects payment or select it on the calendar.

Other Notes Enter any helpful notes or comments that are related to the invoice.

Payment Terms Enter any notes about the payment.
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Editing invoices
Create invoices and change the status to move invoices through development to Accounts Payable.

1. Select Financials  > Invoices  and select the invoice that you want to edit.

Example

Depending on the status and owner of the invoice, either the My Active Invoices  view or the All Invoices  view 

displays.

2. Optional:  If your invoice is not in Draft state, click the Change Status  menu and select Re-draft.

3. Edit the fields on the Invoice  page as needed.

For more information, see New Invoice page  on page 234.

4. Add or edit line items.

For more information, see Adding and editing invoice line items  on page 237.

Note:  You must add line items to move the invoice out of Draft state, mark it as Paid, and roll up the 

expenses.

5. Save  your changes.

Line item rollups
When you change the status of an invoice to Paid, the invoice line item amount rolls up to the program or project budget and 

to the account with which you associated it. You can attribute the different line items of one invoice to different projects or 

programs and to different accounts. Line items from multiple invoices can roll up to the same program or project.

There are two types of rollups:

• Scheduled rollups occur on a scheduled basis.

• Immediate rollups occur when you change the status of an invoice to Paid.

Note:  Depending on the line item approval rules set by your Unica Plan  administrator, line items can require an 

approval process before the invoice can be marked Payable. An invoice must be marked Payable before you can 

change the status of the invoice to Paid and roll up line items. For more information, see Invoice Line Item Approvals 

on page 235.

Invoice Line Item Approvals
Depending on rule criteria your administrator establishes in invoice templates, line items can be automatically approved or 

sent through the Unica Plan  approval process.
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For example, your administrator might define rules based on the line item's cost per unit, total quantity, or total cost. If 

your administrator included rules in your organization's invoice templates, all invoice line items must be approved, either 

automatically by using rules or by the assigned approvers. After the invoice is approved, it can be marked as Payable.

After the invoice is moved from Payable to Paid, the invoice rolls up to assigned accounts and the parent program or 

project's budget. However, if your invoice templates do not contain line item approval rules, the invoice can be marked as 

Payable without going through an approval process.

Approval status for line items can be seen on the invoice summary page.

•  = In Progress

•  = On Hold

•  = Canceled

•  = Completed

Rollups to the source program or project
When you add an invoice line item, you link it to a program or project through the Source Project  or Program  field. After the 

invoice is paid, Unica Plan  includes the invoice line item amount in the program or project budget.

Unica Plan  adds or subtracts the invoice line item amount in the Actual Total  field on the source project or program Budget 

tab. The Actual Total  field signifies the amount of funds that are used in the budget. The Actual Total includes all Paid 

invoices that contain line items that are linked to the project.

For example, if an invoice contains a line item of $75 that you associate with Project 1, the Actual Total on the Project 1 

Budget  tab increases by $75 after the invoice is paid.

If an invoice contains a line item of -$75 (indicating a credit) that you associate with Project 1, the Actual Total on the Project 

1 Budget  tab decreases by $75. If the Actual Total showed $200 before the credit was applied, it is updated to $125.

Note:  Depending on how your administrator configures your invoice templates, marking the invoice Payable can 

trigger an approval process.

Rollups to the source account
When you add an invoice line item, you can designate an account to which you linked the invoice line item.

After the invoice is paid, the invoice line item amount rolls up to the account. The invoice line item amount displays on the 

Actual row on the account Summary tab. Unica Plan  places the amount in a date column that corresponds to the invoice paid 

date.
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Note:  Depending on how your administrator configures your invoice templates, marking the invoice Payable can 

trigger an approval process.

Adding and editing invoice line items
You must add line items to eventually mark the invoice Payable  and roll expenses up to accounts and budgets.

About this task

To add or edit invoice line items, complete the following steps.

1. Navigate to the invoice by selecting Financials  > Invoices.

2. Click the invoice number of the invoice to which you want to add line items.

3. Click the Line Items  icon ( ).

4. Supply information for the fields on the Edit Invoice Line Items  page. Use the following options to help you add, edit, 

move, or delete line items.

Choose from:

◦ Click the Add Row  icon ( ) to insert a new line item.

◦ Use the Move Selected Row Up  icon  or Move Selected Row Down  icon  to change the order in 

which the line items appear.

◦ Click a line item and click the Delete the Selected Row  icon  to delete a line item.

5. Save  your changes.

Results

After line items are saved, the system calculates the Invoice Total of all line items.

Field descriptions for the Edit Invoice Line Items  page
The following table describes the fields available on the Edit Invoice Line Items  page.

Table  49. Fields on the Edit Invoice Line Items  page

Field Description

Item Description Type a description for the line item.

Note:  The # field populates automatically when you create a line item.

Source Project or 

Program

Click the drop-down list to search for a project or program with which the invoice line item is 

associated.
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Table  49. Fields on the Edit Invoice Line Items  page  (continued)

Field Description

In the Select Item  dialog, do the following steps:

1. In the Find by name or code  field, do one of the following options:

◦ To find a particular type of item, select either Project  or Program.

◦ To search for a specific project or program, enter a search string.

◦ To search for all projects or programs, leave the field blank and click Find.

2. Select a project or program from the Search Results  list.

3. Click Select  to close the dialog box and add the selected project or program to the line 

item.

Note:  This field is required to move an invoice into the Payable state. When the 

invoice is in the Paid state, the invoice amount rolls up to the Actual Total  field on 

the source project or program Budget  tab.

Source Account Click the drop-down list to select from all enabled accounts. The funds for this item come from 

the account you choose.

Note:  When the invoice is in the Paid state, the invoice amount rolls up to the source 

account's summary information.

Cost Category Click the drop-down list to select an enabled cost category.

Cost per Unit Enter the amount of the line item.

Qty Enter the line item quantity.

Cost Displays the total cost for the line item. The system calculates this field after you enter values in 

both the Cost per Unit  and Qty  fields.

Invoice status types
In Unica Plan, invoices can be in the Draft, Canceled, Payable, Under Review, or Paid state.

When you change an invoice from one state to another, you can add comments. Unica Plan  records these comments in the 

invoice revision history.

Note:  You must add comments when you change the invoice status to Paid. When you change an invoice to Paid, you 

can enter the date on which the invoice was marked Paid.

The following table describes the invoice status types.
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Table  50. Invoice status types

Status Description

Draft Indicates that the invoice is still being worked on. An invoice is in the Draft state when it is first 

created. To move an invoice out of the Draft state, you must add line items.

If necessary, you can place an invoice in the Draft state by choosing Re-draft Invoice  from the 

Change Status  menu.

Canceled Canceling an invoice is not the same as deleting an invoice. When you cancel an invoice, it is not 

active but you can still view it in Unica Plan. Deleting an invoice removes it from the system. When 

you move an invoice to Canceled, Unica Plan  sends an alert to the invoice owners.

Under Review Approvers are currently examining the invoice line items.

Note:  This internal status occurs after you mark an invoice Payable.

Payable Items on the invoice were reviewed, and the invoice is ready to be sent to Accounts Payable. 

When you move an invoice to Payable, the owner of the account to which the invoice belongs 

receives a notification.

If your organization uses the invoice approval function, changing an invoice state to Payable 

triggers the Unica Plan  approval process. The invoice can enter the Under Review state while 

approvers examine the line items. For more information, see Invoice Line Item Approvals  on 

page 235.

Paid The invoice is paid. When you move an invoice to this status, the system triggers invoice rollup. 

This status is not available until the approval process is complete.

Changing the status of invoices
Change the status of invoices to move them from development to Accounts Payable.

1. Go to the Summary  tab for the invoice of which you want to change the status.

2. Click the Change Status  menu and select a status transition.
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3. If you chose a status transition with comments, type your comments. Click Continue  to close the dialog box and 

apply the new status.

Note:  If you select Canceled  or Paid, you cannot change the status of the invoice later. When you change the 

invoice status to paid, you must use the transition Mark as Paid with comments. You can also enter the date 

on which the invoice was paid.

Deleting an invoice
Owners and users with the appropriate privileges can delete an invoice that is in the Draft state. You cannot delete invoices in 

the Canceled, Payable, or Paid state.

About this task

To delete an invoice, complete the following steps.

1. Navigate to the invoice by selecting Financials  > Invoices.

2. Click the invoice number of the invoice you want to delete.

3. Click the Delete this Item  icon ( ).

4. Click OK  to confirm the deletion.

Printing the invoice summary
You can print all information found on your invoice summary page or select certain columns of information to print.

About this task

To print the invoice summary, complete the following steps.

1. Navigate to the summary page of the invoice you want to print.

2. Click the Print  icon .

Result

A window appears with a list of columns from which you can choose to print. By default, all columns are selected.

3. Clear any columns that you do not want to print.

4. By default, the Shrink to Fit Landscape Page Width  box is checked. Clear this box to print the columns at a size of 

100%.

Selecting this option shrinks the page to fit all selected columns onto a single page. If you use this feature, change 

your printing preference for this print job to landscape.

5. Click Print Selected Columns.

Result



Chapter 14. Invoices

A preview window appears, showing you what the printed information will look like.

6. Click Print.

7. In the Print  dialog, select your printer and printer options, and click Print  to print the selected columns.

Tip:  Choose landscape mode for best results.

8. In the preview window, click Close  to close the print preview.
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Chapter 15. Accounts
A top-level Unica Plan  account represents a corporate account that is established by a finance department for tracking and 

controlling expenditures and cash flows for specific areas of the business. Accounts can have subaccounts.

Key capabilities that are related to accounts include the following items:

• Defining a hierarchy of accounts and subaccounts.

• Funding or allocating money to the account at the beginning of a fiscal period (typically a year), which is revisited 

weekly, monthly, or quarterly.

• Tracking estimated and actual withdrawals from those accounts, by time period.

You must have administrative privileges to add new accounts to Unica Plan.

The account Summary  page
Access the account Summary  tab from the Financials  > Accounts  menu option.

Use the account Summary  tab to perform the following tasks:

• View basic account information.

• Review the account summary table. This view-only table that reflects the budgeted, forecasted, committed, and 

actual amounts for the account. This table also displays remainder amounts.

• Select the fiscal year to view.

Account summary table
The following table describes the Account Summary table.

Table  51. Fields in the Account Summary table

Field Description

Budget Amounts that the account administrator entered to fund the account. For more information about 

creating and editing accounts, see the Unica Plan  Administrator's Guide.

Forecast The sum of the following items, as specified in the budget line item Source Account  field:

• All forecasted values that are entered into the Forecast Amount  field of a finalized project

• The program budget line items for which this account is the source account

These sums appear for a particular month on the table according to when you finalized the line 

items. For example, if you finalize a forecasted line item amount in May, that amount appears in 

the May column of the Forecast row.

Available The difference between values in the Budget and Forecast rows.

Committed The sum of the following items, as specified in the budget line item Source Account  field:
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Table  51. Fields in the Account Summary table  (continued)

Field Description

• All committed values that are entered into the Committed Amount  field of finalized project

• The program budget line items for which this account is the source account

These sums appear for a particular month on the table according to when you finalized the line 

items. For example, if you finalize a committed line item amount in May, that amount appears in 

the May column of the Committed row.

Uncommitted The difference between values in the Budget and Committed rows

Actual The sum of all invoice line items for which this account is the source account, as specified in the 

invoice line item Source Account  field. These invoice line items roll up to this field only when the 

invoice to which they belong is in the Paid state. These sums appear for a particular month in the 

table according to when you marked the invoice line items Paid.

For example, if you mark an invoice line item amount Paid in May, that amount appears in the May 

column of the Actual row.

Remaining The difference between values in the Budget and Actual rows.

Selecting the fiscal year to view
Because accounts can span multiple fiscal years, you can select a year in which to view the account information.

About this task

Your Unica Plan  administrator configures your fiscal year to the month that you want your account fiscal year to begin. For 

more information, see the Unica Plan  Administrator's Guide.

From the Account Summary  drop-down list, select the fiscal year to view.

You can choose from the current year and the following two years. If budget or invoice line items draw from the account in 

other years, those years also appear in the list.
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Chapter 16. Metrics
Metrics are used for management reports and analysis. View metrics on the Tracking  tab for plans, programs, and projects.

Use Unica Plan  metrics for the following calculations.

• Automatically calculate internal measures (such as budgets and resource consumption).

• Automatically tabulate program results, such as the following results.

◦ Measure consistently across activities.

◦ Aggregate results across programs.

• Automatically link key metrics, such as number of contacts and responses, from campaigns back to project metrics.

• Build a marketing memory.

The metrics that are available in a plan, program, or project depend on the template you used to create it.

Setting up program and project metrics
Use the wizard to add a program or project and specify the metrics that you want to collect. The results appear on the 

Tracking  page.

About this task

Note:  This task describes setting up metrics for a program; setting up metrics for a project is similar.

To set up program metrics, complete the following steps.

1. Using the wizard, add a program or project.

When you use the wizard, the Tracking  page displays the template tracking information for your program. You 

cannot change the type of information that is captured on the Tracking  page, but you can enter target values for the 

categories. Depending on how your administrator set up your program templates, the number of columns on the 

Tracking  page can vary.

2. In the Target  column, enter the target value that you want to achieve by running this program.

Example

For example, if the program is a product launch, you might want to achieve 100 contacts or get 1 hour of media 

coverage.

3. If other columns such as Optimistic  or Pessimistic  appear, you can enter corresponding values.

Example

For example, if your target value for a Total Contacts  category was 100, a Pessimistic  value for Total Contacts  might 

be 50.

4. Click Next  to continue the program wizard.

When you are finished creating the program, the metrics you entered appear on the Tracking  tab for that program.
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Editing program and project metrics
When you created your program or project by using the wizard, you entered metrics on the Tracking  page. You can then edit 

any of the values that you entered.

About this task

If the program is linked to a plan, or if the project is linked to a program, you must finalize the edits that you made before 

those edits roll up to the parent object.

Note:  This procedure describes editing metrics for a program; editing metrics for a project is similar.

To edit program metrics, complete the following steps.

1. Navigate to the Tracking  tab of the program whose metrics you would like to edit.

2. Click Edit  ( ).

The Edit Program Tracking  page appears.

3. Edit the values that you would like to change.

4. Click Save and Finish.

Results

The Tracking  tab for the program is displayed. The updated metrics appear in the Program Metrics table.

Entering planned values for metrics that roll up
You can incorporate your goals and performance expectations for your marketing campaign into Unica Plan  by entering 

planned values for metrics that roll up. The planned values display side-by-side with the actual values at the end of the 

campaign.

About this task

When you enter planned values for metrics, you work top-down. You open a plan and specify planned values for the metrics 

for each of its child programs. You then open a program and add planned values for the metrics for each of its child projects.

1. Open a plan or program that has child programs or projects with rollup metrics.

2. Click the Tracking  tab.

3. Click the Planned Rollups  icon ( ).

Result

The Edit Planned Rollup Values  page is displayed.

4. Enter the planned values for the metrics.

5. Click Save and Finish.
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Results

The values that you entered display in the Planned column of the Program Metrics or Project Metrics table on the Tracking 

tab.

Views for rollup metrics
The following table describes the views that are available for rollup metrics.

To change the view for rollup metrics, click the View  icon ( ) and select a view from the drop-down menu.

Table  52. Views for rollup metrics

View mode Description

High-Level Summary Displays a summarized view of all rolled up metric dimensions. The High-Level Summary is the 

default view.

Breakout of Planned Displays details of planned values for rollup metrics.

Breakout of Planned 

and Rollup Target(s)

Displays details of planned and target values for rollup metrics

Breakout of Planned, 

Rollup Target(s), and 

Rollup Actual(s)

Displays details of planned, target, and actual values for rollup metrics.

Breakout of All Rollups Displays details of target, actual, and any other custom values for rollup metrics that are used in 

the plan or program.

Importing metrics from a campaign
If your campaign project has a Tracking  tab, the template creator mapped contact and response metrics in Unica Campaign 

with metrics in Unica Plan. You can import the metric data into the campaign project.

Before you begin

You must have the Analyze campaign  permission in Unica Campaign  to import metrics.

About this task

To import metrics from a campaign, complete the following steps.

1. Navigate to the Tracking  tab of the campaign project whose metrics you want to import.

2. Click Import Values.

Result
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The Unica Campaign  metrics are displayed on the Import Values  page. The information that is imported depends on 

the metrics the template creator defined. Unica Plan  captures and displays the last date of import, which is shown as 

External Sources Last Refreshed Date Time  at the bottom of the table.

3. Click Save and Finish  to update the metrics on the Tracking  tab and close the Import Values  page.

What to do next

If necessary, manually update the metrics that you imported.

Finalizing and rolling up metrics
When a project is linked to a program or a program is linked to a plan, you can roll up metric values from the child object to 

the parent object. Template creators define how metrics roll up to the parent object.

About this task

For more information about defining rollup behavior, see the Unica Plan  Administrator's Guide.

Note:  Planned values for metrics do not roll up. Those values are for top-down planning.

Metric values do not roll up automatically. Unica Plan  rolls up the values when you indicate that they are final. Each time that 

you import new metric values or edit metric values, you must indicate that the values are final in order for them to roll up.

Whenever there are metric values that have not been rolled up, a Finalize  link displays on the Tracking  tab of the object that 

contains the values.

1. Navigate to the Tracking  tab of the project or program whose metrics you want to roll up to their parent program or 

plan.

2. Click the Finalize  link.

Note:  The Finalize  link displays only if there are new or changed metric values that have not yet been rolled 

up.

3. The metrics that are defined for rollup are rolled up to the parent program or plan and are available on the parent 

object's Tracking  tab.
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Chapter 17. Reports
By default, Unica Plan  provides a set of predefined reports and dashboard components. The Unica Plan  reports package 

provides additional example reports and dashboard report components that are created in IBM®  Cognos®, a separate 

business intelligence application.

You access reports from Unica Plan  in the following ways:

• Click the Analysis  tabs of individual items like projects and marketing objects to see reports that apply to the current 

item.

• Select the Analytics  > analytics  to see example Cognos®  reports that present data from more than one object.

The reports administrator can modify the reports, create new reports, add custom attributes, and set up criteria filters.

Report appearance and output

Each Cognos®  report has a header, a body section, a page footer, and navigational controls. When you run a report, it 

appears in your browser window in HTML format. For many of the reports, you can select a different format (for example, 

PDF or XML) to view.

Because the following reports have multiple queries, you cannot export them as CSV or XML files.

• Analytics  page report: Project Crosstab Summary Report

• Analysis  tab reports: Project Detailed Expense Breakout, Project Approval and Response, and Budget Summary 

reports (for plans, programs, and projects)

For more information about report output appearance and formats, see the Cognos®  documentation.

Sending reports in email

Click the Email  icon ( ) to open a form where you enter email addresses for recipients of the report. After you complete 

the form and click OK, the report is sent in the format that is chosen for display.

For example, if you choose PDF and email, the report is sent as a PDF attachment to the message.

Enter the following information in the email dialog:

• Email addresses: Type the address for each recipient, separated by semicolons.

• Subject: Type subject for the message. Defaults to the name of the report.

• Body: Type the message.

• Attachments: Ensure that Include the report  is selected.
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Note:  Do not select Include a link to the report. This option is not currently supported.

Filtering data with search and select
You can filter the data in reports in different ways, depending on the report. Use search and select filters to perform a search 

and then choose which results to use for the report.

About this task

Use filters for the following types of data:

• Owners

• Users

• Vendors

• Projects

You can search by project name or project code.

1. Type keywords to search and, optionally, select one of the following search options:

Choose from:

◦ Starts with any of these keywords (default)

◦ Starts with the first keyword, and contains all of the remaining keywords

◦ Contains any of these keywords

◦ Contains all of these keywords

Example

For example, if you are searching for project code PRO1001, you can type PRO  or 1001. Then, select Contains any of 

these keywords.

2. Click Search.

Result

The system returns data that matches the search criteria.

3. Use Insert, Remove, Select all, and Deselect all  to create a list of items for your report. Move the items that you want 

to appear in your report into the Choices  list box, as shown in the following example:
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The report contains data for the owners, users, vendors, or projects that appear in the Choices  list box.

Dates filters
To narrow the date range for your report, use the Date filter.

The Earliest date  option puts no limitation on the begin dates for the search. Similarly, the Latest date  option does not limit 

by end date. The default setting is for both options to be selected, which means the system does not filter on dates.

Entering actual dates in the From  or To  field, or both, limits the report to tasks that contain dates active within the selected 

range.

Active dates

The date prompts use active dates. All projects, plans, and programs that are active any time within the specified date range 

meet the report criteria.

For example, if you specify a date range from January 1, 2015 to March 15, 2015, the following projects meet the criteria:

• Projects starting on or after January 1, 2015, no matter when they end.

• Projects ending on or before March 15, 2015, no matter when they began.

The following projects do not meet the criteria:

• Projects ending before January 1, 2015

• Projects starting after March 15, 2015

Status and type filters
Status and type filters limit reports to include only tasks with the selected status or type.

The filter options are based on the template that was used to create the project. For these filters, select as many options as 

you want.
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Note:  Making no selection is equivalent to selecting all options.

Multi-object reports
When the Unica Plan  reports package is installed, you can generate reports from the Analytics Home  page.

The following table describes the default reports.

Table  53. Default reports: Analytics Home  page

Report Description

Marketing Activity 

Report

Lists all users who logged in to Unica Plan  during a specified date range, with the total number of 

projects each user created.

Overdue Milestone 

Report

Displays all overdue milestones with task end dates that fall between the selected start and end 

dates.

Program Tasks and 

Milestones

Displays all milestones for the program you selected in the parameter field.

Project Health 

(Monthly)

Reports the percentage of time that each health status applied to the selected projects during 

the specified month. Includes a bar graph and a data grid for each project. The system uses the 

automated daily health status calculations for this report. To see the status that was calculated 

for each day, click the bar graph or the project name.

Project Health (Trend) Plots the average monthly health scores of the selected projects during the specified year on a 

line graph. The system uses the daily automated health status calculations for this report.

Project On Time 

Analysis

Displays completed projects within the specified time period along with the number of days early 

or late. These dates are calculated by pulling the greatest date in the workflow for the project for 

both the target and forecast/actual columns.

Project Performance 

Crosstab (Custom)

Displays project performance metrics, including leads passed, revenue, and ROI. The data 

is aggregated over initiative and project type versus business units. This report requires the 

Financial Management Module.

Project Performance 

Summary

Displays projects and their budget data. This report requires the Financial Management Module.

Project Performance 

Summary (Custom)

Displays projects that are grouped by initiative, with their budget, cost, revenue, response rate, 

and lead generation performance data. This report demonstrates how a sample report can be 

customized with custom attributes. This report does not work unless your template administrator 

implements the example custom attributes. This report requires the Financial Management 

Module.

Project Tasks Displays all tasks and their status for the specified project.
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Table  53. Default reports: Analytics Home  page  (continued)

Report Description

Resource Task Load Displays tasks that are assigned to selected users. The report returns tasks for each project that 

falls into the specified date range.

Resource Utilization 

Summary

Displays a summarized view of resource use percentages by user. Select start and end dates to 

specify a date range for the report.

System Programs Displays a breakdown of programs by status and template type.

System Projects Displays a breakdown of projects by status and template type.

System Users Displays details for each Unica Plan  user.

Task On Time Analysis Displays all tasks that are either early or late, where the task end date falls between the selected 

Start Date and End Date. The report is grouped by task name.

If a task ended early, the number of days it finished ahead of schedule displays on a green 

background. If it ended late, the number of days late displays as a negative number on a red 

background.

Vendor Spend 

Summary

Displays total invoiced expenses for specified vendors in the specified date range, including 

breakouts for paid, approved, and received expenses. This report requires the Financial 

Management Module.

Generating the Marketing Activity report
The Marketing Activity report presents a list of all Unica Plan  users who logged in to the system during a specified date 

range, with the total number of projects each one created.

About this task

To generate a Marketing Activity report, complete the following steps.

1. Select Analytics  > analytics.

2. In the list of reports, click Marketing Activity Report. 

Result

A screen appears, which allows you to set filter criteria.

3. Choose start and end dates for the report.

4. Click Finish  to create the report.

Results

The report contains the following columns: First Name, Last Name, Email Address, Login ID, No. of Projects, and No. of 

Subprojects.
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Generating the Overdue Milestone report
The Overdue Milestone report shows all overdue milestones with task end dates that fall between the selected start and end 

dates. You can filter the report by using the date and status filter options.

About this task

To generate an Overdue Milestone report, complete the following steps.

1. Select Analytics  > analytics.

2. In the list of reports, click Overdue Milestone Report. 

Result

A screen appears, which allows you to set filter criteria.

3. Choose start and end dates for the report.

4. Optional:  Set filters for Task and Project status.

5. Click Finish  to create the report.

Results

The report displays a list of milestones, which are grouped by the milestone owner and sorted by project code. The report 

includes the following columns: Milestone Owner, Project Code, Milestone, Task Number, Status, Task Name, End Date, 

Forecast/Actual End, Days Late, and Notes.

Generating the Program Tasks and Milestones report
The Program Tasks and Milestones report shows all milestones for projects that are part of the program that is selected 

in the parameter field. You can filter the report on milestone type. If you chose not to filter on milestone type, all tasks are 

displayed.

About this task

To generate the Program Tasks and Milestones report, complete the following steps.

1. Select Analytics  > analytics.

2. In the list of reports, click Program Tasks and Milestones.

Result

A screen appears, which allows you to set filter criteria.

3. Select a program in the Program  drop-down menu.

4. Optional:  Select milestone types for the report. If you do not choose any milestone types, the report contains all 

tasks in all projects that belong to the selected program.

5. Click Finish  to create the report.

Results
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The report displays a list of milestones or tasks, which are grouped by project and sorted by date. The report includes the 

following columns: Project Name, Milestone type, Task Number, Forecast/Actual dates and effort, Target dates and effort, 

Variance, and Notes.

The Variance column contains the number of days early or late the milestone occurred. If a milestone is reached early, it is 

displayed on a green background. If it is reached late, it is displayed as a negative number on a red background.

Generating the Project Performance Crosstab report
The Project Performance Crosstab report shows high-level project metrics in a cross tabulation along multiple dimensions of 

custom attributes.

About this task

Note:  This report requires the Financial Management Module.

1. Select Analytics  > analytics.

2. In the list of reports, click Project Performance Crosstab.

Result

A screen appears, which allows you to set filter criteria.

3. On the first filter page, choose the projects to include in the report.

To specify other filters, click Additional Prompts  and proceed to step 4. Otherwise, skip to step 5.

4. Optional:  On the second filter page, specify any of the following filters:

Choose from:

◦ Project owner

◦ Project date range

◦ Project status

◦ Project type: determined based on the template that was used to create the project

All sections on the filter pages are optional. If you do not enter any information in any of the sections, the resulting 

report contains the resource task load for all users and all projects in the system.

5. Click Finish  to create the report.

Example

The sample report is a cross tab of project performance metrics including leads passed, revenue, and ROI (Return on 

Investment), aggregated over initiative and project type for business units. The sample report contains the following 

information:

• Row Dimensions: (1) Initiative, (2) Project Type

Data in the rows is grouped by Initiative. You can use this field to categorize your programs and plans. Each Initiative 

section contains rows for each Project Type included in the report.
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Project type is determined from the template that was used for creating the project. Sample project types are 

Database Marketing Campaign, Tradeshow Template, Marketing Collateral, and Campaign Project Template.

• Column Dimension: Business Unit

A business unit is a field on the project and plan creation page. It is one way to categorize projects and plans.

• Metrics to show: number of leads passed, revenue, and ROI (Return on Investment)

Example of a Project Performance Crosstab report:

Generating the Project Performance Summary report
The standard Project Performance Summary report lists projects alphabetically, with the status, date, and budget 

information. The custom version lists projects that are grouped by initiative, with budget, cost, revenue, response rate, and 

lead generation performance data.

About this task

Note:  Both versions of this report require the Financial Management Module.

The custom version of this report also contains additional prompts and custom fields. It demonstrates how a standard 

report can be customized by using custom attributes and works only if your template administrator implements the custom 

attributes.

1. Select Analytics  > analytics.

2. In the list of reports, click Project Performance Summary.

Result

A screen appears, which allows you to set filter criteria.

3. On the first filter screen, choose the projects to include in the report. If your only filter criteria is projects, click Finish 

to run the report.
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To specify other filters, click Additional Prompts  and proceed to step 4. Otherwise, skip to step 5.

4. Optional:  On the second filter page, specify any of the following filters:

Choose from:

◦ Project owner

◦ Project date range

◦ Project status

◦ Project type: determined based on the template that was used to create the project

All sections on the filter pages are optional. If you do not enter any information in any of the sections, the report 

contains project performance for all projects in the system.

5. Click Finish  to create the report.

Results

The report displays a list of projects that are sorted by project name. The custom version is grouped by Initiative. The reports 

contain the following columns:

Table  54. Columns in the Project Performance Summary report

Column Description

Project Name/Code Displays the project name and its ID.

Status Displays the status of each project.

Target dates Displays the target start and end dates.

Business Unit, Segment, 

and Product Family

Displays the business unit, segment, and product family for each project. These fields are 

included with the sample templates, and are used to categorize projects. Not all types of projects 

contain all of these fields. If your report uses a project that does not contain one or more of these 

fields, the column is ignored (it is blank for that project).

These fields are only in the custom version of the report.

Total Budgeted Total 

Forecasted Actual Cost

Displays various budgeting information. These fields are supplied from the budget tab for each 

project.

Total Revenue Displays revenue metrics, if defined, for the project.

Response rates and 

leads columns

Displays response rate and leads generation data. Response rates and leads data are taken from 

the metrics for each project, which is found in the Tracking  tab.

These fields are only in the custom version of the report.

ROI Displays ROI (Return On Investment) metrics, if defined, for the project.

This field is only in the custom version of the report.
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Generating the Resource Task Load report

About this task

To generate the Resource Task Load report, complete the following steps.

1. Select Analytics  > analytics.

2. In the list of reports, click Resource Task Load.

Result

The Filter Resource Workload  screen appears.

3. Specify any of the following filters:

Choose from:

◦ User

◦ Projects

◦ Project date range

◦ Project status

◦ Project type: determined based on the template that was used to create the project

All sections on the filter page are optional. If you do not enter any information in any of the sections, your report 

contains the resource task load for all users and all projects in the system.

4. Click Finish  to create the report.

Results

The report results are written to the screen, unless another format is selected. The report displays tasks that meet the filter 

criteria, which are grouped by user. The report includes the following columns from the project Workflow  tab:

Table  55. Columns on the Resource Task Load report

Column Description

Task Name Displays the project name and its ID.

Project Name Displays the project name and code. Clicking the link opens the summary page of the project, if 

your report administrator has configured the drill-back URL.

Dates Displays the forecast/actual and target start and end dates.

Status Displays the status of each task.

% Complete Displays the current progress of each task.

Notes® Displays the notes for a task.

Condition Displays a condition, based on the dates for a task.

If the end date for a task is later than its target end date, this column contains one of two values:
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Table  55. Columns on the Resource Task Load report  (continued)

Column Description

• Late: If the status is In Progress or Completed, and Forecast Start Date is later than Target 

Start Date.

• Overdue: If the status is In Progress or Completed, and Forecast End Date is later than 

Target End Date.

For all other tasks, this field is blank.

Generating the Vendor Spend Summary report
The Vendor Spend Summary report displays total invoiced expenses for specified vendors in a specified date range, including 

breakouts for paid, approved, and received expenses.

About this task

Note:  This report requires the Financial Management Module.

To generate the Vendor Spend Summary report, complete the following steps.

1. Select Analytics  > analytics.

2. In the list of reports, click Vendor Spend Summary.

Result

A screen appears where you can set filter criteria.

3. Specify filters for:

◦ Vendor

◦ Invoice date range (defaults to today's date)

Both filters are required.

4. Click Finish  to create the report.

Results

The report is a summary of invoices by vendor, with three columns. The columns categorize the invoice totals by their status, 

as follows:

• The Outstanding  column totals all invoices with a status of Draft.

• The Payable  column sums all invoices with a status of Payable.

• The Actual Spent  column sums all invoices with a status of Paid.

An example of the Vendor Spend Summary report:
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Single-object reports
The single-object reports are available from the Analysis  tab of projects, programs, and plans. For these reports, you are 

reporting on that single object.

The following table describes both the standard single-object reports and the example IBM®  Cognos®  reports that are made 

available when the Unica Plan  reports package is installed.

Table  56. Default reports: Analysis  tab

Report Description

Revision History A report that lists the revisions that were made to the current object. You see this report by 

default when you click the Analysis  tab of accounts, approvals, assets, plans, programs, 

projects, marketing objects, requests, teams, and invoices.

Approval Responses A report for projects that displays information about approval tasks.

Invoice Summary List A report for projects and programs that lists invoice summary information.

Note:  This report requires the Financial Management Module.

Marketing Object 

Cross-Reference

A report for projects and marketing objects that lists the marketing objects referenced or 

modified by the current object.

Approval and Compliance 

Listing

An example Cognos®  report for projects that displays additional information about 

approval tasks.

Budget Summary An example Cognos®  report for projects, programs, and plans that displays a summary of 

the budget by week, month, or quarter.

Note:  This report requires the Financial Management Module.

Detailed Expense Breakout An example Cognos®  report for projects that displays a breakout of the project expenses.
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Table  56. Default reports: Analysis  tab  (continued)

Report Description

Note:  This report requires the Financial Management Module.

Work Assigned A report for teams that displays work assignments by team and by team member.

Viewing the revision history of an object
After you work in an object, you can view its revision history to see who created and modified the object, which fields were 

modified, and when the modification took place.

About this task

You can review the revision history for the following objects: accounts, approvals, assets, plans, programs, projects, requests, 

teams, and invoices.

1. Navigate to the Summary  tab of an object to view its revision history.

2. Click the Analysis  tab.

By default, the page displays the revision history of the object, listing all modifications to the object since it was 

created.

You can select Revision History  >  Report Type  to display the revision history if another report is displayed.

Note the following options:

◦ For projects, select Approval Responses  > Report Type  to display the revision history for any approvals that 

are linked to tasks within the project.

◦ For approvals, an entry is created whenever the approval round number changes (when the approval owner 

requests reapproval for whatever reason).

For example, if Connie Contact (approval owner) changes an approval and requests reapproval, an entry like 

the following message is added to the revision history of the approval:

Connie Contact on 12/15/2005 01:47:50 PM Approval Round #2: Approval was re-requested and the round 

number has increased.

Generating the Approval and Compliance Listing report
The Approval and Compliance Listing report lists the approval processes for the workflow approval tasks of a project. It is 

separated into sections for current approval processes, completed approval processes, and approval processes that are 

scheduled to begin in the future.

About this task

To generate the Approval and Compliance Listing report, complete the following steps.



Chapter 17. Reports

1. Select Operations  > Projects.

2. From the list of projects, select the project to generate the report for.

3. Navigate to the Analysis  tab of the project.

4. Select Report Type  > Approval and Compliance Listing.

Result

The report displays on screen.

Results

This report contains the following information:

Table  57. Columns on the Approval and Compliance Listing report

Column Description

Approval 

Process/Progress

Displays the task number, name, and progress for each approval process listed. Progress is 

described as how many approvals were received out of the total number expected.

Items Being Approved Displays a list of the items to be approved.

Approvers Displays a list of the approvers. For a required approver, displays (Required) next to the name of 

the approver.

Linked Task Displays the task number and name of the workflow task that are linked to the approval.

Status
Displays the status of the approval:

• In Progress: Approval process is active.

• On Hold: Approval process is temporarily halted.

• Completed: Approval process is completed.

• Not Started: Approval process has not been submitted for review.

Generating the Budget Summary by Quarter report
The Budget Summary by Quarter report displays budget information by quarter for the selected project, program, or plan, and 

fiscal year. For programs and plans, data rolls up from contributing projects and programs.

About this task

Note:  This report requires the Financial Management Module.

To generate the Budget Summary by Quarter report, complete the following steps.

1. From the Operations  menu, select one of the following report options:

Choose from:
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◦ Projects

◦ Programs

◦ Plans

2. Click the Analysis  tab.

3. Select Report Type  > Budget Summary by Quarter.

Result

The report for the current fiscal year displays. If there is data for more than one year, you can choose a different fiscal 

year for the report from the  Fiscal Year  menu.

Results

Data is organized for the selected fiscal year, as follows:

Table  58. Data on the Budget Summary by Quarter report

Section Description

Summary table This table displays summary budget information:

• Rows: Different breakdowns of the budget, such as actual/remaining, 

committed/uncommitted, and forecast/available

• Columns: Fiscal year total, then one column for each quarter

Note:  For projects, the report consists of only this table.

Details table For programs and plans, this table shows budget information that is rolled up from subordinate 

objects.

• Rows: For a program report, each project that is part of the program has its own row. 

Similarly, for a plan report, each program has its own row.

• Columns: Each quarter has columns for rollup budget, rollup forecast, rollup committed, 

and rollup actual.

Generating the Detailed Expense Breakout report
The Detailed Expense Breakout report displays the expenses for the selected fiscal quarter.

About this task

Note:  This report requires the Financial Management Module.

To generate the Detailed Expense Breakout report
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1. Select Operations  > Projects.

2. From the list of projects, select the project to report on.

3. Click the Analysis  tab of the project.

4. Select Report Type  > Detailed Expense Breakout.

Result

The report for the current quarter displays. If there is data for more than one quarter, you can choose a different 

quarter for the report from the Fiscal Quarter  menu.

Results

Data is organized for the selected quarter, as follows:

Table  59. Data on the Detailed Expense Breakout report

Section Description

Accounts Displays three columns (actual, committed, and forecast) of the budget information for the 

account. The data for each account is displayed on its own row. The first row contains summary 

data for all accounts.

Cost categories Displays three columns (actual, committed, and forecast) of budget information. The data for 

each category is displayed on its own row. The first row contains summary data for all cost 

categories.

Vendors Displays actual money that is spent per vendor. There is one row per vendor, and the first row 

presents summary data.

Generating the Work Assigned to Team or Team Member reports
The Work Assigned to Team or Team Member reports display the approvals, projects, project requests, and tasks that are 

associated with a team as a whole or with a specific team member.

About this task

To generate the Work Assigned to Team or Team Member reports, complete the following steps.

1. Navigate to the Analysis  tab of a team.

2. Select the report type and work assignment (approvals, projects, project requests, or tasks). If you select the Work 

Assigned to Team Member report, also select the team member.

Result

The report is displayed.

What to do next

The following information is available.
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Table  60. Data on the Work Assigned to Team or Team Member Reports

Section Description

Name Displays the name for approvals, project requests, and tasks; clicking the link opens 

the summary page of the work assignment (if your Report Administrator configured the 

drill-back URL).

Project Name Displays the project name for projects; clicking the link opens the summary page of the 

project (if your Report Administrator configured the drill-back URL).

Project Code Displays the project code for approvals, projects, and tasks.

Project Owner Displays the project owner for approvals and tasks.

Requester Displays the requester for approvals and project requests.

Task Owner Displays the task owner for tasks.

Request ID Displays the ID for project requests.

Approver Displays the approver for approvals.

Status Displays the status for approvals, projects, and tasks.

Dashboard portlets
To manage your dashboards and add portlets to them, click Dashboard  > Create Dashboard.

You can use dashboards portlets to access the information and application features that you need most often. Each 

dashboard includes one or more portlets that present different ways for you to access and update information quickly and 

efficiently:

• List portlets provide a list of links to items in Unica Plan, such as Approvals Awaiting Action, Manage My Tasks, and 

My Alerts.

• Quick Links provide single-click access to options such as Create New Project or Add Invoice.

• Report portlets give you access to reports such as Budget by Project Type or Marketing Financial Position. These 

portlets are available if the Unica Plan  reports package is installed

• Custom portlets allow you to make configurations to show any standard or saved searches

Unica Plan  list portlets
If the Unica Plan  reports package is not installed, you still have access to the Unica Plan  list portlets that are available on 

your dashboard.

Your system administrator selects the portlets that members of your organization can add to the dashboard. To manage 

your dashboards and add portlets to them, select Dashboard  > Create Dashboard.



Chapter 17. Reports

Table  61. Standard Unica Plan  list portlets

Report Description

Approvals Awaiting Action List of approvals that wait for your action.

Manage My Tasks Lists your Pending and Active tasks and Not Started and In Progress approvals. An option to 

change the status of each item appears.

• For tasks, you can change the status to Finish or Skip.

• For Not Started approvals, you can change the status to Submit or Cancel.

• For In Progress approvals that you own, you can change the status to Stop, Finish, or 

Cancel.

• For In Progress approvals that you are assigned to approve, you can change the 

status to Approve or Reject.

My Active Projects Lists your active projects.

My Alerts Lists your Unica Plan  alerts.

My Project Health Lists the name, health status, percentage complete, and number of tasks that are assigned 

to you for each project that you own or that includes you as a reviewer or member. The 

percentage complete is calculated as:

(Number of Finished Tasks + Number of Skipped Tasks)/Total Number of Workflow Tasks

• To recalculate project health status, click . The system recalculates the health 

status for display by this portlet only. It does not work elsewhere in Unica Plan.

Note:  Project health calculations can be made only at 5-minute intervals.

• If you own more than 100 projects, click Show All  to open the list in a new dialog.

• To export listed project data into a .CSV file, click Export.

• You can view the summary information for a project on the Summary  tab. To view 

more metrics for project health, click the percentage complete indicator. To view the 

My Tasks  list, click the number in the Tasks column.

My Requests Lists requests that you own.

My Tasks Lists tasks that you own.

Projects Over Budget Lists all projects that are over budget for the calendar year.
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Table  61. Standard Unica Plan  list portlets  (continued)

Report Description

Note:  This report requires the Financial Management module.

Quick link portlets
Quick links are pre-defined links to Unica  products. Some quick links enable users to perform basic actions in the Unica 

product within the dashboard, without navigating to the product. You can configure portlets that contain a set of quick links 

that you choose.

Quick links for Unica  products are installed when the product is installed. As of the 9.0.0 release, only Unica Plan  provides 

quick links. The same security considerations apply for quick links as for pre-defined portlets.

To add a quick links portlet to one of your dashboards, click Manage Portlets > Create Quick Link Portlet  and select the 

quick links you want to include.

The following table describes the quick links available when Unica Plan  is installed.

Table  62. List of quick link portlets

Quicklink Function

Create New Project Request Opens up a popup window where you can choose a project template to create a Project 

Request. You can also click Continue  to open the Project Request wizard in the application.

Create New Project Opens up a popup window where you can choose a Project template to create a Project. You 

can also click Continue  to open the Project wizard in the application.

Add Invoice Opens the Add Invoice wizard in the application.

Projects Opens the Project List page in the application.

Reports Opens the Analytics > Operational Analytics  page.

Resource Library Opens the Asset Library page in the application.

Approvals Opens the Approvals List page in the application.
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Unica Plan  report portlets
The following table describes the Unica Plan  dashboard portlets that are available after the Unica Insights is installed or the 

Cognos Unica Plan Reports package for Cognos is installed.

Table  63. Standard Unica Plan  report portlets

Report Description

Budget by Project Type An example report shows a 3-D pie chart of the budget per project type for the current 

calendar year. This report requires the Financial Management module.

Completed Projects by 

Quarter

An example report shows a 3-D bar chart of the number of early, on-time, and late projects 

completed this quarter.

Forecast by Project Type An example report shows a 3-D pie chart of the forecasted spending per project type for the 

current calendar year.

Manager Approval Summary An example report shows data for active and completed approvals for all In Progress 

projects in the system.

Manager Task Summary An example report shows data for active and completed tasks for all In Progress projects.

Marketing Financial Position An example report shows a timeline with Budget, Forecasted, Committed, and Actual 

amounts for all plans in all states in the current calendar year. This report requires the 

Financial Management module.

My Task Summary An example report shows data about all active and completed tasks for the user who is 

viewing the report in all In Progress projects.

My Approval Summary An example report shows data about active and completed approvals for the user who is 

viewing the report in all In Progress projects.

Projects by Project Type An example report shows a 3-D pie diagram that shows all In Progress projects in the system 

by template type.

Projects by Status An example report shows a 3-D bar chart that shows all projects in the system by status: 

draft, in progress, on hold, canceled, and finished.

Projects Requested and 

Completed

An example report shows a timeline graph of the number of project requests and number of 

completed projects per month. This report counts project requests with the following states 

only: Submitted, Accepted, or Returned.

Spend by Project Type An example report shows a 3-D pie chart of the actual amount that is spent per project type 

in the current calendar year. This report requires the Financial Management module.

Custom portlet to show standard or saved search

To add a custom portlet to one of your dashboard, refer to the “Unica Platform Administrator's Guide > Dashboard 

management > Custom portlets. Before you begin section - for creating the custom portlet with a saved search. Note: The 

URLs must first be registered.
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Get the URL from the list you want to show and append &hideToolbar=true to it. Example: http://myServer:7001/plan/

uapcalendarservlet?

cat=commonsearch&func=openSavedSearch&folderid=1&searchid=1&keepSearchDialogOpen=no&refetch=yes&searchResultFlag=no&focusSearchDialogTextField=yes&recreateListHandler=yes&keepCurrentView=no&data=project&launch_context=list&hideToolbar=true

To avoid any authentication issue, the dashboard must include at least one Plan list portlet.
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You can perform simple and advanced searches in Unica Plan.

You can perform a simple or advanced search for plans, programs, projects, tasks, assets, approvals, marketing objects, 

and invoices from any view in the corresponding section of Unica Plan. Searching in the Programs section retrieves only 

programs. Searching in the Projects section retrieves only projects.

Simple searches

You can use the Unica  simple search function to search for most objects, including plans, programs, projects, assets, 

approvals, tasks, and invoices. You can perform these searches by using the Search  field in the menu bar at the top of the 

window. For details on this search function, see the Unica Platform  Administrator's Guide. You can use this search to search 

for most objects, including plans, programs, projects, assets, approvals, tasks, and invoices.

Advanced searches

You can use the Unica Plan  advanced search function to specify more complex searches. These searches can be based on 

several different criteria that apply the type of items for which you are searching. You can save commonly used advanced 

searches to save time.

Advanced searching works the same for all objects except assets. Unica Plan  provides one type of advanced search page for 

assets and a different type for all other objects that contain advanced search functions.

Permissions considerations

When you search for an object, Unica Plan  always conducts the search against all the objects the user has security rights to 

view (for example, all projects). This comprehensive search occurs even if you initiate the search from within a filtered view, 

such as the Active Projects view, or from within a saved search.

For example, your system administrator did not give you access to the Workflow  tab of a project template. Even if you are a 

member of the project, tasks from the project that is created from that template do not appear in the results of an All Tasks 

search. However, if one or more tasks from that project are assigned to you, then those projects display regardless of your 

access rights.

Grid searches
With advanced searches, grid attributes appear in the list of available attributes to add to a search. This search looks for all 

project templates that are enabled, whether any projects or marketing objects exist that were created from that template.

For example, assume that your system contains the following items:

• A project template named "Trade show", which is enabled.

• A Vendors  tab is available for Trade show templates.

• The Vendors  tab contains a grid. One of the grid columns is named Vendor URL.
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On the advanced search screen for projects, you can select Vendor URL  when you choose a condition for the search. The 

Vendor URL  attribute appears in the list, even if your system does not contain any "Trade show" projects.

When a template is deleted, its grid attributes are no longer available as search criteria. You can search for attributes in a 

disabled template by choosing a disabled template or All Disabled  from the advanced search screen.

Object attribute searches
You can search for attributes that are contained in marketing objects that are linked from other marketing objects or from 

projects.

For example, suppose that you have projects that link to marketing objects that contain an attribute for which you want to 

search. The projects are of type "Marketing Collateral", which link to marketing objects. These marketing objects are of type 

"Creatives", which contain an attribute Cost, which is the cost of the creative.

From the project page, you can perform an advanced search that returns projects that are based on the criteria you specify 

about the Cost  attribute.

Searching a digital asset library
Use the advanced search for assets to search for information in specific fields that the owner provided when they created or 

modified the assets.

About this task

To perform an advanced search of a digital asset library, complete the following steps.

1. Select Operations  > Assets.

2. Select a digital asset library to search.

3. Click the Search/Filter  icon ( ).

Result

The Assets Search  screen appears.

4. Complete the fields, depending on what you want to search for.

5. Click Search.

Results

The items that meet the search criteria are displayed on the Assets  list page.

Searching for objects other than assets
Use the advanced search to search for objects that are not assets.

About this task
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To perform an advanced search (except for assets), complete the following steps.

1. Open the list page of the object type for which you want to search.

Example

For example, open the list page for a project or task.

2. Click the Search  icon ( ).

Result

The Advanced Search  page appears:

3. Select a template on which to base the search.

The list groups templates for the object type into All Templates, All Enabled, and All Disabled.

Note:  This list does not appear if there is only one template available for the object type.

4. Select an attribute on which to base the search.

Attributes are listed in alphabetical order.

5. Select an operator for the search.

The operators that are available depend on the type of attribute that is selected for the search.

6. Select or enter a value.

7. Repeat steps 3 through 6 as necessary to add criteria to your advanced search.

8. If you specify multiple criteria, indicate whether you want to search for objects that match any of your criteria or all of 

your criteria.

9. Optional:  Click Save as  to save the search.

Administrators can also publish the search by selecting the Publish  check box on the Save As  dialog box. Published 

searches are available to all Unica Plan  users.

10. Click Apply  to complete the search based on your criteria.

Regrouping and reordering search criteria
As you construct search criteria, you can rearrange the grouping and order of any search condition.
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About this task

To regroup and reorder search criteria, complete the following steps.

1. For the condition you want to move, position the cursor over the number box for the condition.

Result

The cursor changes to a double vertical arrow. The tooltip Drag to move this condition to another place in the 

query.  appears.

2. Drag the condition to where you want to insert it.

Result

The red guide line shows where the condition will be inserted.

3. When the condition is positioned correctly, release the mouse to drop it into its new location.

Note:  You can drag and drop search criteria at any level.

The Not In operator
The operator Not In  returns all instances of objects that do not have the value of the attribute that is specified in the search 

or do not include the attribute.

Templates and attributes

Unica Plan  objects (plans, programs, and projects) are created from templates.

Templates have definitions of attributes, such as brochure_type. Project instances that are created from the same template 

can have different values for their attributes. For example, TS001 might have Tri-fold  defined as its brochure type, and TS002 

might have Bi-fold  defined as its brochure type.

In a typical Unica Plan  installation, there are multiple project templates, and a particular attribute might be present in some 

templates and absent in others.

The behavior of the Not In operator

For example, if you search for "all fruits that do not have black colored seeds", your search returns fruits that do not have 

black colored seeds and fruits that are seedless. (Seedless fruits do not have black colored seeds.)

Consider the following example:

• Template1 has the custom tab Business  that contains the attribute BusinessUnit.

• Template2 does not have the Business  custom tab, so it does not contain the BusinessUnit  attribute.

• Two projects are created from Template1:

◦ Project1 is created with "Insurance" as the value for BusinessUnit.

◦ Project2 is created with "Banking" as the value for BusinessUnit.

• Two projects are created from Template2: Project3 and Project4.
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If you create a search with the following criteria, the search returns Project2, Project3, and Project4 because none of these 

projects has BusinessUnit = Insurance.

[All Templates] -> [BusinessUnit] -> [Not In] -> [Insurance]

Assets advanced search page
When you click Advanced Search  on a digital asset list page, the system displays a page with the following fields.

Table  64. Advanced search options for digital assets

Field Description

Asset Name Search in the Asset Name  field of all existing assets. Unica Plan  searches for all asset names that 

contain the text string you enter. You can use the following standard wildcards:

• * - to search for any string

• ? - to search for any character.

AND

OR

Choose a Boolean operator:

• AND: Returns items that contain all of the words in the Asset Name  field.

• OR: Returns items that contain any of the words in the  Asset Name  field.

Asset Code Search in the Asset Code  field of all existing assets. Unica Plan  searches for all codes that 

contain the string that you enter.

Description Search for text in the Description  field of all the existing assets. Unica Plan  searches all 

description fields for the characters that you enter.

Status Select any or all of the statuses to search: Draft, Finalized, or Locked.

Expires Before Specify a date. Unica Plan  searches for all assets with expiration dates on or before the date that 

you specify.

Folder Name Enter part or all of a folder name to search. Unica Plan  searches for all folder names that contain 

the text string that you enter and searches for assets in that folder.

Keywords Search in the Keywords  field of all assets. Unica Plan  searches for any of the keywords that 

contain the text string that you enter.

Owners Select one or more owners to search for assets that belong to the owner.

Version Name Search in the Version Name  field of all assets. Unica Plan  searches for all versions that contain 

the text string that you enter.

Usage Guidelines Search in the Usage Guidelines  field of all assets. Unica Plan  searches for all usage guidelines 

that contain the text string that you enter.

273



Unica Plan V12.1.7 User's Guide

274

Advanced search page for objects other than assets
When you click Search  on the list page for most Unica Plan  objects, the system displays a page with the following fields.

Table  65. Advanced Search options for other objects

Control Description

Search for Enter text to indicate the objects for which you are searching.

Select items Specify whether the search needs to match all or any of the search criteria. The default is all.

Condition Construct a search condition by specifying the following options:

• Select the template on which to base the condition.

• Select the attribute for which you want to search.

• Select the search operator.

• Enter the value for the criteria.

For example, search for projects with names that include the word Marketing.

• Select All Enabled  to search on all enabled project templates.

• Select Project Name.

• Select Contains .

• Type Marketing.

Grouping Construct a grouping for the search results by specifying the following options:

• Select all  or any  for the grouping criteria.

• Supply the remainder of the grouping criteria as described for constructing the Condition.

Insert a new condition Insert a new line for entering a condition.

Insert a new grouping Insert a new line for grouping the search criteria.

Remove selected Remove any selected conditions or groupings.

Save as Save your criteria as a named search. Unica Plan  administrators can publish a search by selecting 

the Publish  check box.

Apply Complete the search based on the criteria that you specified.

Reset Reset the dialog box to clearing the criteria that you specified.

Close Close the dialog box without completing the search.

Saved searches
You can save any advanced search by clicking Save As  on the Advanced Search  page. Saved searches are available only for 

plans, programs, projects, and marketing objects.
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There are two types of saved searches: unpublished and published. Unpublished saved searches are available only to the 

user who saved it. Published saved searches are available to all users. Only an administrator can publish saved searches.

How to access saved searches

After you save a search, you can access the search and rerun it with the same criteria. You can access saved searches in two 

ways:

• From the Action  menu on the object list page

• On the list page, when you view all objects of that type by selecting All [item]  in the Action  menu

For example, saved searches for projects are available on the Projects List  page when you view all projects and requests. If 

your system contains any published saved searches, they are listed with your unpublished saved searches.

How to set the sort order in saved searches

When you save a search, the sort column and sort order that exist on the page from which you are searching becomes the 

default sort order in the saved search.

Note:  If you create a saved search from another saved search that has optional columns, the optional columns are 

not included. If the sort column in the original search was optional, in the second saved search the sort column 

reverts to the default. The sort column does not exist in the new saved search.

You can change the sort column and sort order of an unpublished search by doing the following actions:

1. Changing the sort column and sort order of the list page

2. Accessing the saved search

3. Clicking Save  to update the search

This option applies only to unpublished searches. To change the sort column and sort order for a published search, an 

administrator must unpublish the search, change the sort, and republish the search.

Viewing a saved search
You can view all published searches and any unpublished searches that you saved.

About this task

To view a saved search, complete the following steps.

1. Open the list page for an object type.

2. Click All <objects>  (where <objects>  are projects/requests, programs, or plans).

Result

Your saved searches and all published searches appear as folders at the top of the screen.
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3. Click the folder that contains the search results you want to view.

Note:  Saved searches are also available from the Actions  icon menu.

Deleting a saved search
You can delete only your own saved searches. You cannot select any other searches.

About this task

You cannot delete a saved search with any of the following characteristics:

• Created by another user

• A default calendar, project, or task search

• A system search

• Published

• The search the user is currently using

1. Open the list page for an object type.

2. Click the Actions  icon ( ) and select the search or searches that you want to delete.

3. Click Delete Selected  to remove your selected searches.
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You can use alerts and the message board both to communicate information to other users of Unica Plan. Alerts and the 

message board are available for plans, programs, projects, requests, assets, accounts, approvals, invoices, tasks, teams, and 

marketing objects.

From version 12.1.2, you can use alerts for the Checklist and To-do feature as well. The message board feature is not 

available for Checklists and To-dos.

You can use alerts to communicate information to specific people about the state of an object or about an action that the 

user needs to take. Default alert subscriptions are set by administrators but can be overridden on a per-object basis by 

owners and participants of the specific objects.

For workflow tasks, alerts are either brief or detailed.

You can use the message board to communicate information to the other members of the team or to an object owner.

The Alerts  page
When you receive an alert, go to the Alerts  page to view it. Alerts are also sent to affected users' email addresses (for each 

user that has a valid email address that is set up).

For a detailed list of events that might trigger an alert and for more information about setting up alerts, see the Unica Plan 

Administrator's Guide.

To view alerts, log in and click the Alerts  icon ( ). Clicking, or scrolling, over the alerts icon shows a drop-down menu that 

separates the alerts for your installed applications. The number of alerts is displayed to the left of each application name. 

After you choose which application's alerts to view, the page displays the following information:

Table  66. Columns on the Alerts  page

Column Description

Page heading The number of unread alerts, in parentheses, and the total number of alerts

Check box Select alerts for a specific action, for example, to mark a group of alerts for deletion.

Select the box in the first line, next to the Message Text label, to select all the alerts.

Message text Text of the alert

Date/Time The time of the event that triggered the alert

You can perform the following actions from the Alertspage:
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Table  67. Controls on the Alerts  page

Link/Button Description

Select the envelope icon next to an alert to mark the alert as read.

After you click the icon, the alert is disabled. Reselect the icon to mark the alert as unread.

Alert title Click the link in the alert to go to the object that is the subject of the alert.

Note:  The Alerts  page remains open while you view the information in a separate window.

Pages Click a page number to list the corresponding page of alerts.

Delete Selected Click to delete the selected alerts.

Delete All Click to delete all of your alerts.

Mark All as Read Click to mark all your alerts as read, graying out each alert. A confirmation screen is displayed to 

ensure that you want to mark all alerts as read.

Mark All as Unread If you have no unread alerts, click this link to mark all your alerts as unread.

Close Click to close the Alerts  page.

Alerts on outside email addresses
You can receive alerts to an email address that is outside the domain of your organization.

If your email address is outside the domain of the organization that has Unica Plan  installed, you need to modify your SMTP 

server to receive alerts. Add the IP address of the Unica Plan  server to the relay allowed IP address list.

Comments for alerts
Users can add comments to some alerts before the system sends the alerts.

For many events, the system sends alerts that are based on actions that users perform.

For example, when a project owner starts a project, the system sends alerts to project members. Before the system sends 

the alert, the project owner can add comments to the alert. The system provides a dialog box that contains the text of the 

alert. The user can enter any additional comments to the alert. When the user closes the dialog box, the system sends the 

alert, including the comments.

For the following events, users can add comments to the alert before the system sends the alert:
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Table  68. You can add comments to the alerts for these events

Object Events

Project request
• A project request is submitted.

• A project request is accepted.

• A project request is returned.

• A project request is canceled.

Project
• A project is started.

• A project is put on-hold.

• A project is restarted.

• A project is completed.

• A project is canceled.

• A project is put in not started state.

Program
• A program is started.

• A program is put on-hold.

• A program is restarted.

• A program is completed.

• A program is canceled.

Plan
• A plan is started.

• A plan is put on-hold.

• A plan is restarted.

• A plan is completed.

• A plan is canceled.

Approval
• An approval process is started.

• An approval process is put on-hold.

• An approval process is restarted.

• An approval process is complete.

• An approval process is canceled

Asset
• An asset is drafted.

• An asset is locked.

279



Unica Plan V12.1.7 User's Guide

280

Table  68. You can add comments to the alerts for these events  (continued)

Object Events

• An asset is finalized.

• An asset is archived.

Invoice
• An invoice is marked as payable.

• An invoice is marked as paid.

• An invoice is redrafted.

• An invoice is canceled.

Checklists
• A checklist is created.

• A checklist is updated.

• A checklist is deleted.

• A checklist is shared.

• A checklist is unshared.

• A todoItem is created.

• A todoItem is updated.

• A todoItem is assigned.

• A todoItem is unassigned.

• A todoItem is completed.

• A todoItem is rejected.

• A todoItem is deleted.

Marketing object The status of a marketing object changed.

Subscribing to alerts for an object
Users who are not administrators can override default settings within a plan, program, project, or project request. By 

overriding the default, you can control the alerts that each object owner and participant receives.

About this task

If there are permissions that are configured for any of the tabs of a project or request, the system filters the alerts. For 

example, alerts about attachments are not sent to users who do not have access to a project Attachments  tab.

1. Open the object for which you want to change alert subscriptions.

2. Click the Communicate  icon ( ) and select Subscribe to Alerts.

3. From the list of alerts, select the alert that you want to change. You can set or clear alert subscriptions for each type 

of user: Owner, Editor, Viewer, Assignee, or Participant. The possible entries are as follows:
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Option Description

Check mark The user receives the alert or alarm.

Blank The user does not receive the alert or alarm.

n/a You did not specify team membersusers  for this access 

level  (for example, Program Participant)  when you creat­

ed the object. After you add team members  with the cor­

responding access level, you can set alerts for that ac­

cess level.

4. Click Accept  to save your changes or Cancel  to leave the alert settings as they were.

Brief and detailed task alerts
When someone makes edits to a workflow, they can make numerous edits that can affect several tasks, members, and 

dates. You can determine whether users receive detailed or brief alerts about the workflow changes.

Both brief and detailed alerts can be sent through email and within Unica Plan:

• Brief mode: The notification informs users that changes were made to the workflow. In certain cases, the field that 

was changed and new value are shown.

• Detailed mode: The notification contains a section for each task that changed. For each change, both the previous 

and current values are listed in the alert.

Note the following restrictions:

• If a project is set up to deliver detailed alerts to owners and participants, any changes to workflow tasks lead to a 

detailed alert sent to project owners and affected task members. Brief alerts that are related to workflow tasks, such 

as Task Assigned or Task Started, are not sent.

• If a project is set up to deliver detailed alerts to owners only, then changes to workflow task rows lead to a detailed 

alert sent to project owners only. Affected task members receive brief alerts.

Task alert level

Your administrator can select the Detailed workflow change notification  alert. If so, by default, all projects send detailed 

alerts. Project owners and members can override the default setting on a per-project basis, by changing the setting for the 

Detailed workflow change notification, in the alert subscription window for each project.

Group events that contribute to detailed alerts
Edits that are made to the workflow and a few other actions can lead to task alerts being sent, if a project is set for detailed 

alerts.

The following table describes the actions that result in alerts:
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Table  69. Actions that result in alerts

Tab Actions

People
• If a user uses the find and replace feature to change a workflow, Unica Plan  sends an alert 

to both the previous and new task owners.

• If a user clicks Assign work by role, Unica Plan  sends an alert to each user assigned (or 

unassigned) tasks.

Tasks
• If a user clicks Complete Selected, Skip Selected, or Reassign Selected, Unica Plan  sends 

an alert that indicates the affected tasks.

• If a user edits a task from the screen, Unica Plan  sends an alert to indicate the changes to 

the task.

Teams If a team manager or member reassigns tasks, Unica Plan  sends an alert to both the previous and 

new task owners.

Approvals If a user edits an approval task that is part of a workflow, Unica Plan  sends an alert to indicate 

changes to the task.

Examples of brief and detailed alerts
The following examples show both brief and detailed alerts.

The following example depicts an email that a user might receive if the project is set up to deliver brief alerts:

 

Subject: Project workflow updated: "Project 0004 (TRS1022)"
Project updated: "Project 0004 (TRS1022)"
By: asm admin
When: Monday, October 15, 2007 at 1:38:24 PM EST
Comment: "Workflow" tab updated.
Description: Tradeshow for 1st Mutual Bank of Fred
Click
http://svr01:7001/MktOps/affiniumplan.jsp?cat=projecttabs&projectid
=103 to go to project.

The following example depicts an email that a user might receive if the project is set up to deliver detailed alerts.

 

Subject: Project workflow updated: "Project 0004 (TRS1022)"
Project workflow updated: "Project 0004 (TRS1022)"
By: asm admin
When: Monday, October 15, 2007 at 1:38:24 PM EST
Task : 1.1 Determine objectives and theme (Task Code : <empty>)
Target Start changed to 11/01/2007 09:00:00 AM from 10/17/2007
09:00:00 AM
Notes changed to My Added new notes...... from Added new notes
% Complete changed to 6 from 3
Target End changed to 11/05/2007 05:00:00 PM from 10/19/2007
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05:00:00 PM
Members changed to rm_user3, rm_user2, from asm admin
Task : 1.2 Estimate costs (1.1,1.1) (Task Code : <empty>)
Target Start changed to 11/06/2007 09:00:00 AM from 10/22/2007
09:00:00 AM
Notes changed to My Added new notes...... from Added new notes
% Complete changed to 25 from 10
Target End changed to 11/07/2007 05:00:00 PM from 10/23/2007
05:00:00 PM
Members changed to rm_user3, rm_user2, from asm admin
:
:
Click
http://svr01:7001/MktOps/affiniumplan.jsp?cat=projectworkflow&projectid
=103 to go to project.

Posting a message on the message board
On the message board, you post and read messages about a particular plan, program, project, asset, account, approval, 

or invoice object. You can use this feature as a method of communicating information about an object. When you post a 

message to the message board, any user who has permission to access that object can view the posted message.

About this task

To post a message on the message board, complete the following steps.

1. Open the list page for the object type of the object for which you want to post a message.

Example

For example, click Operations  > Accounts.

You can post messages for plans, programs, projects, assets, accounts, approvals, or invoices.

2. Click the plan, program, project, account, approval, or invoice for which you want to post a message.

3. Click Communicate  ( ) in the Unica Plan  toolbar and select Post a Message.

Result

The Messages  window is displayed. From version 12.1.3, if the administrator has configured Slack as the 

collaboration tool, with Unica Plan, you can click Slack channel  to directly access the channel on the Slack 

application and read the conversation on Slack. By clicking Slack channel  on Plan, you can avoid browsing through 

various channels on Slack to locate the appropriate channel.

4. Enter your message.

5. Select a delivery option.

By default, you also receive an email alert when you post a message.

6. Click Post Comment.

Result

The Messages  window displays all the posted comments for this object. Your new comment displays at the top of 

the list.
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If you chose an email option, your message includes a line that lists the email recipients, such as:

(cc'd to Mary Manager, Connie Contact, aartiste@mycompany.com)

Full names displays for users who are identified in Unica Platform, otherwise the email address displays.

7. Click Close  if this comment is the only one you want to post now, or click Post a Comment  to post an another 

comment.

Result

Unica Plan  posts the message to the message board and sends email messages as specified. The email messages 

contain the text that you posted and a link to the object you identified as the subject.

Configuring a Collaboration Tool
You can configure a collaboration tool with Unica Plan. Unica Plan provides out-of-the-box settings that you can use to 

collaborate using Slack. Slack is not packaged with the Unica installer. You have to create your own Slack account. The Plan 

administrator will set up the configurations required to use the collaborations tool.

About this task

Some rules related to using a third-party collaboration tool are as follows:

• The project owner and the participants should have an account in the third-party collaboration tool.

• Only the project owner can create a channel for the project

• If a participant does not have an account in the third-party collaboration tool, the project owner can still add a 

participant. The participant will be able to view messages and send messages on Plan, but will not be able to send 

messages on the collaboration tool.

• The project owner can create only one channel per project.

To configure a collaboration tool and to start collaboration, complete the following steps:

1. Click the project for which you want to create a collaboration channel.

2. Click Communicate  ( ) in the Unica Plan  toolbar and select Configure collaboration tool. The Configure 

collaboration tool  will be disabled for participants (team members) in a project.

Result

The Configure collaboration tool  dialog appears.

3. Perform the following steps:

a. Select Enable collaboration tool.

b. Type an appropriate Channel name.

c. Click Accept.

4. Add team members or participants for collaboration. For more information, see Managing project members  on 

page 175.
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For verification, see the third-party collaboration tool if the notification appears for successful addition of 

participants.

5. Once the members are successfully added, the members can collaborate with each other from Plan or from the third-

party application. The notifications and the messages will be visible in both applications.
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Chapter 20. Reading a message on the message board
You can read messages that were previously posted to the message board, if you have permission to view that object. 

Messages can be posted for plans, programs, projects, assets, accounts, approvals, or invoices.

About this task

To read a message on the message board, complete the following steps.

1. Open the list page for the object type of the object for which you want to read a message.

Example

For example, click Operations  > Accounts.

You can post or read messages for plans, programs, projects, assets, accounts, approvals, or invoices.

2. Click the plan, program, project, asset, account, approval, or invoice whose messages you want to read.

3. Click the Communicate  icon ( ) and select Read Messages.

Result

The Messages  window displays all the messages on the message board for that object. From version 12.1.3, if the 

administrator has configured Slack as the collaboration tool, with Unica Plan, you can click Slack channel  to directly 

access the channel on the Slack application and read the conversation on Slack. By clicking Slack channel  on Plan, 

you can avoid browsing through various channels on Slack to locate the appropriate channel. For more information 

on configuring Slack on Unica Plan, see Configuring a Collaboration Tool  on page 284.

Note:  For the Slack channel  feature to work, you must be logged in to Slack.

4. Click Close  to exit the message board or click Post a Comment  to respond to a posted message.
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Checklists are independent of other features of Plan and you can use checklists to maintain lists of to-dos for yourself or any 

other user.

• For more information on To-dos, see To-dos  on page 287.

• For more information on Checklists, see Checklists  on page 295.

To-dos
To-dos are items in a checklist. To-do is a task or an activity that you must perform.

The features of To-dos are as follows:

• You can create a To-do for yourself.

• You can create a To-do for someone else.

• You can add a To-do to a checklist.

• You can have independent To-dos. These To-dos are not assigned to a checklist.

• You can set the status of a To-do.

• You can set the priority of a To-do.

• You can set a due date for a To-do.

• You can reject a To-do assigned to you by someone else.

Creating To-dos
To create to-dos, complete the following steps:

1. From the Unica Platform homepage, select Plan  > Checklist.

Result

The Checklists  page appears.

2. Click + To-do.

Result

The Create To-do  panel appears.

3. In the Status  dropdown, select the status from the following options:

◦ New  - Select the option if the To-do is new.

◦ In Progress  - Select the option if the To-do is already in progress.

◦ Complete  - Select the option if the To-do is completed but you are creating it for tracking purposes.

4. In the Priority  dropdown, select the priority of the To-do using one of the following options:

◦ Low

◦ Medium

◦ High

5. Provide values for the following fields:
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◦ Name of To-do  - A name for the To-do that you are creating. This is a mandatory field.

◦ Description  - A description for the To-do.

◦ Select Checklist  - A checklist that the To-do belongs to. This is an optional field. A To-do need not be part of a 

checklist.

◦ Assign To  - The user that you want the To-do to be assigned to. You can assign it to self or another user.

◦ Due Date  - The date by which the To-do should be completed.

6. Click Add.

Result

A success message appears for the To-do that you created.

Viewing the To-do list and previewing a To-do
After creating a To-do, it appears in the list of to-dos.

About this task

To view the list of To-dos or to preview a To-do, complete the following steps:

1. From the Unica Platform homepage, select Plan  > Checklist.

Result

The Checklists  page appears. The panel on the left lists the To-dos.

2. By default, the My To-dos  section is seen. You can view all your To-dos based on the filter and the sorting order that 

you have set.

a. The available options for filtering the results are as follows:

▪ Created By Me  - Select this option to view all To-dos that you have created.

▪ Assigned To Me  - Select this option to view all To-dos assigned to you.

▪ Unassociated To-dos  - Select this option to view all To-dos that are not part of a Checklist, but might 

be created by you or assigned to you.

▪ Completed To-dos  - Select this option to view all To-dos whose status is marked as Complete.

▪ Overdue  - Select this option to view all To-dos that have missed the due date.

▪ Unscheduled  - Select this option to view all To-dos that do not have a due date.

▪ All To-dos  - Select this option to view all To-dos.

The default filter is Assigned To Me. If you want to change the default filter, click the Default  button succeeding 

the options to set the new default filter. The total number of To-dos, based on the filter applied, appears below 

the filter.

b. The available options for sorting the results are as follows:

▪ By Name: A - Z  - Select this option to filter results by name in ascending order.

▪ By Name: Z - A  - Select this option to filter results by name in descending order.

▪ By Due Date: Ascending  - Select this option to filter results by due date in ascending order.

▪ By Due Date: Descending  - Select this option to filter results by due date in descending order.
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▪ By Priority: High - Low  - Select this option to filter results by priority, starting from high to low.

▪ By Priority: Low - Low  - Select this option to filter results by priority, starting from low to high.

The default sort option is By Priority: High - Low. If you want to change the default sort option, click the 

Default  button succeeding the options to set the new default sort option.

3. Select Flagged To-dos  to view the list of flagged to-dos. For information on flagging a to-do, see Flagging To-dos  on 

page 293. The filters and sorting is the same as steps 2a  and 2b.

4. To preview a To-do from the list of My To-dos  or Flagged To-dos, click a To-do and a preview dialog appears with the 

following details:

◦ Name of To-do  - The To-do name.

◦ Name of Checklist  - The Checklist the To-do belongs to.

◦ Due date  - The due date of the To-do.

◦ Status  - The current status of the To-do.

◦ Owner  - The user who created the To-do.

◦ Assign to  - To user the To-do is assigned to.

To close the To-do preview, click Close. To modify the To-do, click Edit To-do.

Searching for To-dos

About this task

To search for To-dos, complete the following steps:

1. On the Checklist page, place the cursor on the Search for To-do  field.

2. Type in the name of the required To-do. If the To-do exists, the system locates and displays the To-do.

3. If you still cannot see the To-do, change the Filter  to the value All To-dos.

Editing a To-do
Modify or update existing To-dos using the Edit option.

About this task

You can edit the To-dos for the following reasons:

• Updating the status

• Updating the priority

• Assign a To-do to another user

• Change the name of a To-do

• Update the description of a To-do

• Assign the To-do to a checklist

To edit a To-do, complete the following steps:
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1. From the Unica Platform homepage, select Plan  > Checklist.

Result

The Checklists  page appears.

2. Select a To-do from the list of My To-dos, Flagged To-dos, or from the checklists on My Board. If required, use the 

Search feature to locate a To-do.

3. Perform Step 4 or Step 5 to edit a To-do:

4. Method 1:

a. Click the To-do.

Result

A preview dialog of the To-do appears.

b. Click Edit To-do.

Result

The Edit To-do  dialog appears.

c. In the General  tab, make the necessary modifications. For more information on the fields, see Creating To-dos 

on page 287.

d. In the Notes  tab, you can add, edit, or delete Notes. For more information, see Using Notes  on page 290.

e. In the History  tab, view all the changes made to the To-do.

f. Click Save.

5. Method 2:

a. After locating the To-do, select  > .

Result

The Edit To-do  dialog appears.

b. In the General  tab, make the necessary modifications. For more information on the fields, see Creating To-dos 

on page 287.

c. In the Notes  tab, you can add, edit, or delete Notes. For more information, see Using Notes  on page 290.

d. In the History  tab, view all the changes made to the To-do.

e. Click Save.

Using Notes
(This feature is available in version 12.1.0.4) You can use the Notes tab to track actions taken on To-dos.

About this task
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You can add, edit, or delete notes based on your role related to the To-do or Checklist. The following table lists the roles and 

permissions for using Notes in a To-do:

Role Permissions

To-do Owner Add Notes | Edit Notes | Delete Notes

To-do Assignee Add Notes | Edit Notes | Delete Notes

Checklist Owner Add Notes | Edit Notes | Delete Notes

Checklist Editor Add Notes | Edit Notes | Delete Notes

Checklist Viewer NA

Also, when you add, edit, or delete notes, the details are logged in the History  tab.

1. Adding Notes

a. Locate the required To-do.

b. Select  > .

Result

The Edit To-do  panel appears.

c. Select Notes  tab.

d. Place the cursor in the Type your note here  field and type your note.

e. Click Add.

2. Editing Notes

a. Locate the required To-do.

b. Select  > .

Result

The Edit To-do  panel appears.

c. Select Notes  tab.

d. For the required Note, select  > .

Result

The Edit Note  dialog appears.

e. Make the required modifications and click Save.
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3. Deleting Notes

a. Locate the required To-do.

b. Select  > .

Result

The Edit To-do  panel appears.

c. Select Notes  tab.

d. For the required Note, select  > .

Result

The Delete Note  confirmation box appears.

e. Click Delete.

Actions on To-dos
You can perform the following actions on To-dos:

• Duplicating a To-do.

• Change the status of a single To-do, or multiple To-dos, to In Progress.

• Change the status of a single To-do, or multiple To-dos, to Completed.

• Flag  a single To-do or multiple To-dos.

• Unselect  a single To-do or multiple To-dos.

• Delete  a single To-dos or multiple To-dos.

Copying a To-do

About this task

To create a copy of a To-do, complete the following steps:

1. On the Checklists  page, locate the required To-do from the My To-dos  tab or the Flagged To-dos  tab. If required, use 

the search feature to locate a To-do.

2. After locating the To-do, select  >

Result

The Copy To-do  dialog appears.

3. Enter an appropriate name for the copied To-do.

4. If required, select the following options:

◦ Keep Chekclist  - Creates a copy of the To-do in the checklist of the original To-do.

◦ Keep Due Date  - Retains the due date of the original To-do.
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◦ Keep Assignee  - Retains the assignee of the original To-do.

◦ Keep Description  - Retains the description of the original To-do.

5. Click Duplicate.

Result

A success message appears.

Changing the status to In Progress

About this task

To change the status of a single To-do, or multiple To-dos, to In Progress, complete the following steps:

1. On the Checklists  page, locate the required To-do, or To-dos, from the My To-dos  tab or the Flagged To-dos  tab. If 

required, use the search feature to locate the To-dos.

2. After locating the To-dos, select the checkbox preceding the To-dos. Ensure that the status of all the selected To-dos 

is New.

3. Select Actions  > Mark as 'In Progress'.

Changing the status to Completed

About this task

To change the status of a single To-do, or multiple To-dos, to Completed, complete the following steps:

1. On the Checklists  page, locate the required To-do, or To-dos, from the My To-dos  tab or the Flagged To-dos  tab. If 

required, use the search feature to locate the To-dos.

2. After locating the To-dos, select the checkbox preceding the To-dos. Ensure that the status of all the selected To-dos 

is New  or In Progress.

3. Select Actions  > Mark as 'Completed'.

Flagging To-dos

About this task

You can flag specific to-dos as per your requirement. Flagging to-dos helps you locate the To-dos that you want to take 

action on.

To flag a single to-do or to flag multiple to-dos, complete the following steps:

1. To flag an single To-do, complete the following steps:

a. In the My To-dos  tab, locate the required To-do. If required, use the search feature to locate the To-do.

b. After locating the required To-do, select  > .

2. To flag multiple To-dos, complete the following steps:
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a. On the Checklists  page, locate the required To-dos from the My To-dos  tab. If required, use the search feature 

to locate the To-dos.

b. After locating the To-dos, select the checkbox preceding the To-dos.

c. Select Actions  > Mark as 'Flag'.

Unselecting To-dos

About this task

To unselect To-dos, complete the following steps:

1. On the Checklists  page, locate the required To-do, or To-dos, from the My To-dos  tab or the Flagged To-dos  tab. If 

required, use the search feature to locate the To-dos.

2. To unselect all selected To-dos, select Actions  > Unselect All To-dos.

Deleting To-dos

About this task

You can delete only the to-dos created by you. You cannot delete to-dos assigned to you.

To delete a single to-do or to delete multiple to-dos, complete the following steps:

1. To delete an single To-do, complete the following steps:

a. In the My To-dos  tab, of the Flagged To-dos  tab, locate the required To-do. If required, use the search feature 

to locate the To-do.

b. After locating the required To-do, select  > .

Result

A confirmation box appears.

c. Click Delete.

Result

A success message appears upon deletion.

2. To delete multiple To-dos, complete the following steps:

a. On the Checklists  page, locate the required To-dos from the My To-dos  tab or the Flagged To-dos  tab. If 

required, use the search feature to locate the To-dos.

b. After locating the To-dos, select the checkbox preceding the To-dos.

c. Select Actions  > Delete All To-dos.

Result

A confirmation box appears.

d. Click Delete.
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Result

A success message appears upon deletion.

Rejecting To-dos
(This feature is available in version 12.1.0.4) Sometimes, an assigner may assign a To-do to the wrong assignee. In such 

cases, assignees can reject a To-do. You can only reject To-dos that are assigned to you and not part of any checklist.

About this task

Some conditions related to rejecting to-dos are as follows:

• You can only reject To-dos that are assigned to you.

• You can only reject To-dos with Status  as New.

To reject a To-do, complete the following steps:

1. Locate the required To-do.

2. Click it to open a preview.

3. Click Reject To-do.

A Reject To-do  dialog appears.

4. Enter Reason For Rejecting a To-do.

5. Click Reject.

Checklists
You can use a Checklist to create and maintain a list of to-dos for yourself or for another user.

The features of checklists are as follows:

• You can create a checklist for yourself.

• You can share a checklist with other users and assign edit privileges to the users.

• You can share a checklist with other users and assign only view privileges to the users.

• You can set the status of a checklist.

Checklist users can have one of the following roles:

Role Permissions

Owner View Checklist | Modify Checklist | Delete Checklist

Editor View Checklist | Modify Checklist

Viewer View Checklist

Creating Checklists
Create a checklist to maintain a list of To-dos for a particular activity.
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About this task

To create a Checklist, complete the following steps:

1. On the Checklists page, click + Checklist. In case of two or more checklists, you can also add a new Checklist by 

placing the cursor between two checklist tiles and selecting Click here to Add a Checklist.

Result

A new Checklist tile appears in My Board.

Note:  If there are 10 Checklists on My Board, an alert appears saying that there are already 10 Checklists 

on the board. Remove the unwanted checklist by selecting the appropriate option from Select Checklist to 

Remove from Board, and clicking Remove and Add.The system will remove the selected Checklist and add 

the new Checklist.

2. In the Checklist tile, enter an appropriate Name.

3. Click Add.

4. Add To-dos to the Checklist. For more information on adding To-dos, see Creating To-dos  on page 287.

Viewing Checklists and Checklist info
You can view the checklists that you created or the checklists shared with you.

About this task

To view and locate checklists, complete the following steps:

1. On the Checklists  page, you can view the checklists in the My Board  section. You can view a maximum of 10 

checklists on My Board.

2. If required, you can reorganize the checklists in your desired order. Just drag the Checklist from the current location 

and drop it at the required location.

3. Use Search for checklist on the board to locate the required Checklist. For more information, see Searching a 

Checklist  on page 297.

4. After locating the Checklist, to view Checklist information, select .

Result

A side panel appears displaying the following information:

◦ Owner of the Checklist

◦ Number of To-dos in the Checklist

◦ Checklist priority

◦ Users with editor privilege

◦ Users with viewer privilege

◦ History of the Checklist
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Viewing Assigned Checklists
You can assign, or share, a Checklist with another user.

About this task

To share a checklist with another user, complete the following steps:

1. On the Cheklists  page, in My board  section, locate the required checklist tile. If required, use the Search for Checklist 

on Board  bar to locate the checklist.

2. After locating the required checklist, inside the checklist tile, select  > .

Result

The Edit Checklist  dialog appears.

3. In the Shared with:  field, select the user you wish to assign, or share, the Checklist.

4. Click Save.

5. The user, to to whom the Checklist is assigned to, will have a notification on the Cheklists  page, beside My board.

6. The user must select View checklist.

Result

The View Checklist  page appears and the assigned Checklist appears in the Checklist assigned to you  section.

7. If required, the user can drag-and-drop the Checklists to their My board  if it has less than 10 Checklists. If there 

are more than 10 Checklists, the user must first remove the required number of Checklists, and drag-and-drop the 

assigned Checklists to their My board.

Searching a Checklist
You can only search for Checklists that exist on your My Board panel.

About this task

The My Board  panel displays only 10 checklists at a time and the search only locates the matching checklists out of the 10 

checklists on yor board.

To search checklists, complete the following steps:

1. From the Platform homepage, select Plan  > Checklist.

2. On the My Board  panel, place the cursor on the Search for checklist on the board  field.

3. Type in the name of the required Checklist. If the checklist is available on the My Board  panel, the system locates and 

displays the Checklist.

Adding To-dos to a Checklist
You can either create to-dos and add it to a checklist, or you can directly add to-dos inside a checklist.

About this task

To add to-dos to a checklist, you can perform either of the following steps:
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1. If you want to create a To-do first and assign it to a checklist later, you must:

a. Create a To-do. For more information, see Creating To-dos  on page 287.

b. Drag-and-drop the created To-dos to the required Checklist. You can also drag-and-drop To-dos from one 

Checklist to another.

2. If you want to create a To-do directly into a Checklist, you must:

a. Locate the required Checklist. For more information on locating a Checklist, see .Searching a Checklist  on 

page 297

b. Select + To-do.

c. Perform the steps mentioned in Creating To-dos  on page 287. You cannot modify the field Select Checklist 

as you are creating the To-do for a specific Checklist.

Searching for To-dos in a Checklist
Instead of using the common search for To-dos, you can search for To-dos in a specific Checklist.

About this task

To search for To-dos in a specific Checklist only, complete the following steps:

1. Locate the required Checklist. For more information on locating a Checklist, see Searching a Checklist  on page 297.

2. Inside the located Checklist, place the cursor on the Search for To-do  field.

3. Type in the name of the required To-do. If the To-do exists in the Checklist, the system locates and displays the To-do.

4. If you still cannot see the To-do, change the Filter  to the value All To-dos.

Editing a Checklist
You can make modifications to a checklist. When modifying a checklist, you can share the checklist with another user.

About this task

To edit a checklist, complete the following steps:

1. On the Cheklists  page, in My Boards  section, locate the required checklist tile. If required, use the Search for 

Checklist on Board  bar to locate the checklist.

2. After locating the required checklist, inside the checklist tile, select  > .

Result

The Edit Checklist  dialog appears.

3. In the General  tab, you may modify the following fields:

◦ Priority  - Available values are:

▪ Low

▪ Medium

▪ High

◦ Name of Checklist  - The checklist name.
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◦ Shared with:  - To share the checklist with a user, search for the user and select the user. Assing one of the 

following privileges to the user:

▪ Can edit  - The selected user can edit the checklist.

▪ Can view  - The selected user can only view the checklist.

To remove the selected user, hover over the user name and select .

4. Select History  tab to view all edits made to the checklist by you or the user with whom the checklist was shared.

5. Click Save.

Result

A success message appears.

Copying a Checklist
You can make a copy of an existing checklist with all settings intact.

About this task

To create a copy of a checklist, complete the following steps:

1. On the Cheklists  page, in My Boards  section, locate the required checklist tile. If required, use the Search for 

Checklist on Board  bar to locate the checklist.

2. After locating the required checklist, inside the checklist tile, select  > .

Result

The Copy checklist  dialog appears.

Note:  If there are already 10 Checklists on My Board, an alert appears saying that there are already 10 

Checklists on the board. Remove the unwanted checklist by selecting the appropriate option from Select 

Checklist to Remove from Board, and clicking Remove and Add.The system will remove the selected 

Checklist and add the copied Checklist.

3. Enter an appropriate name for the copied checklist.

4. If required, select the following options:

◦ Keep All Assignments  - Retains all the assignments of the original checklist.

◦ Keep All Due Date  - Retains the due date of all To-dos of the original checklists.

◦ Keep Editors  - Retains all users with editing privileges on the checklist.

◦ Keep Viewers  - Retains all users with viewing privileges on the checklist.

5. Click Duplicate.

Result

A success message appears.
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Deleting a Checklist
You can delete a checklist with all the To-dos.

About this task

To delete a checklist, complete the following steps:

1. On the Cheklists  page, in My Boards  section, locate the required checklist tile. If required, use the Search for 

Checklist on Board  bar to locate the checklist.

2. After locating the required checklist, inside the checklist tile, select  > .

Result

The Delete checklist  dialog appears.

3. Click Delete.

Result

A success message appears. Any To-dos owned by other users will not be deleted. They will be disassociated from 

the Checklist.

Setting Checklist preferences
You can set your preferences for Checklists displayed on My board.

About this task

To set Checklist preferences, complete the following steps:

1. On the Checklist  page, click Checklist preference.

Result

The Checklist preference  side panel appears.

2. You can perform the following actions on the Checklist  section:

a. Place the cursor in the Search for checklist field, type the Checklist name and click the search icon.

b. If you do not see any results, change the default filter to one of the following options:

▪ Created by me

▪ Editable

▪ Viewable

c. If required, you can also change the sorting options from the list.

3. Drag-and-drop Checklists from the Checklist  section to the My board  section.

Note:
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◦ You cannot drag-and-drop Checklists, if it displays the message Already added on My board  in the 

Checklist.

◦ My board  section accommodates only 10 Checklists at a time. You can drag-and-drop Checklists only 

if the number of Checklists is lesser than 10. If there are already 10 Checklists, you must delete the 

required number of Checklists you wish to add, before performing the drag-and-drop action. See Step 

4  for removing Checklists from My board.

4. You can perform the following actions on the My board  section:

a. Select  succeeding the Checklist to view Checklist information. For more details, see Viewing Checklists 

and Checklist info  on page 296.

b. Select  to delete individual Checklists from My board.

c. Select the checkbox preceeding the Checklists and click Remove from board  to remove multiple Checklists 

from the board.

301


	Unica Plan V12.1.7 User's Guide
	Contents
	Chapter 1. Introduction
	What does Unica Plan do?
	Why use Unica Plan?
	Unica Plan documentation and help
	Unica Plan workflow
	Integration with Unica Campaign

	Business processes
	Relationship of planning objects
	Plans
	Programs
	Projects
	Project structure
	Project requests

	Approvals
	Teams
	Alerts
	Attachments
	Metrics
	Workflows
	Functional roles
	Security policies
	Strategic planning and financial management
	Accounts
	Budgets
	Fiscal year
	Granularity

	Cost categories
	Invoices

	Libraries of reusable elements
	Marketing objects
	Marketing object type
	Marketing object template
	Marketing object instance

	Digital asset management


	Logging in to Unica
	Customize Unica Plan
	Setting your start page
	Setting your basic settings
	Setting your approvals options
	Setting your project options
	User Personalization section

	Setting your tasks options
	Setting options for projects
	Receiving project health status updates by email

	Optional project columns
	Rearranging columns on object lists
	Setting your analytics options
	Defining Out-of-office settings


	Chapter 2. Common tasks
	Attachments
	To add an attachment to an object
	To remove an attachment from an object
	To send e-mail attachments

	Statuses of business processes
	Status changes
	Changing the status of business processes
	Changing the status of multiple projects or requests

	Disabled attribute values
	Disabled attribute values in objects
	Example: disabled attribute values

	Selecting resources
	Printing objects
	Exporting information in Microsoft™ Excel format

	Chapter 3. Plans
	Plan views
	Summary information for plans
	Fiscal year for plans
	Viewing budget information
	Editing budget information

	Adding a plan
	Adding and removing program areas
	Linking a program to a plan
	Creating a program from a plan
	Removing a program from a plan
	Starting plans
	Deleting a plan

	Chapter 4. Programs
	Program views
	Summary information for programs
	Supporting projects and requests
	Adding a program
	Starting programs
	Adding new project requests and projects to programs
	Linking existing projects to programs
	Removing projects from programs
	Deleting programs

	Chapter 5. Projects
	Projects and project requests
	Project reconciliation
	Project request statuses
	Project health

	Project views
	Selecting project views
	Project search
	Displaying projects in list and calendar view modes

	Unica Campaign projects in an integrated system
	Project codes and campaign codes

	Creating projects
	Cloning projects
	Starting projects
	Project attachments tab
	Project requests
	Creating requests
	Submitting requests
	Monitoring the status of project requests
	Canceling or redrafting requests
	Responding to requests as an individual
	Copying requests

	Copying projects
	Team projects and requests
	Team projects lifecycle
	

	Reassigning team projects
	Responding to team requests as a team manager

	Navigating from projects to programs
	Linked projects
	Subprojects overview
	Details on the project-subproject relationship
	Creating child projects and requests
	Linking child projects and requests to projects
	Security for linked projects
	Removing parent-child project links

	Linking a Journey to Projects
	Linking a Journey
	Viewing the linked Journey

	Unlinking a Journey

	Assigning work
	Reconciling projects
	Deleting projects
	Project and request deactivation
	Deactivating projects and requests
	Reactivating projects and requests


	Chapter 6. Workflows
	Workflows - Enhanced version
	Workflow concepts
	Tasks
	Form tasks
	Approval tasks
	Flowchart approval
	Stages
	Milestones
	Dates
	Duration
	Effort
	Locked tasks
	People and roles
	Schedules
	Baseline scheduling
	Up-to-date scheduling
	Using a baseline schedule
	Keeping an up-to-date schedule

	Recalculating dates
	Calculating workflow dates automatically
	Calculating date dependencies above a locked task

	Scheduling work time
	Non-work time
	Weekends
	Work and non-work time settings


	Modifying workflows
	Workflow toolbar
	Adding a stage or task
	Adding form tasks
	Adding rows to the workflow
	Adding rows below a locked approval task
	Stage and task sequence
	Task dependencies
	Inserting tasks in series
	Inserting tasks in parallel
	Deleting tasks
	Default and "last used" modes


	Workflow columns
	Filling data into a range of cells
	Workflow copy and paste
	Copying tasks on Macintosh/Safari
	Copying data in Internet Explorer

	Adding roles and members to tasks
	Roles, people, and approval tasks
	Example: Order of reviewers for an approval task
	The My Tasks list

	Filters on the My Tasks page
	Task pane
	Defining a milestone for a task

	Workflow task status
	Approval task status
	Completing multiple tasks
	Skipping multiple tasks
	Skipping an approval task


	Importing workflow templates into projects
	Considerations for importing and exporting form tasks in workflow templates
	Considerations for importing and exporting approvals with approval steps in workflow templates

	Saving projects as workflow templates

	Workflows - Classic version
	Workflow views
	Spreadsheet view mode
	Post Task Update dialog
	Task status tab
	Task attachments tab

	Adding an attachment to a task
	Starting an approval process from view mode

	Timeline view mode
	Spreadsheet or timeline view customization
	Options on the Project Workflow Tab Layout dialog

	Setting the first column width

	Process flowchart view
	Workflow concepts
	Tasks
	Form tasks
	Approval tasks
	Flowchart approval
	Stages
	Milestones
	Dates
	Duration
	Effort
	Locked tasks
	People and roles
	Schedules
	Baseline scheduling
	Up-to-date scheduling
	Using a baseline schedule
	Keeping an up-to-date schedule

	Date dependency calculations
	Calculating workflow dates automatically
	Calculating date dependencies above a locked task

	Scheduling work time
	Non-work time
	Weekends
	Work and non-work time settings


	Editing workflow spreadsheets
	Edit mode toolbar
	Adding a stage or task
	Adding form tasks
	Adding rows to the workflow spreadsheet
	Adding rows below a locked approval task
	Stage and task sequence
	Task dependencies
	Inserting tasks in series
	Inserting tasks in parallel
	Deleting tasks
	Default and "last used" modes


	Workflow spreadsheet columns
	Filling data into a range of cells
	Workflow copy and paste
	Copying tasks on Macintosh/Safari
	Copying data in Internet Explorer

	Adding roles and members to tasks
	Roles, people, and approval tasks
	Example: Order of reviewers for an approval task
	The My Tasks list

	Filters on the My Tasks page
	Task pane
	Defining a milestone for a task

	Workflow task status
	Approval task status
	Completing multiple tasks
	Skipping multiple tasks
	Skipping an approval task


	Importing workflow templates into projects
	Considerations for importing and exporting form tasks in workflow templates
	Considerations for importing and exporting approvals with approval steps in workflow templates



	Chapter 7. Approvals
	Approval concepts
	Approval Status
	Stand-alone approvals
	Approval tasks
	Reapproval rules for form approvals
	Configuring form approval tasks
	Approval dates
	Due dates for approvals
	Approval due date calculation example
	Different approver durations example

	Approval Sequence
	Rejected approvals
	Approval organization

	Approval process workflow
	Creating Approval Processes
	Assigning Approvers
	Adding approval items
	Submitting approval processes for review
	Methods of evaluating approvals
	Evaluating approval processes
	Approval portlet
	Evaluating approval processes in the Approval Portlet
	Mobile features in Unica Plan
	Evaluating approval processes on mobile devices

	Post complete response
	Modifying approval processes
	Canceling approval processes
	Copying approval processes
	Deleting an approval
	Completing approval processes
	Putting approval processes on hold
	Reactivating approval processes that are on hold

	Reassigning team approvals
	Approval processes linked to workflow tasks
	Attachment markup types in Unica Plan
	Native markup for websites
	Marking up attachments
	Adobe™ Acrobat markup in Unica Plan
	Native Unica Plan markup
	Menu bar
	Annotations list

	PDF Embed API markup


	Chapter 8. People and teams
	People tab
	Project member management
	Notes on managing project members
	Managing project members
	Managing teams
	Team alerts
	Team summary page
	Adding and editing teams
	Editing team members
	Task routing options
	Approval routing options
	Request routing options
	Virtual project participants
	Assigning team tasks
	Assigning team requests


	Changing the access level for a project member
	Find and replace task members or reviewers
	Filters
	Buttons

	Select project members and reviewers page

	Managing reviewers
	Object access levels
	Roles and permissions
	Assigning work by role
	Removing a role
	Adding a role

	Assigning people to roles

	Chapter 9. Calendar
	Customizing the calendar appearance
	Calendar display options
	Setting your default calendar options
	Changing your view of the calendar

	Timeline view of the calendar
	Text or graphical calendar views
	Monthly calendar
	Calendar color coding
	Horizontal bars on the calendar
	Brief and detailed views of tasks

	Publishing the calendar

	Chapter 10. Grids
	Grid edit mode
	Permissions
	Locked data
	Revision history

	Grid controls
	View mode
	Edit mode

	Importing grid data
	Exporting grid data
	Posting read-only grid data to URLs
	Grouping read-only grid data

	Chapter 11. Marketing objects
	Marketing object type
	Marketing object template
	Marketing object instance
	Offer object type
	Creating marketing objects
	Marketing object cross-reference report
	Modifies and references relationships
	Select marketing objects
	Deleting marketing objects
	Adding marketing object references to forms or grid rows
	Marketing object references in approvals
	Simple search (Search tab)
	Saved search (Browse tab)


	Chapter 12. Assets and asset libraries
	Asset libraries
	Changing from asset list view to thumbnail view
	Adding an asset
	New Asset page
	Security considerations

	Editing an asset
	Adding a version of an asset
	Asset statuses
	Changing the status of assets
	Viewing an asset
	Viewing history of an asset
	Adding an asset folder
	Deleting assets and folders from the Asset list page
	Deleting an asset from within the asset
	Moving assets and folders from the Asset list page
	Moving an asset from within the asset

	Chapter 13. Budgets
	Fiscal year
	Granularity
	Budget funding
	Planning budgets from the top down
	Planning budgets from the bottom up

	Effects of deleting links between plans, programs, and projects
	Budgets and accounts
	Budget views
	The Plan Budget tab
	Plan Budget Summary table
	The Remaining column

	Program Costs table

	The Program Budget tab
	Navigating with budget ancestors
	Program Budget Summary table
	Project Costs table
	Program Line Item Details table

	The Project Budget tab
	Budget allocation versions
	Creating budget versions
	Deleting budget versions
	Comparing budget versions
	Marking a budget version "in-use"

	Allocating funds
	Allocating funds for stand-alone programs and projects
	Adding and editing line items
	Finalizing budget line items
	Discarding budget line items

	Budget line item approvals

	Chapter 14. Invoices
	Adding an invoice
	New Invoice page
	Editing invoices
	Line item rollups
	Invoice Line Item Approvals
	Rollups to the source program or project
	Rollups to the source account

	Adding and editing invoice line items
	Field descriptions for the Edit Invoice Line Items page
	Invoice status types
	Changing the status of invoices
	Deleting an invoice
	Printing the invoice summary

	Chapter 15. Accounts
	The account Summary page
	Account summary table
	Selecting the fiscal year to view

	Chapter 16. Metrics
	Setting up program and project metrics
	Editing program and project metrics
	Entering planned values for metrics that roll up
	Views for rollup metrics
	Importing metrics from a campaign
	Finalizing and rolling up metrics

	Chapter 17. Reports
	Report appearance and output
	Sending reports in email
	Filtering data with search and select
	Dates filters
	Active dates

	Status and type filters
	Multi-object reports
	Generating the Marketing Activity report
	Generating the Overdue Milestone report
	Generating the Program Tasks and Milestones report
	Generating the Project Performance Crosstab report
	Generating the Project Performance Summary report
	Generating the Resource Task Load report
	Generating the Vendor Spend Summary report

	Single-object reports
	Viewing the revision history of an object
	Generating the Approval and Compliance Listing report
	Generating the Budget Summary by Quarter report
	Generating the Detailed Expense Breakout report
	Generating the Work Assigned to Team or Team Member reports

	Dashboard portlets
	Unica Plan list portlets
	Quick link portlets
	Unica Plan report portlets
	Custom portlet to show standard or saved search


	Chapter 18. Searches
	Simple searches
	Advanced searches
	Permissions considerations
	Grid searches
	Object attribute searches
	Searching a digital asset library
	Searching for objects other than assets
	Regrouping and reordering search criteria
	The Not In operator
	Templates and attributes
	The behavior of the Not In operator

	Assets advanced search page
	Advanced search page for objects other than assets
	Saved searches
	How to access saved searches
	How to set the sort order in saved searches
	Viewing a saved search
	Deleting a saved search


	Chapter 19. Alerts and the message board
	The Alerts page
	Alerts on outside email addresses
	Comments for alerts
	Subscribing to alerts for an object
	Brief and detailed task alerts
	Task alert level
	Group events that contribute to detailed alerts
	Examples of brief and detailed alerts

	Posting a message on the message board
	Configuring a Collaboration Tool

	Chapter 20. Reading a message on the message board
	Chapter 21. Checklists and To-dos
	To-dos
	Creating To-dos
	Viewing the To-do list and previewing a To-do
	Searching for To-dos
	Editing a To-do
	Using Notes

	Actions on To-dos
	Copying a To-do
	Changing the status to In Progress
	Changing the status to Completed
	Flagging To-dos
	Unselecting To-dos
	Deleting To-dos

	Rejecting To-dos

	Checklists
	Creating Checklists
	Viewing Checklists and Checklist info
	Viewing Assigned Checklists

	Searching a Checklist
	Adding To-dos to a Checklist
	Searching for To-dos in a Checklist
	Editing a Checklist
	Copying a Checklist
	Deleting a Checklist
	Setting Checklist preferences



